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om00before0010

In dit document worden MONTAGE M6, MONTAGE M7 en MONTAGE M8x gezamenlijk
"MONTAGE M" genoemd.

Indicatie Omschrijving

Geeft aan dat er een defect, storing of gegevensverlies mogelijk is.

Geeft aanvullende informatie aan.

Over deze handleiding

Informatie

De illustraties en lcd-schermen zoals getoond in deze bedieningshandleiding zijn alleen voor
instructieve doeleinden.

Tenzij anders is aangegeven, zijn de afbeeldingen en schermen in deze bedieningshandleiding
gebaseerd op de MONTAGE M6 (in het Engels).

Lightning is het handelsmerk van Apple Inc., gedeponeerd in de V.S. en andere landen.

De MIDI 2.0-logo's ( ) zijn handelsmerken of gedeponeerde handelsmerken van de
Association of Musical Electronics Industry (AMEI) en THE MIDI MANUFACTURERS
ASSOCIATION INCORPORATED (MMA).

De namen van bedrijven en producten in deze handleiding zijn handelsmerken of gedeponeerde
handelsmerken van hun respectieve eigenaars.

Indicaties in dit document

Modelnaam

Overige
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om00before0020

Hieronder vindt u informatie over het gebruik van de bedieningshandleiding (HTML). Voor meer
informatie over het gebruik van de PDF-versie, raadpleegt u de handleiding voor uw viewer-software.

Voer het trefwoord in het zoekvak in de rechterbovenhoek in om in de bedieningshandleiding te
zoeken.

Als u iets aan de bladwijzers wilt toevoegen, klikt u op het sterpictogram rechts van de koptitel.
Als u een bladwijzer wilt verwijderen, klikt u op " " rechts van de koptitel.

Klik of tik op het pictogram onder aan de pagina en selecteer de printer.

Gebruik van de MONTAGE M bedieningshandleiding

Zoeken

Bladwijzer maken

Afdrukken
De pagina opslaan als PDF-bestand
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om00before0030

Nieuwe functies:

Opgeloste problemen:

Opgeloste problemen:

Opgeloste problemen:

Nieuwe functies:

Opgeloste problemen:

Nieuwe functies:

Firmwareversies

v1.22 t/m v2.00

Een nieuw effecttype (Shimmer Reverb) is toegevoegd.

Nieuwe golfvormen (nieuwe CFX en CP80) en performances zijn toegevoegd.

Wave Folder is toegevoegd aan AN-X-partijen.

De AN-X Smart Morph-functie is toegevoegd.

Ondersteunt nu de MIDI 2.0-protocollen.

Er zijn verbeteringen aangebracht in de gebruikersinterface.

Andere kleine problemen werden opgelost.

v1.21 t/m v1.22

Er is een probleem opgelost waarbij bepaalde performance-informatie niet correct werd geladen bij
het laden van de volgende modelbestanden.
* MOTIF XS, MOTIF XF, MOXF, MONTAGE, MODX, MODX+.

v1.20 t/m v1.21

Er is een communicatiefout met Expanded Softsynth Plugin for MONTAGE M. opgelost.

v1.11 t/m v1.20

Ondersteunt nu Expanded Softsynth Plugin for MONTAGE M.

U kunt nu de parameterwaarden zien wanneer u de knoppen bedient terwijl er een grafiek wordt
weergegeven op het Sub-display.

U kunt nu gedeeltelijke wijzigingen aanbrengen in de lettergrootte op het scherm Live Set en het
scherm Category Search.

Er zijn verbeteringen aangebracht in de gebruikersinterface.

v1.10 t/m v1.11

Er is een probleem opgelost waarbij de Keyboard AT Mode ook de MONTAGE M6/7 beïnvloedde.

Andere kleine problemen werden opgelost.

v1.00 t/m v1.10

Er zijn nieuwe performances toegevoegd.
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Opgeloste problemen:

Er zijn verbeteringen aangebracht in de gebruikersinterface.

Andere kleine problemen werden opgelost.
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om01basicoperation0010

In dit hoofdstuk wordt de basisstructuur van MONTAGE M uitgelegd en hoe u deze kunt gebruiken.

Inhoudsopgave

De MONTAGE M gebruiken

Basisstructuur

Instellen voor live performance

Opnemen en afspelen

Back-upbestanden van uw performances beheren

Gebruik van microfoons en audioapparatuur

Externe MIDI-instrumenten aansluiten
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om01basicoperation0020

Inhoudsopgave

Basisstructuur

Blokschema en datastroom

Toongeneratorblok

Intern geheugen
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om01basicoperation0030

Dit instrument bestaat uit acht belangrijke functionele blokken: Controller, Motion Sequencer, Tone
Generator, Effects, Sequencer, Arpeggio, Envelope Follower en A/D Input.

(Klik of tik op de tekst in het functionele blok om naar de bijbehorende pagina te springen.)

(1) Besturingsbericht
(2) Audiosignaal
(3) Regelaar

Blokschema en datastroom
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(4) Motion Sequencer
(5) Toongenerator
(6) Effecten
(7) Sequencer
(8) Arpeggio
(9) Envelope Follower
(10) A/D-ingang
(11) Controlematrix
(12) Computer
(13) Externe MIDI-apparatuur
(14) Microfoon, audioapparatuur enz.
(15) Versterkers enz.
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om01basicoperation0350

Het toongeneratorblok is uitgerust met een hybride soundengine die drie synthesesystemen
combineert.

De AWM2-soundengine beschikt over golfvormen met gesamplede golfdata die u aan elk element
kunt toewijzen, en waarmee u vervolgens het geluid kunt aanpassen met behulp van filters en EG's
(envelopgeneratoren). Elke normale partij gebruikt maximaal 128 elementen om een breed scala aan
rijke geluiden te genereren waarmee u expressieve geluiden kunt creëren. Omdat de onbewerkte
golfvormen die zijn gesampled van de daadwerkelijke akoestische instrumenten, zijn verwerkt om
elke noot voor verschillende muzieksoorten te kunnen gebruiken, produceert deze soundengine het
realistische geluid van muziekinstrumenten zoals bijvoorbeeld piano en blaasinstrumenten. U kunt
deze soundengine niet alleen gebruiken voor het reproduceren van realistische instrumentgeluiden,
maar ook voor het creëren van compleet nieuwe geluiden met behulp van filters en de EG. Voor de
drumpartij kunt u maximaal 73 drumtoetsen gebruiken om de golfvormen van percussiegeluiden aan
elke toets op het toetsenbord toe te wijzen, om zo een gewenste drumkit te creëren.

Toongeneratorblok

AWM2-soundengine

Normale partij

Drumpartij
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De drumpartij heeft maximaal 73 drumtoetsen die u kunt gebruiken om de gewenste drumkits te
maken door de golfvormen van percussiegeluiden aan elke toets op het toetsenbord toe te wijzen.

De FM-X-soundengine gebruikt acht oscillatoren (operators) om de frequentie van de golven die door
elke operator worden gegenereerd, te moduleren om rijke harmonische boventonen te creëren.
De operators zijn gegroepeerd in twee rollen: Carrier en Modulator. De Modulators moduleren de
volgende operator terwijl de Carriers de resulterende geluiden genereren. De functie waarin de
operator zichzelf moduleert, wordt 'feedback' genoemd. De FM-X-soundengine beschikt over
voorgeprogrammeerde algoritmen met 88 verschillende patronen om de operators met elkaar te
verbinden. Met deze soundengine kunt u de parameters gebruiken om de harmonische boventonen
van de operator-golven te regelen en dezelfde hoogwaardige filters, effecten en EQ toe te passen die
beschikbaar zijn in de AWM2-soundengine om complexere geluiden te creëren dan mogelijk zijn met
conventionele FM-soundengines.

Afzonderlijke drumgeluiden (voor elke toets anders) (C0 t/m
C6)

FM-X-soundengine
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(1) Feedback
(2) Modulator
(3) Carrier
(4) Operator
(5) Frequency Modulation
(6) Algorithm
(7) Voorbeeld van FM (frequentiemodulatie)
(8) Modulator wave
(9) Carrier wave
(10) Modulated wave

De AN-X is een virtueel analoge soundengine die het gedrag van analoge synthesizers digitaal tot in
detail reproduceert.
Met hun traditionele en innovatieve kenmerken bieden de oscillatoren van deze AN-soundengine van
de volgende generatie meer flexibiliteit in modulatie- en golfvormingsfuncties, zodat u een grote
verscheidenheid aan geluiden kunt creëren - van 'echte' vintage tot scherp en extreem.

AN-X-soundengine

Beschikt over drie oscillatoren en één ruisgenerator.

OSC3 moduleert OSC1 en OSC2 (ofwel met frequentiemodulatie of ringmodulatie).

Elke OSC regelt de vorm van de golven door Pulse Width, OSC Self Sync of Wave Shaper te
gebruiken.

U kunt instellen dat elke OSC uitvoer maakt vóór of na Filter 1 en Filter 2.
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om01basicoperation0040

Het interne geheugen van dit instrument bevat de opgeslagen Performances, Live Sets, songs en
andere instellingen.
Dit schema toont de datastroom tussen het interne geheugen en het externe apparaat.

(Klik of tik om de afbeelding te vergroten.)

Bevat de vooraf ingestelde performances, vooraf ingestelde arpeggio's, vooraf ingestelde
auditiefrasen en andere instellingen.
U kunt de gegevens in het Preset-geheugen niet overschrijven, aangezien dit alleen-lezen is.

De bewerkingsbuffer is het werkgebied voor het bewerken van Performances, Live Sets, songs en
andere instellingen.
In dit werkgebied mag u zowel lezen als schrijven, en de inhoud binnen dit werkgebied wordt gewist

Intern geheugen

Presetgeheugen

Bewerkingsbuffer
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wanneer het instrument wordt uitgeschakeld.
De bewerkte performances en motion sequences moeten in het gebruikersgeheugen worden
opgeslagen voordat u een andere performance selecteert of het instrument uitschakelt.
(Andere instellingen worden automatisch opgeslagen.)

Het gebruikersgeheugen bestaat uit twee gebieden: Gebruiker en Bibliotheek.

Het gebruikersgebied bevat de opgeslagen performances en motion sequences, en andere
instellingen voor het hele instrument, zoals Utility-instellingen en andere gebruikersdata die in de
bewerkingsbuffer zijn bewerkt.
Wanneer een gebruikersperformance wordt bewerkt, kunt u deze opslaan als een nieuwe
performance of de bestaande performance overschrijven.

In het bibliotheekgebied kunnen maximaal 16 bibliotheekbestanden (.Y2L) worden geladen vanaf het
USB-flashstation. De instellingen die zijn opgeslagen in het bibliotheekgebied kunnen niet worden
bewerkt. Als u de instellingen in het bibliotheekgebied wilt bewerken, stuurt u de data naar de
bewerkingsbuffer door een performance te selecteren die is opgeslagen in het bibliotheekgebied of
door een motion sequence uit het bibliotheekgebied te laden. Na het bewerken worden de gegevens
opgeslagen in het gebruikersgebied.

Het gebruikersgeheugen wordt gebruikt voor lezen en schrijven, en de gegevens in dit gebied blijven
behouden nadat het instrument is uitgeschakeld.

De terugroepbuffer en de vergelijkingsbuffer zijn gebieden die worden gebruikt voor het tijdelijk
opslaan van de instellingen die u aan het bewerken bent.

De terugroepbuffer wordt gebruikt als back-up voor de bewerkingsbuffer.
Als u per ongeluk naar een andere performance bent overgestapt zonder de instelling eerst op te
slaan, kunt u de terugroepfunctie gebruiken (Recall) om de tijdelijk opgeslagen instellingen van de
terugroepbuffer naar de bewerkingsbuffer te herstellen.

De vergelijkingsbuffer is het gebied waar instellingen worden bewaard voordat wijzigingen worden
aangebracht. Door de vergelijkingsfunctie te gebruiken, kunt u de instellingen die tijdelijk zijn
opgeslagen in de vergelijkingsbuffer gebruiken om de bewerkte en onbewerkte geluiden te
vergelijken.

Deze buffers zijn bedoeld voor het lezen en schrijven van data, maar de instellingen gaan verloren
als het instrument wordt uitgeschakeld.

Gebruikersgeheugen

Terugroepbuffer en vergelijkingsbuffer
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om01basicoperation0050

Hieronder ziet u een algemene workflowgids voor de MONTAGE M.

1 Een performance selecteren

Maak een keuze uit het Live set-scherm of het Category Search-scherm.

2 De instellingen bewerken

3 Bewerkte instellingen opslaan

4 Een Live Setmaken

5 Een Live Setselecteren

6 Het toetsenbord bespelen

Instellen voor live performance
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om01basicoperation0060

1 Druk op de knop [LIVE SET].

Het Live Set-scherm wordt weergegeven.

2 Druk indien nodig op de [BANK]-knop en de [PAGE]-knop om een ander
scherm te selecteren. Zoek een performance die u wilt gebruiken en tik op de
naam van de performance op het scherm om deze te selecteren.

Een performance selecteren in het Live Set-scherm
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om01basicoperation0070

Met de functie Category Search kunt u performances, partijen, ritmepatronen, arpeggio's en
golfvormen doorzoeken om te vinden wat u wilt gebruiken.
Als u naar de gewenste performance wilt zoeken, opent u het scherm Performance en drukt u op de
knop [CATEGORY] om het scherm Performance Category Search (Zoeken in performancecategorie)
te openen.
Terwijl het scherm Category Search wordt weergegeven, kunt u de knoppen op het bovenpaneel
gebruiken om de Part Select-, Mute- of Solo-instellingen te wijzigen.

OPMERKING
U kunt ook een performance selecteren door de cursor op de Performance Name op het Home-scherm te plaatsen
en de datadraaiknop, [INC/YES]-knop en [DEC/NO]-knop te gebruiken.

1 Druk op de knop [CATEGORY].

Het scherm Performance Category wordt weergegeven.
U kunt het scherm Performance Category Search ook openen door Category Search te
selecteren in het contextmenu van de Performance Name.

(1) Filter
Met behulp van het filter kunt u door de lijst met performances zoeken.

OPMERKING

Een performance selecteren in het scherm Category Search

U kunt de OR-voorwaarde (Of) voor categorieën gebruiken door op de juiste selectieknoppen
voor de categorienaam te drukken.
U kunt de OR-voorwaarde (Of) ook instellen door op de categorienaam te tikken terwijl u de
[SHIFT]-knop ingedrukt houdt.
U kunt ook een subcategorie selecteren door tegelijkertijd de [SHIFT]-knop ingedrukt te houden
en op een van de selectieknoppen voor het sleufnummer en de categorienaam te drukken.
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Selecteer er een uit Main en Sub.

Selecteer een attribuut of combinaties van attributen. Afhankelijk van de combinatie
gebruikt het filter de voorwaarden AND of OR (En of Of).

Filter:

Exacte overeenkomst · AWM2, FM-X en AN-X

AND-voorwaarde · MC, SSS en Smart Morph

OR-voorwaarde
· Single en Multi
· MOTIF XF, MONTAGE en MONTAGE M

(2) Bank
(3) Zoeken op trefwoord
(4) Taak
(5) De lijst met performances die overeenkomen met de geselecteerde Category en

Attribute

De geselecteerde performance wordt wit weergegeven, performances met één partij
worden groen weergegeven en performances met meerdere partijen worden blauw

Category

Attribute
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weergegeven.

(6) De sorteervolgorde wijzigen
(7) Auditie

2 Wijzig indien nodig het filter, de bank en de sorteervolgorde.

3 Selecteer er een uit de lijst rechts.

Verplaats de cursor met de datadraaiknop, de knoppen omhoog en omlaag, de knop [INC] of
de knop [DEC].
Door de PAGE-knoppen of de Display-draaiknoppen op het bovenpaneel te gebruiken, kunt u
naar beneden scrollen zonder de Performance te wijzigen.

OPMERKING
Houd tegelijkertijd de knop [SHIFT] ingedrukt en gebruik de sleufnummerknoppen 9 t/m 16 om een ​​
specifieke performance te selecteren.

4 Om het scherm Performance Category Search te sluiten, drukt u op de knop
[ENTER], [EXIT] of [PERFORMANCE] op het bovenpaneel of tikt u op het
pictogram  (Home) of  (Afsluiten) op het scherm.

OPMERKING
U kunt de functie Part Category Search gebruiken als u een van de partijen in een performance met
meerdere partijen wilt wijzigen.
Om het scherm Part Category Search te openen, selecteert u een partij die u wilt wijzigen en drukt u
vervolgens op een van de [CATEGORY]-knoppen terwijl u de [SHIFT]-knop ingedrukt houdt.

Door de auditiefrase te gebruiken, kunt u naar het geluid van de performance luisteren en horen hoe
het geluid zal veranderen door de regelaars te bedienen, voordat de selectie definitief is.

1 Druk op de knop [AUDITION] op het bovenpaneel of tik op de knop Audition
op het scherm Category Search.

De auditiefrase van de huidige performance wordt afgespeeld.
Als u tijdens het afspelen van de auditiefrase een nieuwe performance selecteert, wordt de
auditiefrase van de nieuwe performance afgespeeld.

Een geïnitialiseerde performance of een performance met één partij selecteren
met behulp van een filter

Selecteer een geïnitialiseerde performance uit de lijst die wordt weergegeven door Bank/Favorite in
te stellen op All of Preset en het filter Category op Init.

Selecteer een performance met één partij uit de weergegeven lijst door het filter Attribute in te
stellen op Single.

Luisteren naar de auditiefrasen
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Als de knop [AUDITION] is uitgeschakeld, is de auditiefunctie niet beschikbaar voor de
geselecteerde performance en gebeurt er niets als u erop drukt.

2 Om het afspelen van de auditiefrase te stoppen, drukt u nogmaals op de knop
[AUDITION] op het bovenpaneel of tikt u op de knop Audition op het scherm.
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om01basicoperation0080

Er zijn andere functies voor het aanpassen van de balans tussen partijen binnen de performance of
voor het snel overschakelen naar verschillende groepen instellingen die vooraf voor de knoppen zijn
geregistreerd.

Inhoudsopgave

Met de Mix-functie kunt u de balans tussen de partijen aanpassen.
De pan-, volume- en andere instellingen voor alle partijen worden op één scherm weergegeven,
zodat u de Mixing-parameters voor de performance gemakkelijk kunt aanpassen.

1 Tik om het scherm te openen vanuit [PERFORMANCE] → Mixing.

Het scherm Mixing wordt weergegeven.

Algemene functies gebruiken voor de gehele performance

De balans tussen partijen aanpassen (mixen)

Procedure voor mixen

Scènes gebruiken

Procedure voor het registreren van een scène

Scènes registreren vanaf het Scene-scherm

Scènes registreren vanaf andere schermen

De balans tussen partijen aanpassen (mixen)

Procedure voor mixen
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(1) Hoofdcategorie voor elke partij
(2) Van weergave wisselen voor Solo, Mute en Keyboard Control
(3) Schakelen tussen de weergaven 3-band EQ en 2-band EQ
(4) EQ voor elke partij
(5) Parameters voor elke partij
(6) Overschakelen naar weergave voor 16 partijen
(7) Weergave audiopartij (weergave van 16 partijen niet getoond)

Met de audiopartij kunt u de parameters instellen voor de audio-ingang van de A/D INPUT-

aansluitingen en de [USB TO HOST]-aansluiting (digitale* partij).

* Verwijst naar de audio die is ingesteld op Digital L/R in audiokanalen.

2 Selecteer een parameter met behulp van de PART-knoppen of cursorknoppen
op het bovenpaneel, of tik op de pictogrammen en knoppen op het scherm.

3 Wijzig de waarde met behulp van de datadraaiknop of de relevante Display-
knop.

Als u de waarde heel nauwkeurig wilt aanpassen, drukt u op de knop [EDIT/ ] terwijl het
Mixing-scherm wordt weergegeven, om het scherm Edit te openen.

De scène is een 'momentopname' van verschillende instellingen, zoals het arpeggiotype, het Motion
Sequence-type en de partijparameters. Door verschillende scènes te registreren onder elk van de
acht SCENE-knoppen, kunt u de SCENE-knoppen gebruiken om verschillende instellingen
onmiddellijk op te roepen.
Dit zou bijvoorbeeld handig zijn als u alleen de typen arpeggio en motion sequence wilt wijzigen,
zonder de performance te wijzigen, om de voortgang van een song te volgen of om een ​​ander aspect
van een performance naar voren te brengen.

1 Open het scherm vanuit de [PERFORMANCE] → Scene.

Het scherm Scene wordt weergegeven.

Scènes gebruiken

Procedure voor het registreren van een scène

Scènes registreren vanaf het Scene-scherm
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(1) Tabblad Scene
(2) Geheugenschakelaar
(3) Instellingen voor het tabblad

Als de Memorize switch (geheugenschakelaar) op On staat, verschijnen de parameters
voor de functie op het scherm.

2 Stel scènes 1 tot 8 in.

De functies waarvoor Memory (geheugenschakelaar) is ingesteld op On, worden geregistreerd
onder de geselecteerde SCENE-knop.
De zojuist ingestelde scène wordt nu actief als u op de juiste SCENE-knop drukt.

3 Druk op de knop [STORE] om de scène-instellingen in de performance op te
slaan.

LET OP

Zorg ervoor dat u de scène-instellingen die u zojuist hebt bewerkt, opslaat (Store) voordat u naar
een andere performance overschakelt of het instrument uitschakelt. Als u de opslagbewerking
Store niet uitvoert, gaan de scène-instellingen verloren.

Als een parameter die voor een scène kan worden geregistreerd al aan een knop of schuifregelaar is
toegewezen, verplaatst u de knop of de schuifregelaar. Vervolgens houdt u tegelijk de knop [SHIFT]
ingedrukt en drukt u op de knop [SCENE]. Daarna drukt u op de knop [STORE] om de scène-
instellingen in de performance op te slaan.

Scènes registreren vanaf andere schermen
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om01basicoperation0100

Inhoudsopgave

Met Split kunt u het toetsenbord in secties verdelen om elke sectie met een ander geluid te spelen,
terwijl u met Layer meerdere geluiden boven op elkaar kunt combineren in een Split-sectie of over
het hele toetsenbord.

De instellingen bewerken

Split en Layer gebruiken

Procedure voor bewerken

Procedure voor volledige bewerking

Het scherm Navigation gebruiken

Procedure voor snelle bewerking

Toonveranderingen creëren

Effectverbindingen en instellingen

De effectinstellingen wijzigen

Arpeggio gebruiken

Arpeggio in- en uitschakelen

Arpeggio wijzigen met behulp van de knoppen

De manier wijzigen waarop het afspelen van arpeggio's wordt in- of uitgeschakeld

Motion Control gebruiken

Basisprincipes voor Motion Control

De Super Knob-instellingen aanpassen

De Super Knob bedienen vanaf de pedalen

Voorbeeld van een instelling voor de Super Knob

Motion Sequencer gebruiken

Motion Sequencer in- of uitschakelen

Motion Sequencer wijzigen met behulp van de knoppen

De manier wijzigen waarop Motion Sequence wordt geactiveerd

De Motion Sequence bewerken

De Envelope Follower gebruiken

Een voorbeeld van het instellen van de Envelope Follower in het scherm Rhythm
Pattern

Smart Morph gebruiken

Split en Layer gebruiken
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Om splitsingen en lagen op de MONTAGE M in te stellen, gebruikt u de splitspunten om groepen
toetsenbordsecties te maken en een partij aan elke groep toe te wijzen.

Om het scherm Split setting te openen, drukt u op de knop [SPLIT].
Het scherm Split Job voor de performance verschijnt, waarin u de Split-instellingen kunt wijzigen.
Door op de items op het scherm te tikken om het nummer en de positie voor het splitspunt op te
geven, kunt u het toetsenbereik instellen en voor elke partij een geluid selecteren.
Door op de groepsknop (A, B, C, D) op het scherm te tikken terwijl u de [SHIFT]-knop ingedrukt
houdt, kunt u de partij voor meer dan één groep instellen.

Wanneer de installatie is voltooid, drukt u op de knop [EXIT] op het bovenpaneel of tikt u op Done op
het scherm.

Als u op  linksboven tikt, wordt de instelling geannuleerd en wordt het scherm gesloten.

Als u het notenbereik wilt wijzigen, houdt u de knop [SHIFT] ingedrukt terwijl u op de knop [SPLIT]
drukt.
Hierdoor wordt de weergave Part—Note van het scherm Performance geopend, waarin u het
notenbereik van elke partij kunt wijzigen.
Stel de waarde in met behulp van het ingebouwde toetsenbord of de datadraaiknop.

Bewerken heeft betrekking op de functies voor volledige bewerking met gebruik van het hoofddisplay
en de functies voor snelle bewerking met gebruik van het sub-display.
U kunt Full Edit (volledige bewerking) gebruiken om toegang te krijgen tot alle bewerkingsfuncties en
Quick Edit (snelle bewerking) gebruiken om direct toegang te krijgen tot enkele veelgebruikte
parameters.
Door de knop [PAGE JUMP] te gebruiken, kunt u dezelfde parameter bewerken vanuit Full Edit en
Quick Edit.
U kunt ook verschillende schermen voor het hoofddisplay en het sub-display gebruiken om meerdere
parameters tegelijk te controleren terwijl u schakelt tussen Full Edit en Quick Edit.

Procedure voor bewerken
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(1) Quick Edit (bekijk het sub-display)
(2) Full Edit (bekijk het hoofddisplay)

1 Selecteer een performance.

2 Verplaats de cursor op scherm Performance naar de gewenste Performance
Name of Part.

3 Druk op de knop [EDIT/ ] of tik op Edit in het contextmenu.

Het scherm Common Edit verschijnt als de cursor op de Performance Name staat.
Het scherm Part Edit voor de soundengine verschijnt als de cursor op de Part staat.

4 Selecteer een tabblad op de eerste en tweede rij om het scherm te openen.

Om een tabblad te selecteren, kunt u tegelijkertijd de [SHIFT]-knop ingedrukt houden en de
juiste selectieknoppen voor sleufnummer en categorienaam gebruiken, of eenvoudigweg op
het tabblad op het scherm tikken. (Raadpleeg de Beknopte handleiding.)

Het wordt aanbevolen om de instellingen op elk tabblad van boven naar beneden te wijzigen.

5 Bewerk de instellingen door de parameters rechts van de tabbladen te
wijzigen.

Procedure voor volledige bewerking

Voorbeeld: normale partij (AWM2)
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6 Ga indien nodig verder met het bewerken van de parameters op verschillende
tabbladen.

Het te bewerken doel wordt weergegeven op de navigatiebalk.
Selecteer Common (Algemeen) om de instellingen voor de hele performance te bewerken.
Selecteer Part Common (Algemeen partij) om de instellingen voor de hele partij te bewerken.
Als u naar de gedetailleerde instellingen wilt gaan, selecteert u een van de volgende opties:
Element 1 tot 128, Operator 1 tot 8, Oscillator 1 tot 3, Noise en de toetsen C0 tot C6 van de
partij.

7 Als u klaar bent met bewerken, drukt u op de knop [STORE] om de
performance op te slaan.

U kunt de te bewerken parameter wijzigen door het scherm Edit te openen vanuit:
[PERFORMANCE] → [EDIT/ ] en het gewenste item te selecteren op de navigatiebalk.

1 Druk op de knop [NAVIGATION].

Het scherm NAVIGATION verschijnt.

Wanneer u tijdens het bewerken op de knop [NAVIGATION] drukt, kunt u eenvoudig vinden
waar u zich  op de kaart bevindt.

2 Selecteer de gewenste parameter om te bewerken.

Selecteer Part Common (Algemeen partij) om de instellingen voor de hele partij te bewerken.
Als u naar de gedetailleerde instellingen wilt gaan, selecteert u een van de volgende opties:
Element 1 tot 128, Operator 1 tot 8, Oscillator 1 tot 3, Noise en de toetsen C0 tot C6 van de
partij.

Het scherm Navigation gebruiken
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3 Selecteer het pictogram voor de instelling die u wilt wijzigen.

Gebruik de cursorknoppen om de cursor te verplaatsen en druk vervolgens op de knop
[ENTER]. Of tik op het pictogram op het scherm.

4 Wijzig de parameters die op het scherm worden weergegeven.

5 Sla de performance op.

1 Gebruik de knop [QUICK EDIT], Tab PAGE-knoppen en Tabselectieknoppen
om van pagina's en tabbladen op het sub-display te wisselen.

2 Gebruik knoppen 1 tot en met 8 om instellingen te wijzigen.

3 Om de instellingen heel nauwkeurig aan te passen, drukt u op de knop [PAGE
JUMP] om de corresponderende parameter in het hoofddisplay op te roepen.

OPMERKING
Als u naar een ander tabblad in het hoofddisplay bent gegaan, kunt u de corresponderende parameter in het
sub-display oproepen door tegelijkertijd de knop [SHIFT] ingedrukt te houden en op de knop [PAGE JUMP]
te drukken.
(De parameter verschijnt in sommige gevallen mogelijk niet.)

Voor het creëren van toonveranderingen kunt u oscillators, filters, EG's (of envelopgeneratoren),
LFO's (of laagfrequente oscillatoren) en effecten gebruiken. Door deze parameters te wijzigen, kunt u
de helderheid, resonantie of andere timbrekwaliteiten van het geluid wijzigen.
De beschikbare instellingen zijn afhankelijk van het type soundengine. Sommige parameters
(hieronder) worden vaak gebruikt voor alle typen soundengines.

Procedure voor snelle bewerking

Toonveranderingen creëren

Oscillator (Osc): creëert de basisgeluidsgolven

Pitch: regelt de toonhoogte

Filter: regelt de afsnijfrequentie

EG: bepaalt hoe het geluid binnen een tijdsbestek verandert

LFO: bepaalt de cyclische verandering van het geluid

Motion Sequencer: creëert complexe veranderingen in het geluid binnen een tijdsbestek
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De effecten die beschikbaar zijn op de MONTAGE M omvatten systeemeffecten die worden
toegepast op alle partijen in de performance, invoegeffecten die worden toegepast op elke partij,
mastereffecten die worden toegepast op de uiteindelijke uitvoer, en equalizers zoals partij-EQ en
master-EQ. Het signaalstroomschema voor de effecten wordt hieronder weergegeven.

(1) De partij-EQ en invoegeffecten instellen
[PERFORMANCE] → Part-selectie → [EDIT/ ] → Effect

Effects: verwerkt het geluid

Effectverbindingen en instellingen
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(2) De variatie- en reverbeffecten instellen
[PERFORMANCE] → Part-selectie → [EDIT/ ] → Effect → Routing
[PERFORMANCE] → Common-selectie → [EDIT/ ] → Effect → Variation
[PERFORMANCE] → Common-selectie → [EDIT/ ] → Effect → Reverb

(3) Het mastereffect instellen
[PERFORMANCE] → Common-selectie → [EDIT/ ] → Effect → Master FX

(4) De master-EQ instellen
[PERFORMANCE] → Common-selectie → [EDIT/ ] → Effect → Master EQ

OPMERKING
De effecten voor de audio-ingang van de A/D INPUT-aansluiting kunnen worden ingesteld via: [PERFORMANCE]
→ Common-selectie → [EDIT/ ] → Audio In.

Voor informatie over de effectcategorie en effecttypen, zie de Effecttypen.
Zie de Data List voor meer informatie over het voorinstellingsprogramma voor elk effecttype.

U kunt de effecten wijzigen door gebruik te maken van Full Edit en Quick Edit.
Als u op de [NAVIGATION]-knop drukt terwijl u de [SHIFT]-knop ingedrukt houdt, verschijnt het
scherm FX Overview en ziet u een overzicht van de effectinstellingen.
Tik op de knoppen op de effectnamen zoals Ins A en Var om het scherm Edit te openen.

Met de arpeggiofunctie op de MONTAGE M kunt u typische arpeggio's spelen, maar ook
ingewikkeldere ritmepatronen en achtergrondtracks aan uw toetsenbordspel toevoegen. Hiermee
beschikt u niet alleen over inspiratie en complete ritmische passages voor uw live optredens, u
beschikt tevens over volledig gevormde instrumentale achtergrondpartijen van verschillende
muziekgenres waarmee u eenvoudiger songs kunt maken.

De effectinstellingen wijzigen

Arpeggio gebruiken
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U kunt ook elk van de acht gewenste arpeggiotypen toewijzen aan elke partij en de arpeggio’s voor
maximaal acht partijen tegelijkertijd afspelen.
U kunt ook het nootbereik (Note Limit) of de sterkte van de toetsaanslag instellen (Velocity Limit) voor
het afspelen van arpeggio.

Met de arpeggiofunctie kunt u accentfrasen spelen (de sequencefrase die alleen wordt gespeeld als
het toetsenbord met een hogere aanslagsnelheid wordt bespeeld dan de opgegeven waarde) of
effectgeluiden zoals fretruis op een gitaar met behulp van de Random SFX-functie. Sommige vooraf
ingestelde arpeggiotypen zijn ingesteld op het afspelen van accentfrasen en willekeurige SFX-
geluiden. U kunt de accentfrasen en willekeurige SFX-geluiden vinden door het scherm Arpeggio
Category Search te gebruiken en Accent (Accentfrase) of Random SFX voor Attribute in te
schakelen.

Druk op de knop [ARP ON/OFF] op het bovenpaneel om het afspelen van arpeggio in of uit te
schakelen.

Door op de knop [QUICK EDIT] te drukken om SELECTED PART te selecteren en vervolgens de
tabselectieknoppen te gebruiken om de tab ARP/MS te selecteren, kunt u vervolgens de knoppen 1
t/m 7 gebruiken om de arpeggio's te wijzigen.
Wijzig de arpeggio's door aan de knoppen te draaien en naar het afspelen van de arpeggio te
luisteren. Vink de namen van de parameters aan die zijn toegewezen aan knoppen 1 tot en met 7 in
het sub-display.
Als u de instellingen verder wilt verfijnen, drukt u op de knop [PAGE JUMP] om naar het hoofddisplay
te gaan en door te gaan met bewerken.

Normaal gesproken wordt het arpeggio afgespeeld terwijl een toets wordt ingedrukt. U kunt de
instellingen echter zo wijzigen dat het arpeggio doorgaat met afspelen nadat de vinger van de toets is
gehaald.

Arpeggio in- en uitschakelen

Arpeggio wijzigen met behulp van de knoppen

De manier wijzigen waarop het afspelen van arpeggio's wordt in- of
uitgeschakeld
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De manier waarop het afspelen van arpeggio's wordt in- of uitgeschakeld, kan worden ingesteld met
Hold en Trigger Mode.

[EDIT/ ] → Part-selectie → Common → Arpeggio → Common

[EDIT/ ] → Part-selectie → Common → Arpeggio → Advanced

Wordt alleen afgespeeld terwijl een toets wordt ingedrukt
Hold: Off
Trigger Mode: Gate

Het afspelen gaat door nadat de vinger van de toets is gehaald
Hold: On
Trigger Mode: Gate

Elke keer dat u op de toets drukt, wordt het afspelen in- of uitgeschakeld
Trigger Mode: Toggle
(ongeacht de Hold-instellingen)

OPMERKING
Als Arp Master en Arp Part zijn ingesteld op ON, kunt u de knop [KEYBOARD HOLD] aanzetten op het
bovenpaneel om hetzelfde effect te bereiken als wanneer u Hold instelt op ON.

Met de Motion Control-functie kunt u in real time Motion (ritmische en dynamische
geluidsveranderingen) creëren, zodat u compleet nieuwe manieren van expressie kunt vinden. Met
deze functie kunt u de instellingen vooraf maken, zodat u de parameters kunt wijzigen zonder de
pedalen of wielen daadwerkelijk te bedienen. Hierdoor kunt u dramatische en krachtige expressieve
veranderingen creëren die het ritme van uw muziek volgen.

Hold

Trigger Mode

Motion Control gebruiken
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(1) Voortdurend regelen van Motion-veranderingen
(2) Schakelen tussen Motions
(3) Trigger
(4) De Motion Sequencer in real time regelen
(5) Ritmische verandering
(6) Automatisering
(7) Multidimensionale geluidswisseling

Motion Control kan worden ingesteld door de Source (bron) voor de regelaar in te stellen, evenals het
besturingsdoel (Destination (Bestemming) en Parameter) in het scherm Control Assign (Toewijzen
van regelaar).

Basisprincipes voor Motion Control
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Voor de Super Knob stelt u het Display Filter in op SuperKnob en stelt u vervolgens de Source
(AsgnKnob 1−8) en Destination in.
Voor Motion Sequence stelt u de Source in op een Motion Sequence Lane van 1 t/m 4.
Voor Envelope Follower stelt u de Source in op EnvFollow.

[PERFORMANCE] → Common-selectie → [EDIT/ ] → Control → Control Assign
[PERFORMANCE] → Part-selectie → [EDIT/ ] → Mod/Control → Control Assign

Door de Super Knob te gebruiken, kunt u tegelijkertijd de waarden Assign 1 t/m 8 besturen die zijn
toegewezen aan Knoppen 1 t/m 8 die voor alle partijen gemeenschappelijk zijn.

Door de Super Knob te bewegen terwijl u het toetsenbord bespeelt, kunt u geluiden wijzigen en kunt
u de parameterwaarden op het sub-display zien.
Als de knop [ASSIGN] is ingeschakeld (en de knop brandt), ziet u de wijzigingen in de knoppen 1 t/m
8 op de indicator en het sub-display.

Door de Super Knob en de Motion Sequencer te combineren, kunt u complexere
geluidsveranderingen bereiken.

U kunt de Super Knob bedienen via de afzonderlijk verkrijgbare voetregelaar (FC7) die is
aangesloten op de MONTAGE M.
Volg de onderstaande procedure.

1 Sluit de voetregelaar (FC7) aan op de FOOT CONTROLLER-aansluiting op het
achterpaneel.

2 Open het scherm vanuit: [PERFORMANCE] → [EDIT/ ] → Control →
Control Number.

De Super Knob-instellingen aanpassen

De Super Knob bedienen vanaf de pedalen
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3 Selecteer SuperKnob voor Foot Ctrl1 of Foot Ctrl2, afhankelijk van de
aansluiting waarop u de voetregelaar hebt aangesloten.

4 Sluit het scherm om de instelling te voltooien.

De Super Knob-instellingen kunnen worden aangepast.
U kunt twee of drie vaste waarden instellen voor het gebruik van de Super Knob voor het morphen
(transformeren) van geluiden. Als u drie vaste waarden wilt instellen, moet u eerst de Mid-instelling
inschakelen.

Hier leggen we uit hoe u morph-effecten kunt toevoegen aan het gelaagde geluid dat is gemaakt met
drie vooraf ingestelde performances (akoestische piano, padgeluid en elektrische piano), terwijl u de
originele instellingen voor deze performances behoudt.

Voorbeeld van een instelling voor de Super Knob

Een voorbeeld van morphen met behulp van drie vaste waarden:

Werkstroom

Selecteer een geluid voor partijen 1 t/m 3 (stap 1)

Stel de Super Knob in om de parameters voor partijen 1 t/m 3 te kunnen besturen (stappen 2 t/m 4)

Controleer de instellingen (stap 5)
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1 Selecteer geluiden voor partijen 1 t/m 3

1-1. Druk op de knop [CATEGORY] en selecteer CFX PopStudioGrand.

1-2. Tik in het Home-scherm op het pictogram [+] bij Part 2 om het scherm Part
Category Search te openen en selecteer AN-X Sine Pad PAT.

1-3. Tik in het Home-scherm op het pictogram [+] bij Part 3 om het scherm Part
Category Search te openen en selecteer TV Show FM EP.

2 Stel de parameters voor partij 1 in.

2-1. Selecteer Part 1.

2-2. Druk op de [CONTROL ASSIGN]-knop terwijl u de [SHIFT]-knop ingedrukt houdt.

Het scherm Control View wordt weergegeven.

2-3. Draai aan de Super Knob.

Het scherm Control Assign wordt weergegeven.

2-4. Door op het pictogram [+] te tikken, wordt Destination 10 (Bestemming 10)
toegevoegd.

Stel de parameters voor de Super Knob in voor de meest linkse, midden- en meest rechtse
posities. (Stappen 6 t/m 8)
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2-5. Tik op het tabblad Destination 10 en selecteer Volume bij Part Param.

2-6. Stel Polarity (Curve Polarity) in op Bi en stel Ratio (Curve Ratio) in op +127.

3 Stel de parameters voor partij 2 in.

3-1. Selecteer Part 2.

3-2. Druk op de knop [CONTROL ASSIGN] terwijl u de knop [SHIFT] ingedrukt houdt
en draai vervolgens aan de Super Knob.

Het scherm Control Assign voor partij 2 wordt weergegeven.

3-3. Als u op het pictogram [+] tikt, wordt Destination 7 toegevoegd.

3-4. Tik op het tabblad Destination 7 en selecteer Volume bij Part Param.

3-5. Stel Polarity (Curve Polarity) in op Bi en stel Ratio (Curve Ratio) in op +127.

4 Stel de parameters voor partij 3 in.

4-1. Selecteer Part 3.

4-2. Druk op de knop [CONTROL ASSIGN] terwijl u de knop [SHIFT] ingedrukt houdt
en draai vervolgens aan de Super Knob.

Het scherm Control Assign voor partij 3 wordt weergegeven.

4-3. Als u op het pictogram [+] tikt, wordt Destination 8 toegevoegd.

4-4. Tik op het tabblad Destination 8 en selecteer Volume bij Part Param.

4-5. Stel Polarity (Curve Polarity) in op Bi en stel Ratio (Curve Ratio) in op +127.

5 Controleer of de parameters voor partijen 1 tot en met 3 zijn ingesteld op
Common Assignable Knob.

5-1. Druk op de COMMON-knop voor selectie van de partij.

5-2. Druk op de knop [CONTROL ASSIGN] terwijl u de knop [SHIFT] ingedrukt houdt
en draai vervolgens aan de Super Knob.

Het scherm Control Assign voor de gemeenschappelijke partij wordt weergegeven.
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5-3. Tik op elk van de tabbladen Destination 6 t/m 8 om te controleren of de Source
respectievelijk is ingesteld op AsgnKnob 6 t/m 8, en de Destination Parameter is
ingesteld op Volume van partij 1 t/m 3.

6 Stel de LEFT-positie in op de Super Knob.

Dit creëert de instellingen voor de Super Knob wanneer deze helemaal naar links wordt
gedraaid.

6-1. Druk op de knop [KNOB POSITION LEFT].

6-2. Zorg ervoor dat COMMON is geselecteerd voor Part Select en druk vervolgens op
de knop [ASSIGN].

6-3. Om alleen de CFX PopStudioGrand op partij 1 op geluid te zetten, draait u knop 6
(Assign6) helemaal naar rechts (tot de maximale waarde) en knop 7 (Assign7) en
knop 8 (Assign8) helemaal naar links (tot de minimumwaarde).

6-4. Sla de instellingen op door tegelijkertijd de [SHIFT]-knop ingedrukt te houden en
op de KNOB POSITION [LEFT]-knop te drukken.

7 Stel de RIGHT-positie in op de Super Knob.

Dit creëert de instellingen voor de Super Knob wanneer deze helemaal naar rechts wordt
gedraaid.

7-1. Druk op de knop [KNOB POSITION RIGHT].

7-2. Om alleen de TV Show FM EP op partij 3 op geluid te zetten, draait u knop 8
(Assign8) helemaal naar rechts (tot de maximale waarde) en knop 6 (Assign6) en
knop 7 (Assign7) helemaal naar links (tot de minimumwaarde).

7-3. Sla de instellingen op door tegelijkertijd de [SHIFT]-knop ingedrukt te houden en
op de KNOB POSITION [RIGHT]-knop te drukken.

8 Stel de Mid position in op de Super Knob.

Schakel de Mid position in en draai vervolgens aan de Super Knob om de waarde voor de
middenpositie in te stellen.
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8-1. Houd de knop [NAVIGATION] ingedrukt.

Het scherm NAVIGATION verschijnt.

8-2. Tik op SUPER KNOB en open het scherm voor de Super Knob-instellingen.

8-3. Stel de waarde 512 in voor de Mid position.

8-4. Druk op de knop [KNOB POSITION MID].

8-5. Om alleen de AN-X Sine Pad PAT op partij 2 op geluid te zetten, draait u knop 7
(Assign7) helemaal naar rechts (tot de maximale waarde) en knop 6 (Assign6) en
knop 8 (Assign8) helemaal naar links (tot de minimumwaarde).

8-6. Sla de instellingen op door tegelijkertijd de [SHIFT]-knop ingedrukt te houden en
op de KNOB POSITION [MID]-knop te drukken.

De hoofdinstelling is nu voltooid.

Pas Curve type, Ratio en Param voor elke partij, LEFT, RIGHT en MID voor de KNOB POSITION
aan, indien gewenst.

Met de Motion Sequencer-functie kunt u geluidsveranderingen creëren door parametertijden te
regelen op basis van een sequence die u van tevoren hebt gemaakt.
Hiermee kunt u ritmische veranderingen instellen die synchroon lopen met het tempo van de
performance, het arpeggio of de ritmes die worden ingevoerd vanaf het aangesloten apparaat, en om
dergelijke veranderingen interactief en in real time te besturen, afhankelijk van de voortgang van de
song.

Met de Motion Sequencer kunt u maximaal vier lanes per partij gebruiken, of acht lanes voor een
performance. U kunt maximaal acht sequencepatronen per lane gebruiken.

U kunt ook het aanslagsnelheidsbereik voor het afspelen van de sequence instellen, de manier
waarop de sequence wordt gespeeld of het aantal stappen dat moet worden gespeeld, op dezelfde

De instellingen preciezer afstellen

Motion Sequencer gebruiken
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manier als u met het arpeggio zou doen.

De parameters voor elke lane kunnen worden ingesteld met de onderstaande procedure.
[PERFORMANCE] → Part-selectie → [EDIT/ ] → Motion Seq → Lane

Druk op de knop [MSEQ ON/OFF] op het bovenpaneel om de functie Motion Sequencer in/uit te
schakelen.

Door op de knop [QUICK EDIT] te drukken om SELECTED PART te selecteren en vervolgens de
tabselectieknoppen te gebruiken om het tabblad ARP/MS te selecteren en de knoppen Tab PAGE te
gebruiken om Motion Sequence te selecteren, kunt u vervolgens de knoppen 1 t/m 8 gebruiken om
de Motion Sequencer te wijzigen.
Wijzig de Motion Sequencer-instellingen door aan de knoppen te draaien en naar het afspelen van
de Motion Sequencer te luisteren. Vink de namen van de parameters aan die zijn toegewezen aan
knoppen 1 tot en met 8 in het sub-display.

Motion Sequencer in- of uitschakelen

Motion Sequencer wijzigen met behulp van de knoppen

De manier wijzigen waarop Motion Sequence wordt geactiveerd
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De manier waarop Motion Sequence wordt geactiveerd, kan worden ingesteld met de parameters
LaneSw en Trigger.

[PERFORMANCE] → Part-selectie → [EDIT/ ] → Motion Seq → Lane

Speelt de Motion Sequence af als u op een toets drukt
LaneSw: On
Trigger: Off

Speelt de Motion Sequencer af als op de knop [MSEQ TRIGGER] wordt gedrukt
LaneSw: On
Trigger: On
Sync: anders dan Arp

Motion Sequence bestaat uit maximaal 16 stappen.
Bewerk elke stap vanuit het scherm Edit Sequence.

Envelope Follower is de functie die de envelop van de golfvorm uit de audio-ingang haalt en wordt
gebruikt als regelaar voor het creëren van veranderingen in het geluid. Hiermee is de uitvoer van
partijen en de uitvoer van het externe apparaat dat op de A/D INPUT-aansluiting is aangesloten
mogelijk.

U kunt bijvoorbeeld de Envelope Follower van de partij waaraan u een ritmepatroon hebt
toegewezen, instellen als Source (Bron) om wijzigingen in andere partijen aan te brengen. Dit is
bijvoorbeeld handig als u het volume van een partij wilt verlagen terwijl een bepaalde andere partij
wordt gespeeld (dit heet 'ducking').

Elke Envelope Follower heeft zijn eigen invoerbron, zoals EnvFollow 1 voor partij 1, EnvFollow 2 voor
partij 2 en EnvFollow AD voor de audiopartij. De uitvoer van elke Envelope Follower kan worden
gewijzigd door een andere Source te selecteren in het scherm Control Assign.
U kunt bijvoorbeeld de Envelope Follower voor Partij 1 (EnvFollow 1) instellen om wijzigingen in partij

LaneSw, Trigger

De Motion Sequence bewerken

De Envelope Follower gebruiken
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2 aan te brengen. Hoe het geluid wordt gewijzigd door de uitvoer van elke Envelope Follower, kan
worden ingesteld in het scherm Control Assign.

(1) Ingangssignaal naar Envelope Follower (vast)
(2) Uitgangssignaal van Envelope Follower (de bestemming kan worden gewijzigd)

U kunt de Envelope Follower instellen in het scherm Rhythm Pattern (Ritmepatroon). Op deze manier
hebt u snel toegang tot de Envelope Follower-parameters die vaak voor de ritmepatronen worden
gebruikt.

Instellingen voor de Envelope Follower:

[PERFORMANCE] → Common-selectie → [EDIT/ ] → Effect → Routing → Envelope Follower
(EnvFollow MST)

[PERFORMANCE] → Common-selectie → [EDIT/ ] → Audio In → Routing → Envelope
Follower (EnvFollow AD)

[PERFORMANCE] → Part-selectie → [EDIT/ ] → Effect → Routing → Envelope Follower
(EnvFollow 1−16)

Een voorbeeld van het instellen van de Envelope Follower in het scherm
Rhythm Pattern
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1 Druk op de knop [SONG/PATTERN] terwijl u de knop [SHIFT] ingedrukt houdt
om het scherm Rhythm Pattern te openen.

2 Selecteer een drumgeluid uit de lijst aan de linkerkant van het scherm.

3 Tik op de Envelope Follower.

4 Zet de schakelaar van de Envelope Follower aan.

U kunt het toetsenbord bespelen om het effect van de Envelope Follower te beluisteren.

5 Wijzig de instellingen indien nodig.

Stel hier Polarity (Curve Polarity) in op Bi, Ratio (Curve Ratio) op −63, Gain (Envelope
Follower Gain) tot −12dB.

6 Als u de instellingen verder wilt bewerken, tikt u op Edit om het scherm voor
de Envelope Follower-instellingen te openen.

U kunt een nieuwe kit of nieuw arpeggiotype voor het ritmepatroon selecteren door
tegelijkertijd de knop [SHIFT] ingedrukt te houden en op de knop [SONG/PATTERN] te
drukken om terug te gaan naar het scherm Rhythm Pattern. De instellingen van de Envelope
Follower blijven behouden, zelfs nadat de nieuwe kit of het arpeggio voor het ritmepatroon zijn
geselecteerd.

Smart Morph is een functie die FM-X- of AN-X-partijen transformeert ('morpht' ) met behulp van
machine learning.
Door Smart Morph te gebruiken, kunt u voor partij 1 een nieuw geluid creëren uit meerdere FM-X- of
AN-X-partijen die u op het toetsenbord kunt spelen.

De functie Smart Morph analyseert elk geluid dat is toegewezen aan partijen 9 tot en met 16 en
tekent één punt per partij op de kaart. Elk punt op de kaart vertegenwoordigt een geluid, en de

Smart Morph gebruiken
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afstand tussen de punten laat de overeenkomsten tussen deze geluiden zien.
Als u op de knop Learn drukt, wordt er automatisch een punt voor het nieuwe geluid gegenereerd
tussen de bestaande punten op de kaart.

Als u op het punt op de kaart tikt, wordt het geluid voor dat punt geselecteerd voor partij 1.
U kunt een nieuwe plaats die u leuk vindt op de kaart vinden en de instellingen ervan opslaan om
een nieuwe partij te maken.

Door het punt op de kaart te slepen terwijl u het toetsenbord bespeelt, of door de Super Knob te
bewegen met de vooraf toegewezen bewegingen van twee tot acht punten, kunt u geheel nieuwe
geluiden creëren.
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om01basicoperation0110

Na het bewerken slaat u de performance die u hebt gemaakt op in het interne geheugen.
Het opslaan van de instellingen in het interne geheugen wordt de bewerking 'Store' genoemd.

LET OP

1 Druk op de knop [STORE].

Wanneer u een nieuwe performance opslaat, ziet u het bericht Store As New Performance.
Als er al een performance met dezelfde naam is opgeslagen, ziet u de opties Overwrite
Current Perf. (Huidige performance overschrijven) en Store As New Performance (Opslaan als
nieuwe performance).

2 Om de performance op te slaan als een nieuwe performance, tikt u op Store
As New Performance.

Om de reeds opgeslagen performance te overschrijven, tikt u op Overwrite Current Perf. en
vervolgens op Store (YES).

3 Typ de naam van de performance op het toetsenbordscherm.

Gebruik het toetsenbord dat op het hoofddisplay wordt weergegeven. Er kunnen maximaal 20
alfanumerieke tekens voor de naam worden gebruikt.

4 Tik op Done wanneer u klaar bent met het invoeren van de naam.

Bewerkte instellingen opslaan

Een performance opslaan

Als u een andere performance selecteert of het instrument uitschakelt zonder eerst de
performance op te slaan, gaan de instellingen die u aan het bewerken bent verloren.

De bestaande performances in de User bank (Gebruikersbank) zullen verloren gaan als u ze
overschrijft. Wanneer u Performances opslaat die u hebt bewerkt, zorg er dan voor dat u
bestaande Performances niet overschrijft. Belangrijke instellingen die u hebt gemaakt, moeten
worden opgeslagen op een USB-flashstation (Save). Voor de opslagbewerking, zie "Instellingen
opslaan op een USB-flashstation als back-upbestand (Save)."
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Wanneer de Store-bewerking is voltooid, wordt het scherm Performance op het scherm
weergegeven.
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Inhoudsopgave

De Live Set-functie is een handige manier om tussen verschillende performances te wisselen, terwijl
u bijvoorbeeld nummers op een setlist speelt.
Op de MONTAGE M kunt u eenvoudig een Live Set maken door uw favoriete performance in elke
sleuf te registreren.

U kunt een performance in de Live Set registreren door de onderstaande procedure te volgen.

LET OP

1 Selecteer een performance in het scherm Performance.

Hier moet de [LIVE SET]-knop volledig of gedimd verlicht zijn.

2 Houd de knop [SHIFT] ingedrukt terwijl u op de knop [LIVE SET] drukt.

Het Live Set Register-scherm wordt weergegeven.

Een Live Set maken

Een performance registreren in de sleuf voor een Live Set

Performances omwisselen die zijn geregistreerd in de sleuven van de Live Set

Een patroon, song of audiobestand registreren in de sleuf van de Live Set

Een voetschakelaar instellen voor het wijzigen van de sleuf van de Live Set

Een performance registreren in de sleuf voor een Live Set

Sla de performance die u zojuist hebt bewerkt, op voordat u de performance registreert in de Live
Set. Wanneer u echter registreert in de Live Set en Store As New Perf. and Register (Opslaan als
nieuwe performance en registreren) of Overwrite Current Perf. and Register (Huidige
performance overschrijven en registreren) selecteert, hoeft u de performance niet vooraf op te
slaan.

Als u een andere performance selecteert of het instrument uitschakelt zonder eerst de
performance op te slaan, gaan de bewerkte instellingen verloren.
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3 Selecteer een sleuf voor het registreren van de performance.

Verplaats de cursor met behulp van de selectieknoppen voor sleufnummer en categorienaam,
of tik op de sleuf die op het scherm wordt weergegeven.

4 Selecteer een van de beschikbare opslagbewerkingen en druk op de knop
[ENTER], of tik eenvoudigweg op uw selectie op het scherm.

De geselecteerde performance wordt geregistreerd in de sleuf.

U kunt de inhoud van twee sleuven omwisselen.

1 Open het scherm vanuit: [LIVE SET] (of Live Set-pictogram) → User Bank
selectie → [EDIT/ ].

Het scherm Live Set Edit wordt weergegeven.
Wanneer de Live Set-pagina op de Preset bank of de Library bank open is, verschijnt het
scherm Live Set Edit niet.

2 Tik op de JOB-knop op het scherm.

Het JOB-scherm verschijnt.

3 Tik op de sleuf waar u de performance naartoe wilt verplaatsen en tik
vervolgens op de knop Exchange op het scherm.

Store As New Perf. and Register: opslaan als een nieuwe performance en registreren in de
sleuf
Overwrite Current Perf. and Register: de huidige performance overschrijven en registreren in
de sleuf
Register without Storing: registreren zonder eerst de performance op te slaan

Performances omwisselen die zijn geregistreerd in de sleuven van de Live Set
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4 Tik op de sleuf waar u de performance naartoe wilt verplaatsen.

De performances van de twee sleuven worden omgewisseld.

5 Wanneer de omwisseling is voltooid, tikt u op Done om de bewerking te
beëindigen.

OPMERKING
Als u de gehele bank of de gehele Live Set-pagina wilt kopiëren of omwisselen, houdt u tegelijkertijd de
[SHIFT]-knop ingedrukt en drukt u op de [EDIT/ ]-knop. Vervolgens verschijnt het dialoogvenster.

U kunt ook patronen, songs of audiobestanden aan Live Set-sleuven toevoegen. Op deze manier
kunt u een sleuf selecteren voor het afspelen van een gewenst patroon, song of audiobestand, en
vervolgens de performance op het toetsenbord meespelen.

1 Open het scherm vanuit: [LIVE SET] (of Live Set-pictogram) → User Bank
selectie → [EDIT/ ].

Het scherm Live Set Edit wordt weergegeven.

Een patroon, song of audiobestand registreren in de sleuf van de Live Set
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2 Selecteer een sleuf of tik op [+] op het scherm.

3 Selecteer een van de sleuftypen.

Sleuftype Type

Perform Performance

Song Song

Audio Audiobestand

Pattern Patroon

4 Tik op de Pattern Name of Audio Name om het scherm Load te openen.

5 Selecteer het gewenste patroon of bestand om in de sleuf te registreren.

6 Tik op Done om de instelling te voltooien.

OPMERKING
U kunt ook een patroon of song registreren in de Live Set-sleuf door op de knoppen [SHIFT] en [LIVE SET]
te drukken als het opgenomen bestand is geselecteerd op het scherm Pattern of het scherm Song.

U kunt een andere Live Set-sleuf selecteren met behulp van een afzonderlijk verkrijgbare
voetschakelaar, zoals de FC4 of FC5.
Volg onderstaande procedure.

1 Sluit een voetschakelaar (FC4 of FC5) aan op de aansluiting ASSIGNABLE
FOOT SWITCH.

2 Open het scherm vanuit: [UTILITY] → Settings → MIDI I/O.

Het MIDI I/O-scherm verschijnt.

Een voetschakelaar instellen voor het wijzigen van de sleuf van de Live Set
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3 Stel FS Assign in op Live Set + of Live Set −.

Met Live Set + kunt u de volgende Live Set-sleuf in voorwaartse volgorde selecteren, en met
Live Set − kunt u de volgende Live Set-sleuf in omgekeerde volgorde selecteren.
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Bij live performances kunt u gemakkelijk het Live Set-scherm of het Home-scherm gebruiken terwijl u
het toetsenbord bespeelt. Als u het Home-scherm gebruikt, zorg er dan voor dat u een sleuf
selecteert op het Live Set-scherm.

1 Druk op de knop [LIVE SET] om het scherm te openen.

2 Wijzig indien nodig de bank en pagina.

3 Selecteer een sleuf.

Tik op het Live Set-scherm op een sleuf op de pagina om deze te selecteren.

Performances voor een setlist selecteren op het Live Set-scherm
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OPMERKING
De selectieknoppen voor het sleufnummer en de categorienaam kunnen worden gebruikt voor het
selecteren van items voor het Live Set-scherm of het scherm Category Search (of het scherm dat het laatst
werd opgeroepen).
Hierdoor kunt u een andere Live Set-sleuf selecteren terwijl u het Home-scherm op het hoofddisplay bekijkt.

53



om01basicoperation0140

Zorg ervoor dat u een performance selecteert voordat u het toetsenbord bespeelt.
Indien gewenst kunt u ook een specifiek patroon, specifieke song of audiobestand afspelen
(geregistreerd in een Live Set-sleuf), tegelijk met uw toetsenbordspel.

U kunt op het toetsenbord meespelen met het patroon, de song of het audiobestand dat in de sleuf is
geregistreerd.

OPMERKING
Terwijl de song of het patroon wordt afgespeeld, kunt u de performance niet wijzigen of een andere sleuf selecteren.
Als u dit probeert, verschijnt er een foutmelding op het scherm.

1 Selecteer een sleuf op het scherm Live Set.

2 Druk op de knop [ ] (Play).

Het patroon, de song of het audiobestand dat in de geselecteerde sleuf is geregistreerd, wordt
vervolgens afgespeeld.

OPMERKING
Terwijl het patroon, de song of het audiobestand wordt afgespeeld, wordt door op de knop [ ] (Play) te
drukken hetzelfde scherm weergegeven als het patroonscherm, het songscherm of het audioscherm.

3 Druk op de knop [ ] (Stop) om het afspelen te stoppen.

Het toetsenbord bespelen

Een patroon, song of audiobestand afspelen dat is geregistreerd in de sleuf
van de Live Set
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U kunt de MONTAGE M gebruiken om patronen, songs en audiobestanden op te nemen en af ​​te
spelen.
Patronen en songs worden opgenomen in het opslaggebied van het instrument, terwijl
audiobestanden worden opgenomen op een aangesloten USB-flashstation.

Inhoudsopgave

Opnemen en afspelen

Voorwaarden voor opnemen en afspelen

Een patroon opnemen

De laatste opnameactie annuleren (Undo en Redo)

Het patroon afspelen

Een song opnemen

Sommige partijen opnieuw opnemen (Punch-in-/Punch-out-opname)

De laatste opnameactie annuleren (Undo en Redo)

De song afspelen

Audio opnemen

Een audiobestand afspelen
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Patronen bestaan ​​uit MIDI-sequencedata, die korte frasen bevatten die zijn opgenomen als MIDI-
events.
Ze kunnen in een loop worden afgespeeld of worden gebruikt met de scènefunctie.
De MONTAGE M kan maximaal 128 patronen in het geheugengebied opslaan.

Songs bestaan ​​uit MIDI-sequencedata, die informatie bevatten over de bediening van het
toetsenbord en andere regelaars die zijn opgenomen als MIDI-events.
De MONTAGE M kan maximaal 128 songs in het geheugengebied opslaan.

Tracks zijn afzonderlijke opslaglocaties voor het opnemen van het toetsenbordspel. Een track
bevat de informatie voor één partij.
Er zijn maximaal 16 tracks beschikbaar op de MONTAGE M, zodat u maximaal 16 partijen kunt
gebruiken voor opnemen en afspelen.

Voorwaarden voor opnemen en afspelen

Patronen

Songs

Tracks
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1 Selecteer het gewenste geluid voor opname op Track 1.

2 Open het scherm vanuit: [SONG/PATTERN] → Pattern.

Het scherm Pattern wordt weergegeven.

OPMERKING
U kunt hetzelfde scherm openen via: [PERFORMANCE] → Play/Rec → Pattern.

3 Wijzig de Length (van de scène), het Tempo en andere instellingen indien
nodig.

4 Druk op een van de [SCENE]-knoppen om de gewenste scène voor opname te
selecteren.

5 Druk op de knop [ ] (Record).

Het opnemen wordt in stand-by gezet.

(1) Patroonnaam
(2) Naam van de momenteel geselecteerde performance
(3) Maat
(4) Positie voor opnemen en afspelen
(5) Tempo
(6) Quantizeren

Een patroon opnemen
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(7) Opnametypes wisselen (wordt niet weergegeven bij het opnemen van een nieuw
patroon)

(8) Scène
(9) Lengte van het patroon
(10) De functie in- of uitschakelen om de opname te starten bij het inschakelen van de toets
(11) De loop-instelling in- of uitschakelen

6 Druk op de knop [ ] (Play) om de opname te starten.

7 Speel op het toetsenbord.

Als Loop is ingeschakeld, wordt de opgenomen frase in een loop afgespeeld terwijl deze zich
op het opnamescherm bevindt. Op deze manier kunt u doorgaan met het opnemen van nieuwe
frasen op andere tracks, zonder dat u de recorder elke keer hoeft te stoppen en opnieuw te
starten.

OPMERKING
Wanneer u tijdens het opnemen op de REC-knop drukt, gaat de REC-knop knipperen en wordt de
Repeteermodus ingeschakeld. In de Repeteermodus wordt het patroon afgespeeld, maar wordt de opname
tijdelijk uitgeschakeld, wat handig is om te oefenen. Tijdens het opnemen kunt u schakelen tussen de
opname- en repeteermodus door op de REC-knop te drukken.

8 Selecteer het gewenste geluid voor opname op Track 2.

9 Speel op het toetsenbord mee met de frase die u op Track 1 hebt opgenomen.

10 Neem indien nodig andere tracks op.

Songs en patronen worden automatisch opgeslagen wanneer ze worden opgenomen.
Als u het tempo of het geluid van de opgenomen song of patroon wilt wijzigen voordat u deze
opslaat, selecteert u StorePattern&Perf Settings (of Store Song&Perf Settings voor een song).

OPMERKING
Als u parameters voor de performance hebt bewerkt, moet u de performance opslaan.

Undo annuleert de laatste opnameactie en verwijdert wat zojuist is opgenomen.
Redo herstelt de opname die werd geannuleerd door Undo.

Undo annuleert de laatste opnameactie en herstelt de opname in de oorspronkelijke staat.

De laatste opnameactie annuleren (Undo en Redo)

Undo (verschijnt niet als er geen opnames zijn.)
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Door Redo te selecteren, wordt de status van vóór de uitvoering van Undo hersteld.
Redo (verschijnt pas nadat Undo werd uitgevoerd.)
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Gebruik de sequencertransportknoppen om het opgenomen patroon af te spelen.

U kunt de SCENE-knoppen gebruiken om een ​​scène te selecteren die u wilt afspelen.

Het patroon afspelen
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Bij songopname worden de handelingen van de regelaars en knoppen, evenals het toetsenbordspel,
als MIDI-data op een track opgenomen. Voor toetsenbordspel worden alleen partijen opgenomen
waarvan de Keyboard Control-schakelaar op On staat.

Voor de knophandelingen worden ook de regelaarwijzigingsberichten en
parameterwijzigingsberichten opgenomen.
Voor meer informatie over regelaarwijziging raadpleegt u de Data List.

OPMERKING
Wanneer Arp Rec is ingeschakeld, wordt alleen het resultaat van het afspelen van arpeggio opgenomen.
Als Arp Rec is uitgeschakeld, worden gegevens van het volledige toetsenbordspel opgenomen, zodat u de
arpeggiopatronen later kunt wijzigen.

1 Selecteer een performance.

2 Druk op de knop [SONG/PATTERN] om het scherm Play/Rec te openen en
selecteer het tabblad Song en druk vervolgens op de knop [ ] (Record).

De knop [ ] (Record) knippert en het opnemen wordt in stand-by gezet.

OPMERKING
Het opnemen kan ook in stand-by worden gezet via: [PERFORMANCE] → Play/Rec → Song en door op de
knop [ ] (Record) te drukken.

3 Wijzig Time Signature (Maatsoort) en Rec Quantize (Opname quantizeren)
indien nodig.

Een song opnemen

61



(1) Songnaam
(2) Naam van de huidige geselecteerde performance
(3) Tel
(4) Positie voor het starten van de opname en het afspelen
(5) Quantizeren
(6) Toont de totale lengte van de sequence en de huidige afspeelpositie
(7) Tijd voor de hele sequence
(8) Schakelt het afspelen voor elke track in/uit.
(9) Arpeggio-opname in- of uitschakelen (alleen voor een nieuwe opname)

4 Wanneer de voorbereiding is voltooid, drukt u op de knop [ ] (Play) om de
opname te starten.

Als Click Settings is ingesteld, begint het vooraf tellen wanneer u op de knop [ ] (Play) drukt.
Begin met het bespelen van het toetsenbord na het vooraf tellen.

5 Als het toetsenbordspel is afgelopen, drukt u op de knop [ ] (Stop) om de
opname te stoppen.

Er zijn drie soorten opnames (Record Type) beschikbaar op de MONTAGE M; Replace, Overdub en
Punch.

Als u een bepaalde sectie opnieuw wilt opnemen, kunt u de Punch-in- en Punch-out-parameters voor
de Punch-opname instellen.
Wanneer u de punch-opname start, wordt de opgenomen song vanaf het begin afgespeeld. Wanneer
het afspelen de voor Punch-in ingestelde maat bereikt, start de opname automatisch. De opname

Sommige partijen opnieuw opnemen (Punch-in-/Punch-out-opname)

Replace: overschrijft de bestaande gegevens.

Overdub: voegt een laag toe aan het bestaande geluid op de track.

Punch: overschrijft het opgegeven gedeelte van de bestaande gegevens.
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eindigt automatisch wanneer de maat wordt bereikt die is ingesteld voor punch-out, en de rest van de
opgenomen song wordt tot het einde afgespeeld. Als u bijvoorbeeld de maten 3 t/m 5 van een song
van acht maten opnieuw wilt opnemen, volgt u de onderstaande instructies.

Voor de nieuwe opname

Na de nieuwe opname

(1) Start de opname
(2) Stop de opname
(3) Nieuwe opgenomen gegevens

Voor Punch-in Punch-out-opname stelt u de volgende parameters in het scherm Record Setup in.

(1) Record Type = Punch
(2) Punch in (maten en tellen om opnieuw op te nemen) = 003:01

Vanaf de hier gespecificeerde maat en tel wordt het geluid van de corresponderende track
uitgeschakeld en wordt uw toetsenbordspel opgenomen.

(3) Punch out (maten en tellen om het opnieuw opnemen te beëindigen) = 005:01
Vanaf de hier gespecificeerde maat en tel zal het nummer worden afgespeeld.
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Undo annuleert de laatste opnameactie en verwijdert wat zojuist is opgenomen.
Redo herstelt de opname die werd geannuleerd door Undo.

Tik om het bevestigingsscherm te zien. Continue annuleert de laatste opnameactie en herstelt de
opname in de oorspronkelijke staat.

Tik om het bevestigingsscherm te zien. Door Continue te selecteren, wordt de status van vóór de
uitvoering van Undo hersteld.

De laatste opnameactie annuleren (Undo en Redo)

Undo (verschijnt niet als er geen opnames zijn.)

Redo (verschijnt pas nadat Undo werd uitgevoerd.)
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Gebruik de sequencertransportknoppen om de opgenomen song te controleren.

De song afspelen
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Met de MONTAGE M kunt u audiobestanden in stereo (44,1 kHz, 24-bit wav) opnemen en afspelen.
Het opnameniveau is vast en het is mogelijk om continu maximaal 74 minuten op te nemen
(aangenomen dat het USB-opslagapparaat voldoende beschikbaar geheugen heeft).

1 Sluit een USB-flashstation aan op de USB TO DEVICE-aansluiting ([1] of [2])
van het instrument.

2 Open het scherm vanuit: [PERFORMANCE] → Play/Rec → Audio.

Het scherm audio recording verschijnt.

3 Druk op de knop [ ] (Record).

De knop [ ] (Record) knippert en het opnemen wordt in stand-by gezet.

(1) Positie voor opname
(2) Toont de totale lengte van het audiobestand en de huidige afspeelpositie
(3) Beschikbare tijd voor opname
(4) Niveaumeter
(5) Triggerniveau

4 Stel het Trigger Level (Triggerniveau) in (5).

Als u het Trigger Level instelt op manual (handmatig), begint de opname zodra u op de knop [
] (Play) drukt.

U kunt Trigger Level ook op een waarde tussen 1 en 127 instellen. In dat geval begint de
opname automatisch zodra u de knop [ ] (Play) indrukt en vervolgens zodra het

Audio opnemen
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afspeelvolume dat niveau overschrijdt.
Het niveau dat u hier instelt, wordt met blauwe driehoekjes weergegeven op de niveaumeter
(4). Voor optimale resultaten stelt u deze parameter zo laag mogelijk in om het volledige
signaal vast te leggen, maar niet zo laag dat ongewenste ruis wordt opgenomen.

5 Druk op de knop [ ] (Play).

Als u het Trigger Level op manual hebt ingesteld, begint de opname meteen zodra u op de
knop [ ] (Play) drukt. Tijdens de opname brandt het lampje op de knop [ ] (Record) rood
en het lampje op de knop [ ] (Play) groen.
Als u een waarde tussen 1 en 127 hebt ingesteld als triggerniveau, begint de opname
automatisch zodra het afspeelvolume dat niveau overschrijdt.

6 Speel op het toetsenbord.

Als u het Trigger Level instelt op een waarde tussen 1 en 127, begint de opname automatisch
zodra het afspeelvolume dat niveau overschrijdt.

7 Als u klaar bent met spelen, drukt u nogmaals op de knop [ ] (Stop).

Het opgenomen audiobestand wordt opgeslagen op het USB-flashstation.
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Zoals hieronder beschreven, kan de MONTAGE M audiobestanden (44,1 kHz, 24-bit of 16-bit .wav in
stereo) afspelen vanaf een USB-flashstation.
U kunt ook een performance op het toetsenbord spelen terwijl u het audiobestand afspeelt.

1 Sluit een USB-flashstation aan op de USB TO DEVICE-aansluiting ([1] of [2])
van het instrument.

2 Selecteer Load in het contextmenu vanuit: [PERFORMANCE] → Play/Rec →
Audio en tik op Audio Name.

3 Selecteer het USB-flashstation en de gewenste map voor het laden van de
audiogegevens.

4 Selecteer het gewenste wav-bestand op het USB-flashstation om te laden.

(1) Audionaam
(2) Volume voor afspelen
(3) Audiolengte

5 Druk op de knop [ ] (Play).

Het audiobestand wordt afgespeeld.

6 Verplaats de cursor naar Audio Volume (2) en pas het afspeelvolume aan met
de datadraaiknop.

Een audiobestand afspelen
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7 Druk op de knop [ ] (Stop) om het afspelen te stoppen.
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U kunt back-ups van de Performances, Live Sets en de Utility-instellingen die u op het instrument
hebt gemaakt en opgeslagen (store) opslaan op een USB-flashstation, en instellingen uit back-
upbestanden van het USB-flashstation naar het instrument laden.

In deze sectie wordt beschreven hoe u alle instellingen in het gebruikersgeheugen op een USB-
flashstation kunt opslaan en hoe u uw instellingen weer naar het instrument kunt laden.

Inhoudsopgave

Back-upbestanden van uw performances beheren

Beschikbare bestandsindelingen

Instellingen opslaan op een USB-flashstation als back-upbestand (Save)

Instellingen herstellen vanaf het back-upbestand dat is opgeslagen op het USB-
flashstation (Load)
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Selecteer de juiste bestandsindeling voor de instellingen waarvan u een back-up wilt maken.

Alles in het gebruikersgeheugen (inclusief het gebruikersgebied, bibliotheekgebied, songs en
patronen)

Alles in het gebruikersgedeelte van het gebruikersgeheugen (inclusief de Utility-instellingen en
Quick Setups)

Gebruikersgebied in gebruikersgeheugen, exclusief de Utility-instellingen en Quick Setups (één
bank voor Live Sets)

Als de bestandsgrootte groter is dan ongeveer 2 GB, wordt het bestand in tweeën gedeeld. Het
tweede bestand heeft een andere bestandsextensie, zoals hieronder weergegeven.

Patronen en songs die in het gebruikersgeheugen zijn opgeslagen

Bestanden die worden gebruikt als gebruikersgolfvormen

Bestanden die worden gebruikt als patronen en songs

Beschikbare bestandsindelingen

Opslaan op een USB-flashstation (Save)

MONTAGE M-indelingen
Back-upbestand (.Y2A)

Gebruikersbestanden (.Y2U)

Bibliotheekbestanden (.Y2L)

Back-upbestand (.Y2B)

Gebruikersbestanden (.Y2W)

Bibliotheekbestanden (.Y2M)

Generieke bestandsindeling
Patronen en songs (.MID)

Instellingen laden van een USB-flashstation (Load)

Bestanden opgeslagen op de MONTAGE M (.Y2A, .Y2U, .Y2L, .MID)

Generieke bestandsindelingen
Audiobestand (.WAV en .AIF)

MIDI-bestand (.MID)

Bestandsindelingen die worden gebruikt voor oudere modellen
MONTAGE (.X7A, .X7U, .X7L)
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MODX, MODX+ (.X8A, .X8U, .X8L)

MOTIF XF (.X3A, .X3V, .X3G, .X3W)

MOTIF XS (.X0A, .X0V, .X0G, .X0W)

MOXF (.X6A, .X6V, .X6G, .X6W)
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1 Sluit een USB-flashstation aan op de USB TO DEVICE-aansluiting ([1] of [2])
van het instrument.

2 Open het scherm vanuit: de [UTILITY] → Contents → Save.

U kunt hetzelfde scherm openen door tegelijkertijd de [SHIFT]-knop ingedrukt te houden en op
de [STORE]-knop te drukken, en vervolgens het tabblad Save te selecteren.

3 In het Content Type selecteert u Backup File.

4 Selecteer het USB-flashstation en de gewenste map waarin u het bestand wilt
opslaan.

Instellingen opslaan op een USB-flashstation als back-upbestand (Save)
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(1) Naam van bovenliggende map
(2) Naam van de doelmap die momenteel is geselecteerd op het USB-flashstation
(3) Opslaan naar
(4) Bestanden die in de map zijn opgeslagen

5 Tik op [+] voor Save As New File.

Hierdoor wordt het scherm voor het invoeren van namen opgeroepen.

OPMERKING
Als u het bestaande bestand wilt overschrijven, bevestigt u het proces door op de bestandsnaam op het
scherm te tikken. Tik op YES om het bestand op te slaan.

6 Voer de bestandsnaam in die u wilt gebruiken.

Raadpleeg de Beknopte handleiding voor specifieke informatie over het invoeren van
bestandsnamen.

7 Tik op Done om het invoeren van de naam te voltooien.

Het back-upbestand wordt vervolgens op het USB-flashstation opgeslagen (Save).
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om01basicoperation0260

LET OP

Wanneer instellingen worden geladen, worden de bestaande instellingen op het instrument
overschreven en gaan ze dus verloren. Belangrijke instellingen die u wilt behouden, moeten
worden opgeslagen op een USB-flashstation (Save) voordat u de instellingen laadt.

1 Sluit een USB-flashstation aan op de USB TO DEVICE-aansluiting ([1] of [2])
van het instrument.

2 Open het scherm vanuit: [UTILITY] → Contents → Load.

U kunt hetzelfde scherm openen door tegelijkertijd de [SHIFT]-knop ingedrukt te houden en op
de [STORE]-knop te drukken.

3 In het Content Type selecteert u Backup File.

4 Selecteer het gewenste bron-USB-flashstation en de map die de instellingen
bevat.

5 Selecteer het gewenste bestand op het USB-flashstation om te laden.

(1) Naam van bovenliggende map
(2) Naam van de gewenste map die momenteel is geselecteerd op het USB-flashstation
(3) Bestanden die in de map zijn opgeslagen

Instellingen herstellen vanaf het back-upbestand dat is opgeslagen op
het USB-flashstation (Load)
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Van performance-instellingen kan een back-up worden gemaakt of deze kunnen worden gedeeld
met Soundmondo (service voor geluidsbeheer en delen).

https://www.yamaha.com/2/soundmondo
Soundmondo
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U kunt een microfoon, audioapparatuur (zoals een cd-speler) en een elektronisch muziekinstrument
(zoals een synthesizer) aansluiten op de A/D INPUT-aansluitingen om een audio-ingangpartij (A/D
INPUT Part) af te spelen.
Wijzigingen in het volume, de pan, effecten en andere instellingen voor de audio-ingangpartij worden
toegepast en vervolgens gemengd met andere partijen voor de uiteindelijke uitvoer van dit
instrument.

Inhoudsopgave

Gebruik van microfoons en audioapparatuur

Microfoons en audioapparatuur aansluiten

De Vocoder gebruiken

Voorbeeld: Vocoder
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1 Schakel het instrument uit en stel de knop A/D INPUT [GAIN] in op de
minimumwaarde.

2 Verbind het externe apparaat met de aansluiting(en) A/D INPUT op het
achterpaneel.

OPMERKING
Zorg dat u een dynamische microfoon gebruikt. Condensatormicrofoons kunnen niet worden gebruikt.

(1) Stereoaudioapparatuur (cd-speler en dergelijke)

3 Zet het aangesloten apparaat aan en zet vervolgens de MONTAGE M aan.

Microfoons en audioapparatuur aansluiten

Een microfoon aansluiten

Audioapparatuur of een elektronisch instrument aansluiten
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4 Open het scherm vanuit: [UTILITY] → Settings → Audio I/O.

5 Selecteer de instelling A/D Input voor het apparaat dat is aangesloten op de
A/D INPUT-aansluitingen.

Wanneer een microfoon of andere apparatuur met een laag uitgangsniveau is aangesloten,
stelt u deze parameter in op Mic. Wanneer een synthesizer of een cd-speler of andere
apparatuur met een hoog uitgangsniveau is aangesloten, stelt u deze parameter in op Line.

6 Druk op de knop A/D INPUT [ON/OFF].

De knop licht op en de invoer van de audioapparatuur die op de MONTAGE M is aangesloten,
wordt ingeschakeld.

7 Luister naar het geluid van het externe apparaat dat is aangesloten op de
MONTAGE M en draai aan de [GAIN]-knop om de versterking aan te passen.

Pas de knop zodanig aan dat de SIG/PEAK-lampjes kort rood oplichten bij alleen de hardste
ingangsgeluiden.

8 Druk op de knop [PERFORMANCE] en selecteer de performance die u wilt
gebruiken met het externe apparaat dat op de MONTAGE M is aangesloten.

9 Bespeel het toetsenbord terwijl u in de microfoon zingt of geluiden afspeelt
met de audioapparatuur.

Pas het A/D INPUT-volume aan met de schuifregelaars.
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Dit instrument is uitgerust met een Vocoder. De Vocoder is een krachtige en populaire
effectprocessor die de kenmerken van de stem die in de microfoon wordt gezongen of gesproken
extraheert om de toetsenbordgeluiden te wijzigen. U kunt bijvoorbeeld het toetsenbord bespelen
terwijl u in de microfoon praat, zodat het instrument robotachtig klinkt.
De Vocoder wijzigt geluid op een manier die vergelijkbaar is met het mechanisme voor het genereren
van de menselijke stem. De menselijke stem bestaat uit geluiden die worden geproduceerd door de
stembanden en worden gefilterd door de keel, neus en mond. Deze klankvormers hebben specifieke
frequentie-eigenschappen en ze fungeren effectief als een filter, waarbij verschillende formanten
worden gevormd (resonantie).
Met het Vocoder-effect worden de filtereigenschappen van de stem geëxtraheerd uit de invoer op de
microfoon, waarna de stemformanten opnieuw worden opgebouwd aan de hand van verschillende
banddoorlaatfilters. De machineachtige 'robot'-stem wordt gemaakt door de hoge klanken van
muziekinstrumenten (zoals een synthesizergeluid) door de filters heen te leiden.

(1) Mic Input of Part Output
(2) Part Output (toetsenbordspel)
(3) Extractie van de kenmerken van het invoergeluid
(4) Formanten maken
(5) Robotachtige stem

Om de Vocoder te gebruiken, sluit u de microfoon aan, stelt u de A/D-ingangsinstellingen in het
scherm Utility in en past u de versterking aan. Selecteer ten slotte een performance die het Vocoder-
effect gebruikt, zoals hieronder wordt weergegeven.

1 Druk op de knop [CATEGORY SEARCH] terwijl het scherm Performance wordt
weergegeven.

2 Tik op de knoppen op het scherm om de categorie Pad/Choir te selecteren.

3 Tik op het zoekvak op het scherm Category Search en voer Vocoder in.

De Vocoder gebruiken

Voorbeeld: Vocoder
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4 Stel het Filter in op Attribute en selecteer Single.

Er wordt een lijst met performances voor Vocoder-effecten weergegeven.

5 Selecteer de gewenste performance en druk op de knop [ENTER] om te
bevestigen.
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De USB- en MIDI-aansluitingen op het achterpaneel worden gebruikt voor aansluiting op een
computer en externe MIDI-apparaten. U kunt deze aansluitingen gebruiken om
programmawijzigingsberichten naar externe MIDI-apparaten te verzenden wanneer u de
performance wijzigt.

De Zone-functie is handig voor het instellen van externe MIDI-apparaten.

Inhoudsopgave

Externe MIDI-instrumenten aansluiten

De functie Zone instellen

Een computer aansluiten en instellen

Een computer aansluiten en instellen

De Yamaha Steinberg USB driver installeren

Instellen voor het verzenden en ontvangen van audio en MIDI

Over audiokanalen

MIDI-kanalen en MIDI-poorten

De MIDI 2.0-functies gebruiken

Over muziekproductie met behulp van de computer

MIDI-opnames maken van uw eigen toetsenbordspel op de DAW

Het toongeneratorblok gebruiken om songs op de DAW af te spelen

De Expanded Softsynth Plugin for MONTAGE M gebruiken

De DAW Remote-functie gebruiken

Een smartapparaat aansluiten

Externe MIDI-instrumenten aansluiten

Een USB MIDI-toetsenbord aansluiten op de [USB TO DEVICE]-aansluiting

Compatibele MIDI-apparaten

Bijzondere opmerkingen over MIDI-communicatie

Een extern MIDI-apparaat aansluiten op MIDI-aansluitingen
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om01basicoperation0300

Met de Zone-functie kunt u meerdere externe apparaten bedienen via het ingebouwde toetsenbord
van dit instrument.
Op de MONTAGE M kunt u maximaal acht zones per performance gebruiken.
U kunt deze functie bijvoorbeeld gebruiken om op aanslagsnelheid of nootbereik te schakelen tussen
de interne toongenerator (toongeneratorblok) en aangesloten externe geluidsmodules.

1 Druk op de knop [PERFORMANCE] om het scherm Performance te openen.

2 Selecteer een partij en open het scherm via [EDIT/ ] → General/Pitch →
Zone Settings.

Het scherm Zone Settings verschijnt.

3 Vink de instelling Part Mode aan.

Selecteer Internal om het geluid van het toongeneratorblok af te spelen, en External om het
geluid van het externe geluidsmodule af te spelen.

OPMERKING
U kunt ook een snelkoppeling gebruiken om de instelling Part Mode te wijzigen. Wanneer [PART SELECT] is
ingeschakeld en u snel twee keer op de overeenkomstige PART-knop drukt (dubbelklikken) schakelt u om
tussen de instellingen Internal en External.

4 Stel indien nodig de parameters in voor Tx/Rx Ch (Transmit-Receive Channel)
en Note Limit.

5 Druk op de knop [STORE] om de performance op te slaan.

De functie Zone instellen

83



om01basicoperation0310

Door uw computer aan te sluiten op de MONTAGE M kunt u met DAW- of sequencesoftware op de
computer uw eigen muziek maken.
De afkorting DAW (Digital Audio Workstation) verwijst naar muzieksoftware voor het opnemen,
bewerken en mixen van audio- en MIDI-data. Noemenswaardige DAW-toepassingen zijn bijvoorbeeld
Cubase, Logic, Pro Tools en Live.

Door een computer op de [USB TO HOST]-aansluiting aan te sluiten, kunt u audiosignalen en MIDI-
berichten verzenden en ontvangen.
Voor de verbinding zijn een USB-kabel van het type AB en het stuurprogramma voor het verzenden
en ontvangen van audio en MIDI vereist.

U kunt de Yamaha Steinberg USB driver installeren of een generiek stuurprogramma gebruiken dat is
meegeleverd met het besturingssysteem van uw computer.

1 Download het nieuwste stuurprogramma via de onderstaande URL.

https://download.yamaha.com/

OPMERKING

2 Pak het gedownloade bestand uit en installeer de Yamaha Steinberg USB
driver op uw computer.

Raadpleeg de installatiehandleiding in het gedownloade bestandspakket voor instructies voor
het downloaden van het stuurprogramma.
Wanneer u dit instrument op een computer aansluit, sluit dan de USB-kabel aan op de
aansluiting [USB TO HOST] van dit instrument en de USB-aansluiting van de computer, zoals
hieronder wordt geïllustreerd.

Een computer aansluiten en instellen

Een computer aansluiten en instellen

De Yamaha Steinberg USB driver installeren

Via de bovenstaande url vindt u ook informatie over systeemvereisten.
De Yamaha Steinberg USB driver kan zonder voorafgaande kennisgeving worden aangepast en
bijgewerkt.
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(1) USB-aansluiting
(2) USB-kabel
(3) [USB TO HOST]-aansluiting
(4) MONTAGE M (achterpaneel)

Sluit de computer aan met een USB-kabel en stel vervolgens de parameters in voor het verwerken
van audio en MIDI via de USB-aansluiting.
Voor audio hoeft u alleen de kabel aan te sluiten. En wijzig indien nodig instellingen zoals de
samplingfrequentie en versterking.
Voor MIDI sluit u de kabel aan en stelt u vervolgens de parameters in voor het verzenden en
ontvangen van MIDI.

Voor de uitvoer van de audiosignalen kunt u de [USB TO HOST]-aansluiting en de OUTPUT-
aansluitingen gebruiken.
Als u een computer rechtstreeks op het instrument wilt aansluiten, gebruikt u de [USB TO HOST]-
aansluiting. Hierdoor kunt u maximaal 32 kanalen (of 16 stereokanalen) gebruiken bij een
samplingfrequentie van 44,1 kHz, of maximaal 8 kanalen (of 4 stereokanalen) bij een
samplingfrequentie van 44,1 kHz tot 192 kHz. Als u wilt selecteren welk signaal naar een specifiek
kanaal moet worden uitgevoerd, opent u het scherm vanuit [PERFORMANCE] → Part-selectie →
[EDIT/ ] → General/Pitch → Part Settings en selecteert u de betreffende Part Output.

Voor de invoer van de audiosignalen kunt u de [USB TO HOST]-aansluiting en de A/D INPUT-
aansluitingen gebruiken.

Instellen voor het verzenden en ontvangen van audio en MIDI

Verzending en ontvangst van MIDI-berichten
Open het scherm vanuit [UTILITY] → Settings → MIDI I/O → MIDI IN/OUT en selecteer USB.
Stel het instrument zo in dat de verzending en ontvangst van MIDI via de [USB TO HOST]-
aansluiting wordt ingeschakeld.

Open het scherm vanuit [UTILITY] → Settings → Advanced → USB Driver Mode.
Selecteer Vendor voor het gebruik van de Yamaha Steinberg USB driver en selecteer Generic voor
het gebruik van het algemene stuurprogramma.

Over audiokanalen

85



Audiosignalen die binnenkomen via de [USB TO HOST]-aansluiting, kunnen maximaal 6 kanalen (of
3 stereokanalen) bevatten, en Digital In L/R, Main L/R en Assign L/R worden gebruikt. Deze kanalen
worden uitsluitend gebruikt voor monitoring wanneer het instrument bijvoorbeeld is aangesloten op
de DAW-software.
De signalen die worden ontvangen op Main L/R, worden uitgevoerd via de OUTPUT L/R-
aansluitingen, terwijl de signalen die worden ontvangen op Assign L/R, worden uitgevoerd via de
ASSIGNABLE OUT-aansluitingen.
De audiosignalen die worden ontvangen op Digital In L/R, kunnen worden gewijzigd wat betreft
volume, effectverzending of uitvoerbestemmingsinstellingen.
Deze instellingen zijn ook beschikbaar voor de audiosignalen die via de A/D INPUT-aansluitingen
worden verwerkt.

Audiokanaal (invoer) Uitvoerbestemming

Main L/R of 1/2 OUTPUT L/R-aansluitingen

Digital L/R of 3/4 Digital In-sectie

Assign L/R of 5/6 ASSIGNABLE OUT L/R-aansluitingen

Er zijn 16 MIDI-kanalen voor het spelen van 16 partijen op dit instrument. Als u meer dan 16 kanalen
wilt gebruiken, kunt u MIDI-poorten gebruiken, die 16 kanalen per poort toestaan. Terwijl een enkele
MIDI-kabel MIDI-data voor één poort (of 16 kanalen) kan verwerken, kan een enkele USB-kabel
MIDI-data voor maximaal 8 poorten (of 128 kanalen) tegelijk verwerken.
Op de MONTAGE M worden de vastgestelde poorten geboden voor de USB-aansluitingen, zoals
hieronder weergegeven.

Speciaal bedoeld voor het gebruik van het toongeneratorblok van dit instrument.

Zorg ervoor dat poort 1 op het externe MIDI-apparaat of de computer is ingesteld als u wilt dat het
toongeneratorblok op het externe MIDI-apparaat of de computer wordt afgespeeld.

Speciaal voor gebruik van de DAW-afstandsbediening.

Speciaal bedoeld voor het ontvangen van MIDI-berichten van een MIDI-apparaat en het verzenden
ervan naar een ander MIDI-apparaat (voor MIDI Thru).

Op poort 3 worden de MIDI-berichten die worden ontvangen via de [USB TO HOST]-aansluiting,
behandeld als 'Thru' op de MIDI [OUT]-aansluiting, terwijl de MIDI-berichten die worden ontvangen
via de MIDI [IN]-aansluiting, worden behandeld als 'Thru' op de [USB TO HOST]-aansluiting.
Om MIDI-berichten tussen de MONTAGE M en de computer via de USB-kabel te verzenden, moet u
de juiste MIDI-poort en het MIDI-kanaal selecteren. Stel de poortinstellingen op het externe apparaat
in die geschikt zijn voor de situatie.

MIDI-kanalen en MIDI-poorten

Poort 1

Poort 2

Poort 3
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Dit instrument ondersteunt MIDI 2.0-functies. Door dit instrument aan te sluiten op een computer die
voldoet aan de operationele vereisten van MIDI 2.0, kunt u data met een hogere resolutie gebruiken
dan die van welk MIDI 1.0-instrument dan ook. Raadpleeg de speciale MIDI 2.0-site
(https://www.yamaha.com/2/midi-2-0/) voor meer informatie over MIDI 2.0.

Raadpleeg de Data List voor meer informatie over de ondersteunde MIDI 2.0-berichten.
https://download.yamaha.com/

Als u de MIDI 2.0-functies wilt gebruiken, definieert u eerst instellingen vanuit [UTILITY] → Settings
→ USB Driver Mode om Generic te selecteren en sluit u vervolgens een computer aan die voldoet
aan de operationele vereisten voor MIDI 2.0.

Door de MONTAGE M en de computer aan te sluiten, kunt u de DAW-software gebruiken zoals in de
onderstaande voorbeelden.

Bij deze instructies wordt ervan uitgegaan dat het instrument en de computer al met elkaar zijn
verbonden. Hieronder vindt u enkele voorbeelden van het gebruik van de DAW-software en dit
instrument.

Hier wordt getoond hoe u uw toetsenbordspel op de DAW opneemt als MIDI-gegevens.

1 Open het scherm vanuit: [UTILITY] → Settings → Quick Setup.

2 Selecteer MIDI Rec on DAW.

OPMERKING
U kunt ook tegelijkertijd op de knop [QUICK SETUP] en een van de selectieknoppen voor slotnummer en
categorienaam drukken om MIDI Rec on DAW te selecteren.

De MIDI 2.0-functies gebruiken

Over muziekproductie met behulp van de computer

De DAW-software op de computer gebruiken om uw toetsenbordspel op te nemen in MIDI of audio

Het toongeneratorblok gebruiken om de song af te spelen die is opgenomen met de DAW-software

MIDI-opnames maken van uw eigen toetsenbordspel op de DAW

Instellingen op de MONTAGE M
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3 Druk op de knop [EXIT] om het scherm Quick Setup te sluiten of druk op de
knop [PERFORMANCE] om het scherm Performance te openen en de
gewenste performance te selecteren voor opname.

1 Schakel MIDI Thru in.

MIDI Thru is een instelling die wordt gebruikt voor het verzenden van MIDI-berichten van het
ingebouwde toetsenbord naar de computer en terug naar het toongeneratorblok van het
instrument, afhankelijk van de instellingen op de opnametracks.
Zoals hieronder bijvoorbeeld wordt weergegeven, worden de MIDI-gegevens die vanaf de
MONTAGE M worden ingevoerd naar kanaal 1 verzonden. Als MIDI Thru op de computer op
ON is ingesteld, worden de MIDI-gegevens vanaf de computer naar kanaal 3 verzonden om
het toongeneratorblok af te spelen op kanaal 3. Door deze instelling te gebruiken, kunt u het
toetsenbordspel opnemen terwijl u naar hetzelfde geluid luistert als de uiteindelijke uitvoer.

(1) Toongeneratorblok
(herkent gegevens via MIDI-kanaal 3)

Instellingen in de DAW-software
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(2) Keyboard
(uitvoer via MIDI-kanaal 1)

(3) Lokaal Control = off
(4) Computer (Cubase, enz.)

2 Neem het toetsenbordspel op de DAW op.

Hier ziet u hoe u de DAW-software als multitimbrale geluidsgenerator kunt gebruiken.
Hiermee kunt u de hoogwaardige MIDI-geluidsgenerator gebruiken zonder de CPU van uw computer
te zwaar te belasten.

1 Selecteer een performance.

Nadat u een performance hebt geselecteerd, kan het handig zijn om het scherm Mixing te
gebruiken vanuit: [PERFORMANCE] → Mixing om partij 1 t/m 16 te mixen.
Stel ook Kbd Ctrl Lock On in vanuit het scherm [UTILITY] → Effect Switch om het Tx/Rx Ch.
van elke partij in te stellen om de ontvangst van berichten mogelijk te maken.

1 Met de tracks die u wilt gebruiken voor het afspelen van het
toongeneratorblok, stelt u de MIDI-uitvoer in op poort 1 op de MONTAGE M.

2 Voer de MIDI-gegevens voor elke track in.

De soundengine die overeenkomt met elke track op het MIDI-kanaal moet worden geregeld via
het scherm Mixing op de MONTAGE M.

De Expanded Softsynth Plugin (ESP) for MONTAGE M beschikt over dezelfde soundengine als de
hardware-MONTAGE M.
Omdat deze software-plug-in synchroon werkt met de hardware-MONTAGE M, kunnen dezelfde
MONTAGE M-geluiden naadloos worden geïntegreerd in uw muziekproductie (waar software het
handigst is voor een DAW) en in uw live performance (waar het eigenlijke instrument op het podium
wordt gebruikt). Hierdoor kunt u beide versies van de MONTAGE M gebruiken, afhankelijk van uw
persoonlijke voorkeuren en specifieke toepassing.

Voor meer informatie over de installatie en activering van de ESP gaat u naar de welkomstpagina
van de MONTAGE M in de brochure Expanded Softsynth Plugin for MONTAGE M Download
Information die wordt meegeleverd met de hardware-MONTAGE M.

De ESP-handleiding kan worden gedownload van de onderstaande website.
https://download.yamaha.com/

Het toongeneratorblok gebruiken om songs op de DAW af te spelen

Instellingen op de MONTAGE M

De instelling in de DAW-software

De Expanded Softsynth Plugin for MONTAGE M gebruiken
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Met de DAW Remote-functie kunt u de DAW-software bedienen via de regelaars op het bovenpaneel
van de MONTAGE M.
Deze functie is alleen beschikbaar als het instrument met een USB-kabel op de computer is
aangesloten. Het kan niet worden gebruikt als het is aangesloten met een MIDI-kabel.

1 Gebruik een USB-kabel van het AB-type om een computer aan te sluiten op de
[USB TO HOST]-aansluiting van het instrument.

2 Selecteer de DAW-software vanuit: [DAW REMOTE] → Settings → DAW.

In deze sectie wordt uitgelegd hoe u de DAW-software instelt.
Afhankelijk van de versie van uw DAW-software kan de instellingsprocedure verschillen of is het
instellen misschien niet mogelijk. Zie voor details de relevante gebruikershandleiding van de DAW-
software die u gebruikt.

OPMERKING
Zodra de verbinding tussen de computer en de MONTAGE M is verbroken, herkent de DAW-software de
MONTAGE M mogelijk niet, zelfs niet nadat de verbinding opnieuw is gemaakt. Als dit gebeurt, start u de DAW
opnieuw op nadat u opnieuw verbinding hebt gemaakt.

1 Device/Studio → Device Settings.../Studio Setup... om het dialoogvenster te
openen.

2 Selecteer MIDI → MIDI Port Setup en schakel het veld In All MIDI Inputs van
MONTAGE M-2 of MONTAGE M Port 2 uit.

3 Druk op de knop [+] linksboven in het dialoogvenster en selecteer Mackie
Control in de lijst.

De DAW Remote-functie gebruiken

Instellingen op de MONTAGE M

Instellingen in de DAW-software

Cubase
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4 Selecteer Remote Devices → Mackie Control.

5 Stel de MIDI Input en de MIDI Output in op MONTAGE M-2 of MONTAGE M
Port2.

6 (Optioneel) Wijs de gewenste functies toe aan F1–F8 van de User Commands.

1 Selecteer Logic Pro X → Preferences → Advanced en schakel Show Advanced
Tools in.

2 Logic Pro X → Control Surfaces → Setup… om het dialoogvenster te openen.

3 Selecteer van New → Install… de optie Mackie Control van Mackie Designs.

4 Stel de Output Port en de Input Port van Mackie Control in op MONTAGE M
Port2.

5 (Optioneel) Logic Pro X → Control Surfaces → Controller Assignments...
(Toewijzingen van regelaars) om Zone in te stellen op Control Surface: Mackie
Control en wijs functies toe aan Control F1–F8.

1 Setup → Peripherals… om het dialoogvenster te openen.

2 Selecteer het tabblad MIDI Controllers.

3 Stel Type in op HUI en stel Receive From en Send To in op MONTAGE M-2 of
MONTAGE M, Port2 van Predefined.

1 Live → Preferences… om het dialoogvenster te openen.

2 Selecteer het tabblad Link/MIDI.

3 Selecteer MackieControl bij Control Surface.

4 Stel de Input en de Output in op MONTAGE M-2 of MONTAGE M Port2.

Logic Pro

Pro Tools

Live
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5 (Optioneel) Wijs gewenste functies voor F1–F8 toe door de werking van MIDI-
noten F#2–C#3 in te stellen in Edit MIDI Map van het menu Options.
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om01basicoperation0320

U kunt een smartapparaat aansluiten zoals een smartphone en een tablet op de MONTAGE M.
Apps voor smartapparaten die compatibel zijn met de MONTAGE M bieden veel handige en leuke
manieren om dit muziekinstrument te gebruiken.

Raadpleeg de Yamaha-website voor meer informatie over de apps en ondersteunde apparaten.

Voor informatie over het aansluiten van de apparaten raadpleegt u de Smart Device Connection
Manual (Handleiding voor het aansluiten van smart apparaten), die verkrijgbaar is op de website van
Yamaha. Voor audiosignaaloverdracht met iOS raadpleegt u de verbindingsinstructies in het
document waarin een Lightning-naar-USB-camera-adapter wordt gebruikt.

Als u een smartapparaat wilt aansluiten, opent u het scherm [UTILITY] → Settings om de USB Driver
Mode in te stellen op Generic.

Een smartapparaat aansluiten
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om01basicoperation0330

Met behulp van USB-kabels en standaard MIDI-kabels (die in de handel verkrijgbaar zijn) kunt u een
extern MIDI-instrument aansluiten op de MONTAGE M.
U kunt een extern MIDI-instrument bespelen vanaf het ingebouwde toetsenbord of het
toongeneratorblok van een extern MIDI-toetsenbord of sequencer bespelen.

Zorg ervoor dat het MIDI-zendkanaal van het externe MIDI-instrument overeenkomt met het MIDI
Receive Channel (MIDI-ontvangstkanaal) van de MONTAGE M.
Om het MIDI Receive Channel van de MONTAGE M in te stellen, gebruikt u MIDI I/O Ch. voor
partijen waarbij Keyboard Control is ingesteld op On, en Tx/Rx Ch. voor partijen waarvoor Keyboard
Control is ingesteld op Off. Als de Part Mode is ingesteld op External, ontvangt de partij geen MIDI-
berichten van het externe apparaat.
Voor meer informatie over het MIDI-zendkanaal van het externe MIDI-toetsenbord raadpleegt u de
gebruikershandleiding van het MIDI-toetsenbord dat u gebruikt.

Gebruik de Zone-functie als u geluiden van zowel het interne toongeneratorblok als de externe
geluidsmodule wilt spelen.
Als u het geluid alleen vanaf de externe geluidsmodule wilt afspelen, verlaagt u het volume op de
MONTAGE M, of stelt u Local Control in op OFF via: [UTILITY] → Settings → MIDI I/O.
Om het ontvangstkanaal op het externe MIDI-apparaat in te stellen, raadpleegt u de
gebruikershandleiding van het MIDI-toetsenbord dat u gebruikt.

Het MIDI-uitvoerkanaal op dit instrument moet op een andere waarde worden ingesteld, afhankelijk
van of er partijen zijn met Part Mode ingesteld op External.
Als er geen partijen zijn waarbij Part Mode is ingesteld op External, wordt MIDI I/O Ch. gebruikt voor
Part Common of een partij waarbij Keyboard Control is ingesteld op On. Tx/Rx Ch. wordt gebruikt
voor een partij waarbij Keyboard Control is ingesteld op Off.
Als er partijen zijn waarbij Part Mode is ingesteld op External, wordt Tx Ch. gebruikt voor Part
Common of een partij waarbij Keyboard Control is ingesteld op On. Tx Ch. wordt gebruikt voor de
partij waarbij Keyboard Control is ingesteld op Off. Alle partijen waarbij Part Mode is ingesteld op
Internal zullen geen MIDI-berichten verzenden.

OPMERKING
U kunt de [USB TO DEVICE]- of MIDI-aansluitingen gebruiken om het externe MIDI-instrument aan te sluiten.

Door een USB MIDI-toetsenbord aan te sluiten op de [USB TO DEVICE]-aansluiting, kunt u het
aangesloten toetsenbord op dezelfde manier gebruiken als het ingebouwde toetsenbord, afhankelijk
van de specificaties van dat toetsenbord.

Externe MIDI-instrumenten aansluiten

Een USB MIDI-toetsenbord aansluiten op de [USB TO DEVICE]-aansluiting
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LET OP

Voor MIDI-communicatie met een apparaat dat is aangesloten via de [USB TO DEVICE]-aansluiting,
worden speciale regels gevolgd waardoor het apparaat zich kan gedragen als een ingebouwd
toetsenbord.

Om MIDI-aansluitingen te gebruiken, sluit u een apparaat aan met MIDI-kabels en selecteert u
vervolgens MIDI in [UTILITY] → Settings → MIDI I/O.

De USB TO DEVICE-aansluiting heeft een maximaal nominaal vermogen van 5 V/500 mA voor
elke aansluiting. Sluit geen USB-apparaten aan met een hoger nominaal vermogen, aangezien u
daarmee het instrument zelf kunt beschadigen.

Gebruik een USB-kabel van het type AB van minder dan 3 meter lang.

Compatibele MIDI-apparaten

MIDI-apparaten die compatibel zijn met USB-klasse
USB MIDI-toetsenborden

Compatibele Yamaha MIDI-apparaten
CP1, CP4 STAGE, CP40 STAGE, CP88, CP73, MODX, MODX+, MONTAGE, MOTIF XF, MOXF,
MX, reface, YC

Bijzondere opmerkingen over MIDI-communicatie

MIDI-communicatie is alleen eenrichtingsverkeer (verzonden vanaf het externe MIDI-apparaat en
ontvangen door de MONTAGE M).

Alle MIDI-gegevens wordt ontvangen, ongeacht de instellingen voor MIDI IN/OUT en MIDI I/O Ch..

Voor partijen waarvoor Keyboard Control is ingeschakeld, worden gegevens die op alle
corresponderende kanalen worden ontvangen, gedeeld.
(Als bijvoorbeeld Keyboard Control voor partijen 1 tot en met 3 is ingeschakeld, worden gegevens
die van elk van de kanalen 1 tot en met 3 worden ontvangen, geleverd aan alle partijen 1 tot en
met 3.)

Elke partij waarvoor Keyboard Control is uitgeschakeld, ontvangt de gegevens van alleen het
overeenkomstige kanaal voor de partij.

Een extern MIDI-apparaat aansluiten op MIDI-aansluitingen
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om02screenparameters0010

Dit hoofdstuk biedt beschrijvingen van de parameters die op het hoofddisplay worden weergegeven.

Inhoudsopgave

Schermen en parameters

De schermen bekijken

Performance-scherm

Common Edit-scherm

Part Edit (AWM2)-scherm

Part Common Edit

Element Edit

Drum Part Edit (AWM2)-scherm (Drumpartij bewerken)

Part Common Edit

Key Edit

Part Edit (FM-X)-scherm

Part Common Edit

Operator Edit

Part Edit (AN-X)-scherm

Part Common Edit

Oscillator Edit

Noise Edit

Category Search-scherm (Zoeken in categorie)

Live Set-scherm

Utility-scherm

Schermen die worden weergegeven door op specifieke knoppen te drukken
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om02screenparameters0020

Raadpleeg de Beknopte Handleiding voor de informatie die op het hoofddisplay wordt weergegeven.

De informatie die op het sub-display wordt weergegeven, varieert afhankelijk van wat u aan het
bewerken bent of wat u met de knop [QUICK EDIT] hebt geselecteerd.

Indicatoren Omschrijving

1 Wat u bewerkt
Toont wat u aan het bewerken bent met Quick Edit (zoals een performance of partij) in het
sub-display.

2 Tabbladen
Toont de parameters voor wat u aan het bewerken bent.
Gebruik de Tabselectieknoppen om van tabblad te wisselen.

3 Pagina
Toont de pagina's op het tabblad.
Gebruik de Tab PAGE-knoppen om van pagina te wisselen.

4 Parametergebied
Toont de waarden, schakelaars en parameternamen.
Gebruik knoppen 1 tot en met 8 om instellingen te wijzigen.

De parameter Ring⇔FM voor AN-X Part Edit, weergegeven op het sub-display, komt overeen met
de parameters Ring Level en FM Level die worden weergegeven op het hoofddisplay.
Door de knop te verplaatsen, kunt u de verhouding van deze modulaties wijzigen.

De schermen bekijken

Informatie op het hoofddisplay

Informatie op het sub-display

Over de parameter Ring⇔FM
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om02screenparameters0050

In het Performance-scherm kunt u een performance selecteren om op het toetsenbord te spelen, of
de performance-instellingen wijzigen om de performance aan te passen.

Inhoudsopgave

Performance-scherm

Home

Motion Control

Super Knob

Knob Auto

Super Knob Motion Sequence Edit

User Curve Edit

Mixing

Scene

Play/Rec

Pattern

Pattern Edit-scherm

Overview

Note

Quantize

Velocity

Gate Time

Cresc. (Crescendo)

Transpose

Roll

Track

Copy/Exchange

Mix

Append

Split

Clear

Divide Drum Tr

Song/Event

Get Phrase

Put Phrase

Erase Event
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Gebruik

(1) Performancenaam
Toont de naam van de geselecteerde performance.
Als u op de naam tikt, wordt het contextmenu voor Category Search, Edit en Property
geopend.
U kunt de status van de performance controleren met de volgende vlaggen.

User Arp

Play FX

Chain

Song

Put Track to Arpeggio

Audio

Smart Morph

Play

Edit

Analyze

Super Knob

Job

Home

Druk op de knop [PERFORMANCE].

Tik op het pictogram  (Home)

Vlag voor favorieten ( )
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Er wordt een ster weergegeven wanneer u de schakelaar Favorite inschakelt. Dezelfde ster
wordt getoond op het scherm Performance Category Search.

De blauwe vlag wordt getoond als u een parameter in de Performance wijzigt. De vlag voor
bewerken wordt uitgeschakeld als u de instellingen opslaat met de [STORE]-knop.

(2) Performance-attribuut
De performance-attributen worden weergegeven.

Attribuut Omschrijving

Performances met gebruik van de AWM2-soundengine.

 (in één kleur) Performances met gebruik van de FM-X-soundengine.

 (in twee
kleuren)

Uitvoeringen met gebruik van een FM-X-partij die de Smart Morph-informatie
bevat.

 (in één kleur) Performances met gebruik van de AN-X-soundengine.

 (in twee
kleuren)

Uitvoeringen met gebruik van een AN-X-partij die de Smart Morph-informatie
bevat.

Performances met Motion Control.

Performance die Seamless Sound Switching ondersteunen.

* Performances waarbij meerdere typen soundengines worden gecombineerd, worden
aangegeven met het teken "+".

(3) Oscilloscope
Toont de golfvorm van de Main L&R-uitvoer.

(4) Part Indicator
Wanneer de cursor op de Performance Name of op partijen 1 t/m 8 staat, wordt de status voor
partijen 9 t/m 16 weergegeven.
Wanneer de cursor op partijen 9 t/m 16 staat, wordt de status voor partijen 1 t/m 8
weergegeven.
Er wordt niets getoond als de partijen 9 t/m 16 niet worden gebruikt.

(5) Bekijk het gebied voor verschillende parameters
In dit weergavegebied worden verschillende parameters weergegeven afhankelijk van de
Display Mode (Weergavemodus).

(6) Naam van partij
Type en categorie van de partij, of de naam van de partij worden weergegeven.
U ziet het contextmenu voor Category Search, Edit, Copy en Property wanneer u op de naam
van de partij tikt.
Wanneer een andere partij dan partij 1 is geselecteerd en het geluid al is ingesteld voor die
partij, wordt het contextmenu voor Category Search, Edit, Copy en Delete weergegeven.
Tik op [+] om een partij toe te voegen.

(7) Keyboard Control-schakelaar
Keyboard Control wordt gebruikt voor het selecteren van partijen die op het toetsenbord
moeten worden gespeeld.

Vlag voor bewerken ( )
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Als Keyboard Control op On staat, kunt u tegelijkertijd partijen bespelen waarvoor Keyboard
Control is ingesteld op On, als de partij is ingesteld op Common of als Keyboard Control voor
de partij is ingesteld op On.
Als Keyboard Control is ingesteld op Off, kunt u de partij alleen op het toetsenbord spelen als
die partij is geselecteerd.
Instellingen: Off, On

(8) Partij dempen
Schakelt Part Mute in of uit.
Instellingen: Off, On

(9) Partij-solo
Schakelt Partij-solo in of uit.
Instellingen: Off, On

(10) Partijvolume
Stelt het volume van de partij in.
Instellingen: 0−127

(11) Partijniveaumeter
Geeft het audio-uitgangsniveau van de partij aan.

(12) [+] (Toevoegen)
Wanneer u op [+] tikt, wordt het scherm Part Category Search of het scherm Performance
Merge, zodat u een partij aan de performance kunt toevoegen.

(13) De Display Mode omschakelen
(14) De View Mode wijzigen

Wanneer u de Display Mode, worden verschillende parameters weergegeven in het weergavegebied
van het Home-scherm.
U kunt een andere Display Mode selecteren door de overeenkomstige weergaveknop te verplaatsen.

Hiermee opent u het Navigation-scherm.

De Display Mode omschakelen

Range

Navigation
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Hiermee opent u het Fx Overview-scherm.

Hiermee opent u het Control View-scherm.

Hiermee zet u de Favorite-schakelaar aan of uit.
Instellingen: Off, On

Stelt het notenbereik (laagste en hoogste noten) in voor de partij.
Als de eerste noot die is opgegeven hoger is ingesteld dan de tweede (bijvoorbeeld C5 tot C4),
worden de noten in het bereik C-2 tot C4 en C5 tot G8 gespeeld.
Instellingen: C−2−G8

Stelt het aanslagbereik voor de partij in.
Instellingen: 1−127

Stelt het uitgangsniveau (Return Level) in van de signalen die door het Variation-effect worden
verwerkt.
Instellingen: 0−127

Stelt het uitgangsniveau (Return Level) in van de signalen die door het Reverb-effect worden
verwerkt.
Instellingen: 0−127

Stelt de pan in van de geselecteerde performance.

Fx Overview

Control View

Favorite

Note Limit

Velocity Limit

FX/Pan

Var Return

Rev Return

Pan
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Instellingen: L63−C−R63

Stelt het volume in van de geselecteerde performance.
Instellingen: 0−127

Hiermee bepaalt u het niveau van de signalen die worden verzonden naar het Part Variation-effect
(Variation-effect voor de partij).
Instellingen: 0−127

Hiermee bepaalt u het niveau van de signalen die worden verzonden naar het Part Reverb-effect.
Instellingen: 0−127

Stelt het droogniveau (of het niveau van de signalen die niet door het systeemeffect worden
verwerkt) van de partij in.
Instellingen: 0−127

Stelt de pan-positie (in het stereoveld) voor de partij in.
Instellingen: L63−C−R63

Wijzigt de arpeggioselectie.
Instellingen: 1−8

Wijzigt de Motion Sequence-selectie.
Instellingen: 1−8

Volume

Var (Part Variation Send)

Rev (Part Reverb Send)

Dry (Part Dry Level)

Pan (Part Pan)

Arp/MS/Porta

Arp Select

MS Select
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Zet Portamento aan of uit voor partijen waarvoor de Portamento Part Sw op On is ingesteld.
Deze schakelaar is gekoppeld aan de [PORTAMENTO]-knop op het bovenpaneel.
Instellingen: Off, On

Stelt de tijdsduur (of snelheid) in voor de toonhoogteovergang van Portamento.
Dit wordt opgegeven als een offsetwaarde voor de Portamento time van de partij.
Instellingen: −64−+63

Zet het arpeggio voor de partij aan of uit.
Als zowel Arpeggio als Arpeggio Hold zijn ingesteld op On, wordt dit weergegeven als 'Arp Hold On.'
Als het arpeggio is ingeschakeld, kunt u Arp Hold in- of uitschakelen door tegelijkertijd de [SHIFT]-
knop ingedrukt te houden en op de knop Arp On/Off op het scherm te tikken.
Instellingen: Off, On

Schakelt Motion Sequencer in of uit voor de partij.
Instellingen: Off, On

Schakelt Portamento voor de partij in of uit.
Instellingen: Off, On

Stelt de tijdsduur in van de toonhoogteovergang van Portamento van de partij.
Instellingen: 0−127

Stelt het MIDI-kanaal in voor invoer en uitvoer van de Part Common en de Part waarbij de Keyboard
Control-schakelaar is ingesteld op ON.

Portamento Switch

Portamento Time

Arp On/Off (Arpeggio Part Switch)

MS On/Off (Motion Sequencer Part Switch)

Prt On/Off (Portamento Part Switch)

Time (Portamento Part Time)

Mode/Transpose

MIDI I/O Ch.
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Instellingen: Ch1–Ch16

Verschuift de toonhoogte van de toetsen in octaven.
Dit is gerelateerd aan de knoppen OCTAVE [-]/[+] op het bovenpaneel.
Instellingen: −3−+3

Verschuift de toonhoogte van de toetsen in halve noten.
Instellingen: −11semi–+11semi

OPMERKING
Voor alle noten buiten het toonhoogtebereik tussen C−2 en G8 (het bereik dat op dit instrument kan worden
gespeeld), zullen de resulterende noten een octaaf hoger (of lager) klinken.

Stelt de interne toongenerator (Int) of de externe geluidsmodule (Ext) in voor het spelen op het
toetsenbord.
Instellingen: Int, Ext

Stelt het kanaal in voor het verzenden en ontvangen van MIDI-berichten voor de zone wanneer Part
Mode is ingesteld op Internal en de Keyboard Control-schakelaar op Off staat.
Instellingen: Ch1–Ch16, Off

Stelt het kanaal in voor het verzenden en ontvangen van MIDI-berichten voor de zone wanneer Part
Mode is ingesteld op External.
Instellingen: Ch1–Ch16

Verschuift de toonhoogte van de zone in octaven.
Instellingen: −3–+0 (standaard)–+3 (in octaven)

Verschuift de toonhoogte van de zone in halve noten.
Instellingen: −11−+0 (standaard)–+11

Octave Shift (Keyboard Octave Shift)

Transpose (Keyboard Transpose)

Int/Ext (Part Mode)

Ch (Tx/Rx Ch)

Ch (Transmit Ch)

Oct (Zone Octave)

Trans (Zone Transpose)

Filter
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Wijzigt het geluid door de afsnijfrequentie van het filter in te stellen.
Als het laagdoorlaatfilter is geselecteerd, kunt u het geluid helderder maken door hier grotere
waarden in te stellen, of donkerder door kleinere waarden in te stellen.
Dit wordt opgegeven als een offsetwaarde voor de filterafsnijfrequentie voor de partij.
Instellingen: −64−+63

Voegt kenmerken toe aan het geluid door het signaalniveau dichtbij de afsnijfrequentie aan te
passen.
Dit wordt opgegeven als een offsetwaarde voor de filterresonantie voor de partij.
Instellingen: −64−+63

Stelt het bereik in van de verandering van de afsnijfrequentie door de FEG.
Dit wordt opgegeven als een offsetwaarde voor de Part FEG Depth.
Instellingen: −64−+63

Wijzigt het geluid door de afsnijfrequentie van het filter in te stellen. Wanneer het laagdoorlaatfilter is
geselecteerd, kunt u een helderder geluid maken door een hogere waarde voor deze parameter in te
stellen, en een donkerder geluid door een kleinere waarde in te stellen.
Dit wordt opgegeven als een offsetwaarde voor de filterafsnijfrequentie die is ingesteld op het scherm
Filter Type.
Instellingen: −64−+63

Voegt speciale toonvariatie toe aan het geluid door het signaalniveau dichtbij de afsnijfrequentie aan
te passen.
Dit wordt opgegeven als een offsetwaarde voor de filterresonantie die is ingesteld op het scherm
Filter Type.
Instellingen: −64−+63

Cutoff (Cutoff Frequency)

Resonance

FEG Depth

Cut (Part Cutoff Frequency)

Res (Part Resonance)

FEG (Part FEG Depth)
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Stelt het bereik in van de verandering van de afsnijfrequentie die wordt geregeld door de instelling
Filter EG in het scherm Filter Type.
Als deze is ingesteld op 0, worden de instellingen in het scherm Filter Type gebruikt zoals ze zijn.
Instellingen: −64−+63

U kunt toegang krijgen tot meer gedetailleerde informatie via het Home-scherm door de View Mode
te gebruiken.
U kunt een andere View Mode selecteren door de overeenkomstige weergaveknop te verplaatsen.
Wanneer de cursor op de Performance Name staat, verandert de weergave ook als u op de knop
[PERFORMANCE] drukt.

Wordt weergegeven wanneer de View Mode is ingesteld op Part Info en de huidige partij een
normale partij (AWM2) is.

(1) Element Sw (Element Switch)
(2) Element Level

Schakelt het element in of uit.
Instellingen: Off, On

Hiermee wordt het uitgangsniveau van het element bepaald.
Instellingen: 0−127

Wordt weergegeven wanneer de View Mode is ingesteld op Part Info en de huidige partij een
drumpartij is.

De View Mode wijzigen

Element Sw/Level

Element Sw (Element Switch)

Element Level

Drum Key
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Hiermee wordt het uitgangsniveau van de drumtoets ingesteld.
Instellingen: 0−127

Wordt weergegeven wanneer de View Mode is ingesteld op Part Info en de huidige partij een
normale partij (FM-X) is.

Verandert het algoritme.
Als u op de afbeelding van het algoritme tikt, wordt het scherm Algorithm Search geopend.
Instellingen: Raadpleeg de Data List.

Hiermee stelt u het feedbackniveau in.
Instellingen: 0−7

Wordt weergegeven wanneer de View Mode is ingesteld op Part Info en de huidige partij een
normale partij (AN-X) is.

Drum Key Level

Algorithm

Algorithm (Algorithm Number)

Feedback (Feedback Level)

Virtual Analog
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(1) 1—3 (Oscillator 1–3)
(2) N (Noise)
(3) Oscillator Level
(4) Noise Level
(5) Filter 1, 2
(6) Amplifier

Hiermee wordt het uitgangsniveau van de oscillator ingesteld.
Instellingen: 0−511

Hiermee stelt u het ruisniveau in.
Instellingen: 0−511

Hiermee opent u het scherm OSC/Tune voor Part Edit (AN-X).

Hiermee opent u het scherm Noise voor Part Edit (AN-X).

Hiermee opent u het scherm Filter Type voor Part Edit (AN-X).

Hiermee opent u het scherm Amp EG voor Part Edit (AN-X).

Wordt weergegeven wanneer de View Mode is ingesteld op Smart Morph.
De kaart wordt niet weergegeven als er geen Smart Morph-informatie is.

Oscillator Level

Noise Level

1–3 (Oscillator 1–3)

N (Noise)

Filter 1, 2

Amplifier

Smart Morph
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Wordt weergegeven wanneer de View Mode is ingesteld op Motion Seq.
Toont de lane die is ingesteld in de View Lane van de huidige partij.

Wordt weergegeven wanneer de View Mode is ingesteld op Velocity—Note.
Dit is handig voor het instellen van verschillende aanslagsnelheden bij gebruik van meerdere
partijen.

Motion Seq

Velocity—Note

Part—Note
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Wordt weergegeven wanneer de View Mode is ingesteld op Part—Note of Part Info en de huidige
partij Common is.

Op het scherm Motion Control kunt u de Motion Control-instellingen instellen die op de gehele
performance worden toegepast.

In het scherm Super Knob kunt u de waarden instellen voor het bedienen van de Super Knob.
U kunt een koppeling instellen tussen de Super Knob en alle toewijsbare knoppen.

Gebruik

[PERFORMANCE] → Motion Control → Super Knob

(1) Super Knob Link
(2) Assignable Knob 1–8 Value
(3) Assignable Knob 1–8 Value Left
(4) Assignable Knob 1–8 Value Mid
(5) Assignable Knob 1–8 Value Right

Motion Control

Super Knob
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Schakelt de Motion Sequencer voor de gehele performance in/uit.
Deze schakelaar is gekoppeld aan de [MSEQ ON/OFF]-knop op het bovenpaneel.
Instellingen: Off, On

Schakelt de Motion Sequencer die wordt gebruik voor de gehele performance in/uit.
Instellingen: Off, On

Hiermee stelt u het lichtpatroon van de Super Knob in.
Instellingen: Off, Type 1, Type 2-1, Type 2-2, Type 3-1, Type 3-2, Type 4-1, Type 4-2, Type 5-1, Type

5-2, Type 6, Type 7-1, Type 7-2, Type 8-1, Type 8-2, Type 9, Type 10, Type 11, Type 1B,
Type 2-1B, Type 2-2B, Type 3-1B, Type 3-2B, Type 4-1B, Type 4-2B, Type 5-1B, Type 5-
2B, Type 6B, Type 7-1B, Type 7-2B, Type 8-1B, Type 8-2B, Type 9B, Type 10B, Type 11B,
Rotary 1, Rotary 2, Rotary 3, Rotary 4, Rotary 5, Rotary 6, Rotary 7, Rotary 8, Rotary 9,
Rotary 10

Stelt de Super Knob-waarde in.
Instellingen: 0−1023

Hiermee stelt u de Mid-waarde in voor de Super Knob.
Instellingen: Off, 1−1022

Hiermee opent u het scherm Common Edit Control Assign voor het instellen van de parameters die
worden bestuurd door de Super Knob.

Stelt de corresponderende knop in die moet worden gekoppeld aan de Super Knob.
Als deze schakelaars op Off staan, heeft de werking van de Super Knob geen invloed op de
parameter van de knop.
Instellingen: Off, On

Toont de huidige waarden voor de toewijsbare knoppen (knoppen 1 t/m 8).
Instellingen: 0−1023

Toont de waarde van de toewijsbare knoppen (knoppen 1-8) wanneer de Super Knob Value is
ingesteld op 0 (of de Super Knob helemaal naar links is gedraaid).
Instellingen: 0−1023

MS Master (Motion Sequencer Master Switch)

Super Knob MS (Super Knob Motion Sequencer Switch)

LED Pattern

Super Knob (Super Knob Value)

Mid Position

Edit Super Knob

Super Knob Link

Assignable Knob 1–8 Value

Assignable Knob 1–8 Value Left
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Toont de waarde van de toewijsbare knoppen (Knoppen 1−8) als de waarde van de Super Knob is
ingesteld op Mid Position.
Deze parameter is niet beschikbaar wanneer Mid Position is ingesteld op Off.
Instellingen: 0−1023

Toont de waarde van de toewijsbare knoppen (Knoppen 1−8) wanneer de Super Knob Value is
ingesteld op 1023 (of de Super Knob helemaal naar rechts is gedraaid).
Instellingen: 0−1023

OPMERKING
Als u Value Left op een kleinere waarde en Value Right op een grotere waarde instelt, bewegen de knoppen 1-8 in
dezelfde richting als de Super Knob.
Als u Value Right op een kleinere waarde en Value Left op een grotere waarde instelt, bewegen de knoppen 1-8 in
de tegenovergestelde richting als de Super Knob.

In het scherm Knob Auto kunt u de Motion Sequencer voor de Super Knob (Super Knob Motion
Sequencer) instellen.
U kunt de Motion Sequencer zo instellen dat de Super Knob-waarde automatisch wordt geregeld.
Er kan slechts één lane worden gebruikt door de Super Knob.

OPMERKING
U kunt maximaal acht lanes tegelijkertijd gebruiken voor de hele performance. De lane die wordt ingesteld voor de
Super Knob is echter niet een van de acht lanes waar hier naar wordt verwezen.

Gebruik

[PERFORMANCE] → Motion Control → Knob Auto

Schakelt de Motion Sequencer voor de gehele performance in/uit.
Deze schakelaar is gekoppeld aan de [MSEQ ON/OFF]-knop op het bovenpaneel.
Instellingen: Off, On

Assignable Knob 1–8 Value Mid

Assignable Knob 1–8 Value Right

Knob Auto

Motion Seq Master Sw (Motion Sequencer Master Switch)
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Schakelt de Motion Sequencer van de Super Knob in/uit.
Instellingen: Off, On

Stelt knoppen in die worden beïnvloed door de werking van de Super Knob.
Instellingen: Off, On

Stelt in dat de signalen worden ontvangen van de knop [MSEQ TRIGGER].
Als dit is ingesteld op On, begint de Motion Sequence pas met afspelen zodra u op de knop [MSEQ
TRIGGER] drukt.
Instellingen: Off, On

Wijzigt de selectie van het Motion Sequence-type.
Instellingen: 1−8

Stelt in dat de veranderingen in de stapwaarde van de sequence willekeurig moeten zijn.
Instellingen: 0−127

Hiermee opent u het Motion Sequence-scherm.

Selecteert de snelheid en de timing voor het afspelen van de Super Knob Motion Sequence.
Instellingen: Off, Tempo, Beat

Off: Alleen de Super Knob Motion Sequencer wordt afgespeeld.
Tempo: Er wordt afgespeeld in het Performance-tempo.
Beat: er wordt synchroon met de beat afgespeeld.

Stelt de snelheid in voor het afspelen van de Motion Sequence.
Deze parameter is niet beschikbaar wanneer Super Knob Motion Sequencer Sync is ingesteld op
Off.
Instellingen: 0−127

Stelt de vertragingstijd in voor het starten van het afspelen van de Motion Sequence wanneer
Sync is ingesteld op Off.
Instellingen: 0−127

Super Knob MS Sw (Super Knob Motion Sequencer Switch)

MS FX (Super Knob Motion Sequencer FX Receive)

Trigger (Super Knob Motion Sequencer Trigger Receive)

Sequence Select (Motion Sequence Select)

SK MS Random (Super Knob Motion Sequencer Randomness)

Edit Sequence

Tabblad Sync/Speed

Sync (Super Knob Motion Sequencer Sync)

Wanneer Sync is ingesteld op Off

Speed (Super Knob Motion Sequencer Speed)

Delay Time (Super Knob Motion Seq Lane Key On Delay Time Length)
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Stelt de tijd in voor het bereiken van de maximale amplitude van de Motion Sequence wanneer
Sync is ingesteld op Off.
Instellingen: 0−127

Stelt het percentage in voor het uitrekken of comprimeren van de afspeeltijd van de Super Knob
Motion Sequencer.
Deze parameter is beschikbaar wanneer Super Knob Motion Sequencer Sync is ingesteld op iets
anders dan Off.
Instellingen: 50%–6400%, Common

200%: de afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: de afspeeltijd blijft ongewijzigd.
50%: de afspeeltijd wordt gehalveerd en het tempo wordt daardoor verdubbeld.
Common: de waarde van Unit Multiply die is ingesteld in Common Edit, wordt
toegepast.

Stelt de vertragingstijd in voor het starten van het afspelen van de Motion Sequence wanneer
Sync is ingesteld op iets anders dan Off.
Instellingen: 0−32

Stelt de tijd in voor het bereiken van de maximale amplitude voor de Motion Sequence wanneer
Sync is ingesteld op iets anders dan Off.
Instellingen: 0−32

Stelt het aanslagbereik (laagste en hoogste waarden) in voor het afspelen van de Motion
Sequence.
Instellingen: 1−127

Reset het afspelen van de Motion Sequence als u op een willekeurige toets op het toetsenbord
drukt.
Deze parameter is niet beschikbaar wanneer Trigger is ingesteld op On.
Instellingen: Off, Each-On, 1st-On

Each-On: Elke keer dat u een noot speelt, begint het afspelen vanaf het begin.
1st-On: Wanneer u een noot speelt, wordt de sequence gereset op de eerste noot en
begint het afspelen vanaf het begin. Als tweede of volgende noten worden gespeeld
terwijl de eerste noot wordt vastgehouden, wordt de sequence niet opnieuw gereset tot
nog een eerste noot wordt gespeeld.

Fade In Time (Super Knob Motion Seq Lane Fade In Time Length)

Wanneer Sync is ingesteld op iets anders dan Off

Unit (Super Knob Motion Sequencer Unit Multiply)

Delay Steps (Super Knob Motion Seq Lane Key On Delay Step Length)

Fade In Steps (Super Knob Motion Seq Lane Fade In Step Length)

Vel Limit (Super Knob Motion Sequencer Velocity Limit)

Tabblad Loop/Length

Key On Reset (Super Knob Motion Sequencer Key On Reset)

116



Stelt de Motion Sequence in op afspelen in een loop (herhalingen) of eenmalig afspelen.
Instellingen: Off, On

Geeft het beginpunt op voor afspelen in een loop van de Motion Sequence.
Instellingen: 1−16 (moet lager zijn dan de instelling Length)

Stelt de lengte van de Motion Sequence in.
Instellingen: 1−16 (moet hoger zijn dan de instelling Loop Start)

Stelt de lengte in van een stap in de Motion Sequence (als nootwaarde).
Instellingen: 60, 80, 120, 160, 240, 320, 480

Het instellingenscherm voor de Super Knob Motion Sequencer.
U kunt een sequence maken van maximaal zestien stappen.

Geeft het beginpunt op voor afspelen in een loop van de Motion Sequence.
Instellingen: 1−16 (moet lager zijn dan de instelling Length)

Stelt de lengte van de Motion Sequence in.
Instellingen: 1−16 (moet hoger zijn dan de instelling Loop Start)

Stelt de lengte in van een stap in de Motion Sequence (als nootwaarde).
Instellingen: 60, 80, 120, 160, 240, 320, 480

Loop (Super Knob Motion Sequencer Loop)

Loop Start (Super Knob Motion Sequencer Loop Start)

Length (Super Knob Motion Sequence Length)

MS Grid (Super Knob Motion Sequence Grid)

Super Knob Motion Sequence Edit

Loop Start (Super Knob Motion Sequencer Loop Start)

Length (Super Knob Motion Sequence Length)

MS Grid (Super Knob Motion Sequence Grid)

Sequence Select (Motion Sequence Select)
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Wijzigt de selectie van het Motion Sequence-type.
Instellingen: 1−8

Stelt de polariteit van de Motion Sequence in.
Instellingen: Unipolar, Bipolar

Unipolar: Alleen positieve waarden worden gebruikt voor de parameterwijziging.
Bipolar: Zowel positieve als negatieve waarden worden gebruikt voor de
parameterwijziging.

Stelt de mate van veranderingen in de Motion Sequence in.
Instellingen: 0−127

Stelt de geleidelijkheid van de wijzigingen in de Motion Sequence in binnen een tijdsbestek.
Instellingen: 0−127

Toont verschillende taken.

Stelt de waarde in van elke stap in de Motion Sequence.
U kunt de schuifregelaars 1 t/m 8 gebruiken om de waarden voor stap 1 t/m 8 en stap 9 t/m 16 te
wijzigen.
Instellingen: 0−127

Stelt het type en de richting van elke stap in de Motion Sequence in.
Instellingen: A, B, Reverse A, Reverse B

Selecteert een parameterwijzigingscurve voor Pulse A en Pulse B.
Gebruik Super Knob Motion Sequence Step Type om te selecteren welke van de curvetypen u voor
elke stap wilt gebruiken.
De verticale as geeft de tijd aan en de horizontale as geeft de stapwaarde aan.
Instellingen: (Wanneer een vooraf ingestelde bank wordt geselecteerd) Standard, Sigmoid,

Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw, Triangle, Square,
Trapezoid, Tilt Sine, Bounce, Resonance, Sequence, Hold, Harmonic, Steps
(Wanneer een gebruikersbank wordt geselecteerd) User 1–32
(Wanneer een bibliotheekbestand is geladen) Curven gebruikt in Library 1–16

Polarity (Super Knob Motion Sequence Polarity)

Amplitude (Super Knob Motion Sequence Amplitude)

Smooth (Super Knob Motion Sequence Smoothness)

Job

Super Knob Motion Sequence Step Value

Super Knob Motion Sequence Step Type

Pulse A (Super Knob Motion Sequence Step Curve Type A)
Pulse B (Super Knob Motion Sequence Step Curve Type B)

Prm 1 (Super Knob Motion Sequence Step Curve Parameter 1)
Prm 2 (Super Knob Motion Sequence Step Curve Parameter 2)
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Past de vorm van de stapcurve voor de Motion Sequence aan.
Deze instelling is mogelijk, afhankelijk van het curvetype, niet beschikbaar. Het bereik van de
parameterwaarde varieert ook afhankelijk van het curvetype.

Schakelt het gebruik van de knoppen voor het regelen van de stapcurvevorm van de Motion
Sequence in of uit.
Wordt alleen weergegeven als MS FX is ingesteld op On. Deze instelling is mogelijk, afhankelijk van
het curvetype, niet beschikbaar.
Instellingen: Off, On

Hiermee wordt de bewerkte Motion Sequence opgeslagen.

Hiermee wordt de Motion Sequence geladen.

Hiermee wordt de Motion Sequence gekopieerd.

Dit is het instellingenscherm voor de gebruikerscurve.
U kunt een lineaire curve met acht punten of een curve met acht stappen maken.

Geeft het huidige curvenummer weer.
Instellingen: 1-32

U kunt de curve die u bewerkt onder een nieuwe naam opslaan.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u een naam kunt invoeren.

Control (Super Knob Motion Sequence Step Curve Shape Control Switch)

Store Sequence

Load Sequence

Copy Sequence

User Curve Edit

Curve No. (Curve Number)

Curve Name

Curve Type
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Hiermee stelt u het curvetype in.
Instellingen: Linear, Step

Hiermee stelt u ingangsniveau van de curve in.
Input 1 is vastgesteld op de waarde 0.
Input 8 is vastgesteld op de waarde 1023 wanneer het Curve Type is ingesteld op Linear.
Instellingen: 0−1023

Hiermee stelt u uitgangsniveau van de curve in.
Instellingen: 0−1023

In het scherm Mixing kunt u de mix wijzigen door het volume van elke partij aan te passen en
effectinstellingen te maken.
De instellingen in het scherm Mixing worden opgeslagen in de performance.

Gebruik

[PERFORMANCE] → Mixing

Dit verandert de weergave.
Instellingen: Part 1–16, Audio (Part 1–8, Audio part, Master)

Stelt de mix in voor partijen 1 tot en met 16.

Input

Output

Mixing

Part 1–16 (Part 1–16 Switch)
Audio (Audio Switch)

Wanneer de weergave Part 1–16 is geselecteerd
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(1) Part Category
(2) Keyboard Control
(3) Volume
(4) Part Level Meter

De hoofdcategorie van de geselecteerde partij wordt weergegeven.
Als u op de naam tikt, wordt het contextmenu voor Category Search, Edit en Property geopend.
Wanneer een andere partij dan Part 1 is geselecteerd en het geluid al is ingesteld voor die partij,
verschijnt het contextmenu voor Category Search, Edit, Copy en Delete.
Tik op [+] om een partij toe te voegen.
Instellingen: Raadpleeg de Data List.

Schakelt tussen de weergave Mute/Solo en de weergave Keyboard Control.

Schakelt Mute en Solo voor de partij in of uit.
Instellingen: Off, On

Schakelt toetsenbordbediening in of uit.
Voor partijen 9 t/m 16 worden de knoppen niet weergegeven, omdat Keyboard Control voor die
partijen niet op On kan worden ingesteld.
Instellingen: Off, On

Schakelt tussen de weergave 2-band EQ en de weergave 3-band EQ van partijen 1 tot en met 16.
Instellingen: 3-band, 2-band

Part Category

Mute/Solo Switch
Kbd Ctrl Switch

Mute (Part Mute)
Solo (Part Solo)

Keyboard Control

3-band (3-band EQ Switch)
2-band (2-band EQ Switch)
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Toont de EQ-instelling in de weergaven 3-band of 2-band.
Als u op het gebied tikt, wordt het contextmenu van Part EQ geopend.

Hiermee stelt u het niveau van de signalen van partijen 1 tot en met 16 in die worden verzonden naar
het Reverb-effect.
Instellingen: 0−127

Hiermee stelt u het niveau van de signalen van partijen 1 tot en met 16 in die worden verzonden naar
het Variation-effect.
Instellingen: 0−127

Stelt het droogniveau in (of het niveau van de signalen die niet worden verwerkt door het
systeemeffect) van partijen 1 tot en met 16.
Instellingen: 0−127

Stelt de panpositie in (in het stereoveld) voor partijen 1 tot en met 16.
Instellingen: L63−C−R63

Stelt het volume in voor partijen 1 tot en met 16.
Instellingen: 0−127

Toont het niveau voor partijen 1 tot en met 16.

Stelt de mix voor de audiopartij in.

EQ (Equalizer)

Rev Send (Reverb Send)

Var Send (Variation Send)

Dry Level

Pan

Volume

Part Level Meter

Wanneer de weergave Audio is geselecteerd
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(1) Part Category
(2) Digi (Digital Part)
(3) Main (USB Main Part)
(4) Asgn (USB Assign Part)
(5) AD (A/D Part)
(6) Mst (Master)
(7) A/D Part EQ
(8) Master EQ
(9) Digital Part Volume
(10) Part Level Meter
(11) Digi (Digital Part Level Meter)
(12) USB Main Monitor Volume
(13) Main (Main L&R Level Meter)
(14) USB Assign Monitor Volume
(15) Asgn (Assign L&R Level Meter)
(16) A/D Part Volume
(17) AD (A/D Part Level Meter)
(18) Performance Volume

De hoofdcategorie van de geselecteerde partij wordt weergegeven.
Als u op de naam tikt, wordt het contextmenu voor Category Search, Edit en Property geopend.
Wanneer een andere partij dan Part 1 is geselecteerd en het geluid al is ingesteld voor die partij,
verschijnt het contextmenu voor Category Search, Edit, Copy en Delete.
Tik op [+] om een partij toe te voegen.
Instellingen: Raadpleeg de Data List.

Part Category

Digi (Digital Part)
Main (USB Main Part)
Asgn (USB Assign Part)
AD (A/D Part)
Mst (Master)
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Als u op de naam tikt, wordt het contextmenu voor Edit geopend.

Schakelt tussen de weergave Mute/Solo en de weergave Keyboard Control.

Schakelt Mute en Solo voor de partij in of uit.
Instellingen: Off, On

Als u op het gebied tikt, wordt het contextmenu van Part EQ geopend.

Stelt het niveau in van de signalen die worden verzonden van de digitale partij of A/D-partij naar het
reverbeffect.
Instellingen: 0−127

Stelt het niveau in van de signalen die worden verzonden van de digitale partij of A/D-partij naar het
Variation-effect.
Instellingen: 0−127

Stelt het droogniveau (of het niveau van de signalen zonder het systeemeffect) van het digitale
gedeelte of de A/D-partij in.
Instellingen: 0−127

Stelt de pan (locatie in het geluidsveld) van de digitale partij of de A/D-partij in.
Instellingen: L63−C−R63

Stelt het volume voor de audiopartij in.
Instellingen: 0−127

Mute/Solo Switch
Kbd Ctrl Switch

Mute (Part Mute)
Solo (Part Solo)

A/D Part EQ

Digital Part Reverb Send
A/D Part Reverb Send

Digital Part Variation Send
A/D Part Variation Send

Digital Part Dry Level
A/D Part Dry Level

Digital Part Pan
A/D Part Pan

Digital Part Volume
A/D Part Volume
USB Main Monitor Volume
USB Assign Monitor Volume

Master EQ
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Toont de 5-bands parametrische EQ.
Als u tikt op de naam wordt het contextmenu voor Master EQ Edit geopend.

Stelt het uitgangsniveau (retourniveau) in van de signalen die door het Reverb- of Variation-effect
worden verwerkt.
Instellingen: 0−127

Stelt het niveau in van de signalen die worden verzonden naar het Reverb-effect.
Instellingen: 0−127

Stelt het niveau in van de signalen die worden verzonden naar het Variation-effect.
Instellingen: 0−127

Stelt de pan (locatie in het geluidsveld) van de performance in.
Deze parameterwaarde compenseert de paninstelling voor elke partij.
Instellingen: L63−C−R63

Stelt het volume voor de performance in.
Instellingen: 0−127

Toont het niveau van partijen 1 t/m 8 en audiopartij.

In het scherm Scene kunt u de instellingen voor het arpeggiotype, het Motion Sequencetype en de
partijparameters registreren voor elk van de SCENE-knoppen.
Stel in dit scherm het juiste Memory (Memory Switch) in op On en bewerk de gewenste
parameterwaarden zodat u de instellingen in de scène kunt opslaan.

OPMERKING
De scènefunctie kan worden ingesteld vanuit een ander scherm dan Scene. U kunt de toegewezen
scèneparameters wijzigen door de overeenkomstige knoppen en schuifregelaars te verplaatsen en de instellingen
te registreren door tegelijkertijd de [SHIFT]-knop ingedrukt te houden en op de gewenste SCENE-knop te drukken.

Gebruik

Rev Return (Reverb Return)
Var Return (Variation Return)

Rev Send (Reverb Send)

Var Send (Variation Send)

Pan (Performance Pan)

Performance Volume

Part Level Meter
Digi (Digital Part Level Meter)
Main (Main L&R Level Meter)
Asgn (Assign L&R Level Meter)
AD (A/D Part Level Meter)

Scene
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[PERFORMANCE] → Scene

(1) Scene Select

Selecteer een tabblad Scene om de instellingen te registreren.
De tabbladen Scene1 tot Scene8 zijn gekoppeld aan de SCENE-knoppen op het bovenpaneel.
Instellingen: 1−8

Selecteert elk van de parameterwaarden, zoals Arpeggio, Motion Sequencer, Super Knob, Super
Knob Link, Mixing, Keyboard Control, Amplitude EG en Arp/MS FX, om in de scène te registreren.
Als deze schakelaars op Off staan, worden de parameterwaarden niet op het scherm weergegeven,
zelfs niet als de overeenkomstige tabbladen zijn geselecteerd.
Instellingen: Off, On

Verandert de weergave tussen Part 1–16 en Common.
De weergaven zijn beschikbaar in de tabbladen Mixing 1, Mixing 2, Kbd Ctrl, AEG, Arp/MS FX1 en
Arp/MS FX2.

Door Offset in te stellen op Off, kunt u kleinere stappen gebruiken om enkele van de Scene-
parameters in te stellen.
Getoond op de tabbladen Mixing 1, Mixing 2 en AEG.
Instellingen: Off (Absolute), On (Offset)

Schakelt de Motion Sequencer voor de gehele performance in/uit.
Instellingen: Off, On

Wijzigt de Motion Sequence-selectie.

Scene Select

Memory (Memory Switch)

Part 1–16 / Common

Offset (Scene Mixing / AEG Value Mode Switch)

Wanneer de Memory Switches voor Arp en Motion Seq zijn ingesteld op On

Motion Seq Master (Motion Sequencer Master Switch)

Motion Seq Select (Motion Sequence Select)
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Instellingen: 1−8

Zet het arpeggio voor de performance aan of uit.
Instellingen: Off, On

Wijzigt de arpeggioselectie.
Instellingen: 1−8

Stelt de Super Knob-waarde in.
Instellingen: 0−1023

Hiermee wordt de link tussen de Super Knob en de Assignable Knobs 1–8 (Toewijsbare knoppen 1-
8) ingesteld.
Als deze schakelaar op Off staat, heeft de werking van de Super Knob geen invloed op de parameter
van de toewijsbare knoppen.
Instellingen: Off, On

Arp Master (Arpeggio Master Switch)

Arp Select (Arpeggio Select)

Wanneer de Memory Switches voor Super Knob en Link zijn ingesteld op On

Super Knob (Super Knob Value)

Super Knob Link

Wanneer de Memory Switches voor Mixing 1 en Mixing 2 zijn ingesteld op On
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Part 1–16-weergave: Scene-parameters voor Parts 1–16 worden getoond.
Common-weergave: Scene parameters voor Parts 1–8 en Common worden getoond.
Common-parameters worden toegepast op de gehele performance.

Stelt de Reverb Send (Naar reverb zenden) in voor elke partij.
Instellingen: 0−127

Stelt de Variation Send (Naar variation zenden) in voor elke partij.
Instellingen: 0−127

Stelt het droge niveau van elke partij in.
Instellingen: 0−127

Stelt de pan voor elke partij in.
Instellingen: L63−C−R63

Stelt het volume voor elke partij in.
Instellingen: 0−127

Stelt de Reverb-retour in.
Instellingen: 0−127

Stelt de Variation-retour in.

Mixing 1

Part 1–16-weergave

Rev Send (Reverb Send)

Var Send (Variation Send)

Dry Level

Pan

Volume (Part Volume)

Common view

Rev Return (Reverb Return)

Var Return (Variation Return)
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Instellingen: 0−127

Stelt de pan voor de performance in.
Instellingen: L63−C−R63

Bepaalt de afsnijfrequentie voor elke partij.
Instellingen: −64−+63

Stelt de filterresonantie of filterbreedte voor elke partij in.
Instellingen: −64−+63

Stelt de FEG-diepte voor elke partij in.
Instellingen: −64−+63

Door Offset op Off te zetten, kunnen sommige Scene-parameters nauwkeuriger worden
aangepast.

Instellingen: (FM-X, AN-X): 0−1023

Instellingen: (FM-X): 0−127
Instellingen: (AN-X): 0−255

Instellingen: (AN-X): −9600−+9600

OPMERKING
Het wordt aanbevolen om Offset in te stellen op On als u zowel Smart Morph als Scene wilt gebruiken.

Schakelt Mute en Solo voor de partij in of uit.
Instellingen: Off, On

Stelt het volume van de partij in.
Instellingen: 0−127

Pan (Performance Pan)

Mixing 2

Part 1–16-weergave

Wanneer Offset is ingesteld op On

Cutoff (Cutoff Frequency)

Res (Filter Resonance/Width)

FEG Depth

Wanneer Offset is ingesteld op Off

Cutoff

Resonance

FEG

Mute (Part Mute)

Volume (Part Volume)
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Stelt de offsetwaarde in voor de afsnijfrequentie van de partij.
Instellingen: −64−+63

Stelt de offsetwaarde in voor de filterresonantie of filterbreedte van de partij.
Instellingen: −64−+63

Dit wordt opgegeven als een offsetwaarde voor de Part FEG Depth (FEG-diepte van de partij).
Instellingen: −64−+63

Schakelt Keyboard Control (toetsenbordbesturing) voor de partij in of uit.
Als de Keyboard Control voor de partij op Off is ingesteld, wordt er geen geluid geproduceerd
wanneer u het toetsenbord bespeelt.
Instellingen: Off (grijs), On (groen)

Common-weergave

Cutoff (Cutoff Frequency)

Res (Filter Resonance/Width)

FEG Depth

Als de Memory Switch voor Kbd Ctrl is ingesteld op On

Kbd Ctrl (Part Keyboard Control Switch)

Als de Memory Switch voor AEG is ingesteld op On
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Stelt de AEG-aanslagtijd voor de partij in.
Instellingen: −64−+63

Stelt de AEG-wegsterftijd voor de partij in.
Instellingen: −64−+63

Hiermee bepaalt u het AEG-sustainniveau van de partij.
Instellingen: −64−+63

Stelt de AEG-releasetijd voor de partij in.
Instellingen: −64−+63

Door Offset op Off te zetten, kunnen sommige Scene-parameters nauwkeuriger worden
aangepast.

Instellingen: (AN-X): 0−255

Instellingen: (AN-X): 0−255

Instellingen: (AN-X): 0−511

Instellingen: (AN-X): 0−255

Stelt de offsetwaarde in op Attack voor de partij.
Instellingen: −64−+63

Stelt de offsetwaarde in op Decay voor de partij.
Instellingen: −64−+63

Stelt de offsetwaarde in op Sustain voor de partij.

Part 1–16-weergave

Wanneer Offset is ingesteld op On

Attack (AEG Attack Time)

Decay (AEG Decay Time)

Sustain (AEG Sustain Level)

Release (AEG Release Time)

Wanneer Offset is ingesteld op Off

Attack

Decay

Sustain

Release

Common-weergave

Attack

Decay

Sustain
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Instellingen: −64−+63

Stelt de offsetwaarde in op Release voor de partij.
Instellingen: −64−+63

Stelt de swingwaarde van het arpeggio of de Motion Sequencer in voor elke partij.
Instellingen: −120−+120

Stelt de Unit Multiply-waarde van het arpeggio of de Motion Sequencer in voor elke partij.
Instellingen: 50%–400%, Common

200%: de afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: de afspeeltijd blijft ongewijzigd.
50%: de afspeeltijd wordt gehalveerd en het tempo wordt daardoor verdubbeld.
Common: de waarde die is ingesteld in de Unit Multiply die geldt voor alle partijen,
wordt toegepast.

Stelt de gatetijdsnelheid van het arpeggio in voor elke partij.
Instellingen: 0%−200%

Stelt de aanslagsnelheid van het arpeggio in voor elke partij.
Instellingen: 0%−200%

Stelt de offsetwaarde in op Swing voor elke partij.

Release

Wanneer de Memory Switches voor Arp/MS FX 1 en Arp/MS FX 2 zijn ingesteld op On

Arp/MS FX 1

Part 1–16-weergave

Swing

Unit (Part Unit Multiply)

Gate Time (Arp Gate Time Rate)

Velocity (Arp Velocity Rate)

Common-weergave

Swing
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Instellingen: −120−+120

Stelt de Unit Multiply voor alle partijen in.
Instellingen: 50%−400%

200%: de afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: de afspeeltijd blijft ongewijzigd.
50%: de afspeeltijd wordt gehalveerd en het tempo wordt daardoor verdubbeld.

Stelt de offsetwaarde in op Arpeggio Gate Time Rate voor elke partij.
Instellingen: −100−+100

Stelt de offsetwaarde in op Arpeggio Velocity Rate voor elke partij.
Instellingen: −100−+100

Stelt de amplitude van de Motion Sequencer voor elke partij in.
Instellingen: −127−+127

Stelt de pulsvorm van de Motion Sequencer voor elke partij in.
Instellingen: −100−+100

Stelt de geleidelijkheid van de Motion Sequencer voor elke partij in.
Instellingen: −127−+127

Stelt de willekeurigheid van de Motion Sequencer voor elke partij in.
Instellingen: 0−127

Stelt de offsetwaarde in op Motion Sequencer Amplitude voor elke partij.
Instellingen: −127−+127

Stelt de offsetwaarde in op Motion Sequencer Pulse Shape voor elke partij.
Instellingen: −100−+100

Unit (Common Unit Multiply)

Gate Time (Arp Gate Time Rate)

Velocity (Arp Velocity Rate)

Arp/MS FX 2

Part 1–16-weergave

Amp (Motion Sequencer Amplitude)

Shape (Motion Sequencer Pulse Shape)

Smooth (Motion Sequencer Smoothness)

Random (Motion Sequencer Randomness)

Common-weergave

Amp (Motion Sequencer Amplitude)

Shape (Motion Sequencer Pulse Shape)
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Stelt de offsetwaarde in op Motion Sequencer Smoothness voor elke partij.
Instellingen: −127−+127

Stelt de offsetwaarde in op Motion Sequencer Randomness voor elke partij.
Instellingen: −127−+127

Op het scherm Play/Rec kunt u patronen en songs opnemen in het interne geheugen van dit
instrument, en audio op een USB-flashstation, en uw opnamen afspelen.

Gebruik

(1) Link Icon

Toont de naam van het geselecteerde patroon.
Als u op de naam tikt, ziet u het contextmenu voor Load, Rename en New Pattern.
U kunt een patroon selecteren met de knoppen [INC/YES] en [DEC/NO] wanneer de cursor op de
Pattern Name staat.

Het koppelingspictogram wordt weergegeven als de performance die wordt gebruikt voor het
opnemen van het patroon en de geselecteerde performance dezelfde is. Als dit niet het geval is,

Smooth (Motion Sequencer Smoothness)

Random (Motion Sequencer Randomness)

Play/Rec

Pattern

Afspelen en stand-by voor afspelen

[SONG/PATTERN]-knop → Pattern

[PERFORMANCE] → Play/Rec → Pattern

[ ] (Play)-knop → Pattern

Pattern Name

Link Icon
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wordt het pictogram voor verbroken koppeling weergegeven.

Toont de naam van de geselecteerde performance.

OPMERKING
De blauwe vlag wordt getoond als u een parameter in de Performance wijzigt.

Het scherm Tempo Settings wordt weergegeven.

Toont het metrum voor het patroon.

Stelt de positie in voor het starten van het afspelen en opnemen, evenals de huidige positie van het
afspelen.
Het getal aan de linkerkant is de maat en de getallen aan de rechterkant zijn de tellen en kliks.

Stelt het tempo in voor het afspelen van patronen.
Instellingen: 5−300

Slaat de koppeling op tussen de bewerkte patronen en de gebruikte performance.

OPMERKING
Als u de parameters voor de performance hebt bewerkt, moet u ook de performance opslaan.

Opent het scherm voor patroonbewerking en jobs.

Toont de naam van de geselecteerde scène.
Deze schakelaar is gekoppeld aan de SCENE-knoppen op het bovenpaneel.

Stelt de sequentielengte van de geselecteerde scène in.
Instellingen: 1−256

Stelt het patroon in om te beginnen met opnemen of afspelen zodra u een toets op het toetsenbord
indrukt.
Instellingen: Off, On

Performance Name

Click Settings

Time Signature

Position

Tempo

Store Pattern & Perf Settings (Store Pattern and Performance Settings)

Edit/Job

Scene

Length

Key On Start

Chain
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Schakelt ketengewijs afspelen in/uit.
Instellingen: Off, On

Undo annuleert de laatste opnameactie en verwijdert wat zojuist is opgenomen.
Deze knop is actief wanneer u instellingen in een sequence wijzigt.

Redo herstelt de opname die werd geannuleerd door Undo. Deze knop is pas actief nadat Undo is
gebruikt.

Schakelt tussen partijweergaven.

Gebruik

Stelt het metrum van de scène in.
Instellingen: 1/16–16/16, 1/8–16/8, 1/4–8/4

Quantize is een functie die de opgenomen noten corrigeert zodat ze op de exacte fractie van de tel
vallen (in nootwaarden).
Instellingen: Off, 60 (tweeëndertigste noot), 80 (zestiende noottriool), 120 (zestiende noot), 160

(achtste noot triool), 240 (achtste noot), 320 (kwartnoottriool), 480 (kwartnoot)

Als Loop is ingesteld op On, gaat de patroonopname in een loop door.

Undo

Redo

Part 1–8
Part 9–16

Stand-by voor opnemen

[SONG/PATTERN]-knop → Pattern → [ ] (Record)-knop

[PERFORMANCE] → Play/Rec → Pattern → [ ] (Record)-knop

Time Signature

Rec Quantize (Record Quantize)

Loop
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Instellingen: Off, On

OPMERKING
Als u tijdens het opnemen van een song op de knop [ ] (Record) drukt, wordt de recorder in de repeteermodus
gezet en gaat de knop [ ] (Record) knipperen. In de Repeteermodus wordt het patroon afgespeeld, maar wordt
de opname tijdelijk gepauzeerd, wat handig is om te oefenen. Tijdens het opnemen van een song kunt u op de knop
[ ] (Record) drukken om te schakelen tussen de opnamemodus en de repeteermodus.

Gebruik

U kunt specifieke nootevents verwijderen door op de knop [SHIFT] te drukken en de toets in te
drukken te spelen die overeenkomt met de noot die u wilt verwijderen.
U kunt ook op de knop Erase op het scherm tikken om de functie in te schakelen, en vervolgens op
de overeenkomstige toets op het toetsenbord drukken om de nootevent te verwijderen.

Wanneer u een regelaar bedient tijdens een overdub-opname, kunt u de bestaande events van die
regelaar verwijderen en de handeling opnemen als nieuwe events.

Gebruik

[PERFORMANCE] → Play/Rec → Pattern → (met de song reeds opgenomen) → [ ] (Record)-
knop → Tik op Record Type → Selecteer Overdub in het menu → [ ] (Play)-knop

Opname

[SONG/PATTERN]-knop → Pattern → [ ] (Record)-knop → [ ] (Play)-knop

[PERFORMANCE] → Play/Rec → Pattern → [ ] (Record)-knop → [ ] (Play)-knop

Hold [SHIFT] + key to erase
Erase

Overdub-opname
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Selecteert uit een Replace- of Overdub-opname.
Instellingen: Replace, Overdub

Door de Pattern-functie te gebruiken, kunt u voor elke scène een sequence registreren.

Undo annuleert de laatste opnameactie en verwijdert wat zojuist is opgenomen.
Deze knop wordt beschikbaar wanneer een of meer jobs zijn gebruikt nadat een sequence is
opgenomen.

Redo herstelt de opname die werd geannuleerd door Undo. Deze knop wordt beschikbaar nadat
Undo is gebruikt.

Voert de geselecteerde job uit naar de MIDI-sequence.

Gebruik

Record Type

Pattern Edit-scherm

Algemene bewerkingen voor alle tabbladen op het scherm Pattern Edit

Undo

Redo

Execute

Overview

[ ] (Play)-knop → Pattern → [EDIT/ ] → Overview

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Overview

138



Tik op deze knop om de hoofd- en subcategorieën van de partij te zien.
Het verandert ook de lijst die wordt weergegeven op het scherm Play/Rec.

Tik hierop om de naam van de partij te zien.
Hiermee wordt ook de lijst gewijzigd die wordt weergegeven op het scherm Play/Rec.

Toont de status van de dempings- en solo-instellingen voor de partij.

Geeft het geselecteerde scènenummer weer.

Hiermee opent u het Save-scherm. U kunt de sequence van de geselecteerde scène opslaan als een
MIDI-bestand.

Opent het Load-scherm voor het laden van een MIDI-bestand.
Nadat u een MIDI-bestand hebt geselecteerd, selecteert u een patroon en scène op de laadlocatie.

Stelt de sequentielengte van de geselecteerde scène in.

Toont de huidige positie tijdens het afspelen van een scène en laat u de positie van het afspelen
instellen.
Instellingen: 001−256

Type

Name

Part Mute Icon
Part Solo Icon

Scene

Save As .mid File

Load .mid File

Length

Position

Note
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Quantizering is het proces van aanpassen van de timing van nootevents door deze dichter bij de
eerstvolgende exacte tel te plaatsen. U kunt deze functie bijvoorbeeld gebruiken om de timing te
verbeteren van een patroon dat u in real time hebt opgenomen.

Gebruik

Geeft de track op voor de Quantize-bewerking.
Instellingen: All, 1−16

Geeft de scène op voor de Quantize-bewerking.
Instellingen: 1−8

Geeft de startmaatpositie op voor de Quantize-bewerking.
Instellingen: 001−257

Geeft de starttelpositie op voor de Quantize-bewerking.

Quantize

[ ] (Play)-knop → Pattern → [EDIT/ ] → Note → Quantize

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Quantize

Track

Scene

Start Measure

Start Beat
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Instellingen: afhankelijk van de instelling Time Signature.

Geeft de startklokpositie op voor de Quantize-bewerking.
Instellingen: afhankelijk van de instelling Time Signature.

Geeft de eindmaatpositie op voor de Quantize-bewerking.
Instellingen: 001−257

Geeft de eindtelpositie op voor de Quantize-bewerking.
Instellingen: afhankelijk van de instelling Time Signature.

Geeft de eindklokpositie op voor de Quantize-bewerking.
Instellingen: afhankelijk van de instelling Time Signature.

Stelt de kwantizeringsresolutie in (of een noot die als basis voor de kwantizering moet worden
gebruikt).
Instellingen: Tweeëndertigste noot, zestiende noottriool, zestiende noot, achtste noottriool, achtste

noot, kwartnoottriool, kwartnoot, zestiende noot + zestiendenoottriool, achtste noot +
achtstenoottriool

Stelt de 'magnetische sterkte' van de kwantizering in.
Wanneer deze parameter wordt ingesteld op 100%, worden alle noten verplaatst naar de positie die
is opgegeven in Quantize.
Een instelling van 0% resulteert in geen kwantizering.
Instellingen: 0%−100%

Wijzigt de timing van even genummerde tellen (backbeats), geteld vanaf de waarde die is opgegeven
in Quantize, om een swinggevoel toe te voegen aan de ritmes.
Instellingen: afhankelijk van de instelling Quantize (quantization resolution).

Wanneer Quantize wordt ingesteld op een kwartnoot, achtste noot, zestiende noot of
tweeëndertigste noot: 0 tot de helft van het rooster
Wanneer Quantize wordt ingesteld op kwartnoottriool, achtstenoottriool of
zestiendenoottriool: 1 tot de helft van het rooster
Wanneer Quantize wordt ingesteld op achtste noot + achtste noottriool, of zestiende
noot + zestiende noottriool: 0 tot de helft van het trioolrooster

Verandert de gate-tijd (of de daadwerkelijke tijd voor de gespeelde noot) van de even genummerde
tellen (backbeats), geteld vanaf de waarde die is opgegeven in Quantize om een swinggevoel toe te

Start Clock

End Measure

End Beat

End Clock

Quantize

Strength

Swing Rate

Gate Time
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voegen aan de ritmes.
Instellingen: 0%−200%

Wijzigt de Velocity-waarde, waardoor u het volume van de noten in het opgegeven bereik kunt
wijzigen.

OPMERKING
Velocity wordt berekend met de formule zoals hieronder weergegeven.
Aangepaste Velocity = (origineel Velocity × Rate) + Offset
Als het resultaat 0 of minder is, wordt de waarde ingesteld op 1. Als het resultaat hoger is dan 128, wordt de waarde
ingesteld op 127.

Gebruik

Stelt de aanslagsnelheid in van alle noten in de geselecteerde sectie.
Wanneer dit is ingesteld op Off, werkt Set All niet.
Wanneer dit is ingesteld op iets anders dan Off, zijn Rate en Offset uitgeschakeld.
Instellingen: Off, 001−127

Stelt het percentage in voor het wijzigen van de aanslagsnelheid.
Indien ingesteld op 99% of lager, zal de aanslagsnelheid langzamer zijn. Wanneer dit is ingesteld op
101% of hoger, zal de aanslagsnelheid hoger zijn.
Bij 100% blijft de aanslagsnelheid ongewijzigd.
Deze parameter kan niet worden gewijzigd wanneer Set All is ingesteld op een andere waarde dan
Off.
Instellingen: 0%−200%

Velocity

[ ] (Play)-knop → Pattern → [EDIT/ ] → Note → Velocity

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Velocity

Set All

Rate

Offset
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Stelt de waarde in die moet worden opgeteld bij of afgetrokken van de oorspronkelijke
aanslagsnelheidwaarde.
Wanneer dit is ingesteld op -1 of lager, zal de aanslagsnelheid langzamer zijn. Wanneer dit is
ingesteld op +1 of hoger, zal de aanslagsnelheid sneller zijn.
Wanneer dit is ingesteld op 0, blijft de aanslagsnelheid onveranderd.
Deze parameter kan niet worden gewijzigd als Set All is ingesteld op een andere waarde dan Off.
Instellingen: −127−+127

Geeft de tijd op voor het spelen van noten in de opgegeven sectie (Gate Time).

OPMERKING
Gate Time wordt berekend met de formule zoals hieronder weergegeven.
Aangepaste Gate Time = (Origineel Gate Time × Rate) + Offset
Als het resultaat 0 of minder is, wordt de waarde ingesteld op 1.

Gebruik

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Note → Velocity in het
scherm Pattern Edit, behalve dat de beschikbare instellingen voor Set All anders zijn.

Instellingen: Off, 001−9999

Met deze job kunt u een crescendo of decrescendo maken voor een opgegeven notenbereik.
(Crescendo is een geleidelijke toename in volume en decrescendo is een geleidelijke afname.)

Gebruik

Gate Time

[ ] (Play)-knop → Pattern → [EDIT/ ] → Note → Gate Time

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Gate Time

Set All

Cresc. (Crescendo)
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Stelt de intensiteit in van het crescendo of decrescendo. De aanslagwaarden van de noten in het
opgegeven bereik worden geleidelijk aan verhoogd of verlaagd, te beginnen met de eerste noot in
het bereik. De aanslag van de laatste noot in het bereik wordt de oorspronkelijke aanslag van de noot
plus de waarde van Velocity Range. Als de resulterende aanslag buiten het bereik 1−127 ligt, wordt
deze ingesteld op 1 of 127. De instelling +1 of hoger produceert een crescendo, en de instelling −1 of
lager produceert een decrescendo. De instelling 0 veroorzaakt geen wijziging.
Instellingen: −127−+127

Met deze job kunt u de toonsoort of de toonhoogte van de noten in het opgegeven bereik wijzigen.

OPMERKING
Wanneer de Transpose-job wordt uitgevoerd, worden alle noten buiten het toegestane bereik van C−2−G8
automatisch aangepast zodat ze binnen het bereik passen.

Gebruik

[ ] (Play)-knop → Pattern → [EDIT/ ] → Note → Cresc.

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Cresc.

Velocity Range

Transpose

[ ] (Play)-knop → Pattern → [EDIT/ ] → Note → Transpose

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Transpose
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Voor het grootste deel is het scherm hier hetzelfde als het scherm dat wordt geopend via Note →
Quantize in het scherm Pattern Edit.

Geeft het bereik op van de toetsen (noten) voor transponeren.
Tik om het contextmenu te openen en stel vervolgens Keyboard in op On om de toetsen op het
toetsenbord te gebruiken om het bereik in te stellen.
Instellingen: C−2−G8

Stelt het bereik van de noten in die in halve tonen verschuiven.
Bij een instelling van +12 wordt naar een octaaf hoger getransponeerd, bij een instelling van -12 naar
een octaaf lager.
De waarde 0 levert geen verandering op.
Instellingen: −127−+127

Met deze job maakt u een reeks herhaalde noten (zoals een drumroffel) over het opgegeven bereik.

Gebruik

Note

Transpose

Roll

[ ] (Play)-knop → Pattern → [EDIT/ ] → Note → Roll

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Note → Roll
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Voor het grootste deel is het scherm hier hetzelfde als het scherm dat wordt geopend via Note →
Quantize in het scherm Pattern Edit, behalve dat de beschikbare instellingen voor Track anders zijn.

Instellingen: 1−16

Stelt de grootte in van de stap (het aantal clocks) tussen iedere noot in de roffel.
Door een kleinere waarde in te stellen, kunt u snellere roffels spelen.
De hier gespecificeerde clock is voor het begin van het bereik.
Instellingen: 015−999

Stelt de grootte in van de stap (het aantal clocks) tussen iedere noot in de roffel.
Door een kleinere waarde in te stellen, kunt u snellere roffels spelen.
De hier gespecificeerde clock is voor het einde van het bereik.
Instellingen: 015−999

Stelt de noot voor roffels in.
Tik om het contextmenu te openen en stel vervolgens Keyboard in op On om de toets op het
toetsenbord te gebruiken.
Instellingen: C−2−G8

Stelt de aanslagsnelheid in voor de sterkte van de roffels.
De hier gespecificeerde aanslagsnelheid is voor het begin van het bereik.
Instellingen: 001−127

Stelt de aanslagsnelheid in voor de sterkte van de roffels.
De hier gespecificeerde aanslagsnelheid is voor het einde van het bereik.
Instellingen: 001−127

Track

Start Step

End Step

Note

Start Velocity

End Velocity

146



OPMERKING
Door zowel Start Velocity als End Velocity in te stellen, kunt u crescendo of decrescendo voor de roffels creëren.

Met deze job kopieert u gegevens van een opgegeven brontrack naar de opgegeven
bestemmingstrack of wisselt u gegevens uit tussen twee opgegeven tracks.

Gebruik

Hiermee kopieert u gegevens van de opgegeven track naar een andere track.

LET OP

Wanneer Copy Track wordt uitgevoerd, worden de bestaande gegevens op de bestemmingstrack
overschreven en gaan ze verloren.

Wisselt gegevens uit tussen twee tracks.

Geeft het patroon op waaruit u wilt kopiëren.

Geeft de track op waaruit u wilt kopiëren.
Instellingen: All, 1−16

Track

Copy/Exchange

[ ] (Play)-knop → Pattern → [EDIT/ ] → Track → Copy/Exchange

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Copy/Exchange

Copy

Exchange

Pattern Name *1 Source

Track *1 Source
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Geeft de scène op waaruit u wilt kopiëren.
Instellingen: All, 1−8

Geeft het patroon op waarnaartoe u wilt kopiëren.

Geeft de track op waarnaartoe u wilt kopiëren.
Deze parameter is niet beschikbaar als de bron is ingesteld op All.
Instellingen: 1−16

Geeft de scène op waarnaartoe u wilt kopiëren.
Deze parameter is niet beschikbaar als de bron is ingesteld op All.
Instellingen: 1−8

Voert de Copy-bewerking uit.

OPMERKING
Wanneer Copy Track wordt uitgevoerd met de track en Scene is ingesteld op All, worden de Chain-gegevens ook
gekopieerd.

Voert de Exchange-bewerking uit.

OPMERKING
Wanneer Exchange Track wordt uitgevoerd met de track en Scene is ingesteld op All, worden de Chain-gegevens
ook uitgewisseld.

Mixt (voegt samen) de gegevens van de opgegeven track A en track B en plaatst het resultaat in
track B.

Gebruik

Scene *1 Source

Pattern Name *2 Destination

Track *2 Destination

Scene *2 Destination

Copy Track

Exchange Track

Mix

[ ] (Play)-knop → Pattern → [EDIT/ ] → Track → Mix

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Mix
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Geeft het eerste patroon op dat gemixt moet worden.

Geeft de track op voor de Mix-bewerking.
Instellingen: 1−16

Geeft de scène op voor de Mix-bewerking.
Instellingen: All, 1−8

Geeft het eerste patroon op dat gemixt moet worden.

Geeft de track op voor de Mix-bewerking.
Instellingen: 1−16

Geeft de scène op voor de Mix-bewerking.
Deze parameter is niet beschikbaar als de bron A is ingesteld op All.
Instellingen: 1−8

Toont de naam van het geselecteerde patroon waarnaartoe moet worden gemixt.

Toont het tracknummer voor de Mix-bewerking.

Toont het scènenummer voor de Mix-bewerking.
Deze parameter is niet beschikbaar als de bron A is ingesteld op All.

Pattern Name *1 Source A

Track *1 Source A

Scene *1 Source A

Pattern Name *2 Source B

Track *2 Source B

Scene *2 Source B

Pattern Name *3 Destination B

Track *3 Destination B

Scene *3 Destination B
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Voert de Mix-bewerking uit.

Voegt de gegevens in de opgegeven track toe aan het einde van een andere track.

Gebruik

Geeft het patroon op waaruit u wilt toevoegen.

Geeft de track op voor de Append-bewerking.
Instellingen: All, 1−16

Geeft de scène op voor de Append-bewerking.
Instellingen: 1−8

Geeft het patroon op waarnaartoe u wilt toevoegen.

Geeft de track op voor de Append-bewerking.
Deze parameter is niet beschikbaar als de bron is ingesteld op All.
Instellingen: 1−16

Geeft de scène op voor de Append-bewerking.

Mix Track

Append

[ ] (Play)-knop → Pattern → [EDIT/ ] → Track → Append

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Append

Pattern Name *1 Source

Track *1 Source

Scene *1 Source

Pattern Name *2 Destination

Track *2 Destination

Scene *2 Destination
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Instellingen: 1−8

Voert de Append-bewerking uit.

Splitst de gegevens van de opgegeven track op de opgegeven maat en verplaatst de tweede helft
naar een andere opgegeven track.

Gebruik

Geeft het patroon op dat moet worden gesplitst.

Geeft de track op voor de Split-bewerking.
Instellingen: All, 1−16

Geeft de scène op voor de Split-bewerking.
Instellingen: 1−8

Geeft de maat op waar de gegevens moeten worden gesplitst.
Instellingen: 2–256

Toont het patroon waarin u wilt splitsen.

Append Track

Split

[ ] (Play)-knop → Pattern → [EDIT/ ] → Track → Split

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Split

Pattern Name *1 Source

Track *1 Source

Scene *1 Source

Measure *1 Source

Pattern Name

151



Toont de track voor de Split-bewerking.

Toont de scène voor de Split-bewerking.

Geeft het patroon op waar de gesplitste gegevens naartoe moeten worden gestuurd.

Geeft de track op voor de Split-bewerking.
Deze parameter is niet beschikbaar als de bron is ingesteld op All.
Instellingen: 1−16

Geeft de scène op voor de Split-bewerking.
Instellingen: 1−8

Voert de Split-bewerking uit.

Verwijdert gegevens van de opgegeven track.

Gebruik

Geeft het patroon op dat moet worden verwijderd.

Track

Scene

Pattern Name *2 Destination

Track *2 Destination

Scene *2 Destination

Spilt Track

Clear

[ ] (Play)-knop → Pattern → [EDIT/ ] → Track → Clear

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Clear

Pattern Name
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Geeft de track op voor de Clear-bewerking.
Instellingen: All, 1−16

Geeft de scène op voor de Clear-bewerking.
Instellingen: 1−8

Voert de Clear-bewerking uit.

OPMERKING
Wanneer Clear Track wordt uitgevoerd met de track en Scene is ingesteld op All, worden de Chain-gegevens ook
verwijderd.

Neemt de opgenomen drums van de opgegeven track en wijst elk instrument (individueel percussie-
instrument in het drumstel) toe aan de tracks 9 tot en met 16.

OPMERKING
Wanneer er bestaande gegevens aanwezig zijn op de tracks 9 t/m 16 en de partijen 9 t/m 16, zal het uitvoeren van
de Divide Drum Track-bewerking de bestaande gegevens overschrijven. Undo en Redo kunnen niet worden
gebruikt bij deze bewerking.

Gebruik

Geeft het patroon op voor de Divide-bewerking.

Geeft de track op voor de Divide-bewerking.

Track

Scene

Clear Track

Divide Drum Tr (Divide Drum Track)

[ ] (Play)-knop → Pattern → [EDIT/ ] → Track → Divide Drum Tr

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Track → Divide Drum Tr

Pattern Name

Track
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Instellingen: 1−16

Voert de Divide-bewerking uit.

Kopieert een specifiek gedeelte van de song naar de opgegeven track.

LET OP

De bestaande gegevens op de kopieerbestemming worden overschreven en gaan verloren.

Gebruik

Geeft de song op waaruit u wilt kopiëren.

Geeft de track op voor de Get Phrase-bewerking.
Instellingen: All, 1−16

Geeft de startmaatpositie op voor de Get Phrase-bewerking.
Instellingen: 001−998

Geeft de eindmaatpositie op voor de Get Phrase-bewerking.
Instellingen: 002−999

Divide Drum Track

Song/Event

Get Phrase

[ ] (Play)-knop → Pattern → [EDIT/ ] → Song/Event → Get Phrase

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Song/Event → Get Phrase

Song Name

Track *1 Source

Start Measure

End Measure
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Geeft het patroon op waarnaartoe u wilt kopiëren.

Geeft de track op waarnaartoe u wilt kopiëren.
Deze parameter is niet beschikbaar als de bron is ingesteld op All.
Instellingen: 1−16

Geeft de scène op waarnaartoe u wilt kopiëren.
Instellingen: 1−8

Voert de Get Phrase-bewerking uit.

Kopieert opgegeven maten van de patroontrack naar de opgegeven songtrack.

OPMERKING
De gekopieerde gegevens worden samengevoegd met de bestaande gegevens op de bestemmingstrack.

Gebruik

Geeft het patroon op waaruit u wilt kopiëren.

Geeft de track op voor de Put Phrase-bewerking.
Instellingen: 1−16

Pattern Name

Track *2 Destination

Scene

Get Phrase from Song

Put Phrase

[ ] (Play)-knop → Pattern → [EDIT/ ] → Song/Event → Put Phrase

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Song/Event → Put Phrase

Pattern Name

Track *1 Source
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Geeft de scène op voor de Put Phrase-bewerking.
Instellingen: 1−8

Geeft de song op waarnaartoe u wilt kopiëren.

Geeft de track op voor de Put Phrase-bewerking.
Instellingen: 1−16

Geeft de maat op waarnaartoe u wilt kopiëren.
Instellingen: 001−999

Voert de Put Phrase-bewerking uit.

Wist de event.

Gebruik

Voor het grootste deel is het scherm hier hetzelfde als het scherm dat wordt geopend via Note →
Quantize in het scherm Pattern Edit.

Wijzigt de instelling Auto Select van het Event Type.
Als dit is ingesteld op On, kunt u eenvoudigweg de regelaar verplaatsen waarvan u de gegevens wilt

Scene

Song Name

Track *2 Destination

Measure

Put Phrase to Song

Erase Event

[ ] (Play)-knop → Pattern → [EDIT/ ] → Song/Event → Erase Event

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Song/Event → Erase Event

Auto Select
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wissen, waarna de bijbehorende event van de regelaar automatisch wordt ingesteld op Event Type.
Instellingen: Off, On

Geeft het type event op dat u wilt wissen.
Instellingen: Note, Poly, CC, NRPN, RPN, PC, AfterTouch, PitchBend, SysEx, All

Wordt weergegeven wanneer de Event Type is ingesteld op CC. Geeft het regelaarwijzigingsnummer
van het event op dat u wilt wissen.
Instellingen: All, 1−127

Voert de Erase Event-bewerking uit.

Registreert de gegevens in de opgegeven maten van de scène als een gebruikersarpeggio.

LET OP

De bestaande gegevens op de bestemming worden overschreven en gaan verloren.

Gebruik

Geeft de scène op voor de User Arpeggio-bewerking.
Instellingen: 1−8

Geeft de startmaatpositie op voor de User Arpeggio-bewerking.

Event Type

CC Number

Erase Event

User Arp (User Arpeggio)

[ ] (Play)-knop → Pattern → [EDIT/ ] → Song/Event → User Arp

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Song/Event → User Arp

Scene

Start Measure

157



Instellingen: 1−256

Geeft de eindmaatpositie op voor de User Arpeggio-bewerking.
Instellingen: 2−257

Stelt het arpeggionummer in van het gebruikersarpeggio waarnaar moet worden geconverteerd.
In eerste instantie wordt het laagste ongebruikte nummer ingesteld.
Wanneer u een nummer opgeeft dat al in gebruik is, gaat het bestaande arpeggio op de bestemming
verloren.
Instellingen: 1−256

Stelt de hoofd- en subcategorieën van het geconverteerde arpeggio in.
Instellingen: Raadpleeg de Data List.

Voer de naam van het arpeggiotype in. Er kunnen maximaal 20 alfanumerieke tekens worden
gebruikt.

Stelt het tracknummer in waarvan moet worden geconverteerd voor elke arpeggiotrack.
Instellingen: 1−16

Selecteert hoe de MIDI-sequence die is opgenomen in de Track wordt geconverteerd naar een
arpeggio.
U kunt voor elke arpeggiotrack een ander Convert Type gebruiken.
Instellingen: Normal, Fixed, Org Notes

Normal: Alleen de MIDI-sequence die de noten gebruikt die op het toetsenbord (op het
gebruikte octaaf) worden gespeeld, wordt afgespeeld.
Fixed: Dezelfde MIDI-reeks wordt afgespeeld, ongeacht hoe u het toetsenbord bespeelt.
Org Notes: In principe hetzelfde als Fixed, maar de MIDI-reeks verandert afhankelijk van
de akkoorden die u op het toetsenbord speelt.

Hiermee stelt u de grondtoon in wanneer het Convert Type van een track is ingesteld op Org Notes.
Deze parameter is niet beschikbaar als er geen track is ingesteld op Org Notes.
Instellingen: C−2−G8

Converteert het patroon naar een gebruikersarpeggio met behulp van de instellingen op het scherm.
Deze knop is niet beschikbaar als alle tracks zijn ingesteld op Off omdat conversie niet mogelijk is.

End Measure

Arp (Arp Number)

Category (Arpeggio Category)
Sub Category (Arpeggio Sub Category)

Name (Arpeggio Name)

Track

Convert Type

Org Notes Root

Store As User Arp (Store As User Arpeggio)
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Past effecten toe op de MIDI-sequence tijdens het afspelen van patronen. Stelt het bereik en het
niveau van het effect in voor elke parameter van de opgegeven track.

Gebruik

Geeft de track op die moet worden genormaliseerd.
Instellingen: All, 1−16

Geeft de scène op die moet worden genormaliseerd.
Instellingen: All, 1−8

Legt het effect dat is opgegeven in Play FX vast op de MIDI-gegevens.

Stelt de sequentielengte van de geselecteerde scène in.

Play FX (Play Effects)

[ ] (Play)-knop → Pattern → [EDIT/ ] → Play FX

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Play FX

Track

Scene

Normalize Play FX

Length
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Toont de huidige positie voor het afspelen van een scène en laat u de positie van het afspelen
instellen.
Instellingen: 001−256

Bepaalt Qntz Value, Qntz Str, Swing Vel, Swing Gate en Swing Rate.

Stelt de kwantizeringsresolutie in (of een noot die als basis voor de kwantizering moet worden
gebruikt).
Instellingen: Off, 60 (tweeëndertigste noot), 80 (zestiende noottriool), 120 (zestiende noot), 160

(achtste noot triool), 240 (achtste noot), 320 (kwartnoottriool), 480 (kwartnoot)

Stelt de 'magnetische sterkte' van de kwantizering in.
Wanneer deze parameter is ingesteld op 100%, worden alle noten verplaatst naar de positie die is
opgegeven in de Qntz Value (Quantize Value).
De instelling 0% leidt tot geen kwantizering.
Instellingen: 0%−100%

Wijzigt de timing van even genummerde tellen (backbeats), geteld vanaf de waarde die is opgegeven
in Qntz Value (Quantize Value), om een swinggevoel toe te voegen aan de ritmes. Deze parameter is
niet beschikbaar wanneer de quantizeerresolutie is ingesteld op Off.
Instellingen: 0%−200%

Verandert de gate-tijd (of de daadwerkelijke tijd voor de gespeelde noot) van de even genummerde
tellen (backbeats), geteld vanaf de waarde die is opgegeven in Qntz Value (Quantize Value) om een
swinggevoel toe te voegen aan de ritmes. Deze parameter is niet beschikbaar wanneer de
quantizeerresolutie is ingesteld op Off.
Instellingen: 0%−200%

Wijzigt de timing van even genummerde tellen (backbeats), geteld vanaf de waarde die is opgegeven
in Qntz Value (Quantize Value), om een swinggevoel toe te voegen aan de ritmes. Deze parameter is
niet beschikbaar wanneer de quantizeerresolutie is ingesteld op Off.
Instellingen: 0-helft van quantizeerresolutie

Position

Play FX1

Qntz Value (Quantize Value)

Qntz Str (Quantize Strength)

Swing Vel (Swing Velocity Rate)

Swing Gate (Swing Gate Time Rate)

Swing Rate (Swing Offset)
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Bepaalt Note Shift, Clock Shift, Gate Time, Velocity Rate en Velocity Offset.

Past de toonhoogte aan in stappen van een halve toon.
Instellingen: −99−+99

Verschuift de timing van de noten vooruit of achteruit in klokstappen.
Instellingen: −120−+120

Verandert de gate-tijd (de werkelijke tijd waarop het geluid van de noot moet worden gegenereerd)
van de nootevents.
Instellingen: 0%−200%

Verandert de aanslagsnelheid met het opgegeven percentage.
Instellingen: 0%−200%

Verhoogt of verlaagt de aanslag snelheid met de opgegeven waarde.
Instellingen: −99−+99

Deze job koppelt scènes aan elkaar om af te spelen.

Gebruik

Play FX2

Note Shift

Clock Shift

Gate Time

Velocity Rate

Velocity Offset

Chain

[ ] (Play)-knop → Pattern → [EDIT/ ] → Chain

[PERFORMANCE] → Play/Rec → Pattern → Edit/Job → Chain
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Schakelt ketengewijs afspelen in.
Instellingen: Off, On

Geeft de startmaatpositie op voor het afspelen van scènes.
Instellingen: 001−999

Stelt de scène in om af te spelen op de opgegeven maat.
Instellingen: 1–8, End

Wanneer er meer dan acht rijen zijn voor de lijsten Measure en Scene, wordt de pijl-omhoog of -
omlaag weergegeven.

Slaat de keten op als een song.

Toont de lengte van de gehele sequence.

Toont de huidige positie tijdens het ketengewijs afspelen en laat u de positie van het afspelen
instellen.
Instellingen: 001−999

In het scherm Song kunt u uw toetsenspel opnemen in MIDI Song, en de song afspelen.
De gegevens van zowel het toetsenbordspel als de bediening van regelaars en knoppen worden
opgenomen op de MIDI-track.
U kunt ook het afspelen van arpeggio's selecteren om op te nemen in de song.

Chain

Measure

Scene

Page

Convert to Song

Length

Position

Song
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Gebruik

(1) Link Icon
(2) Song Length
(3) Track Play Switch

Toont de naam van de geselecteerde song.
Als u op de naam tikt, wordt het contextmenu voor Load, Rename, New Song en User Arp geopend.

U kunt een song selecteren met de knoppen [INC/YES] en [DEC/NO] wanneer de cursor op de Song
Name staat.

Toont de naam van de geselecteerde performance.

OPMERKING
De blauwe vlag wordt getoond als u een parameter in de Performance wijzigt.

Het koppelingspictogram wordt weergegeven als de performance die wordt gebruikt voor het
opnemen van de song en de geselecteerde performance dezelfde is. Als dit niet het geval is, wordt
het pictogram voor verbroken koppeling weergegeven.

Hiermee wordt het scherm Tempo Settings geopend.

Afspelen en stand-by voor afspelen

[SONG/PATTERN]-knop → Song

[PERFORMANCE] → Play/Rec → Song

[ ] (Play)-knop → Song

Song Name

Performance Name

Link Icon

Click Settings
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Toont het metrum voor het patroon.

Stelt de positie in voor het starten van het afspelen en opnemen, evenals de huidige positie van het
afspelen.
Het getal aan de linkerkant is de maat en de getallen aan de rechterkant zijn de tellen en tikken.

Stelt het tempo in voor het afspelen van de song.
Instellingen: 5−300

Zet afspelen in een loop aan of uit.
Als dit is ingesteld op On, wordt het afspelen van een sectie tussen de Loop Start en Loop End
herhaald.
Instellingen: Off, On

Stelt de sectie voor afspelen in een loop in. Het getal aan de linkerkant is de maat, en het getal aan
de rechterkant is de tel. Deze parameter is niet beschikbaar als Loop is ingesteld op Off.

Slaat de koppeling op tussen de bewerkte songs en de gebruikte performance.

OPMERKING
Als u de parameters voor de performance hebt bewerkt, moet u ook de performance opslaan.

Als u op deze knop drukt, wordt het scherm Save geopend, waar u de song als bestand kunt
opslaan.
Save As .mid File is niet beschikbaar in de volgende gevallen.

Toont de lengte van de gehele sequence.

Schakelt het afspelen van elke track in of uit.
Instellingen: Off, On

Time Signature

Position

Tempo

Loop

Loop Start / End

Store Song & Perf Settings (Store Song and Performance Settings)

Save As .mid File

Voor een nieuwe opname (als er geen song is)

Tijdens het afspelen

Wanneer opname-stand-by is ingeschakeld

Tijdens het opnemen

Song Length

Track Play Switch

Opname en opname-standby
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Gebruik

New recording

Als er al iets is opgenomen

Toont het metrum voor de song.
Instellingen: 1/16–16/16, 1/8–16/8, 1/4–8/4

Quantize is een functie die de opgenomen noten corrigeert zodat ze op de exacte fractie van de tel
vallen (in nootwaarden).
Instellingen: Off, 60 (tweeëndertigste noot), 80 (zestiende noottriool), 120 (zestiende noot), 160

(achtste noot triool), 240 (achtste noot), 320 (kwartnoottriool), 480 (kwartnoot)

Selecteert een opnametype voor de reeds opgenomen tracks. Deze parameter is niet beschikbaar
voor een nieuwe opname.
Instellingen: Replace, Overdub, Punch

Replace: overschrijven en opnemen in real time. De bestaande gegevens gaan verloren.

[SONG/PATTERN]-knop → Song → [ ] (Record)-knop

[PERFORMANCE] → Play/Rec → Song → [ ] (Record)-knop

Time Signature

Rec Quantize

Record Type
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Overdub: overdubben en opnemen in real time. De bestaande gegevens gaan niet
verloren.
Punch: een sectie opnieuw opnemen en opnemen in real time. Hierdoor worden de
bestaande gegevens van een opgegeven sectie overschreven.

Stelt het Punch in-punt in (specifieke maat en tel waarop begonnen moet worden met de
heropname).
Deze parameter is alleen beschikbaar als Record Type is ingesteld op Punch.

Stelt het Punch out-punt in (specifieke maat en tel waarop gestopt moet worden met de heropname).
Deze parameter is alleen beschikbaar als Record Type is ingesteld op Punch.

Wanneer Arp Rec op On is ingesteld, wordt het resultaat van het afspelen van arpeggio opgenomen.
Als dit is ingesteld op Off, wordt alleen het toetsenspel opgenomen.
Deze parameter kan worden ingesteld voor de opnamen van een nieuwe song. De instelling kan na
het opnemen niet worden gewijzigd.
Als u iets wilt toevoegen aan de song die is opgenomen waarbij Arp Rec was ingesteld op Off, kan
alleen Replace worden gebruikt als Record Type.
Instellingen: Off, On

OPMERKING
Als Arp Rec is ingesteld op Off voor de song, kunt u een ander arpeggio selecteren om af te spelen door de
arpeggioselectie in de performance te wijzigen.

Undo annuleert de laatste opnameactie en verwijdert wat zojuist is opgenomen.
Deze knop is actief wanneer u instellingen in een sequence wijzigt.

Redo herstelt de opname die werd geannuleerd door Undo. Deze knop is pas actief nadat Undo is
gebruikt.

Converteert de geselecteerde song naar een gebruikersarpeggio.
Er kunnen maximaal 16 verschillende noten worden geconverteerd. (Alle noten met hetzelfde
nootnummer worden als één geteld.)
Zorg ervoor dat u slechts maximaal 16 noten voor een song gebruikt als u deze naar een
gebruikersarpeggio wilt converteren, vooral als u meerdere tracks gebruikt.

Gebruik

Open het scherm vanuit [PERFORMANCE] → Play/Rec → Song → Tik op de Song Name om het
contextmenu te openen → User Arp

Punch In

Punch Out

Arp Rec

Undo

Redo

Put Track to Arpeggio
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Stelt het arpeggionummer in van het gebruikersarpeggio voor conversie.
In eerste instantie wordt het volgende ongebruikte nummer ingesteld.
Houd er rekening mee dat als u dit wijzigt in een nummer dat al in gebruik is, het arpeggio wordt
overschreven, wat betekent dat u het bestaande gebruikersarpeggio voor dat nummer verliest.
Instellingen: 1−256

Stelt de hoofd- en subcategorieën van het geconverteerde arpeggio in.
Instellingen: Raadpleeg de Data List.

Stelt de arpeggionaam in. U kunt maximaal 20 alfanumerieke tekens gebruiken.

Stelt het tracknummer van de song in waarvan moet worden geconverteerd voor elke arpeggiotrack.
Instellingen: 1−16

Selecteert hoe de MIDI-sequence die in de song is opgenomen, vanuit drie verschillende instellingen
naar het arpeggio moet worden geconverteerd.
U kunt voor elke arpeggiotrack een ander Convert Type gebruiken.
Instellingen: Normal, Fixed, Org Notes

Normal: het arpeggio wordt afgespeeld op hetzelfde octaaf als de opgenomen MIDI-
sequence.
Fixed: de opgenomen MIDI-sequence wordt afgespeeld op dezelfde manier, ongeacht hoe
u het toetsenbord bespeelt.
Org Notes: in principe hetzelfde als Fixed, maar de MIDI-sequence verandert afhankelijk
van de akkoorden die u op het toetsenbord speelt.

Hiermee stelt u de grondtoon in wanneer het Convert Type van een track is ingesteld op Org Notes.
Deze parameter is niet beschikbaar als er geen track is ingesteld op Org Notes.

Arp (Arpeggio Number)

Category (Arpeggio Category)
Sub Category (Arpeggio Sub Category)

Name (Arpeggio Name)

Song Track

Convert Type

Org Notes Root (Original Notes Root)
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Instellingen: C−2−G8

Stelt de startmaat voor de conversie in.
Instellingen: 1−998

Stelt de eindmaat voor de conversie in.
Instellingen: 2−999

Converteert de song naar een gebruikersarpeggio met de instellingen die in dit scherm zijn
opgegeven.
Deze knop is niet beschikbaar als alle tracks zijn ingesteld op Off.

In het scherm Audio kunt u uw toetsenspel als audiobestand met de WAV-indeling (44,1 kHz, 24-bits
stereo) opnemen naar een USB-flashstation. U kunt maximaal 74 minuten of langer opnemen, tot de
maximale capaciteit van het USB-flashstation.

Gebruik

Toont de naam van het geselecteerde audiobestand.
Als u op de naam tikt, wordt het contextmenu voor Load geopend.

Start Measure

End Measure

Store As User Arp

Audio

Afspelen en stand-by voor afspelen

[SONG/PATTERN]-knop → Audio

[PERFORMANCE] → Play/Rec → Audio

[ ] (Play)-knop → Audio

Audio Name

Position
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Stelt de positie in voor het starten van het afspelen, evenals de huidige positie van het afspelen.

Stelt de positie in voor het starten van het afspelen. Deze parameter is niet beschikbaar tijdens
opnemen.
Instellingen: 0−255

Toont de totale lengte van het audiobestand.

Geeft het audio-ingangs-/uitgangsniveau aan.

Gebruik

[PERFORMANCE] → Play/Rec → Audio → [ ] (Record)-knop

Toont de opneembare tijd voor audio. Deze parameter wordt alleen weergegeven als opnamestand-
by is ingeschakeld.

Selecteert hoe u de opname wilt starten. Deze parameter wordt alleen weergegeven als
opnamestand-by is ingeschakeld.

Wanneer Trigger Level is ingesteld op handmatig, kunt u de opname starten door op de [ ] (Play)-
knop te drukken.

Wanneer Trigger Level is ingesteld op een waarde tussen 1 en 127, kunt u beginnen met opnemen
nadat u op de [ ] (Play)-knop hebt gedrukt en het signaalniveau de opgegeven waarde
overschrijdt. Het niveau dat u hier instelt, wordt met blauwe driehoekjes weergegeven op de
niveaumeter.

Audio Volume

Audio Length

Level meter

Opname en opname-standby

Recordable (Audio Recordable Time)

Trigger Level
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Voor optimale resultaten stelt u deze parameter zo laag mogelijk in om het volledige signaal vast te
leggen, maar niet zo laag dat ongewenste ruis wordt opgenomen.
Instellingen: manual, 1−127

Tik op de Smart Morph-kaart en breng wijzigingen aan in het FM-X- of AN-X-geluid in partij 1.

Gebruik

[PERFORMANCE] → Smart Morph → Play

Gebruik

[PERFORMANCE] → Smart Morph → Edit

Tik om het scherm Part Category Search te openen, waarin u een FM-X- of AN-X-geluid kunt
selecteren.

Smart Morph

Play

Edit

Ongebruikte partij
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Als u op de naam tikt, wordt het contextmenu voor Category Search, Edit en Property geopend.

Selecteert de weergave Part Main Category of Part Name voor partijen.

Schakelt tussen FM-X en AN-X.
Instellingen: FM-X, AN-X

Tik op de knop om machine learning te starten (kaarten maken).
Deze knop wordt niet weergegeven als er geen FM-X- of AN-X-geluid is op partijen 9 tot en met 16.

Na de Learn-bewerking wordt de knop Undo rechtsboven weergegeven.
Gebruik de knop Undo om de oorspronkelijke kaart te herstellen voordat u machine learning gebruikt.
Na de Undo-bewerking verschijnt de knop Redo, waarmee u de kaart kunt herstellen tot de toestand
van vóór Undo.

Gebruik

[PERFORMANCE] → Smart Morph → Analyze

Partij die wordt gebruikt

Display

Mode

Learn

Undo
Redo

Analyze
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Elke stip op de kaart vertegenwoordigt de parameterwaarde die een graad of niveau in een rode tint
aangeeft.
Voor de lijst met beschikbare parameters raadpleegt u "Parameters die kunnen worden ingesteld
voor Rood, Groen en Blauw."

Elke stip op de kaart vertegenwoordigt de parameterwaarde die een graad of niveau in een groene
tint aangeeft.
Voor de lijst met beschikbare parameters raadpleegt u "Parameters die kunnen worden ingesteld
voor Rood, Groen en Blauw."

Elke stip op de kaart vertegenwoordigt de parameterwaarde die een graad of niveau in een blauwe
tint aangeeft.
Voor de lijst met beschikbare parameters raadpleegt u "Parameters die kunnen worden ingesteld
voor Rood, Groen en Blauw."

Wanneer dit is ingesteld op Auto, worden Rood, Groen en Blauw automatisch gereset voor het
Learn-proces.
Wanneer dit is ingesteld op Manual, worden Rood, Groen en Blauw niet automatisch gereset voor het
Learn-proces.
Instellingen: Auto, Manual

Tik op de knop om machine learning te starten (kaarten maken).

Na de Learn-bewerking wordt de knop Undo rechtsboven weergegeven.
Gebruik de knop Undo om de oorspronkelijke kaart te herstellen voordat u machine learning gebruikt.
Na de Undo-bewerking verschijnt de knop Redo, waarmee u de kaart kunt herstellen tot de toestand
van vóór Undo.

Red

Green

Blue

Coloring

Learn

Undo
Redo
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Naam van parameter Weergegeven naam

Random Pan Depth Random Pan Depth

Alternate Pan Depth Alternate Pan

Scaling Pan Depth Scaling Pan Depth

Key On Delay Time Length KeyOnDly Time

Key On Delay Tempo Sync Switch KeyOnDly Sync

Key On Delay Note Length KeyOnDly Note

Pitch Velocity Sensitivity Pitch/Vel

Random Pitch Depth Random Pitch Depth

Pitch Key Follow Sensitivity Pitch/Key

Pitch Key Follow Sensitivity Center Note Pitch/Key Center

PEG Initial Level PEG Initial Lvl

PEG Attack Level PEG Attack Lvl

PEG Decay 1 Level PEG Decay 1 Lvl

PEG Decay 2 Level PEG Decay 2 Lvl

PEG Release Level PEG Release Lvl

PEG Attack Time PEG Attack Tm

PEG Decay 1 Time PEG Decay 1 Tm

PEG Decay 2 Time PEG Decay 2 Tm

PEG Release Time PEG Release Tm

PEG Depth Vel Sensitivity PEG Depth/Vel

PEG Depth PEG Depth

PEG Time Key Follow PEG Time/Key

2nd LFO Wave 2nd LFO Wave

2nd LFO Speed LFO Speed

2nd LFO Phase LFO Phase

2nd LFO Delay Time LFO Delay

Parameters die kunnen worden ingesteld voor Red, Green en Blue:
FM Common
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Naam van parameter Weergegeven naam

2nd LFO Key On Reset LFO Key On Reset

2nd LFO Pitch Mod Depth LFO Pitch Mod

2nd LFO Amp Mod Depth LFO Amp Mod

2nd LFO Filter Mod Depth LFO Filter Mod

Algorithm Number Algorithm Number

Feedback Level Feedback Level

LFO Speed Range LFO Speed Range

LFO Extended Speed LFO Ex Speed

Filter Type Filter Type

Filter Cutoff Frequency Cutoff

Filter Cutoff Vel Sensitivity Cutoff/Vel

Filter Resonance/Width Resonance / Width

Resonance Vel Sensitivity Res/Vel

HPF Cutoff Frequency HPF Cutoff

Distance Distance

Filter Gain Filter Gain

FEG Hold Time FEG Hold Tm

FEG Attack Time FEG Attack Tm

FEG Decay 1 Time FEG Decay 1 Tm

FEG Decay 2 Time FEG Decay 2 Tm

FEG Release Time FEG Release Tm

FEG Hold Level FEG Hold Lvl

FEG Attack Level FEG Attack Lvl

FEG Decay 1 Level FEG Decay 1 Lvl

FEG Decay 2 Level FEG Decay 2 Lvl

FEG Release Level FEG Release Lvl

FEG Depth FEG Depth

FEG Time Velocity Sensitivity Segment FEG Segment

FEG Time Vel Sensitivity FEG Time/Vel

FEG Depth Vel Sensitivity FEG Depth/Vel

FEG Depth / Vel Curve FEG Curve

FEG Time Key Follow FEG Time/Key

FEG Time Key Follow Sensitivity Center Note FEG Center

Filter Cutoff Key Follow Flt Cutoff/Key

Filter Cutoff Scaling Break Point 1 Flt Break Point 1
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Naam van parameter Weergegeven naam

Filter Cutoff Scaling Break Point 2 Flt Break Point 2

Filter Cutoff Scaling Break Point 3 Flt Break Point 3

Filter Cutoff Scaling Break Point 4 Flt Break Point 4

Cutoff Scaling Offset 1 Flt Cutoff Offset 1

Cutoff Scaling Offset 2 Flt Cutoff Offset 2

Cutoff Scaling Offset 3 Flt Cutoff Offset 3

Cutoff Scaling Offset 4 Flt Cutoff Offset 4

HPF Cutoff Key Follow HPF Cutoff/Key

Naam van parameter Weergegeven naam

Key On Reset Key On Reset

Freq Mode Freq Mode

Coarse Coarse

Fine Fine

Detune Detune

Pitch/Key Pitch/Key

Pitch/Vel Pitch/Vel

Spectral Spectral

Skirt Skirt

Resonance Resonance

Initial PEG Initial Lvl

Attack PEG Attack Lvl

Attack PEG Attack Tm

Decay PEG Decay Tm

Attack AEG Attack Lvl

Decay 1 AEG Decay 1 Lvl

Decay 2 AEG Decay 2 Lvl

Rel(Hold) AEG Release Lvl

Attack AEG Attack Tm

Decay 1 AEG Decay 1 Tm

Decay 2 AEG Decay 2 Tm

Release AEG Release Tm

Hold AEG Hold Tm

Time/Key AEG Time/Key

Operator
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Naam van parameter Weergegeven naam

Level Level

Break Point Lvl Break Point

Lvl/Key Lo Lvl/Key Lo

Lvl/Key Hi Lvl/Key Hi

Curve Lo Curve Lo

Curve Hi Curve Hi

Level/Vel Level/Vel

Depth Offset LFO PM Depth

Depth Offset LFO AM Depth

Pitch/Ctrl Pitch/Ctrl

Level/Ctrl Level/Ctrl

Naam van parameter Weergegeven naam

Random Pan Depth Random Pan

Alternate Pan Depth Alternate Pan

Scaling Pan Depth Scaling Pan

Key On Delay Time Length Delay Length

Key On Delay Tempo Sync Switch KeyOnDly Sync

Key On Delay Note Length Delay Length

Unison Unison

Unison Detune Unison Detune

Unison Spread Unison Spread

OSC Reset OSC Reset

Voltage Drift Voltage Drift

Ageing Ageing

Pitch EG Attack Time Attack

Pitch EG Decay Time Decay

Pitch EG Sustain Level Sustain

Pitch EG Release Time Release

Pitch EG Time Velocity Sensitivity Time/Vel

Pitch LFO Wave Wave

Pitch LFO Speed Speed

Pitch LFO Key On Reset Key On Reset

Pitch LFO Phase Phase

AN-X Common
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Naam van parameter Weergegeven naam

Pitch LFO Delay Time Delay

Pitch LFO Fade In Time Fade In

Noise Generator Tone Noise Tone

Noise Generator Out Select Connect

Noise Generator Out Level Out Level

Noise Generator Out Level Velocity Sensitivity Out Level/Vel

Filter Common Cutoff EG Attack Time Attack

Filter Common Cutoff EG Decay Time Decay

Filter Common Cutoff EG Sustain Level Sustain

Filter Common Cutoff EG Release Time Release

Filter Common Cutoff EG Time Velocity Sensitivity Time/Vel

Filter Common Cutoff LFO Wave Wave

Filter Common Cutoff LFO Speed Speed

Filter Common Cutoff LFO Key On Reset Key On Reset

Filter Common Cutoff LFO Phase Phase

Filter Common Cutoff LFO Delay Time Delay

Filter Common Cutoff LFO Fade In Time Fade In

Amplitude Level Level

Amplitude Level Velocity Sensitivity Level/Vel

Amplitude Level LFO Depth LFO Depth

Amplitude Level Key Follow Level/Key

Amplitude Saturator Drive Drive

Amplitude EG Attack Time Attack

Amplitude EG Decay Time Decay

Amplitude EG Sustain Level Sustain

Amplitude EG Release Time Release

Amplitude EG Time Velocity Sensitivity Time/Vel

Amplitude LFO Wave Wave

Amplitude LFO Speed Speed

Amplitude LFO Key On Reset Key On Reset

Amplitude LFO Phase Phase

Amplitude LFO Delay Time Delay

Amplitude LFO Fade In Time Fade In

Oscillator
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Naam van parameter Weergegeven naam

Oscillator Wave Wave

Oscillator Octave Octave

Oscillator Pitch Pitch

Oscillator Pitch EG Depth Pitch EG Depth

Oscillator Pitch EG Depth Velocity Sensitivity Pitch EG Depth/Vel

Oscillator Pitch LFO Depth Pitch LFO Depth

Oscillator Self Sync Pitch Sync Pitch

Oscillator Self Sync Pitch Velocity Sensitivity Sync Pitch/Vel

Oscillator Self Sync EG Depth Sync

Oscillator Self Sync LFO Depth Sync

Oscillator Pulse Width Pulse Width

Oscillator Pulse Width Velocity Sensitivity PulseWidth/Vel

Oscillator Pulse Width EG Depth Pulse Width

Oscillator Pulse Width LFO Depth Pulse Width

Oscillator Wave Shaper Shaper

Oscillator Wave Shaper Velocity Sensitivity Shaper/Vel

Oscillator Wave Shaper EG Depth Shaper

Oscillator Wave Shaper LFO Depth Shaper

Oscillator FM Level FM Level

Oscillator FM Level Velocity Sensitivity FM Level/Vel

Oscillator Ring Level Ring Level

Oscillator Ring Level Velocity Sensitivity Ring Level/Vel

Oscillator Out Select Connect

Oscillator Out Invert Enable Invert

Oscillator Out Level Out Level

Oscillator Out Level Velocity Sensitivity Out Level/Vel

Oscillator EG Attack Time Attack

Oscillator EG Decay Time Decay

Oscillator EG Sustain Level Sustain

Oscillator EG Release Time Release

Oscillator LFO Wave Wave

Oscillator LFO Speed Speed

Oscillator LFO Key On Reset Key On Reset

Oscillator LFO Phase Phase

Oscillator LFO Delay Time Delay
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Naam van parameter Weergegeven naam

Oscillator LFO Fade In Time Fade In

Naam van parameter Weergegeven naam

Filter Type Type

Filter Cutoff Cutoff

Filter Cutoff Velocity Sensitivity Cutoff/Vel

Filter Cutoff EG Depth Filter EG Depth

Filter Cutoff EG Depth Velocity Sensitivity Filter EG Depth/Vel

Filter Cutoff LFO Depth Filter LFO Depth

Filter Cutoff Key Follow Cutoff/Key

Filter Resonance Resonance

Filter Resonance Velocity Sensitivity Resonance/Vel

Filter Saturator Drive Saturator Drive

Filter Saturator Drive Velocity Sensitivity Saturator Drive/...

Filter Out Level Out Level

Naam van parameter Weergegeven naam

Modifier Wave Folder Wave Folder

Modifier Wave Folder Velocity Sensitivity Folder/Vel

Modifier Wave Folder EG Depth EG Depth

Modifier Wave Folder LFO Depth LFO Depth

Modifier Wave Folder Texture Texture

Modifier Wave Folder Type Type

Modifier EG Attack Time Attack

Modifier EG Decay Time Decay

Modifier EG Sustain Level Sustain

Modifier EG Release Time Release

Modifier EG Time Velocity Sensitivity Time/Vel

Modifier LFO Wave Wave

Modifier LFO Speed Speed

Modifier LFO Key On Reset Key On Reset

Modifier LFO Phase Phase

Modifier LFO Delay Time Delay

Filter

Modifier
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Naam van parameter Weergegeven naam

Modifier LFO Fade In Time Fade In

Gebruik

[PERFORMANCE] → Smart Morph → Super Knob

Indien ingesteld op On, kunt u de Super Knob gebruiken om het pad op de kaart van begin tot eind te
volgen, in plaats van met uw vinger over het touchscreen te bewegen.
Instellingen: Off, On

Stelt de positie in van de kleinste Super Knob-waarde op de kaart.
Wanneer de cursor op Start staat, tikt u op de kaart om de waarde van het beginpunt in te stellen.

Stelt de positie in van de grootste Super Knob-waarde op de kaart.
Wanneer de cursor op End staat, tikt u op de kaart om de waarde van het eindpunt in te stellen.

Stelt het aantal verspreide punten (waypoints) in tussen het begin en het einde.
Instellingen: 0−6

Stelt de positie op de kaart in.

Gebruik

[PERFORMANCE] → Smart Morph → Job

Super Knob

Super Knob Link

Start

End

Waypoints

Waypoint 1–Waypoint 6

Job
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Hiermee opent u het Load-scherm.
In het scherm Load kunt u een andere performance selecteren en de Smart Morph-instellingen van
die performance importeren naar de huidige performance.

Verwijdert de Smart Morph-instellingen van de geselecteerde performance.

Verwijdert alle partijen 9 tot en met 16 in één keer om deze partijen ongebruikt te maken.
Wanneer partijen 9 tot en met 16 op ongebruikt zijn ingesteld, wordt de SSS ingeschakeld.
Partijen 9 tot en met 16 worden gebruikt voor het maken van een Smart Morphing-kaart.
Wanneer u klaar bent met het aanpassen van de parameters en u de kaart niet meer nodig hebt, kunt
u partijen 9 tot en met 16 verwijderen.

Load Smart Morph

Delete Smart Morph

Delete Part 9–16
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om02screenparameters0060

Op het Common Edit-scherm kunt u de parameters voor de gehele performance bewerken, evenals
de parameters voor de audiopartij.

Inhoudsopgave

Common Edit-scherm

General/Pitch

Perf Settings

USB Monitor

Pitch

Edit User Tuning

Filter/Amp

Filter EG

Amp EG

Effect

Routing

Variation

Reverb

Master FX

Master EQ

Envelope Follower Edit

Audio In

Mixing

Routing

Ins A

Ins B

2-band EQ

Arp/MS

Arp Common

Arp Overview (Arpeggio Overview)

MS Common (Motion Sequencer Common)

MS Overview (Motion Sequencer Overview)

Lane

Motion Sequence Edit

Control

Control Assign
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Op het scherm Perf Settings (Performance-instellingen) kunt u algemene parameters voor de
performance instellen.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → General/Pitch → Perf Settings

Stelt de hoofd- en subcategorie van de geselecteerde performance in.
Instellingen: Raadpleeg de Data List.

U kunt de performance die u bewerkt onder een nieuwe naam opslaan. Deze naam mag uit
maximaal 20 alfanumerieke tekens bestaan.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u een naam kunt invoeren.

Stelt een MC-vlag in voor de geselecteerde performance.
Indien dit wordt ingesteld op On, verschijnt de MC flag op het Performance-scherm. Op het scherm
Performance Category Search wordt de performance gefilterd op het MC-attribuut.
Instellingen: Off, On

After Touch

Ribbon Settings

Control Number

Control Settings

General/Pitch

Perf Settings

Main Category
Sub Category

Performance Name

MC Flag (Motion Control Flag)
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Stelt het volume in van de geselecteerde performance.
Instellingen: 0-127

Stelt de pan in van de geselecteerde performance.
Instellingen: L63-C-R63

Stelt het uitgangsniveau (Return Level) in van de signalen die door het Variation-effect worden
verwerkt.
Instellingen: 0-127

Stelt het uitgangsniveau (Return Level) in van de signalen die door het Reverb-effect worden
verwerkt.
Instellingen: 0-127

Zet Portamento aan of uit voor partijen waarvoor de Portamento Part Sw op On is ingesteld.
Deze schakelaar is gekoppeld aan de [PORTAMENTO]-knop op het bovenpaneel.
Instellingen: Off, On

Stelt de tijdsduur (of snelheid) in voor de toonhoogteovergang van Portamento.
Dit wordt opgegeven als een offsetwaarde voor de portamento-tijd van de partij.
Instellingen: -64-+63

Converteert alle songs die in het interne geheugen zijn opgeslagen naar gebruikersaudities.
Als er al gebruikersaudities bestaan, worden alle eerdere gebruikersaudities overschreven.

Selecteert de bank voor de auditiefrasen.

Selecteert de auditiefrase.
Aan de vooraf ingestelde performances zijn al geschikte auditiefrasen toegewezen.
Door de auditiefrase af te spelen, kunt u naar de geselecteerde performance in een passende
muzikale context luisteren.
Instellingen: Raadpleeg de Data List.

Toont de naam van de auditiefrase.

Volume (Performance Volume)

Pan (Performance Pan)

Var Return (Variation Return)

Rev Return (Reverb Return)

Portamento Master Sw (Portamento Master Switch)

Portamento Time

Update User Auditions

Audition Bank

Audition Phrase Number

Audition Phrase Name
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Past de toonhoogte van de noten in de auditiefrase aan in halve tonen.
Instellingen: −24–+24

Hiermee past u de aanslagsnelheid van de auditiefrase aan.
Instellingen: −63–+63

Op het USB Monitor-scherm kunt u het volume aanpassen van de audiosignalen die worden
ingevoerd via de [USB TO HOST]-aansluitingen.
Wanneer u op USB Volume in de Audio Signal Flow tikt, wordt de cursor verplaatst naar USB Volume
op het Audio I/O-scherm.

OPMERKING
USB Main Monitor Volume en USB Assign Monitor Volume worden opgeslagen in de Performance.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → General/Pitch → USB Monitor

Hiermee past u het volume van de audiosignaalinvoer aan van de [USB TO HOST]-aansluiting en de
uitvoer naar de OUTPUT-aansluitingen.
Instellingen: 0-127

Hiermee past u het volume van de audiosignaalinvoer aan van de [USB TO HOST]-aansluiting en de
uitvoer naar de ASSIGNABLE OUTPUT (BALANCED)-aansluitingen.
Instellingen: 0-127

Note Shift (nootverschuiving van auditiefrase)

Velocity Shift (Audition Velocity Shift)

USB Monitor

Monitor Volume Main

Monitor Volume Assign

Audio Settings
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Hiermee opent u het scherm UTILITY Audio I/O.
Hetzelfde scherm kan worden geopend vanuit [UTILITY]→Settings→Audio I/O.

Op het Pitch-scherm kunt u de toonhoogte-instellingen maken.

Gebruik

Sw, Mode, Time en Time Mode worden niet weergegeven voor de drumpartij.

Schakelt de weergave tussen partijen 1 tot en met 8 en partijen 9 tot en met 16.

Stelt in dat Portamento wordt toegepast op partijen waarbij de Portamento Part Switch op On staat.
Deze schakelaar is gekoppeld aan de [PORTAMENTO]-knop op het bovenpaneel.
Instellingen: Off, On

Stelt de tijdsduur (of snelheid) in voor de toonhoogteovergang van Portamento.
Dit wordt opgegeven als een offsetwaarde voor de portamento-tijd van de partij.
Instellingen: -64-+63

De partijen in dezelfde groep krijgen dezelfde toonhoogte.
Dit is handig als u Portamento op een gelaagd geluid wilt toepassen of dezelfde micro-tuning-
instellingen voor meerdere partijen tegelijk wilt hebben.

Pitch

[PERFORMANCE] → Common selectie → [EDIT/ ] → General/Pitch → Pitch

[SHIFT] + [PORTAMENTO]

Portamento-weergave

Part

Master Sw (Portamento-masterschakelaar)

Time (Portamento Time)

Group (Pitch Control Group)
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Schakelt Portamento voor de partij in of uit.
Instellingen: Off, On

Stelt in hoe Portamento wordt toegepast door de manier waarop u het toetsenbord bespeelt.
Instellingen: Fingered, Full-time

Fingered: portamento wordt alleen toegepast als u legato speelt (de volgende noot speelt
voordat u de vorige noot loslaat).
Full-time: portamento wordt op alle noten toegepast.

Stelt de tijdsduur (of snelheid) in voor de toonhoogteovergang van Portamento voor de partij.
Instellingen: 0-127

Hiermee stelt u in hoe de toonhoogte verandert binnen een tijdsbestek.
Instellingen: Rate 1, Time 1, Rate 2, Time 2

Rate 1: de toonhoogte verandert met een opgegeven snelheid.
Time 1: de toonhoogte verandert op een opgegeven tijdstip.
Rate 2: de toonhoogte verandert met een opgegeven snelheid binnen een octaaf.
Time 2: de toonhoogte verandert op een opgegeven tijdstip binnen een octaaf.

Mono / Poly wordt niet weergegeven voor de drumpartij.

Stelt het bereik in van de veranderingen die met het pitchbendwiel worden gecreëerd in halve tonen.
Instellingen: -48-+0-+24

Sw (Portamento Part Switch)

Portamento Mode

Time (Portamento Part Time)

Time Mode (Portamento Time Mode)

Pitch Bend / Mono-weergave

Lower (Pitch Bend Lower)
Upper (Pitch Bend Upper)

Mono / Poly
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Stelt de toongeneratiemodus voor het toetsenbord in.
Mono wordt alleen gebruikt voor enkele noten en Poly wordt gebruikt om verschillende noten
gelijktijdig te spelen.
Instellingen: Mono, Poly

Hiermee opent u het scherm Control Assign voor Common Edit.

Micro Tuning Name en Root worden niet weergegeven voor de drumpartij.

Stelt het fijnstemmen (temperament) voor de partij in.
Instellingen: Equal Temperament, Pure Major, Pure Minor, Werckmeister, Kirnberger, Vallotti &

Young, 1/4 shift, 1/4 tone, 1/8 tone, Indian, Arabic 1, Arabic 2, Arabic 3, User 1–8 (wanneer
een gebruikersbank is geselecteerd), Library 1-1–16-8 (wanneer een bibliotheekbestand is
geladen)

Stelt de grondtoon in voor het fijnstemmen.
Deze parameter wordt niet weergegeven wanneer het geselecteerde type in Micro Tuning Name
geen grondtoon vereist.
Instellingen: C-B

Opent het Global Tuning-instellingenscherm.

Opent het User Tuning-instellingenscherm.

Edit Control Assign

Micro Tuning-weergave

Micro Tuning Name

Root (Micro Tuning Root)

Edit Global Tuning

Edit User Tuning

Note Shift / Detune-weergave
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Past de toonhoogte aan in stappen van een halve toon.
Instellingen: -24-+0-+24

Past de toonhoogte van de partij aan in stappen van 0,1 Hz.
Door de toonhoogte iets te verschuiven, kunt u het geluid ontstemmen.
Instellingen: -12,8Hz-+0,0Hz-+12,7Hz

Dit is het instellingenscherm voor User Micro Tuning.

Geeft het geselecteerde gebruikersmicrostemmingnummer aan.
Instellingen: 1-8

U kunt de User Micro Tuning die u bewerkt onder een nieuwe naam opslaan.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u een naam kunt invoeren.

Shift (Note Shift)

Detune

Edit User Tuning

Tuning No. (Micro Tuning Number)

Tuning Name (Micro Tuning Name)

C, C♯, D, D♯, E, F, F♯, G, G♯, A, A♯, B
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U kunt de toonhoogte van elke noot aanpassen in stappen van 1 cent en zo de fijnstemming
instellen.
Instellingen: -99-+99

Initialiseert de geselecteerde fijnstemming van de gebruiker.

Op het scherm Filter EG kunt u de filterenvelopegenerator (FEG) instellen.
Hiermee kunt u de mate (of het niveau) van veranderingen in de afsnijfrequentie instellen en hoe
deze veranderingen in de loop van de tijd evolueren, vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment dat het geluid wegsterft.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Filter/Amp → Filter EG

Stelt de tijdsduur in die nodig is voordat het geluid verandert vanaf het moment dat u een toets
indrukt tot het moment waarop de afsnijfrequentie de waarde bereikt die is ingesteld bij Attack Level.
Dit wordt opgegeven als een offsetwaarde voor de FEG van de partij.
Instellingen: -64-+63

Stelt de tijdsduur in die nodig is voordat de afsnijfrequentie verandert vanaf het aanslagniveau. U
kunt de scherpte of de vervalsnelheid van het geluid regelen.
Dit wordt opgegeven als een offsetwaarde voor de FEG van de partij.
Instellingen: -64-+63

Initialize

Filter/Amp

Filter EG

FEG Atk (FEG Attack Time)

FEG Decay (FEG Decay Time)

FEG Rel (FEG Release Time)
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Stelt de tijdsduur in die nodig is voordat de afsnijfrequentie naar het releaseniveau daalt wanneer u
uw vinger van de toets haalt.
Dit wordt opgegeven als een offsetwaarde voor de FEG van de partij.
Instellingen: -64-+63

Wijzigt het geluid door de afsnijfrequentie van het filter in te stellen.
Wanneer het laagdoorlaatfilter is geselecteerd, kunt u een helderder geluid maken door een hogere
waarde voor deze parameter in te stellen, en een donkerder geluid door een kleinere waarde in te
stellen.
Dit wordt opgegeven als een offsetwaarde voor de filterafsnijfrequentie voor de partij.
Instellingen: -64-+63

Voegt speciale kenmerken toe aan het geluid door het signaalniveau dichtbij de afsnijfrequentie aan
te passen.
Dit wordt opgegeven als een offsetwaarde voor de filterresonantie voor de partij.
Instellingen: -64-+63

Stelt het dieptebereik in van de afsnijfrequentie die wordt geregeld door de FEG.
Dit wordt opgegeven als een offsetwaarde voor de Part FEG Depth (FEG-diepte van de partij).
Instellingen: -64-+63

Op het scherm Amp EG kunt u de AEG-tijd (Amplitude Envelope Generator) instellen. Door de Amp
EG in te stellen, kunt u instellen hoe het volume verandert vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment waarop het geluid wegsterft.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Filter/Amp → Amp EG

Cutoff (Cutoff Frequency)

Resonance

FEG Depth

Amp EG
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De instellingen op het Amp EG-scherm zijn offsetwaarden ten opzichte van de AEG voor alle partijen.

Stelt de tijdsduur in die nodig is voordat het volume verandert vanaf het moment dat u een toets op
het toetsenbord indrukt tot het moment waarop het maximum wordt bereikt.
Instellingen: -64-+63

Stelt de tijd in die nodig is voordat het volume verandert nadat het het maximum heeft bereikt.
Instellingen: -64-+63

Stelt het volume in dat wordt aangehouden terwijl de toets ingedrukt wordt gehouden.
Instellingen: -64-+63

Stelt de tijdsduur in die verstrijkt totdat het geluid wegsterft nadat u de toets hebt losgelaten.
Instellingen: -64-+63

Op dit scherm kunt u de systeemeffecten instellen die op alle partijen worden toegepast en de
signaalstroom van de mastereffecten bekijken.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Effect → Routing

Schakelt de Variation-, Reverb-en Master-effecten in of uit.

Attack (AEG Attack Time)

Decay (AEG Decay Time)

Sustain (AEG Sustain Level)

Release (AEG Release Time)

Effect

Routing

Var (Variation Switch)
Rev (Reverb Switch)
MFX (Master Effect Switch)
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Instellingen: Off, On

Stelt het type in voor de Variation-, Reverb-en Master-effecten.
Instellingen: Raadpleeg de Effecttypen.

Selecteert een voorinstelling uit de Variation-, Reverb- en Master Effects-parameters.
Instellingen: Raadpleeg de Data List.

Stelt de Side Chain Part (of de modulator, afhankelijk van het effecttype) in voor de Variation- en
Master-effecten.
Deze parameter is niet beschikbaar als Master is ingesteld op de modulatorpartij. In dat geval wordt
de parameterwaarde tussen haakjes weergegeven, zoals in "(Master)".
Instellingen: Part 1–16, A/D, Master, Off

Stelt het uitgangsniveau (retourniveau) in van de signalen die door het Variation- of Reverb-effect
worden verwerkt.
Instellingen: 0-127

Stelt de stereolocatie in van de signalen die door het Variation- of Reverb-effect worden verwerkt.
Instellingen: L63 (links)–C (center)–R63 (rechts)

Hiermee stelt u het zendniveau in van signalen die wordt verzonden door het Variation-effect.
Instellingen: 0-127

Zet de Master EQ aan of uit.
Instellingen: Off, On

Hiermee opent u het instellingenscherm voor de Envelope Follower.

Var Type (Variation Type)
Rev Type (Reverb Type)
MFX Type (Master Effect Type)

Var Preset (Variation Preset Number)
Rev Preset (Reverb Preset Number)
MFX Preset (Master Effect Preset Number)

Side Chain (Variation Side Chain Part)
Side Chain (Master Effect Side Chain Part)
Modulator (Variation Modulator Part)
Modulator (Master Effect Modulator Part)

Var Return (Variation Return)
Rev Return (Reverb Return)

Var Pan (Variation Pan)
Rev Pan (Reverb Pan)

Var to Rev (Variation To Reverb)

Master EQ (Master EQ Switch)

Envelope Follower
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Hiermee stelt u het Variation-effect in.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Effect → Variation

(1) Variation Switch

Schakelt het Variation-effect in of uit.
Instellingen: Off, On

Stelt de categorie en het type van het Variation-effect in.
Instellingen: Raadpleeg de Effecttypen.

Selecteert een van de vooraf ingestelde effectparameters voor elk effecttype.
Instellingen: Raadpleeg de Data List.

Variation

Variation Switch

Category (Variation Category)
Type (Variation Type)

Preset (Variation Preset Number)
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Stelt de partij in voor de Side Chain (of de modulator, afhankelijk van het effecttype) voor het
Variation-effect.
Deze parameter is niet beschikbaar als Master is ingesteld op de modulatorpartij. In dat geval wordt
de parameterwaarde tussen haakjes weergegeven, zoals in "(Master)".
Instellingen: Part 1–16, A/D, Master, Off

De Effectparameters verschillen per effecttype.
Instellingen: Raadpleeg de Effectparameters.

Stelt het reverb-effect in.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Effect → Reverb

(1) Reverb Switch

Schakelt het Reverb-effect in of uit.
Instellingen: Off, On

Stelt de categorie en het type van het Reverb-effect in.
Instellingen: Raadpleeg de Effecttypen.

Selecteert een van de vooraf ingestelde effectparameters voor elk effecttype.

Side Chain (Variation Side Chain Part)
Modulator (Variation Modulator Part)

Effect Parameter

Reverb

Reverb Switch

Category (Reverb Category)
Type (Reverb Type)

Preset (Reverb Preset Number)
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Instellingen: Raadpleeg de Data List.

De Effectparameters verschillen per effecttype.
Instellingen: Raadpleeg de Effectparameters.

Stelt het Master-effect in.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Effect → Master FX

(1) Master Effect Switch

Schakelt het Master-effect in of uit.
Instellingen: Off, On

Stelt de categorie en het type van het Master-effect in.
Instellingen: Raadpleeg de Effecttypen.

Selecteert een van de vooraf ingestelde effectparameters voor elk effecttype.
Instellingen: Raadpleeg de Data List.

Stelt de Side Chain (of de modulator, afhankelijk van het effecttype) in voor de Master-effecten.
Deze parameter is niet beschikbaar als Master is ingesteld op de modulatorpartij. In dat geval wordt

Effect Parameter

Master FX

Master Effect Switch

Category (Master Effect Category)
Type (Master Effect Type)

Preset (Master Effect Preset Number)

Side Chain (Master Effect Side Chain Part)
Modulator (Master Effect Modulator Part)
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de parameterwaarde tussen haakjes weergegeven, zoals in "(Master)".
Instellingen: Part 1–16, A/D, Master, Off

De Effectparameters verschillen per effecttype.
Instellingen: Raadpleeg de Effectparameters.

Stelt de Master EQ in.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Effect → Master EQ

Zet de Master EQ aan of uit.
Instellingen: Off, On

Stelt het signaalniveau van de Low-band in.
Instellingen: −12–+12 (dB)

Stelt het signaalniveau van de Lo Mid-band in.
Instellingen: −12–+12 (dB)

Stelt het signaalniveau van de Mid-band in.
Instellingen: −12–+12 (dB)

Stelt het signaalniveau van de Hi Mid-band in.
Instellingen: −12–+12 (dB)

Effect Parameter

Master EQ

Master EQ (Master EQ Switch)

Low Gain (Master EQ Low Gain)

Lo Mid Gain (Master EQ Low Mid Gain)

Mid Gain (Master EQ Mid Gain)

Hi Mid Gain (Master EQ High Mid Gain)
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Stelt het signaalniveau van de High-band in.
Instellingen: −12–+12 (dB)

Stelt de frequentie van de Low-band in.
Instellingen: 32 (Hz)–2,0 (kHz)

Stelt de frequentie van de Lo Mid-band in.
Instellingen: 100 (Hz)-10 (kHz)

Stelt de frequentie van de Mid-band in.
Instellingen: 100 (Hz)-10 (kHz)

Stelt de frequentie van de Hi Mid-band in.
Instellingen: 100 (Hz)-10 (kHz)

Stelt de frequentie van de High-band in.
Instellingen: 500 (Hz)–16 (kHz)

Stelt de bandbreedte van de Low-band in.
Deze parameter is alleen beschikbaar wanneer Low Shape (Master EQ Low Shape) is ingesteld op
Peak.
Instellingen: 0,1-12,0

Stelt de bandbreedte van de Lo Mid-band in.
Instellingen: 0,1-12,0

Stelt de bandbreedte van de Mid-band in.
Instellingen: 0,1-12,0

Stelt de bandbreedte van de Hi Mid-band in.
Instellingen: 0,1-12,0

Stelt de bandbreedte van de High-band in.
Deze parameter is alleen beschikbaar wanneer High Shape (Master EQ High Shape) is ingesteld op

High Gain (Master EQ High Gain)

Low Freq (Master EQ Low Frequency)

Lo Mid Freq (Master EQ Low Mid Frequency)

Mid Freq (Master EQ Mid Frequency)

Hi Mid Freq (Master EQ High Mid Frequency)

High Freq (Master EQ High Frequency)

Low Q (Master EQ Low Q)

Lo Mid Q (Master EQ Low Mid Q)

Mid Q (Master EQ Mid Q)

Hi Mid Q (Master EQ High Mid Q)

High Q (Master EQ High Q)
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Peak.
Instellingen: 0,1-12,0

Bepaalt of de EQ is ingesteld op een shelvingtype (dat de signalen boven of onder een opgegeven
frequentie-instelling afkapt of versterkt) of op een parametrisch type (dat de signalen op een
opgegeven frequentie afkapt of versterkt) voor de EQ.
Instellingen: Shelf, Peak

Hiermee opent u het instellingenscherm voor de Envelope Follower.

Geeft de ingangsbron weer voor de geselecteerde Envelope Follower.
Instellingen: Master, AD, Part 1–16

Bepaalt de ingangsversterking van de ingangsbron die is ingesteld voor de partij.
Instellingen: −24,0 dB–0,0 dB–+24,0 dB

Stelt de aanslagtijd van de Envelope Follower in.
Instellingen: 1 ms–40 ms

Stelt de releasetijd voor de Envelope Follower in.
Instellingen: 10 ms–680 ms

Toont het ingangsniveau voor de signalen die worden ingevoerd vanaf de ingangsbron van de partij
die u hebt geselecteerd.

Low Shape (Master EQ Low Shape)
High Shape (Master EQ High Shape)

Envelope Follower Edit

Part (Input Source)

Gain (Envelope Follower Gain)

Attack (Envelope Follower Attack)

Release (Envelope Follower Release)

Ingangsniveau
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Geeft het uitgangsniveau van de Envelope Follower aan.

Hiermee opent u het scherm Control Assign voor de geselecteerde partij.

Op het Mixing-scherm kunt u de A/D-partij (signalen van de A/D INPUT-aansluitingen) en de digitale
partij (signalen van de [USB TO HOST]-aansluiting*) mixen.
* Heeft alleen betrekking op de audio voor de digitale L/R van de apparaatpoort.

Gebruik

Bepaalt de verwerkingsmethode voor de ingangssignalen op het linker- en rechterkanaal.
Instellingen: L Mono, R Mono, L+R Mono, Stereo

L Mono: gebruikt alleen het linkerkanaal.
R Mono: gebruikt alleen het rechterkanaal.
L+R Mono: mengt de linker- en rechterkanalen en verwerkt in mono.
Stereo: verwerkt de stereo-ingang in stereo.

OPMERKING
Als het geluid alleen wordt ingevoerd via het [L/MONO]-kanaal, wordt het in mono bewerkt.

Stelt het volume van de A/D-partij of de digitale partij in.
Instellingen: 0-127

Envelope Follower Output

Edit

Audio In

Mixing

[PERFORMANCE] → Common selectie → [EDIT/ ] → Audio In → Mixing

[SHIFT] + [A/D INPUT ON/OFF]

Input Mode (A/D Part Input Mode)
Input Mode (Digital Part Input Mode)

Volume (A/D Part Volume)
Volume (Digital Part Volume)
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Stelt de panpositie (in het stereoveld) van de A/D-partij of de digitale partij in.
Instellingen: L63-C-R63

Stelt het droogniveau (of het niveau van de signalen die niet worden verwerkt door het
systeemeffect) van de A/D-partij of de digitale partij in.
Deze parameter is alleen beschikbaar als Output Select is ingesteld op MainL&R.
Instellingen: 0-127

Stelt het niveau in van de signalen die worden verzonden vanaf de A/D-partij of de digitale partij naar
het Variation-effect.
Deze parameter is alleen beschikbaar als Output Select is ingesteld op MainL&R.
Instellingen: 0-127

Stelt het niveau in van de signalen die worden verzonden van de A/D-partij of de digitale partij naar
het Reverb-effect.
Deze parameter is alleen beschikbaar als Output Select is ingesteld op MainL&R.
Instellingen: 0-127

Stelt de uitvoerbestemming in voor de audiosignalen van de A/D-partij of de digitale partij.
Instellingen: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off

MainL&R: uitgang in stereo (twee kanalen) naar de OUTPUT [L/MONO]- en [R]-
aansluitingen.
AsgnL&R: uitgang in stereo (twee kanalen) naar de ASSIGNABLE OUTPUT [L]- en [R]-
aansluitingen.
USB1&2–USB29&30: uitgang in stereo (kanalen 1 en 2, naar kanalen 29 en 30) naar de
[USB TO HOST]-aansluiting.
AsgnL: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [L]-aansluiting.
AsgnR: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [R]-aansluiting.
USB1–30: uitgang in mono (kanaal 1–30) naar de [USB TO HOST]-aansluiting.
Off: geen uitgang van het audiosignaal voor de partij.

Op het scherm Routing kunt u de effectroutering voor de A/D-partij instellen.

Gebruik

Pan (A/D Part Pan)
Pan (Digital Part Pan)

Dry Level (A/D Part Dry Level)
Dry Level (Digital Part Dry Level)

Var Send (A/D Part Variation Send)
Var Send (Digital Part Variation Send)

Rev Send (A/D Part Reverb Send)
Rev Send (Digital Part Reverb Send)

Output Select (A/D Part Output Select)
Output Select (Digital Part Output Select)

Routing
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[PERFORMANCE] → Common selectie → [EDIT/ ] → Audio In → Routing

(1) A/D Part Insertion FX A Switch
(2) A/D Part Insertion FX B Switch

Schakelt de weergave om voor A/D In en Digital In.
Als Digital In is geselecteerd, zijn alleen Digital Part Reverb Send, Digital Part Variation Send en
Digital Part Output Select beschikbaar.

Schakelt Invoegeffect A en Invoegeffect B in of uit.
Instellingen: Off, On

Stelt het effecttype in.
Instellingen: Raadpleeg de Effecttypen.

Selecteert een van de vooraf ingestelde effectparameters voor elk effecttype.
Door een voorinstelling te selecteren, kunt u de manier wijzigen waarop effecten worden toegepast.
Instellingen: Raadpleeg de Data List.

A/D In
Digital In

A/D Part Insertion FX A Switch
A/D Part Insertion FX B Switch

Type (A/D Part Insertion Effect A Type)
Type (A/D Part Insertion Effect B Type)

Preset (A/D Part Insertion Effect A Preset)
Preset (A/D Part Insertion Effect B Preset)

Side Chain (A/D Part Insertion Effect A Side Chain)
Side Chain (A/D Part Insertion Effect B Side Chain)
Modulator (A/D Part Insertion Effect A Modulator)
Modulator (A/D Part Insertion Effect B Modulator)
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Stelt de Side Chain Part (of de Modulator, afhankelijk van het effecttype) in voor Insertion Effect A of
Insertion Effect B.
Deze parameter is niet beschikbaar als de partij zelf of de master is ingesteld op Modulator. In dat
geval wordt de parameterwaarde tussen haakjes weergegeven, zoals in "(Master)".
Instellingen: Part 1–16, A/D, Master, Off

Stelt de effectroutering in voor invoegeffect A en invoegeffect B.
Het diagram verandert dienovereenkomstig wanneer de instellingen worden gewijzigd.
Instellingen: Ins A→B, Ins B→A

Opent de 2-band EQ voor de A/D-partij.

Stelt het niveau in van de signalen (of bypass-signalen) die worden verzonden van invoegeffect A of
invoegeffect B naar het reverb-effect.
Deze parameter is alleen beschikbaar als Output Select is ingesteld op MainL&R.
Instellingen: 0-127

Stelt het niveau in van de signalen (of bypass-signalen) die worden verzonden van invoegeffect A of
invoegeffect B naar het variation-effect.
Deze parameter is alleen beschikbaar als Output Select is ingesteld op MainL&R.
Instellingen: 0-127

Hiermee opent u het instellingenscherm voor de Envelope Follower.

Stelt de uitvoerbestemming voor de audiosignalen in.
Instellingen: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off

MainL&R: uitgang in stereo (twee kanalen) naar de OUTPUT [L/MONO]- en OUTPUT [R]-
aansluitingen.
AsgnL&R: uitgang in stereo (twee kanalen) naar de ASSIGNABLE OUTPUT [L]- en
ASSIGNABLE OUTPUT [R]-aansluitingen.
USB1&2–USB29&30: uitgang in stereo (kanalen 1 en 2, naar kanalen 29 en 30) naar de
[USB TO HOST]-aansluiting.
AsgnL: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [L]-aansluiting.
AsgnR: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [R]-aansluiting.
USB1–30: uitgang in mono (kanaal 1–30) naar de [USB TO HOST]-aansluiting.
Off: geen uitgang van het audiosignaal voor de partij.

Ins Connect (A/D Part Insertion Effect Connect Type)

2-band EQ

Rev Send (A/D Part Reverb Send)
Rev Send (Digital Part Reverb Send)

Var Send (A/D Part Variation Send)
Var Send (Digital Part Variation Send)

Envelope Follower

Output Select (A/D Part Output Select)
Output Select (Digital Part Output Select)

203



Op de schermen Ins A en Ins B kunt u de invoegeffecten instellen.

Gebruik

(1) Insertion FX Switch

Schakelt het invoegeffect in.
Instellingen: Off, On

Stelt de categorie en het type van het Insertion-effect in.
Instellingen: Raadpleeg de Effecttypen.

Ins A
Ins B

[PERFORMANCE] → Common selectie → [EDIT/ ] → Audio In → Ins A

[PERFORMANCE] → Common selectie → [EDIT/ ] → Audio In → Ins B

Insertion FX Switch

Category (Insertion Effect A Category)
Category (Insertion Effect B Category)
Type (Insertion Effect A Type)
Type (Insertion Effect B Type)
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Selecteert een van de vooraf ingestelde effectparameters voor elk effecttype.
Door een voorinstelling te selecteren, kunt u de manier wijzigen waarop effecten worden toegepast.
Instellingen: Raadpleeg de Data List.

Stelt de Side Chain Part (of de Modulator, afhankelijk van het effecttype) in voor Insertion Effect A of
Insertion Effect B.
Deze parameter is niet beschikbaar als de partij zelf of de master is ingesteld op Modulator. In dat
geval wordt de parameterwaarde tussen haakjes weergegeven, zoals in "(Master)".
Instellingen: Part 1–16, A/D, Master, Off

De Effectparameters verschillen per effecttype.
Instellingen: Raadpleeg de Effectparameters.

Op het 2-band EQ-scherm kunt u de Partij-EQ instellen.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Common → Audio In → 2-band EQ

Selecteert het gewenste EQ-type.
Instellingen: Thru, LPF, HPF, Low Shelf, Hi Shelf, Peak/Dip

Thru: negeert de equalizer en laat het volledige signaal onbeïnvloed.
LPF: passeert de signalen boven de afsnijfrequentie.

Preset (Insertion Effect A Preset)
Preset (Insertion Effect B Preset)

Side Chain (Insertion Effect A Side Chain Part)
Side Chain (Insertion Effect B Side Chain Part)
Modulator (Insertion Effect A Modulator Part)
Modulator (Insertion Effect B Modulator Part)

Effect Parameter

2-band EQ

EQ1 Type (A/D Part 2-band EQ 1 Type)
EQ2 Type (A/D Part 2-band EQ 2 Type)
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HPF: passeert de signalen onder de afsnijfrequentie.
Low Shelf: kapt de signalen af of versterkt ze onder de opgegeven frequentie-instelling.
Hi Shelf: kapt de signalen af of versterkt ze boven de opgegeven frequentie-instelling.
Peak/Dip: kapt de signalen af of versterkt ze op de opgegeven frequentie-instelling.

Stelt de frequentie in die moet worden afgekapt of versterkt.
Deze parameter is niet beschikbaar wanneer EQ Type is ingesteld op Thru.
Instellingen: 63,0 Hz–18,0 kHz

Stelt het signaalniveau in van de frequentieband die is ingesteld in EQ1 Freq of EQ2 Freq.
Deze parameter is niet beschikbaar wanneer EQ Type is ingesteld op Thru, LPF of HPF.
Instellingen: -12,0 dB-+12,0 dB

Stelt de bandbreedte in voor het afkappen of versterken van het volume van de frequenties die zijn
ingesteld met EQ1 Freq of EQ2 Freq.
Deze parameter is alleen beschikbaar wanneer EQ Type is ingesteld op Peak/Dip.
Instellingen: 0,1-12,0

Stelt de uitgangsversterking van de 2-band EQ in.
Instellingen: −12,0 dB–+12,0 dB

Op het scherm Arp Common kunt u de Arpeggio-parameters voor de gehele performance instellen.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Arp/MS → Arp Common

EQ 1 Freq (A/D Part 2-band EQ 1 Frequency)
EQ 2 Freq (A/D Part 2-band EQ 2 Frequency)

EQ 1 Gain (A/D Part 2-band EQ 1 Gain)
EQ 2 Gain (A/D Part 2-band EQ 2 Gain)

EQ 1 Q (A/D Part 2-band EQ 1 Q)
EQ 2 Q (A/D Part 2-band EQ 2 Q)

Uitgangsniveau (A/D partij 2-band EQ-uitgangsniveau)

Arp/MS

Arp Common
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Zet het arpeggio voor de performance aan of uit.
Deze schakelaar is gekoppeld aan de [ARP ON/OFF]-knop op het bovenpaneel.
Instellingen: Off, On

Past de timing aan voor het starten van de volgende arpeggiofrase terwijl de eerste arpeggio wordt
afgespeeld, bij het afspelen van arpeggiofrasen in meerdere partijen. Als dit is ingesteld op Off, wordt
de arpeggio afgespeeld wanneer u de partij op het toetsenbord speelt.
Instellingen: Off, 60 (tweeëndertigste noot), 80 (zestiende noottriool), 120 (zestiende noot), 160

(achtste noot triool), 240 (achtste noot), 320 (kwartnoottriool), 480 (kwartnoot) (De hier
aangegeven getallen zijn klokwaarden.)

Stelt de swingwaarde van het arpeggio en Motion Sequencer in voor de performance.
Dit wordt opgegeven als een offsetwaarde voor Part Swing.
Instellingen: -120-+120

Stelt het percentage in voor het uitrekken of comprimeren van de arpeggioafspeeltijd voor gehele
performance.
Deze parameter is van invloed op partijen waarvoor Unit (Arpeggio Unit Multiply) is ingesteld op
Common.
De onderverdeling van de tel en het tempo verandert wanneer u de afspeeltijd uitrekt of comprimeert,
zodat u een compleet nieuw gevoel kunt creëren voor het arpeggio dat u oorspronkelijk hebt
geselecteerd.
Instellingen: 50%-400%

200%: De afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: De afspeeltijd blijft ongewijzigd.
50%: De afspeeltijd wordt gehalveerd en het tempo wordt daardoor verdubbeld.

Stelt de sterkte in van de quantizeringsinstelling die wordt toegepast op het arpeggio voor de
performance.

Arp Master (Arpeggio Master Switch)

Sync Quantize (Arpeggio Sync Quantize Value)

Swing (Swing Offset)

Unit (Common Unit Multiply)

Qntz Strength (Arpeggio Quantize Strength Offset)
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Dit wordt opgegeven als een offsetwaarde voor Part Qntz Strength (Arpeggio Quantize Strength).
Instellingen: -100-+100

Verschuift de toonhoogte van het arpeggio voor de performance in octaven.
Dit wordt opgegeven als een offsetwaarde voor Part Octave Shift (Arpeggio Octave Shift).
Instellingen: −20-+20

Verschuift het bereik van het arpeggio voor de performance in octaven.
Dit wordt opgegeven als een offsetwaarde voor Part Octave Range (Arpeggio Octave Range).
Instellingen: −6–+6

Stelt de gatetijdsnelheid van het arpeggio in voor de performance.
Dit wordt opgegeven als een offsetwaarde voor Part Gate Time (Arpeggio Gate Time Rate).
Instellingen: -100-+100

Stelt de aanslagsnelheid van het arpeggio in voor de performance.
Dit wordt opgegeven als een offsetwaarde voor Part Velocity (Arpeggio Velocity Rate).
Instellingen: -100-+100

Wijzigt de arpeggioselectie.
Instellingen: 1-8

Op het scherm Arp Overview scherm kunt u de arpeggiotypen instellen uit de lijst met alle partijen.

Gebruik

Octave Shift (Arpeggio Octave Shift Offset)

Octave Range (Arpeggio Octave Range Offset)

Gate Time (Arpeggio Gate Time Rate Offset)

Velocity (Arpeggio Velocity Rate Offset)

Arp Select (Arpeggio Select)

Arp Overview (Arpeggio Overview)

[PERFORMANCE] → Common selectie → [EDIT/ ] → Arp/MS → Arp Overview

(Wanneer een geselecteerde partij Common is) [SHIFT] + [ARP ON/OFF]
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Schakelt de weergave om voor partijen.
Instellingen: Part 1–8, Part 9–16

Zet het arpeggio voor de performance aan of uit.
Deze schakelaar is gekoppeld aan de [ARP ON/OFF]-knop op het bovenpaneel.
Instellingen: Off, On

Stelt de Arpeggiogroep in voor het gebruik van hetzelfde arpeggio in meerdere partijen.
De partijen die aan dezelfde Group zijn toegewezen, hebben dezelfde arpeggio-instellingen.

Wijzigt de arpeggioselectie.
Instellingen: 1-8

Zet het arpeggio voor elke partij aan of uit.
Instellingen: Off, On

Instellingen: Raadpleeg de Data List.

Instellingen: Raadpleeg de Data List.

Part 1–8
Part 9–16

Arp Master (Arpeggio Master Switch)

Group (Arpeggio Group)

Arp Select (Arpeggio Select)

Sw (Part Arpeggio Switch)

Wanneer View is ingesteld op Category

Category (Arpeggio Category)
Sub (Arpeggio Sub Category)
Name (Arpeggio Name)

Wanneer View is ingesteld op Number

Bank (Arpeggio Bank)
Number (Arpeggio Number)
Name (Arpeggio Name)

209



Instellingen: Raadpleeg de Data List.

Stelt het aanslagsnelheidsbereik (laagste en hoogste waarden) in voor het afspelen van het
arpeggio.
Als dit zo is ingesteld dat de hogere waarde als eerste is en de lagere waarde als tweede
(bijvoorbeeld 93 tot 34), wordt het arpeggio alleen gespeeld met aanslagsnelheden van 1 tot 34 en
93 tot 127.
Instellingen: 1-127

Stelt het notenbereik (de laagste en hoogste noten) in voor het afspelen van het arpeggio.
Als de eerst opgegeven noot hoger is dan de tweede (bjjvoorbeeld C5 tot C4), wordt het arpeggio
afgespeeld voor noten in de bereiken van C-2 tot C4 en C5 tot G8.
Instellingen: C-2-G8

Op het scherm MS Common kunt u de Motion Sequencer-parameters voor de gehele performance
instellen.

Gebruik

Stelt de swingwaarde van het arpeggio en Motion Sequencer in voor de performance.
Dit wordt opgegeven als een offsetwaarde voor de Part Swing.
Instellingen: -120-+120

Wanneer View is ingesteld op Range

Name (arpeggionaam)

Velocity Limit (Arpeggio Velocity Limit)

Note Limit (Arpeggio Note Limit)

MS Common (Motion Sequencer Common)

[PERFORMANCE] → Common selectie → [EDIT/ ] → Arp/MS → MS Common

(Wanneer een geselecteerde partij Common is) [SHIFT] + [MSEQ ON/OFF]

Common Swing (Swing Offset)

Common Unit (Common Unit Multiply)
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Stelt het percentage in voor het uitrekken of comprimeren van de afspeeltijd van de Motion
Sequencer voor de gehele performance.
Deze parameter is van invloed op lanes waarvoor Unit Multiply is ingesteld op Common.
De onderverdeling van de tel en het tempo verandert wanneer u de afspeeltijd uitrekt of comprimeert,
zodat u een compleet nieuw gevoel kunt creëren voor de Motion Sequencer die u oorspronkelijk hebt
geselecteerd.
Instellingen: 50%-400%

200%: De afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: De afspeeltijd blijft ongewijzigd.
50%: De afspeeltijd wordt gehalveerd en het tempo wordt daardoor verdubbeld.

Stelt de amplitude van de Motion Sequencer in (of hoeveel de sequence verandert) voor de gehele
performance.
Dit wordt opgegeven als een offsetwaarde voor de amplitude van de Part Amplitude (Part Motion
Sequencer Amplitude).
Deze parameterwaarde verschuift de amplitude van de lanes binnen de performance als MS FX op
On is ingesteld voor de lane.
Instellingen: -127-+127

Stelt de Motion Sequencer Pulse Shape (of de vorm van de stapcurve) in voor de performance.
Dit wordt opgegeven als een offsetwaarde voor de amplitude van de Part Shape (Part Motion
Sequencer Pulse Shape).
Deze parameterwaarde verschuift de parameters voor de lanes binnen de performance als de MS FX
op On is ingesteld voor de lane en Control op On is ingesteld.
Instellingen: -100-+100

Stelt de geleidelijkheid van de Motion Sequence in (of de geleidelijkheid van de veranderingen in de
sequence binnen een tijdsbestek) voor de gehele performance.
Dit wordt opgegeven als een offsetwaarde voor de amplitude van de Part Motion Seq Smooth (Part
Motion Sequencer Smoothness).
Deze parameterwaarde verschuift de geleidelijkheid van de lanes binnen de performance als de MS
FX op On is ingesteld voor de lane.
Instellingen: -127-+127

Stelt de willekeur van de Motion Sequencer in (of de willekeur van de veranderingen in de
stapwaarde van de sequence) voor de gehele performance.
Dit wordt opgegeven als een offsetwaarde voor de amplitude van de Part Motion Seq Random (Part
Motion Sequencer Randomness).
Deze parameterwaarde verschuift de willekeurigheid van de lanes binnen de performance als de MS
FX op On is ingesteld voor de lane.
Instellingen: -127-+127

Common Amplitude (Motion Sequencer Amplitude Performance Offset)

Common Shape (Motion Sequencer Pulse Shape Performance Offset)

Common Smooth (Motion Sequencer Smoothness Performance Offset)

Common Random (Motion Sequencer Randomness Performance Offset)
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Stelt de lane van de Motion Sequencer zo in dat deze wordt weergegeven wanneer de View Mode
van het scherm Home is ingesteld op Motion Seq.
Instellingen: Super Knob, 1–4

Stelt de willekeur van de veranderingen in A/D Part Motion Sequencer Step Value in.
Instellingen: 0-127

Wijzigt de Motion Sequence-selectie.
Instellingen: 1-8

Op het scherm MS Overview scherm kunt u de Motion Sequencer instellen uit de lijst met alle
partijen.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Arp/MS → MS Overview

Schakelt de Motion Sequencer voor de gehele performance in/uit.
Deze schakelaar is gekoppeld aan de [MSEQ ON/OFF]-knop op het bovenpaneel.
Instellingen: Off, On

Toont het aantal Lane-schakelaars dat is ingesteld op On.
Het getal aan de rechterkant van de schuine streep (/) geeft het maximale aantal lanes aan dat u
tegelijkertijd op On kunt zetten.

Wijzigt de Motion Sequence-selectie.

View Lane (Motion Seq View Lane)

AD MS Random (A/D Part Motion Sequencer Randomness)

MS Select (Motion Sequence Select)

MS Overview (Motion Sequencer Overview)

MS Master (Motion Seq Master Switch)

Active (actieve Motion Sequencer)

MS Select (Motion Sequence Select)
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Instellingen: 1-8

Schakelt de Motion Sequencer voor elke partij in of uit.
Instellingen: Off, On

Zet elke lane aan of uit.
U kunt maximaal vier Motion Sequencer-lanes in één partij gebruiken, of maximaal acht lanes in een
gehele performance.
Instellingen: Off, On

Op het scherm Lane kunt u de Motion Sequencer-parameters instellen voor elke lane.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Arp/MS → Lane

Schakelt de Motion Sequencer voor de gehele performance in/uit.
Instellingen: Off, On

Schakelt Motion Sequencer in of uit voor de partij.
Instellingen: Off, On

Toont de parameters voor de geselecteerde lane.
Instellingen: 1-4

PartSw (Motion Sequencer Part Switch)

Lane Switch

Lane

Motion Seq Master Sw (Motion Sequencer Master Switch)

Motion Seq Part Sw (Motion Sequencer Part Switch)

Lane (Lane Select)

LaneSw (Lane Switch)
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Zet elke lane aan of uit.
U kunt maximaal vier Motion Sequencer-lanes in één partij gebruiken, of maximaal acht lanes in een
gehele performance.
Indien ingesteld op Off, worden de parameters voor die lane niet weergegeven.
Instellingen: Off, On

Stelt knoppen in die worden beïnvloed door de werking van de Superknop.
Instellingen: Off, On

Stelt in of de geselecteerde lane signalen ontvangt van de knop [MSEQ TRIGGER] of niet.
Als dit is ingesteld op On, begint de Motion Sequence pas met afspelen zodra u op de knop [MSEQ
TRIGGER] drukt.
Instellingen: Off, On

Wijzigt de Motion Sequence-selectie.
Instellingen: 1-8

Toont de geselecteerde lanes en sequences.

Hiermee opent u het scherm Motion Sequence.
U kunt een sequence maken van maximaal zestien stappen.

Toont de stapcurve voor de geselecteerde sequence.

Stelt het afspelen in van de Motion Sequence die is ingesteld op de Destination in het Control Assign-
scherm om te synchroniseren met het tempo of de tel van de performance.
Instellingen: Off, Tempo, Beat, Lane1 (wanneer Lanes 2–4 zijn geselecteerd)

Off: alleen de Motion Sequencer van de lane wordt afgespeeld.
Tempo: speelt de Motion Sequence van de lane af in het performance-tempo.
Beat: er wordt synchroon met de beat afgespeeld.
Lane1: speelt de Motion Sequencer van de lane synchroon af met Lane 1.

Stelt de snelheid in voor het afspelen van de Motion Sequence.
Deze parameter is beschikbaar wanneer Sync (Lane Sync) is ingesteld op Off.
Instellingen: 0-127

MS FX (Lane FX Receive)

Trigger (Lane Trigger Receive)

Sequence Select (Motion Sequence Select)

Target Sequence

Edit Sequence

Motion Seq Step n Value

Tabblad Sync/Speed

Sync (Lane Sync)

Wanneer Sync is ingesteld op Off

Speed (Lane Speed)
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Stelt de vertragingstijd in voor het starten van het afspelen van de Motion Sequence wanneer
Sync is ingesteld op Off.
Instellingen: 0-127

Stelt de tijd in voor het bereiken van de maximale amplitude van de Motion Sequence wanneer
Sync is ingesteld op Off.
Instellingen: 0-127

Stelt het percentage in voor het uitrekken of comprimeren van de afspeeltijd van de Motion
Sequencer voor de huidige lane.
Deze parameter is beschikbaar wanneer Sync (Lane Sync) is ingesteld op Off of iets anders dan
Lane 1.
Instellingen: 50%-6400%, Common

200%: De afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: De afspeeltijd blijft ongewijzigd.
50%: De afspeeltijd wordt gehalveerd en het tempo wordt daardoor verdubbeld.
Common: De waarde die is ingesteld in de Unit Multiply die geldt voor alle partijen,
wordt toegepast.

Stelt de vertragingstijd in voor het starten van het afspelen van de Motion Sequence wanneer
Sync is ingesteld op iets anders dan Off of Lane1.
Instellingen: 0-32

Stelt de tijd in voor het bereiken van de maximale amplitude voor de Motion Sequence wanneer
Sync is ingesteld op iets anders dan Off.
Instellingen: 0-32

Stelt het aanslagsnelheidsbereik (laagste en hoogste waarden) in voor het afspelen van de Motion
Sequence van de geselecteerde lane.
Deze parameter is beschikbaar wanneer Sync (Lane Sync) is ingesteld op iets anders dan Lane 1.
Wanneer dit is ingesteld op een bereik van de hoogste waarde naar de laagste waarde, wordt de
Motion Sequence alleen afgespeeld in twee aanslagsnelheidsbereiken: van het maximum naar de
hoogste waarde, en van de laagste waarde naar het minimum.
Instellingen: 1-127

Delay Time (A/D Part Motion Seq Lane Key On Delay Time Length)

Fade In Time (A/D Part Motion Seq Lane Fade In Time Length)

Wanneer Sync is ingesteld op iets anders dan Off

Unit (A/D Part Motion Seq Lane Unit Multiply)

Delay Steps (A/D Part Motion Seq Lane Key On Delay Step Length)

Fade In Steps (A/D Part Motion Seq Lane Fade In Step Length)

Lane Vel Limit (Lane Velocity Limit)

Tabblad Loop/Length

Key On Reset (Lane Key On Reset)
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Reset het afspelen van de Motion Sequence als u op een willekeurige toets op het toetsenbord drukt.
Deze parameter is beschikbaar wanneer Sync (Lane Sync) is ingesteld op iets anders dan Lane 1.
Deze parameter is niet beschikbaar als Trigger is ingesteld op On.
Instellingen: Off, Each-On, 1st-On

Each-On: elke keer dat u een noot speelt, wordt de sequence opnieuw ingesteld en begint
het afspelen vanaf het begin.
1st-On: de sequence wordt gereset op de eerste noot en het afspelen begint vanaf het
begin. De sequence wordt niet gereset wanneer een tweede noot wordt gespeeld terwijl de
eerste noot wordt gespeeld.

Stelt de Motion Sequence in op afspelen in een loop (herhalingen) of eenmalig afspelen.
Deze parameter is beschikbaar wanneer Sync (Lane Sync) is ingesteld op iets anders dan Lane 1.
Instellingen: Off, On

Geeft het beginpunt op voor afspelen in een loop van de Motion Sequence.
Instellingen: 1-16 (moet lager zijn dan de instelling Length

Stelt het aantal stappen in de Motion Sequence in.
Instellingen: 1-16 (moet hoger zijn dan de instelling Loop Start)

Stelt de lengte van een stap in de Motion Sequence in.
Instellingen: 60, 80, 120, 160, 240, 320, 480

Hiermee opent u het instellingenscherm voor de Motion Sequence.
U kunt een sequence maken van maximaal zestien stappen.

Geeft het beginpunt op voor afspelen in een loop van de Motion Sequence.

Loop (Lane Loop)

Loop Start (Lane Loop Start)

Length (Motion Seq Length)

MS Grid (Motion Sequencer Grid)

Motion Sequence Edit

Loop Start (Lane Loop Start)
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Instellingen: 1-16 (moet lager zijn dan de instelling Length

Stelt de lengte van de Motion Sequence in.
Instellingen: 1-16 (moet hoger zijn dan de instelling Loop Start)

Stelt de lengte van een stap in de Motion Sequence in.
Instellingen: 60, 80, 120, 160, 240, 320, 480

Wijzigt de selectie van het Motion Sequence-type.
Instellingen: 1-8

Wijzigt de selectie van de lane.
Instellingen: 1-4

Stelt de polariteit van de Motion Sequence in.
Instellingen: Unipolar, Bipolar

Unipolar: Alleen positieve waarden worden gebruikt voor de parameterwijziging.
Bipolar: Zowel positieve als negatieve waarden worden gebruikt voor de
parameterwijziging.

Stelt de mate van veranderingen in de Motion Sequence in.
Instellingen: 0-127

Stelt de geleidelijkheid van de wijzigingen in de Motion Sequence in binnen een tijdsbestek.
Instellingen: 0-127

Toont verschillende taken.

Stelt de waarde in van elke stap in de Motion Sequence.
U kunt de schuifregelaars 1 t/m 8 gebruiken om de waarden voor stappen 1 t/m 8 en stappen 9 t/m
16 te wijzigen, afhankelijk van de cursorpositie.
Instellingen: 0-127

Stelt het type en de richting van elke stap in de Motion Sequence in.
Instellingen: A, B, Reverse A, Reverse B

Length (Motion Sequence Length)

MS Grid (Motion Sequencer Grid)

Sequence Select (Motion Sequence Select)

Lane Select

Polarity (Motion Sequence Polarity)

Amplitude (Motion Sequence Amplitude)

Smooth (Motion Sequence Smoothness)

Job

Motion Sequence Step Value

Motion Sequence Step Type
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Selecteert een parameterwijzigingscurve voor Pulse A en Pulse B.
Gebruik Motion Sequence Step Type om te selecteren welke van de curvetypen u voor elke stap wilt
gebruiken.
De verticale as geeft de tijd aan en de horizontale as geeft de stapwaarde aan.
Instellingen: (Wanneer een vooraf ingestelde bank wordt geselecteerd) Standard, Sigmoid,

Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw, Triangle, Square,
Trapezoid, Tilt Sine, Bounce, Resonance, Sequence, Hold, Harmonic, Steps
(Wanneer een gebruikersbank wordt geselecteerd) User 1–32
(Wanneer een bibliotheekbestand is geladen) Curven gebruikt in Library 1–16

Past de vorm van de stapcurve voor de Motion Sequence aan.
Deze instelling is mogelijk niet beschikbaar afhankelijk van het curvetype. Het bereik van de
parameterwaarde varieert afhankelijk van het curvetype.

Schakelt het gebruik van de knoppen voor het regelen van de stapcurvevorm van de Motion
Sequence in of uit.
Wordt alleen weergegeven als MS FX is ingesteld op On. Deze instelling is mogelijk, afhankelijk van
het curvetype, niet beschikbaar.
Instellingen: Off, On

Hiermee wordt de bewerkte Motion Sequence opgeslagen.

Hiermee wordt de Motion Sequence geladen.

Hiermee wordt de Motion Sequence gekopieerd.

In het scherm Control Assign kunt u de regelaars voor alle partijen instellen.
Door de parameter (Destination) aan een regelaar (Source) toe te wijzen, kunt u het geluid regelen
op veel verschillende manieren. U kunt fysieke regelaars gebruiken, zoals het Pitchbendwiel en de
knoppen, maar ook de Motion Sequencer en Envelope Follower.
Er kunnen maximaal 32 regelaars tegelijk aan een partij worden toegewezen.

Gebruik

Pulse A (Motion Sequence Step Curve Type A)
Pulse B (Motion Sequence Step Curve Type B)

Prm 1 (Motion Sequence Step Curve Parameter 1)
Prm 2 (Motion Sequence Step Curve Parameter 2)

Control (Motion Sequence Step Curve Shape Control Switch)

Store Sequence

Load Sequence

Copy Sequence

Control

Control Assign

[PERFORMANCE] → Common selectie → [EDIT/ ] → Control → Control Assign

218



Zet de automatische selectie van het Display Filter aan of uit.
Indien ingesteld op On, wordt, bij het verplaatsen van de regelaars die u wilt instellen op Source, de
regelaar automatisch ingesteld op het Display Filter.
Instellingen: Off, On

Selecteert de regelaar voor het weergeven van de instellingen op het scherm.
Wanneer u Super Knob selecteert, worden alle instellingen voor knoppen 1 t/m 8 weergegeven
waarvoor de Super Knob Link op On is ingesteld.
Instellingen: PitchBend, ModWheel, Ch. AT, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath,

AsgnKnob 1–8, Super Knob, AsgnSw 1, AsgnSw 2, MS Lane 1–4, EnvFollow 1–16,
EnvFollowAD, EnvFollowMst, All

Hiermee kunt u een nieuwe naam invoeren voor de knoppen 1 tot en met 8, zodat deze op het sub-
display worden weergegeven.
Deze parameter wordt niet weergegeven als Source is ingesteld op iets anders dan AsgnKnob 1–8.

Hiermee opent u het General/Pitch → Pitch-scherm.
Deze parameter is niet beschikbaar als Source is ingesteld op iets anders dan PitchBend.

Opent het instellingenscherm voor de Motion Sequence.
Deze parameter is niet beschikbaar wanneer Source is ingesteld op iets anders dan MS Lane 1–4.

Opent het instellingenscherm voor de Envelope Follower.
Deze parameter is niet beschikbaar wanneer Source is ingesteld op iets anders dan EnvFollow 1-16,
EnvFollowAD of EnvFollowMst.

Tik op Edit Super Knob op het Super Knob-scherm

Auto Select

Display Filter

Display Name (Assignable Knob Name)

Edit Pitch Bend

Edit Motion Sequencer

Edit Envelope Follower
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Stelt de parameter voor de destination (bestemming) in. Door op het pictogram [+] te tikken, kunt u
een nieuwe bestemming toevoegen.
Wanneer Source is ingesteld op AsgnKnob 1–8, wordt Part1–16 Assign1–8 toegevoegd aan de
instellingen. In dit geval zijn Curve Type en Curve Ratio niet beschikbaar.

Stelt de regelaar in voor het regelen van de parameters die zijn ingesteld voor de Destination.
Wanneer Destination is ingesteld op Part1–16 Assign1–8, is alleen AsgnKnob 1–8 beschikbaar.
Andere regelaars kunnen niet worden gebruikt.
Instellingen: PitchBend, ModWheel, Ch. AT, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath,

AsgnKnob 1–8, AsgnSw 1, AsgnSw 2, MS Lane 1–4, EnvFollow 1–16, EnvFollowAD,
EnvFollowMst

Kopieert de parameters die zijn ingesteld op Destination naar Display Name.
Deze parameter wordt niet weergegeven als Source is ingesteld op iets anders dan AsgnKnob 1–8.

Verwijdert de geselecteerde Destination.

Stelt de parameter in die wordt weergegeven wanneer u Part1–16 Assign1–8 probeert in te stellen op
de Destination en meerdere bestemmingen al zijn toegewezen aan Part Assign.

Stelt de partijparameter voor de Destination in.
Instellingen: Raadpleeg de Data List.

De onderstaande parameters verschijnen alleen wanneer Destination 1–32 is ingesteld op Part1–16
Assign1–8. Bovendien zijn alleen de sneltoetsen beschikbaar op de schermen als partijknoppen 1-8
niet kunnen worden gevonden in Destination.

Hiermee opent u het scherm Control Assign voor de geselecteerde partij.

Stelt de veranderingscurve van de parameterset in op Destination.
De horizontale as vertegenwoordigt de regelaarwaarde die is ingesteld in Source terwijl de verticale
as de parameterwaarde vertegenwoordigt.
Instellingen: Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw,

Triangle, Square, Trapezoid, Tilt Sine, Bounce, Resonance, Sequence, Hold, Harmonic,
Steps, User 1–32 (als een gebruikersbank is geselecteerd), Library 1–16 (als een
bibliotheekbestand is geladen)

Destination

Source

Destination to Name

Delete

Destination (Part Assignable Knob Destination)

Parameter (Part Assignable Knob Parameter)

Edit (Part) Control Assign

Curve Type
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Stelt de polariteit in van de curve die is ingesteld in Curve Type.
Instellingen: Uni, Bi

Uni: parameterwijzigingen vinden alleen plaats binnen het positieve bereik of het negatieve
bereik, afhankelijk van de curvevorm.
Bi: parameterwijzigingen vinden zowel in positieve als in negatieve bereiken plaats,
afhankelijk van de vorm van de curve.

Stelt de verhouding van de parameterwaarden in.
Instellingen: -128-+127

Past de curvevorm aan.
Deze instelling is mogelijk niet beschikbaar afhankelijk van het curvetype.

Opent het instellingenscherm voor de gebruikerscurve.
U kunt een lineaire curve met acht punten of een curve met acht stappen maken.

Selecteert de aftertouch-instellingen van het toetsenbord die van de performance naar de interne
toongenerator op de MONTAGE M8x worden verzonden.

Instellingen: De uitvoer van Aftertouch naar een extern apparaat moet worden ingesteld via
[UTILITY] → Settings → MIDI I/O → AT MIDI Out.

De MONTAGE M8x heeft een ingebouwd toetsenbord dat polyfone aftertouch ondersteunt.
De ingebouwde toetsenborden op de MONTAGE M6 en MONTAGE M7 ondersteunen alleen
Channel Aftertouch; hun interne toongenerator ondersteunt echter polyfone aftertouch, waardoor u
polyfone aftertouch kunt gebruiken voor het afspelen van songs en patronen, en voor het ontvangen
van MIDI-berichten van een extern apparaat dat compatibel is met polyfone aftertouch.
Om de aftertouch-ontvangst met de interne toongenerator in te stellen, stelt u de parameter in op het
Tx/Rx Switch-scherm.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Control → After Touch

Polarity (Curve Polarity)

Ratio (Curve Ratio)

Param 1 (Curve Parameter 1)
Param 2 (Curve Parameter 2)

Edit User Curve

After Touch

MONTAGE M8x
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Selecteert de modus voor het verzenden van Aftertouch-berichten van het toetsenbord naar de
interne toongenerator.
Deze parameter is ingesteld op Channel op de MONTAGE M6 en MONTAGE M7, ongeacht de
instelling hier.
Instellingen: Poly (polyfone aftertouch), Channel (kanaal aftertouch)

Stelt de lintregelaar in.

Gebruik

MONTAGE M7 en MONTAGE M6

Keyboard AT Mode (After Touch Mode)

Ribbon Settings

[PERFORMANCE] → Common selectie → [EDIT/ ] → Control → Ribbon Settings

[SHIFT] + [HOLD]
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Stelt de roostermodus in voor de lintregelaar.
Instellingen: Continuous, 5 step, 3 step

OPMERKING
Stel dit in op Continuous als u de lintregelaarinstelling wilt gebruiken die u hebt ingesteld op het scherm Control
Assign.

Stelt de manier in waarop de lintregelaar functioneert.
Instellingen: Hold, Reset

Hold: behoudt de waarde van de positie waar u uw vinger van de lintregelaar optilt.
Reset: de waarde wordt automatisch teruggezet op het midden zodra u uw vinger van de
lintregelaar haalt.

Selecteert de partij die moet worden bestuurd met de lintregelaar.
Instellingen: 1-16, Common

Instellingen: raadpleeg het gedeelte Control Box Destination op de Data List.

Instellingen: afhankelijk van de Destination

Stelt het besturingswijzigingsnummer in voor de gehele performance.
U kunt specifieke MIDI-besturingswijzigingsnummers toewijzen aan de knoppen op het voorpaneel
en de regelaars op het externe apparaat.

Ribbon Grid Mode

Continuous-modus

Ribbon Mode (Ribbon Controller Mode)

5-step-modus

3-step-modus

Control Part

Control Destination

Step Value 1–5

Control Number
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OPMERKING
Wat betreft regelaars die niet bij dit instrument zijn inbegrepen, kunt u een externe sequencer of externe MIDI-
regelaars gebruiken.

Gebruik

[PERFORMANCE] → Common selectie → [EDIT/ ] → Control → Control Number

Stelt het regelaarwijzigingsnummer in dat wordt gegenereerd door het gebruik van de lintregelaar.
Wanneer dit instrument een MIDI-besturingswijzigingsbericht ontvangt met het nummer dat bij deze
parameter is ingesteld op het externe apparaat, wordt het bericht op dezelfde manier behandeld als
de werking van de ingebouwde lintregelaar.
Instellingen: Off, 1-95

Stelt het besturingswijzigingsnummer in voor de ademregelaar in dat wordt ontvangen van het
externe apparaat.
Wanneer dit instrument een MIDI-besturingswijzigingsbericht ontvangt met het nummer dat bij deze
parameter is ingesteld op het externe apparaat, wordt het bericht op dezelfde manier behandeld als
de werking van de ademregelaar.
Instellingen: Off, 1-95

Stelt het regelaarwijzigingsnummer in dat wordt gegenereerd door de bediening van de voetregelaar
die is aangesloten op de FOOT CONTROLLER-aansluiting.
Wanneer dit instrument een MIDI-besturingswijzigingsbericht ontvangt met het nummer dat bij deze
parameter is ingesteld op het externe apparaat, wordt het bericht op dezelfde manier behandeld als
de werking van de voetregelaar.
Instellingen: Off, 1-95, Super Knob

Ribbon Ctrl (Ribbon Controller Control Number)

Breath Ctrl (Breath Controller Control Number)

Foot Ctrl 1 (Foot Controller 1 Control Number)
Foot Ctrl 2 (Foot Controller 2 Control Number)

Assign Sw 1 (Assignable Switch 1 Control Number)
Assign Sw 2 (Assignable Switch 2 Control Number)
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Stelt het besturingswijzigingsnummer in dat wordt gegenereerd door de bediening van de knoppen
[ASSIGN 1] en [ASSIGN 2].
Wanneer dit instrument een MIDI-besturingswijzigingsbericht ontvangt met het nummer dat bij deze
parameter is ingesteld op het externe apparaat, wordt het bericht op dezelfde manier behandeld als
de werking van de knoppen [ASSIGN 1] en [ASSIGN 2].
Instellingen: Off, 1-95

Stelt het regelaarwijzigingsnummer in dat wordt gegenereerd door het gebruik van de knop [MSEQ
TRIGGER].
Wanneer dit instrument een MIDI-besturingswijzigingsbericht ontvangt met het nummer dat bij deze
parameter is ingesteld op het externe apparaat, wordt het bericht op dezelfde manier behandeld als
de werking van de knop [MSEQ TRIGGER].
Instellingen: Off, 1-95

Stelt het besturingswijzigingsnummer in dat wordt gegenereerd door de bediening van knoppen 1 t/m
8.
Wanneer dit instrument van het externe apparaat een MIDI-besturingswijzigingsbericht ontvangt van
het nummer dat met deze parameter is ingesteld, wordt het bericht op dezelfde manier behandeld als
de werking van knoppen 1 t/m 8.
Instellingen: Off, 1-95

Hiermee opent u het scherm MIDI settings.
Hetzelfde scherm kan worden geopend vanuit [UTILITY]→ Settings → MIDI I/O.

Toont het regelaarwijzigingsnummer dat wordt gegenereerd door de bediening van de
voetschakelaar die is aangesloten op de FOOT SWITCH [ASSIGNABLE]-aansluiting. Wanneer dit
instrument een MIDI-besturingswijzigingsbericht ontvangt met het nummer dat bij deze parameter is
ingesteld op het externe apparaat, wordt het bericht op dezelfde manier behandeld als de werking
van de voetschakelaar.

Stelt het regelaarwijzigingsnummer in dat wordt gegenereerd door het gebruik van de [SCENE]-
knoppen. Wanneer dit instrument een MIDI-besturingswijzigingsbericht ontvangt met het nummer dat
bij deze parameter is ingesteld op het externe apparaat, wordt het bericht op dezelfde manier
behandeld als de werking van de [SCENE]-knoppen.

Toont het regelaarwijzigingsnummer dat wordt gegenereerd door het gebruik van de Superknop.
Wanneer dit instrument een MIDI-besturingswijzigingsbericht ontvangt van het nummer dat bij deze
parameter is ingesteld op het externe apparaat, wordt het bericht op dezelfde manier behandeld als
de werking van de Superknop.

MS Trigger (Motion Sequencer Trigger Switch Control Number)

Assign Knob (Assignable Knob Control Number)

MIDI Settings

FS Assign (Foot Switch Assign Control Number)

Scene CC (Scene Control Change Number)

Super Knob CC (Super Knob Control Change Number)
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OPMERKING

Stelt de regelaarmodus in.

Gebruik

Stelt de richting van de schuifregelaars 1 t/m 8 in als de schuifregelaarmodus is ingesteld op PART.
Instellingen: Normal (omhoog vanaf beneden), Reverse (omlaag vanaf boven)

Stelt de knoppen [ASSIGN 1] en [ASSIGN 2] in voor de Latch of Momentary-instelling.
Instellingen: Latch, Momentary

Latch: wordt ingesteld op On wanneer u op de knop drukt en op Off wanneer u nogmaals
op de knop drukt.
Momentary: wordt ingesteld op On terwijl u de knop ingedrukt houdt en op Off wanneer u
de knop loslaat.

Wanneer Scene CC en Super Knob CC zijn ingesteld op Off, wordt System Exclusive (SysEx) gebruikt voor het
verwerken van MIDI-berichten.
FS Assign, Scene CC en Super Knob CC worden voor het hele instrument gebruikt. Wijzig indien gewenst deze
instellingen in het Utility MIDI Settings-scherm.

Control Settings

[PERFORMANCE] → Common selectie → [EDIT/ ] → Control → Control Settings

[SHIFT] + [ASSIGN 1]

[SHIFT] + [ASSIGN 2]

Slider Direction Part 1–8

Assignable Switch 1 Mode
Assignable Switch 2 Mode
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om02screenparameters0070

Een normale partij (AWM2) bestaat uit maximaal 128 elementen.
Part Edit (AWM2) bevat Part Common Edit (voor het instellen van parameters voor de gehele partij)
en Element Edit (voor het instellen van parameters voor elk element in de partij).

Part Edit (AWM2)-scherm
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Inhoudsopgave

Part Common Edit

General/Pitch

Part Settings

Zone Settings

Element Settings

Pitch

Filter/Amp

Filter EG

Amp EG

Effect

Routing

Ins A

Ins B

3-band EQ

2-band EQ

Arpeggio

Common

Individual

Advanced

Motion Seq

Common

Lane

Mod/Control

Control Assign

After Touch

Tx/Rx Switch

Control Settings

Part LFO

User LFO Edit

General/Pitch

Part Settings
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Op het scherm Part Settings kunt u de algemene parameters (zoals partijnamen en toongeneratie)
voor de partij instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → Part Settings

Stelt de hoofd- en subcategorie van de geselecteerde partij in.
Instellingen: Raadpleeg de Data List.

U kunt de partij die u bewerkt onder een nieuwe naam opslaan. Deze naam mag uit maximaal 20
alfanumerieke tekens bestaan.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u een naam kunt invoeren.

Stelt het volume van de geselecteerde partij in.
Instellingen: 0−127

Stelt de pan in voor de geselecteerde partij.
Instellingen: L63–C (center)–R63

Stelt het droge niveau van de geselecteerde partij in.
Deze parameter is alleen beschikbaar als Part Output is ingesteld op MainL&R.
Instellingen: 0−127

Stelt de variation-zend van de geselecteerde partij in.
Deze parameter is alleen beschikbaar als Part Output is ingesteld op MainL&R.
Instellingen: 0−127

Main Category (Part Main Category)
Sub Category (Part Sub Category)

Part Name

Volume

Pan

Dry Level

Var Send (Variation Send)

229



Stelt de Reverb Send (Naar reverb zenden) van de geselecteerde partij in.
Deze parameter is alleen beschikbaar als Part Output is ingesteld op MainL&R.
Instellingen: 0−127

Stelt de uitvoerbestemming in voor de audiosignalen van de geselecteerde partij.
Instellingen: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off

MainL&R: uitgang in stereo (twee kanalen) naar de OUTPUT [L/MONO]- en [R]-
aansluitingen.
AsgnL&R: uitgang in stereo (twee kanalen) naar de ASSIGNABLE OUTPUT [L]- en
ASSIGNABLE OUTPUT [R]-aansluitingen.
USB1&2–USB29&30: uitgang in stereo (kanalen 1 en 2, naar kanalen 29 en 30) naar de
[USB TO HOST]-aansluiting.
AsgnL: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [L]-aansluiting.
AsgnR: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [R]-aansluiting.
USB1–30: uitgang in mono (kanaal 1–30) naar de [USB TO HOST]-aansluiting.
Off: geen uitgang van het audiosignaal voor de partij.

Stelt de toongeneratiemodus van de huidige partij in. Mono wordt alleen gebruikt voor enkele noten
en Poly wordt gebruikt om verschillende noten gelijktijdig te spelen.
Wanneer u de instelling Mono gebruikt voor het bespelen van het toetsenbord in legato, kunt u een
vloeiende overgang van geluiden van de ene noot naar de andere creëren.
Instellingen: Mono, Poly

Bepaalt de methode voor het produceren van het geluid wanneer de interne toongenerator twee keer
achter elkaar een noot-aan-bericht met hetzelfde geluid ontvangt.
In de meeste gevallen wordt de instelling Multi aanbevolen. De instelling Multi verbruikt echter veel
noten in de maximale polyfonie, dus het wordt aanbevolen om over te gaan op Single als geluiden in
andere partijen wegvallen of niet goed worden gespeeld.
Instellingen: Single, Multi

Single: stopt de eerste noot en speelt dezelfde noot vervolgens opnieuw. Dit is handig als
u dezelfde noot op hetzelfde kanaal wilt herhalen.
Multi: speelt de tweede noot over de eerste noot heen. Deze instelling zorgt ervoor dat
roffels en herhaalde noten natuurlijk klinken, waarbij crashcimbalen of andere percussie-
instrumenten een lange wegsterftijd hebben.

Stelt de partij zo in dat deze alleen wordt afgespeeld als reactie op het arpeggio.
Elke partij die op On is ingesteld, wordt gespeeld door de noot-aan-berichten die door het arpeggio
worden verzonden.
Instellingen: Off, On

Rev Send (Reverb Send)

Part Output (Part Output Select)

Mono/Poly

Key Assign (Key Assign Mode)

Arp Play Only (Arpeggio Play Only)

Element Pan (Element Pan Switch)
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Stelt de pan in op On of Off vanuit Element Edit ([EDIT/ ]→Part-selectie→Element
selectie→Amplitude→Level/Pan→Pan).
Wanneer de pan is ingesteld op Off, wordt de pan in Element Edit ingesteld op C (midden).
Instellingen: Off, On

Stelt het notenbereik (laagste en hoogste noten) in voor de partij.
Als de eerste noot van Note Limit hoger is ingesteld dan de tweede (bijvoorbeeld C5 tot C4), worden
de noten in de bereiken C-2 tot C4 en C5 tot G8 afgespeeld.
Instellingen: C−2−G8

Stelt het aanslagbereik (laagste en hoogste waarden) in voor de partij.
Als dit zo is ingesteld dat de hogere waarde als eerste is en de lagere waarde als tweede
(bijvoorbeeld 93 tot 34), worden de noten alleen gespeeld met aanslagsnelheden van 1 tot 34 en 93
tot 127.
Instellingen: 1−127

Verhoogt of verlaagt de aanslagsnelheidswaarde die naar de interne toongenerator wordt verzonden.
Instellingen: 0−127

Als Depth = 64 en Offset = 32 Als Depth = 64 en Offset = 64 Als Depth = 64 en Offset = 96

(1) Resulterende werkelijke aanslagsnelheid (van invloed op de toongenerator)
(2) Aanslagsnelheid waarmee u een noot speelt

Stelt in hoe het niveau van de aanslagsnelheidswaarde die naar de interne toongenerator wordt
verzonden op de snelheid of de sterkte van de toetsaanslag reageert.
Instellingen: 0−127

TG Note Limit (Note Limit)

TG Vel Limit (Velocity Limit)

Velocity Offset (Velocity Sensitivity Offset)

Velocity Depth (Velocity Sensitivity Depth)

Als Offset is ingesteld op 64:
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(1) Resulterende werkelijke
aanslagsnelheid (van invloed op de
toongenerator)

(2) Aanslagsnelheid waarmee u een
noot speelt

In het scherm Zone Settings kunt u de parameters voor de Zone-functie instellen.
Met deze functie kunt u het gehele toetsenbord in maximaal acht secties (zones) verdelen en aan
elke zone onafhankelijk een afzonderlijk kanaal toewijzen. Zo hebt u slechts één toetsenbord nodig
om de geluiden van meerdere toetsenborden te spelen. U kunt meerdere partijen op een externe
multi-timbrale geluidsmodule spelen of zowel de interne toongenerator als eventuele aangesloten
externe geluidsmodules bespelen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → Zone Settings

Keyboard Control wordt gebruikt voor het selecteren van partijen die via het toetsenbord moeten
worden gespeeld.
Als deze schakelaar op On staat, kunt u tegelijkertijd alle partijen spelen waarvoor Keyboard Control
is ingesteld op On, als de partij is ingesteld op Common of als Keyboard Control voor de partij is

Zone Settings

Keyboard Sw (Keyboard Control Switch)
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ingesteld op On.
Als Keyboard Control is ingesteld op Off, kunt u de partij alleen op het toetsenbord spelen als die
partij is geselecteerd.
Instellingen: Off, On

Stelt het aanslagbereik (laagste en hoogste waarden) in voor de zone.
Als dit zo is ingesteld dat de hogere waarde als eerste is en de lagere waarde als tweede
(bijvoorbeeld 93 tot 34), worden de noten alleen gespeeld met aanslagsnelheden van 1 tot 34 en 93
tot 127.
Instellingen: 1−127

Stelt het notenbereik (laagste en hoogste noten) in voor de zone.
Als de eerste noot van Note Limit hoger is ingesteld dan de tweede (bijvoorbeeld C5 tot C4), worden
de noten in de bereiken C-2 tot C4 en C5 tot G8 afgespeeld.
Instellingen: C−2−G8

Verschuift de toonhoogte van de zone in octaven.
Instellingen: −3–+0 (standaard)–+3 (in octaven)

Verschuift de toonhoogte van de zone in halve noten.
Instellingen: −11−+0 (standaard)–+11

Hiermee wisselt u van partijmodus.
Instellingen: Internal, External

Internal: gebruikt de interne toongenerator.
External: gebruikt de externe geluidsgenerator. Partijen die zijn ingesteld op External,
ontvangen geen MIDI-berichten van het externe apparaat.

Stelt het kanaal in voor het verzenden en ontvangen van MIDI-berichten wanneer de Part Mode is
ingesteld op Internal.
Instellingen: Ch1–Ch16, Off

Stelt het kanaal in voor het verzenden en ontvangen van MIDI-berichten wanneer de Part Mode is
ingesteld op External.
Instellingen: Ch1–Ch16

Toont het kanaal voor het regelen van de partij die is ingesteld op Common en de partij waarbij de
Keyboard Sw is ingesteld op On.

Zone Vel Limit (Zone Velocity Limit)

Zone Note Limit

Octave Shift

Transpose

Part Mode

Tx/Rx Ch (Transmit/Receive Channel)

Transmit Ch

MIDI I/O Ch (MIDI Input/Output Channel)
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Deze instelling geldt voor het gehele instrument. De instelling kan worden gewijzigd op het scherm
Utility MIDI Settings.
Wanneer u Tx/Rx Ch en Transmit Ch gebruikt, gebruik dan niet hetzelfde kanaal als is opgegeven in
MIDI I/O Ch. Als hetzelfde kanaal is ingesteld op Tx/Rx Ch en Transmit Ch, krijgt de instelling in MIDI
I/O Ch voorrang.
Instellingen: Ch1–Ch16

Opent hetzelfde scherm als Utility → Settings → MIDI I/O.

Als deze parameter wordt ingesteld op On, worden de instellingen van MIDI Bank, MIDI Pgm
Number, MIDI Volume en MIDI Pan naar het externe apparaat gezonden wanneer deze parameters
worden gewijzigd.
De instelling wordt echter niet verzonden als de bijbehorende Transmit-schakelaar is ingesteld op
Off. Deze parameter is hetzelfde voor alle performances en kan niet apart worden ingesteld voor
individuele performances.
Deze parameter is alleen beschikbaar als Part Mode is ingesteld op External.
Instellingen: Off, On

De Transmit-schakelaar voor het verzenden van MIDI Bank MSB en MIDI Bank LSB naar het externe
apparaat.
Deze parameter is alleen beschikbaar als Part Mode is ingesteld op External.
Instellingen: Off, On

Selecteert de bank voor het verzenden van de performanceselectie. U kunt de MSB- en LSB-
berichten opgeven.
Deze parameter is niet beschikbaar als Transmit Bank Select is ingesteld op Off, en is alleen
beschikbaar als Part Mode is ingesteld op External.
Instellingen: MSB en LSB: 000−127

Dit is de Transmit-schakelaar voor het verzenden van programmawijzigingsberichten naar het
externe apparaat.
Deze parameter is alleen beschikbaar als Part Mode is ingesteld op External.
Instellingen: Off, On

Selecteert het programmawijzigingsnummer voor het verzenden van de performanceselectie.
Deze parameter is niet beschikbaar als Transmit Program Change is ingesteld op Off, en is alleen
beschikbaar als Part Mode is ingesteld op External.
Instellingen: 001−128

MIDI Settings

MIDI Send

Bank Select (Transmit Bank Select)

MIDI Bank MSB
MIDI Bank LSB

Pgm Change (Transmit Program Change)

MIDI Pgm Num (MIDI Program Number)
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Dit is de Transmit-schakelaar voor het verzenden van de volume-instelling naar het externe apparaat.
Deze parameter is alleen beschikbaar als Part Mode is ingesteld op External.
Instellingen: Off, On

Stelt het volume in voor het verzenden van de performanceselectie.
Deze parameter is alleen beschikbaar als Part Mode is ingesteld op External.
Instellingen: 0−127

Dit is de Transmit-schakelaar voor het verzenden van de paninstelling naar het externe apparaat.
Deze parameter is alleen beschikbaar als Part Mode is ingesteld op External.
Instellingen: Off, On

Stelt de pan in voor het verzenden van de performanceselectie.
Deze parameter is niet beschikbaar als Transmit Pan is ingesteld op Off.
Instellingen: L64−C−R63

Opent het Tx/Rx Switch-scherm.

Stelt het maximale aantal te gebruiken elementen in.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → Element Settings

Maakt de uitbreiding van elementcapaciteit mogelijk.
Wanneer ingesteld op Off, zijn er slechts maximaal acht elementen beschikbaar.

Vol/Exp (Transmit Volume/Expression)

MIDI Volume

Pan (Transmit Pan)

MIDI Pan

Edit Tx/Rx Switch

Element Settings

Ex Elem Sw (Extended Element Switch)

235



Instellingen: Off, On

Stelt het maximale aantal te gebruiken elementen in.
Instellingen: 8−128

OPMERKING
Zelfs wanneer Element Sw is ingesteld op Off, wordt het getal dat is ingesteld in Element Count opgeslagen.

In het scherm Pitch kunt u de toonhoogte voor de partij instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → Pitch

Portamento is een functie waarmee u een vloeiende overgang tussen twee noten kunt creëren.
Door deze parameter op On in te stellen, kunt u Portamento toepassen op partijen waarbij de
Portamento Part Switch op On is ingesteld.
Deze schakelaar is gekoppeld aan de [PORTAMENTO]-knop op het bovenpaneel.
Instellingen: Off, On

Past de toonhoogte aan in stappen van een halve toon.
Instellingen: −24−+0−+24

Past de toonhoogte van de partij aan in stappen van 0,1 Hz.
Door de toonhoogte iets te verschuiven, kunt u het geluid ontstemmen.
Instellingen: −12,8Hz−+0,0Hz−+12,7Hz

Element Count

Pitch

Master Sw (Portamento Master Switch)

Note Shift

Detune

Pitch Control Group
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Partijen die aan dezelfde groep zijn toegewezen, krijgen dezelfde toonhoogte.

Stelt de toongeneratiemodus van de huidige partij in. Mono wordt alleen gebruikt voor enkele noten
en Poly wordt gebruikt om verschillende noten gelijktijdig te spelen.
Wanneer u de instelling Mono gebruikt voor het bespelen van het toetsenbord in legato, kunt u een
vloeiende overgang van geluiden van de ene noot naar de andere creëren.
Instellingen: Mono, Poly

Stelt het bereik in van de veranderingen die met het pitchbendwiel worden gecreëerd in halve tonen
in.
Instellingen: −48−+0−+24

Opent het scherm Control Assign met het DisplayFilter ingesteld op PitchBend.

Schakelt Portamento voor de partij in of uit.
Instellingen: Off, On

Stelt de manier in waarop Portamento wordt toegepast, afhankelijk van uw toetsenspel.
Instellingen: Fingered, Full-time

Fingered: portamento wordt alleen toegepast als u legato speelt (de volgende noot speelt
voordat u de vorige noot loslaat).
Full-time: Portamento wordt te allen tijde toegepast.

Stelt de tijdsduur (of snelheid) in voor de toonhoogteovergang van Portamento.
Instellingen: 0−127

Hiermee stelt u in hoe de toonhoogte verandert binnen een tijdsbestek.
Instellingen: Rate 1, Time 1, Rate 2, Time 2

Rate 1: de toonhoogte verandert met een opgegeven snelheid.
Time 1: de toonhoogte verandert op een opgegeven tijdstip.
Rate 2: de toonhoogte verandert met een opgegeven snelheid binnen een octaaf.
Time 2: de toonhoogte verandert op een opgegeven tijdstip binnen een octaaf.

Stelt de aanslag van de legatonoten in wanneer Mono/Poly is ingesteld op Mono.

Mono/Poly

Pitch Bend↓ (Pitch Bend Range Lower)
Pitch Bend↑ (Pitch Bend Range Upper)

Edit Control Assign

Portamento (Portamento Part Switch)

Mode (Portamento Mode)

Time (Portamento Time)

Time Mode (Portamento Time Mode)

Legato Slope (Portamento Legato Slope)
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Als deze is ingesteld op Mono, kan de aanslag van de noot onnatuurlijk klinken, afhankelijk van de
aanslagsnelheid van de golfvorm die aan de partij is toegewezen. Als dit het geval is, gebruik dan
deze parameter om de aanslag aan te passen.
In de meeste gevallen wordt aanbevolen om deze parameter op een lagere waarde in te stellen voor
golfvormen met een korte aanslag, en op een grotere waarde voor golfvormen met een lange
aanslag.
Instellingen: 0−7

Stelt het fijnstemmen (temperament) voor de partij in.
Instellingen: Equal Temperament, Pure Major, Pure Minor, Werckmeister, Kirnberger, Vallotti &

Young, 1/4 shift, 1/4 tone, 1/8 tone, Indian, Arabic 1, Arabic 2, Arabic 3, User 1–8 (wanneer
een gebruikersbank is geselecteerd), Library 1-1–16-8 (wanneer een bibliotheekbestand is
geladen)

Equal
Temperament

Elk octaaf is verdeeld in 12 intervallen van gelijke grootte.
Dit is de meest gebruikte stemming in de hedendaagse muziek.

Pure Major
Pure Minor

Deze stemmingen houden de zuivere wiskundige intervallen van elke toonladder in stand,
vooral voor drieklanken (grondtoon, terts, kwint).
U kunt dit het beste horen met echte vocale harmonieën, zoals bij koren en a cappella zang.

Werckmeister
Kirnberger
Vallotti & Young

Bij elk van deze stemmingen worden de middentoon- en Pythagoreaanse stemming
gecombineerd.
De belangrijkste eigenschap van deze stemmingen is dat elke toets zijn unieke karakter heeft.
Deze stemmingen werden op grote schaal gebruikt in de tijd van Bach en Beethoven, en
worden zelfs nu nog vaak gebruikt als er muziek uit een bepaald tijdperk wordt gespeeld op een
klavecimbel.

1/4 shift
De gelijkzwevende stemming, 50 cents omhoog verschoven.
Door deze instelling te mixen met gelijkzwevende temperatuur kunt u spanning in uw muziek
creëren.

1/4 tone
Vierentwintig gelijk verdeelde noten per octaaf.
Het spelen van vierentwintig opeenvolgende toetsen op het toetsenbord vormt een octaaf.

1/8 tone
Achtenveertig gelijk verdeelde noten per octaaf.
Het spelen van achtenveertig opeenvolgende toetsen op het toetsenbord vormt een octaaf.

Indian
Meestal gebruikt in Indiase muziek.
Speel alleen witte toetsen.

Arabic Meestal gebruikt in Arabische muziek.

Stelt de grondtoon in voor het fijnstemmen.
Deze parameter wordt alleen weergegeven als fijnstemming waarvoor een grondtoon nodig is, is
geselecteerd.
Instellingen: C−B

Opent het instellingenscherm voor gebruikersfijnstemming.

Micro Tuning Name

Root (Micro Tuning Root)

Edit User Tuning
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In het scherm Filter EG kunt u de filterenvelopegenerator (FEG) voor de partij instellen.
Met de FEG kunt u de mate (of het niveau) van veranderingen in de afsnijfrequentie instellen en hoe
deze veranderingen in de loop van de tijd evolueren, vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment dat het geluid wegsterft.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Filter/Amp → Filter EG

Stelt de tijdsduur in die nodig is voordat het geluid verandert vanaf het moment dat u een toets
indrukt tot het moment waarop de afsnijfrequentie de waarde bereikt die is ingesteld bij Attack Level.
Dit wordt opgegeven als een offsetwaarde voor de Element FEG.
Instellingen: −64−+63

Stelt de tijdsduur in die nodig is voordat de afsnijfrequentie verandert vanaf het aanslagniveau. U
kunt de scherpte of de vervalsnelheid van het geluid regelen.
Dit wordt opgegeven als een offsetwaarde voor de Element FEG.
Instellingen: −64−+63

Filter/Amp

Filter EG

FEG Atk (FEG Attack Time)

FEG Decay (FEG Decay Time)
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Stelt het afsnijfrequentieniveau in dat volgt op het einde van het wegsterfsegment (of het niveau dat
behouden blijft terwijl de toets ingedrukt wordt gehouden).
Dit wordt opgegeven als een offsetwaarde voor de Element FEG.
Instellingen: −64−+63

Stelt de tijdsduur in die nodig is voordat de afsnijfrequentie naar het releaseniveau daalt wanneer u
uw vinger van de toets haalt.
Dit wordt opgegeven als een offsetwaarde voor de Element FEG.
Instellingen: −64−+63

Wijzigt het geluid door de afsnijfrequentie van het filter in te stellen. Wanneer het laagdoorlaatfilter is
geselecteerd, kunt u een helderder geluid maken door een hogere waarde voor deze parameter in te
stellen, en een donkerder geluid door een kleinere waarde in te stellen.
Dit wordt opgegeven als een offsetwaarde voor de afsnijfrequentie voor het element.
Instellingen: −64−+63

Voegt speciale kenmerken toe aan het geluid door het signaalniveau dichtbij de afsnijfrequentie aan
te passen.
Dit wordt opgegeven als een offsetwaarde voor de filterresonantie of filterbreedte voor het element.
Instellingen: −64−+63

Stelt het dieptebereik in van de afsnijfrequentie die wordt geregeld door de FEG voor het element.
Als deze op 0 is ingesteld, worden de instellingen in het element ongewijzigd gebruikt.
Instellingen: −64−+63

In het scherm Amp EG kunt u de AEG-tijd (Amplitude Envelope Generator) voor de partij instellen.
Hiermee kunt u bepalen hoe het volume verandert vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment waarop het geluid wegsterft.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Filter/Amp → Amp EG

FEG Sus (FEG Sustain Level)

FEG Rel (FEG Release Time)

Cutoff (Filter Cutoff Frequency)

Resonance (Filter Resonance)

FEG Depth

Amp EG
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Stelt de tijdsduur in die nodig is voordat het volume verandert vanaf het moment dat u een toets op
het toetsenbord indrukt tot het moment waarop het maximum wordt bereikt.
Dit wordt opgegeven als een offsetwaarde voor de Element AEG.
Instellingen: −64−+63

Stelt de tijd in die nodig is voordat het volume verandert nadat het het maximum heeft bereikt.
Dit wordt opgegeven als een offsetwaarde voor de Element AEG.
Instellingen: −64−+63

Stelt het volume in dat behouden blijft na de wegsterftijd.
Instellingen: −64−+63

Stelt de tijdsduur in die verstrijkt nadat u de toets hebt losgelaten totdat het geluid wegsterft.
Dit wordt opgegeven als een offsetwaarde voor de Element AEG.
Instellingen: −64−+63

In het scherm Routing kunt u de effectroutering voor de partij instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Effect → Routing

AEG Attack (AEG Attack Time)

AEG Decay (AEG Decay Time)

AEG Sustain (AEG Sustain Level)

AEG Release (AEG Release Time)

Effect

Routing
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(1) VCM roterende luidsprekerschakelaar

Toont de naam van het geselecteerde element.
Als Ex Elem Sw (General/Pitch → Element Settings) is ingesteld op Off of als er minder dan acht
elementen zijn, worden de cijfers 1 tot en met 8 weergegeven.
Instellingen: 1−128 (tot aan de instelling Element Count)

Stelt het element dat moet worden uitgevoerd in op invoegeffect A of invoegeffect B.
Als u dit instelt op Thru, worden de invoegeffecten omzeild.
Instellingen: Thru, InsA, InsB

Opent het instellingenscherm voor de 3-band EQ.

Opent het instellingenscherm voor de 2-band EQ.

Stelt de positie in de signaalstroom in bij gebruik van het expressiepedaal.
Instellingen: Normal, Pre FX

Normal: toegepast na de 2-band EQ
Pre FX: toegepast vóór de invoegeffecten. Deze instelling is effectief bij gebruik met niet-
lineaire effecten zoals vervorming. Voorbeeld van gebruik met vervorming: wanneer
ingesteld op Normal, verandert de uitvoer van vervorming. Het vervormingsniveau blijft
hetzelfde en alleen het volume verandert. Als Pre FX is ingesteld, verandert de invoer van
vervorming, dus zowel het vervormingsniveau als het vervormingsvolume veranderen.

Stelt de manier in waarop het expressie-effect wordt toegepast wanneer Expression Type is ingesteld
op Pre FX.

Element (Element Select)

Connect (Element Connection Switch)

3-band EQ

2-band EQ

Expression (Expression Type)

Exp. Curve (Expression Curve)
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Instellingen: Normal: volumecurve van normale kenmerken
Organ: volumecurve van de kenmerken die een vintage orgel simuleren

Stelt het effect van een VCM roterende luidsprekerschakelaar in, dat de kenmerken van een
roterende luidspreker simuleert door gebruik te maken van VCM-technologie.
Deze parameter is alleen beschikbaar voor partij 1.
Instellingen: Off, On

Stelt de effectroutering in voor invoegeffect A en invoegeffect B. Het diagram verandert
dienovereenkomstig wanneer de instellingen worden gewijzigd.

Instellingen: Parallel, Ins A→B, Ins B→A
Parallel: (voor Normal Part (AWM2) en Drum Part): de uitvoer van Insertion Effect A en
Insertion Effect B wordt afzonderlijk naar de Master Effect, Master EQ, Reverb, Variation
en Envelope Follower gestuurd.

Ins A→B: de uitvoer van Insertion Effect A wordt verzonden naar Insertion Effect B, en de
uitvoer van Insertion Effect B wordt verzonden naar de Master Effect, Master EQ, Reverb,
Variation en Envelope Follower.

Ins B→A: de uitvoer van Insertion Effect B wordt verzonden naar Insertion Effect A, en de
uitvoer van Insertion Effect A wordt verzonden naar de Master Effect, Master EQ, Reverb,
Variation en Envelope Follower.

Schakelt Invoegeffect A en Invoegeffect B in of uit.

VCM Rotary Speaker Switch

Ins Connect (Insertion Connection Type)

A (Insertion Effect A Switch)
B (Insertion Effect B Switch)
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Instellingen: Off, On

Stelt het effecttype in.
Instellingen: Raadpleeg de Effecttypen.

Selecteert een van de vooraf ingestelde effectparameters voor elk effecttype.
Door een voorinstelling te selecteren, kunt u de manier wijzigen waarop effecten worden toegepast.
Instellingen: Raadpleeg de Data List.

Stelt de Side Chain Part (of de Modulator, afhankelijk van het effecttype) in voor Insertion Effect A of
Insertion Effect B.
Deze parameter is niet beschikbaar als de partij zelf of de master is ingesteld op Modulator. In dat
geval wordt de parameterwaarde tussen haakjes weergegeven, zoals in "(Master)".
Instellingen: Part 1–16, A/D, Master, Off

Stelt het niveau in van de signalen (of bypass-signalen) die worden verzonden van invoegeffect A of
invoegeffect B naar het reverb-effect. Deze parameter is alleen beschikbaar als Part Output is
ingesteld op MainL&R.
Instellingen: 0−127

Stelt het niveau in van de signalen (of bypass-signalen) die worden verzonden van invoegeffect A of
invoegeffect B naar het variation-effect. Deze parameter is alleen beschikbaar als Part Output is
ingesteld op MainL&R.
Instellingen: 0−127

Stelt de uitvoerbestemming voor de audiosignalen in.
Instellingen: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off

MainL&R: uitgang in stereo (twee kanalen) naar de OUTPUT [L/MONO]- en OUTPUT [R]-
aansluitingen.
AsgnL&R: uitgang in stereo (twee kanalen) naar de ASSIGNABLE OUTPUT [L]- en [R]-
aansluitingen.
USB1&2–USB29&30: uitgang in stereo (kanalen 1 en 2, naar kanalen 29 en 30) naar de
[USB TO HOST]-aansluiting.
AsgnL: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [L]-aansluiting.
AsgnR: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [R]-aansluiting.
USB1–30: uitgang in mono (kanaal 1–30) naar de [USB TO HOST]-aansluiting.
Off: geen uitgang van het audiosignaal voor de partij.

Type (Insertion Effect Type)

Preset (Insertion Effect Preset)

Side Chain (Insertion Side Chain Part)
Modulator (Insertion Modulator Part)

Rev Send (Reverb Send)

Var Send (Variation Send)

Part Output (Part Output Select)

Envelope Follower
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Opent het instellingenscherm voor de Envelope Follower.

In de schermen Ins A en Ins B kunt u de invoegeffecten instellen.

Gebruik

Hetzelfde als Audio In → Ins A of Ins B in Common Edit.

In het scherm 3-band EQ kunt u de partij-EQ instellen. De 3-band EQ kan vóór het invoegeffect
worden toegepast.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Effect → 3-band EQ

Hieronder ziet u het instellingenscherm voor 3-band EQ.

Ins A
Ins B

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Effect → Ins A

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Effect → Ins B

3-band EQ
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Stelt de frequentie van de Low-band in.
Instellingen: 50,1Hz−2,00kHz

Stelt het signaalniveau van de Low-band in.
Instellingen: −12,00 dB−+12,00 dB

Stelt de frequentie van de Mid-band in.
Instellingen: 139,7Hz−10,1kHz

Stelt het signaalniveau van de Mid-band in.
Instellingen: −12,00 dB−+12,00 dB

Stelt de bandbreedte van de Mid-band in.
Instellingen: 0,7−10,3

Stelt de frequentie van de High-band in.
Instellingen: 503,8Hz−14,0kHz

Stelt het signaalniveau van de High-band in.
Instellingen: −12,00 dB−+12,00 dB

In het scherm 2-band EQ kunt u de partij-EQ instellen.
De 2-band EQ kan na het invoegeffect worden toegepast.

EQ Low Freq (3band EQ Low Frequency)

EQ Low Gain (3band EQ Low Gain)

EQ Mid Freq (3band EQ Mid Frequency)

EQ Mid Gain (3band EQ Mid Gain)

EQ Mid Q (3band EQ Mid Q)

EQ Hi Freq (3band EQ High Frequency)

EQ Hi Gain (3band EQ High Gain)

2-band EQ
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Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Effect → 2-band EQ

Hieronder ziet u het instellingenscherm voor 2-band EQ.

Selecteert het gewenste EQ-type.
Instellingen: Thru, LPF, HPF, Low Shelf, Hi Shelf, Peak/Dip

Thru: geeft de signalen door zonder dat er effecten worden toegepast.
LPF: kapt de signalen boven de afsnijfrequentie af.
HPF: kapt de signalen onder de afsnijfrequentie af.
Low Shelf: kapt de signalen af of versterkt ze onder de opgegeven frequentie-instelling.
Hi Shelf: kapt de signalen af of versterkt ze boven de opgegeven frequentie-instelling.
Peak/Dip: kapt de signalen af of versterkt ze op de opgegeven frequentie-instelling.

Stelt de frequentie in die moet worden afgekapt of versterkt.
Deze parameter is niet beschikbaar als het EQ Type is ingesteld op Thru.
Instellingen: 63,0 Hz−18,0 Hz

Stelt het signaalniveau in van de frequentieband die is ingesteld in EQ1 Freq of EQ2 Freq.
Deze parameter is niet beschikbaar als het EQ Type is ingesteld op Thru, LPF of HPF.
Instellingen: -12,0 dB-+12,0 dB

EQ1 Type (2band EQ 1 Type)
EQ2 Type (2band EQ 2 Type)

EQ 1 Freq (2band EQ 1 Frequency)
EQ 2 Freq (2band EQ 2 Frequency)

EQ 1 Gain (2band EQ 1 Gain)
EQ 2 Gain (2band EQ 2 Gain)
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Stelt de bandbreedte in voor het afkappen of versterken van het volume van de frequenties die zijn
ingesteld met EQ1 Freq of EQ2 Freq.
Deze parameter is alleen beschikbaar wanneer het EQ Type is ingesteld op Peak/Dip.
Instellingen: 0,1−12,0

Stelt de uitgangsversterking van de 2-band EQ in.
Instellingen: −12,0 dB–+12,0 dB

In het scherm Common kunt u het arpeggio voor de gehele partij instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Arpeggio → Common

Zet het arpeggio voor de partij aan of uit.
Instellingen: Off, On

Zet het arpeggio voor de performance aan of uit.
Instellingen: Off, On

Past de timing aan voor het starten van de volgende arpeggiofrase bij het afspelen van
arpeggiofrasen in meerdere partijen.
Als deze is ingesteld op Off, begint het afspelen van arpeggio's wanneer de partij op het toetsenbord

EQ 1 Q (2band EQ 1 Q)
EQ 2 Q (2band EQ 2 Q)

Output Level (2band EQ Output Level)

Arpeggio

Common

Arp Part (Part Arpeggio Switch)

Arp Master (Arpeggio Master Switch)

Sync Quantize (Arpeggio Sync Quantize Value)
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wordt gespeeld.
De hier getoonde waarde is in clocks.
Instellingen: Off, 60 (tweeëndertigste noot), 80 (zestiende noottriool), 120 (zestiende noot), 160

(achtste noot triool), 240 (achtste noot), 320 (kwartnoottriool), 480 (kwartnoot)

Stelt de Arpeggio Group in voor het gebruik van hetzelfde arpeggio in meerdere partijen.
De partijen die in dezelfde groep zijn ingesteld, hebben dezelfde arpeggio-instellingen.

Deze indicator is ingesteld op On voor de partij die zich in dezelfde groep bevindt als de
geselecteerde partij.

Schakelt de aanhoudfunctie, die het arpeggio herhaaldelijk blijft afspelen, in of uit, zelfs nadat u de
toets op het toetsenbord heeft losgelaten.
Instellingen: Sync-Off, Off, On

Sync-Off: herhaalt het afspelen van arpeggio's op de achtergrond terwijl uw vingers de
toetsen loslaten en hervat het afspelen wanneer u op een willekeurige toets op het
toetsenbord drukt.
Off: speelt het arpeggio alleen af terwijl een toets ingedrukt wordt gehouden.
On: herhaalt het afspelen van arpeggio's, zelfs nadat u de toets op het toetsenbord heeft
losgelaten.

Stelt de timing in voor het wijzigen van het arpeggiotype terwijl er nog een andere arpeggiofrase
wordt afgespeeld. U kunt Real-time selecteren om onmiddellijk naar een nieuwe arpeggiofrase over
te schakelen, of Measure om aan het begin van de volgende maat naar een nieuwe arpeggiofrase te
schakelen.
Instellingen: Real-time, Measure

Stelt de manier in waarop het arpeggio wordt afgespeeld.
Instellingen: Sort, Thru, Direct, Sort+Drct, Thru+Drct

Sort: speelt hetzelfde arpeggio af, ongeacht de volgorde van de gespeelde toetsen.
Thru: speelt het arpeggio anders af, afhankelijk van de volgorde van de gespeelde
toetsen.
Direct: speelt het arpeggio niet af. Alleen uw toetsenspel wordt gespeeld. Met deze
instelling kunt u echter geluidswijzigingen creëren via regelaarwijzigingsberichten zoals
pan en helderheid, afhankelijk van het arpeggio. Als zodanig is het handig voor
arpeggiotypen die gebruik maken van regelaarwijzigingen of voor arpeggiotypen die zijn
opgenomen in de regelaarcategorie.
Sort+Drct: speelt het arpeggio af volgens de instelling voor Sort, evenals de noten die op
het toetsenbord worden gespeeld.
Thru+Drct: speelt het arpeggio af volgens de instelling voor Thru, evenals de noten die op
het toetsenbord worden gespeeld.

Arpeggio Group

Indicator

Hold (Arpeggio Hold)

Change Timing (Arpeggio Change Timing)

Key Mode (Arpeggio Key Mode)
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Selecteert afspelen in een lus (herhaald) terwijl u de toets op het toetsenbord ingedrukt houdt, of
one-shot (eenmalig) afspelen voor het arpeggio telkens wanneer u een toets indrukt.
Instellingen: Off, On

Stelt de partij in om alleen met het arpeggio te spelen.
Een partij die op On is ingesteld, wordt gespeeld door de noot-aan-berichten die voor het arpeggio
worden verzonden.
Instellingen: Off, On

Wijzigt de timing van even genummerde tellen (backbeats), geteld vanaf de waarde die is opgegeven
in Quantize Value, om een swinggevoel toe te voegen aan het afspelen van arpeggio's.

Instellingen: −120−+120

Stelt het percentage in voor het uitrekken of comprimeren van de arpeggioafspeeltijd.
De onderverdeling van de tel en het tempo verandert wanneer u de afspeeltijd uitrekt of comprimeert,
zodat u een compleet nieuw gevoel kunt creëren voor het arpeggio dat u oorspronkelijk hebt
geselecteerd.
Instellingen: 50%, 66%, 75%, 100%, 133%, 150%, 200%, 266%, 300%, 400%, Common

200%: de afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: de afspeeltijd blijft ongewijzigd.
50%: de afspeeltijd wordt gehalveerd en het tempo wordt daardoor verdubbeld.
Common: de waarde die is ingesteld in de Unit Multiply die geldt voor alle partijen, wordt
toegepast.

Stelt de referentienoot in voor het gebruik van quantizering en swing.
De hier getoonde waarde is in clocks.
Instellingen: Off, 60 (tweeëndertigste noot), 80 (zestiende noottriool), 120 (zestiende noot), 160

(achtste noot triool), 240 (achtste noot), 320 (kwartnoottriool), 480 (kwartnoot)

Stelt de sterkte van de quantizeringsinstelling in (of hoe dicht de noten bij de referentienoot liggen die
is ingesteld in Quantize Value). Een instelling van 100% verschuift de timing volledig naar die
ingesteld in Quantize Value, terwijl een instelling van 0% resulteert in geen quantizering.
Instellingen: 0%−100%

Loop (Arpeggio Loop)

Arp Play Only (Arpeggio Play Only)

Swing

+1 en hoger: na de tel.

-1 en lager: vóór de tel.

0: verandert de even genummerde tellen niet en voegt geen swinggevoel toe.
Deze instelling is handig voor het creëren van de gewenste ritmes voor het spelen met een swing-,
shuffle- en bouncegevoel.

Unit (Arpeggio Unit Multiply)

Quantize Value (Arpeggio Quantize Value)

Qntz Strength (Arpeggio Quantize Strength)
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Stelt de snelheid in voor de gate-tijd (of de tijdsduur voor het spelen van de noten) van het afspelen
van het arpeggio. Als de gate-tijd hierdoor op de waarde 0 wordt ingesteld, wordt de instelling
gewijzigd in de waarde 1.
Instellingen: 0%−200%

Stelt de aanslagsnelheid van het afspelen van het arpeggio in. Als de aanslagsnelheid hierdoor op de
waarde 0 wordt ingesteld, wordt de instelling gewijzigd in een waarde van 1. Wanneer deze wordt
ingesteld op een waarde groter dan 128, wordt de instelling gewijzigd in een waarde van 127.
Instellingen: 0%−200%

Stelt het aanslagbereik (laagste en hoogste waarden) in voor het afspelen van het arpeggio.
Als dit zo is ingesteld dat de hogere waarde als eerste is en de lagere waarde als tweede
(bijvoorbeeld 93 tot 34), wordt het arpeggio alleen gespeeld met aanslagsnelheden van 1 tot 34 en
93 tot 127.
Instellingen: 1−127

Stelt het notenbereik (de laagste en hoogste noten) in voor het afspelen van het arpeggio.
Als de eerst opgegeven noot hoger is dan de tweede (bijvoorbeeld C5 tot C4), worden de noten in de
bereiken C-2 tot C4 en C5 tot G8 afgespeeld.
Instellingen: C−2−G8

Verschuift de toonhoogte van het arpeggio in octaven.
Instellingen: -10-+0-+10

Verschuift het bereik van het arpeggio in octaven.
Instellingen: −3–+0-+3

Selecteert het arpeggio.
Instellingen: 1−8

In het scherm Individual kunt u de arpeggiotypeparameters instellen voor Arpeggio Select 1 tot 8. Als
u op de instelling Arpeggio Type tikt, wordt het menu geopend. Als u Search selecteert, wordt het
scherm Arpeggio Category Search geopend. Als u Number selecteert, kunt u het arpeggiotype op
nummer opgeven.

Gebruik

Gate Time (Arpeggio Gate Time Rate)

Velocity Rate (Arpeggio Velocity Rate)

Arp Vel Limit (Arpeggio Velocity Limit)

Arp Note Limit (Arpeggio Note Limit)

Octave Shift (Arpeggio Output Octave Shift)

Octave Range (Arpeggio Octave Range)

Arp Select (Arpeggio Select)

Individual
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Hetzelfde als het scherm Common.

Selecteert het arpeggio.
Instellingen: 1−8

Toont de categorie van de geselecteerde arpeggio.
Instellingen: Raadpleeg de Data List.

Toont de subcategorie van de geselecteerde arpeggio.
Instellingen: Raadpleeg de Data List.

Toont de naam van de geselecteerde arpeggio.
Instellingen: Raadpleeg de Data List.

Stelt de aanslagsnelheid van het afspelen van het arpeggio in.
Als de Velocity hierdoor op de waarde 0 wordt ingesteld, wordt de instelling gewijzigd in een waarde
van 1. Wanneer deze wordt ingesteld op een waarde groter dan 128, wordt de instelling gewijzigd in
een waarde van 127.
Instellingen: 100%−100%

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Arpeggio → Individual

(Als een geselecteerde partij iets anders is dan Common) [SHIFT] + [ARP ON/OFF]

Arp Part (Part Arpeggio Switch)
Arp Master (Arpeggio Master Switch)
Sync Quantize (Arpeggio Sync Quantize Value)
Arp Group
Indicator

Arp (Arpeggio Select)

Category (Arpeggio Category)

Sub (Arpeggio Sub Category)

Name (Arpeggio Name)

Velocity (Arpeggio Velocity Rate)
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Stelt de gate-tijd (of de tijdsduur voor het spelen van de noten) in voor het afspelen van het arpeggio.
Als de gate-tijd hierdoor op de waarde 0 wordt ingesteld, wordt de instelling gewijzigd in de waarde 1.
Instellingen: -100%-+100%

In het scherm Advanced kunt u de arpeggioparameters instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Arpeggio → Advanced

Hetzelfde als het scherm Common.

Stelt het aanslagsnelheidsniveau in voor het triggeren van een accentfrase.
Accentfrasen zijn sequencefrasen die zijn geprogrammeerd voor bepaalde typen arpeggiopatronen,
zodat deze alleen worden afgespeeld als de toetsen met hoge snelheid worden bespeeld.
Accentfrasen worden geactiveerd als de aanslag hoger is dan Accent Vel Threshold (Arpeggio
Accent Velocity Threshold).
Als de accentfrase niet goed wordt getriggerd, probeer dan de waarde voor Accent Vel Threshold
(Arpeggio Accent Velocity Threshold) te verlagen.

OPMERKING
Raadpleeg de Data List voor meer informatie over de arpeggiotypen die deze functie ondersteunen.
Instellingen: Off, 1−127

Gate Time (Arpeggio Gate Time Rate)

Advanced

Arp Part (Part Arpeggio Switch)
Arp Master (Arpeggio Master Switch)
Sync Quantize (Arpeggio Sync Quantize Value)
Arp Group
Indicator

Accent Vel Threshold (Arpeggio Accent Velocity Threshold)

Accent Start Quantize (Arpeggio Accent Start Quantize)
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Stelt de accentfrase in die wordt geactiveerd wanneer een toets wordt ingedrukt met een
snelheidswaarde die groter is dan de Accent Vel Threshold (Arpeggio Accent Velocity Threshold)
(ingesteld op On) of getriggerd op de timing die is ingesteld in het geselecteerde arpeggiotype
(ingesteld op Off).
Instellingen: Off, On

Schakelt de Random SFX-functie in.
De Random SFX-functie activeert speciale geluiden die in sommige arpeggiotypen voorkomen. Er
zijn verschillende soorten speciale geluiden die u kunt gebruiken. U kunt deze functie bijvoorbeeld
gebruiken om fretruis op een gitaar toe te voegen wanneer u uw vinger van de toets haalt.
Instellingen: Off, On

OPMERKING
Raadpleeg de Data List voor meer informatie over de arpeggiotypen die deze functie ondersteunen.

Stelt de aanslagsnelheidswaarde in voor het triggeren van speciale geluiden voor de Random SFX-
functie.
Instellingen: -64-+0-+63

Stelt speciale geluiden in die worden geactiveerd door het snelheidsniveau voor het indrukken van
toetsen of door het automatisch ingestelde snelheidsniveau.
Instellingen: Off, On

Stelt de aanslagsnelheid van het afspelen van het arpeggio in.
Instellingen: Original, Thru

Original: volgt het snelheidsniveau dat is ingesteld in het arpeggiotype.
Thru: volgt het snelheidsniveau van de toetsaanslag.

Stelt de Trigger Mode in op de instelling Gate waarmee het afspelen van arpeggio's wordt gestart en
gestopt door op een toets te drukken, of de instelling Toggle die starten en stoppen afwisselt door op
een toets te drukken.
Instellingen: Gate, Toggle

Wijzigt de arpeggioselectie.
Instellingen: 1−8

In het scherm Common kunt u de Motion Sequencer-parameters voor de gehele partij instellen.

Random SFX (Arpeggio Random SFX)

Random SFX Velocity Offset (Arpeggio Random SFX Velocity Offset)

Random SFX Key On Ctrl (Arpeggio Random SFX Key On Control)

Velocity Mode (Arpeggio Velocity Mode)

Trigger Mode (Arpeggio Trigger Mode)

Arp Select (Arpeggio Select)

Motion Seq

Common
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Gebruik

Stelt de swingwaarde van het arpeggio en motionsequencer in voor de performance.
Dit wordt opgegeven als een offsetwaarde voor de Part Swing.
Instellingen: −120−+120

Stelt het percentage in voor het uitrekken of comprimeren van de afspeeltijd van het arpeggio en de
motionsequencer voor de gehele performance.
Deze parameter is actief voor de lane waarvoor Unit Multiply is ingesteld op Common.
De onderverdeling van de tel en het tempo verandert wanneer u de afspeeltijd uitrekt of comprimeert,
zodat u een compleet nieuw gevoel kunt creëren voor de motionsequence die u oorspronkelijk hebt
geselecteerd.
Instellingen: 50%−400%

200%: de afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: de afspeeltijd blijft ongewijzigd.
50%: de afspeeltijd wordt gehalveerd en het tempo wordt daardoor verdubbeld.

Stelt de amplitude van de motionsequencer voor de gehele performance in.
Dit wordt opgegeven als een offsetwaarde voor de amplitude van de motionsequencer voor de partij.
De amplitude is hier de mate van veranderingen in de motionsequence.
Deze parameterwaarde compenseert de amplitude van de lanes binnen de performance als MS FX
op On is ingesteld voor de lane.
Instellingen: −127−+127

Stelt de pulsvorm van de motionsequencer voor de performance in.
Dit wordt opgegeven als een offsetwaarde voor de pulsvorm van de motionsequencer voor de partij.
Deze parameter verandert de vorm van de stapcurve waaruit de sequence bestaat.

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Motion Seq → Common

(Als een geselecteerde partij iets anders is dan Common) [SHIFT] + [MSEQ ON/OFF]

Common Swing (Common Swing Offset)

Common Unit (Common Unit Multiply)

Common Amplitude (Common Motion Sequencer Amplitude Performance Offset)

Common Shape (Common Motion Sequencer Pulse Shape Performance Offset)
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Deze parameterwaarde verschuift de parameters voor de lanes binnen de performance als de MS FX
op On is ingesteld voor de lane en Control op On is ingesteld.
Instellingen: −100−+100

Stelt de geleidelijkheid van de motionsequencer voor de performance in.
Dit wordt opgegeven als een offsetwaarde voor de geleidelijkheid van de motionsequencer voor de
partij.
Geleidelijkheid is hier de geleidelijkheid van de veranderingen in de sequence in de loop van de tijd.
Deze parameterwaarde verschuift de geleidelijkheid van de lanes binnen de performance als de MS
FX op On is ingesteld voor de lane.
Instellingen: −127−+127

Stelt de willekeurigheid van de motionsequencer voor de performance in.
Dit wordt opgegeven als een offsetwaarde voor de willekeurigheid van de motionsequencer voor de
partij.
Deze parameter geeft de willekeurigheid aan van veranderingen in de stapwaarde van de sequence.
Deze parameterwaarde verschuift de willekeurigheid van de lanes binnen de performance als de MS
FX op On is ingesteld voor de lane.
Instellingen: −127−+127

Wijzigt de timing van even genummerde tellen (backbeats), geteld vanaf de waarde die is opgegeven
in MS Grid, om een swinggevoel toe te voegen aan het afspelen van de motionsequencer.

Instellingen: −120−+120

Stelt het percentage in voor het uitrekken of comprimeren van de arpeggioafspeeltijd voor de partij.
De parameterinstelling is effectief wanneer de Unit Multiply van elke lane is ingesteld op Arp.
Instellingen: 50%–400%, Common

200%: de afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: de afspeeltijd blijft ongewijzigd.
50%: de afspeeltijd wordt gehalveerd en het tempo wordt daardoor verdubbeld.
Common: de waarde die is ingesteld in de Unit Multiply die geldt voor alle partijen, wordt
toegepast.

Stelt de amplitude van de motionsequencer voor de partij in.
Dit wordt opgegeven als een offsetwaarde voor de amplitude van de motionsequencer voor elke
lane.

Common Smooth (Common Motion Sequencer Smoothness Performance Offset)

Common Random (Common Motion Sequencer Randomness Performance Offset)

Part Swing (Part Swing)

+1 en hoger: na de tel.

-1 en lager: vóór de tel.

0: verandert de even genummerde tellen niet en voegt geen swinggevoel toe.
Deze instelling is handig voor het creëren van de gewenste ritmes voor het spelen met een swing-,
shuffle- en bouncegevoel.

Part Unit (Arpeggio Unit Multiply)

Part Amplitude (Part Motion Sequencer Amplitude)
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Deze parameterwaarde compenseert de amplitude van de lanes binnen de partij als de MS FX op On
is ingesteld voor de lane.
Instellingen: −127−+127

Stelt de pulsvorm van de motionsequencer voor de partij in.
Dit wordt opgegeven als een offsetwaarde voor de parameter van de stapcurve voor de amplitude
van de motionsequencer voor elke lane.
Deze parameterwaarde verschuift de parameters voor de lanes binnen de partij als de MS FX op On
is ingesteld voor de lane en Control op On is ingesteld.
Instellingen: −100−+100

Stelt de geleidelijkheid van de motionsequencer voor de partij in.
Dit wordt opgegeven als een offsetwaarde voor de geleidelijkheid van de motionsequencer voor elke
lane.
Deze parameterwaarde compenseert de geleidelijkheid van de lanes binnen de partij als MS FX op
On is ingesteld voor de lane.
Instellingen: −127−+127

Stelt de willekeurigheid van de motionsequencer voor de partij in.
Stelt in dat de veranderingen in de stapwaarde van de sequence willekeurig moeten zijn.
Instellingen: 0−127

Stelt de lane van de motionsequencer zo in dat deze wordt weergegeven wanneer de View Mode
van het Home-scherm is ingesteld op Motion Seq.

Selecteert de motionsequence die u wilt afspelen.
Instellingen: 1−8

In het scherm Lane kunt u de parameters instellen voor elke lane van de motionsequencer.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Motion Seq → Lane

Part Shape (Part Motion Sequencer Pulse Shape)

Part Motion Seq Smooth (Part Motion Sequencer Smoothness)

Part Motion Seq Random (Part Motion Sequencer Randomness)

Motion Seq View Lane

MS Select (Motion Sequence Select)

Lane
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Schakelt de Motion Sequencer voor de gehele performance in/uit.
Instellingen: Off, On

Schakelt Motion Sequencer in of uit voor de partij.
Instellingen: Off, On

Selecteert een lane.
Instellingen: 1−4

Geeft de lane en de sequence aan.

Opent het scherm Motion Sequence.
U kunt een sequence maken van maximaal zestien stappen.

Stelt de waarde in van elke stap in de Motion Sequence.
U kunt de schuifregelaars 1 t/m 8 gebruiken om de waarden voor stappen 1 t/m 8 en stappen 9 t/m
16 te wijzigen, afhankelijk van de cursorpositie.
Instellingen: 0−127

Zet elke lane aan of uit.
U kunt maximaal vier motionsequencerlanes in één partij gebruiken, of maximaal acht lanes in een
gehele performance. Indien ingesteld op Off, worden de parameters voor die lane niet weergegeven.
Instellingen: Off, On

Motion Seq Master Sw (Motion Sequencer Master Switch)

Motion Seq Part Sw (Motion Sequencer Part Switch)

Lane Select

Target Sequence

Edit Sequence

Motion Seq Step Value

LaneSw (Lane Switch)

MS FX (Lane FX Receive)
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Stelt de geselecteerde lane in om de signalen van de knoppen te ontvangen voor het wijzigen van de
parameters voor de motionsequencer zoals Swing en Smooth.
Instellingen: Off, On

Stelt de geselecteerde lane in om de signalen van de knop [MSEQ TRIGGER] te ontvangen.
Als dit is ingesteld op On, begint de Motion Sequence pas met afspelen zodra u op de knop [MSEQ
TRIGGER] drukt.
Instellingen: Off, On

Wijzigt de Motion Sequence-selectie.
Instellingen: 1−8

Stelt de snelheid en de timing in van het afspelen van de motionsequence die is ingesteld voor de
Destination in het scherm Control Assign.
Instellingen: Off, Tempo, Beat, Arp, Lane1 (als Lanes 2–4 zijn geselecteerd)

Off: alleen de motionsequencer van de lane wordt afgespeeld.
Tempo: speelt de motionsequencer van de lane af in het performancetempo.
Beat: er wordt synchroon met de beat afgespeeld.
Arp: speelt de motionsequencer van de lane synchroon af met het begin van het afspelen
van arpeggio.
Lane1: speelt de motionsequencer van de lane synchroon af met Lane 1.

Stelt de snelheid in voor het afspelen van de Motion Sequence.
Deze parameter is beschikbaar wanneer Lane Motion Sequencer Sync is ingesteld op Off.
Instellingen: 0−127

Stelt de vertragingstijd in voor het starten van het afspelen van de motionsequence wanneer Sync
is ingesteld op Off.
Instellingen: 0−127

Stelt de tijd in voor het bereiken van de maximale amplitude van de Motion Sequence wanneer
Sync is ingesteld op Off.
Instellingen: 0−127

Trigger (Lane Trigger Receive)

Sequence Select (Motion Sequence Select)

Tabblad Sync/Speed

Sync (Lane Sync)

Wanneer Sync is ingesteld op Off

Speed (Lane Speed)

Delay Time (Lane Key On Delay Time Length)

Fade In Time (Lane Fade In Time Length)

Wanneer Sync is ingesteld op iets anders dan Off

Unit Multiply (Lane Unit Multiply)
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Stelt het percentage in voor het uitrekken of comprimeren van de afspeeltijd van de Motion
Sequencer voor de huidige lane.
Deze parameter is beschikbaar wanneer de motionsequencer voor de lane is ingesteld op Off of
op iets anders dan Lane 1.
Instellingen: 50%–6400%, Common, Arp

200%: de afspeeltijd wordt verdubbeld en het tempo wordt daardoor gehalveerd.
100%: de afspeeltijd blijft ongewijzigd.
50%: de tijdsduur wordt gehalveerd en het tempo wordt daardoor verdubbeld.
Common: de waarde die is ingesteld in de Unit Multiply die geldt voor alle partijen,
wordt toegepast.
Arp: de waarde die is ingesteld in de Unit Multiply van het geselecteerde arpeggio van
de partij, wordt toegepast.

Stelt de vertragingstijd in voor het starten van het afspelen van de motionsequence wanneer Sync
is ingesteld op iets anders dan Off of Lane1.
Instellingen: 0−32

Stelt de tijd in voor het bereiken van de maximale amplitude voor de Motion Sequence wanneer
Sync is ingesteld op iets anders dan Off.
Instellingen: 0−32

Stelt het aanslagsnelheidsbereik (laagste en hoogste waarden) in voor het afspelen van de Motion
Sequence van de geselecteerde lane.
Deze parameter is beschikbaar wanneer de motionsequencer voor de lane is ingesteld op iets
anders dan Lane 1.
Wanneer de Velocity Limit is ingesteld op een bereik van de hoogste waarde naar de laagste waarde,
wordt de motionsequence alleen afgespeeld in twee aanslagsnelheidsbereiken: van het maximum
naar de hoogste waarde, en van de laagste waarde naar het minimum.
Instellingen: 1−127

Reset het afspelen van de Motion Sequence als u op een willekeurige toets op het toetsenbord drukt.
Deze parameter is beschikbaar wanneer de motionsequencer voor de lane is ingesteld op Arp of op
iets anders dan Lane 1.
Deze parameter is niet beschikbaar als Trigger is ingesteld op On.
Instellingen: Off, Each-On, 1st-On

Each-On: elke keer dat u een noot speelt, wordt de sequence opnieuw ingesteld en begint
het afspelen vanaf het begin.
1st-On: het afspelen begint vanaf het begin bij de eerste noot die u speelt. Als de eerste
noot wordt vastgehouden terwijl een tweede noot wordt gespeeld, wordt de sequence niet
opnieuw ingesteld bij de tweede of eventuele volgende noten.

Lane Key On Delay (Lane Key On Delay Time Length)

Lane Fade In (Lane Fade In Time Length)

Lane Vel Limit (Lane Velocity Limit)

Tabblad Loop/Length

Key On Reset (Lane Key On Reset)
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Stelt de Motion Sequence in op afspelen in een loop (herhalingen) of eenmalig afspelen.
Deze parameter is beschikbaar wanneer de motionsequencer voor de lane is ingesteld op iets
anders dan Lane 1.
Instellingen: Off, On

Stelt de stap in voor het starten van het afspelen voor de tweede keer of later bij het herhalen van het
afspelen van motionsequence.
Instellingen: 1–Length (Loop Length)

Stelt het aantal stappen in de Motion Sequence in.
Instellingen: Loop Start (Lane Loop Start) –16

Stelt de lengte van een stap in de Motion Sequence in.
Instellingen: 60, 80, 120, 160, 240, 320, 480

In het scherm Control Assign kunt u de regelaars voor de partij instellen.
Door de parameter (Destination) aan een regelaar (Source) toe te wijzen, kunt u het geluid regelen
op veel verschillende manieren. U kunt fysieke regelaars gebruiken, zoals het Pitchbendwiel en de
knoppen, maar ook de Motion Sequencer en Envelope Follower.
Er kunnen maximaal 32 regelaars tegelijk aan een partij worden toegewezen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Mod/Control → Control Assign

Loop (Lane Loop)

Loop Start

Length (Motion Sequence Length)

MS Grid (Motion Sequencer Grid)

Mod/Control

Control Assign
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Wanneer Display Filter is ingesteld op Super Knob en u op [+] tikt, wordt het bericht in het bovenste
gedeelte van de display weergegeven en worden de instellingen voor Control Assign voor de
Common Edit automatisch toegevoegd.

OPMERKING
Als er geen toewijsbare knoppen beschikbaar zijn, wordt [+] niet weergegeven.

Zet de automatische selectie van het Display Filter aan of uit.
Als dit is ingesteld op On, wordt bij het verplaatsen van de regelaar die u wilt instellen op Source, de
regelaar automatisch ingesteld op het Display Filter.
Instellingen: Off, On

Selecteert de regelaar voor het weergeven van de instellingen op het scherm.
Wanneer u Super Knob selecteert, worden alle instellingen weergegeven waarvoor de Super Knob
Link op On is ingesteld.
Instellingen: PitchBend, ModWheel, AfterTouch, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath,

AsgnKnob 1–8, Super Knob, AsgnSw 1, AsgnSw 2, MS Lane 1–4, EnvFollow 1–16,
EnvFollowAD, EnvFollowMst, All

OPMERKING
Als de controller die is ingesteld op Display Filter door andere partijen wordt gebruikt, zullen de overeenkomstige
PART-knoppen knipperen.

Hierdoor wordt het scherm met toonhoogte-instellingen opgeroepen.
Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via [EDIT/ ] →
General/Pitch → Pitch.
Deze parameter is niet beschikbaar wanneer Source is ingesteld op iets anders dan PitchBend.

Hiermee kunt u een nieuwe naam invoeren voor de knoppen 1 tot en met 8, zodat deze op het sub-
display worden weergegeven.
Deze parameter wordt niet weergegeven als Source is ingesteld op iets anders dan AsgnKnob 1–8.

Hiermee opent u het Motion Sequence-scherm.
U kunt een sequence van maximaal 16 stappen maken.
Deze parameter is niet beschikbaar als Source is ingesteld op iets anders dan MS Lane 1−4.

Opent het instellingenscherm voor de Envelope Follower.
Deze parameter is niet beschikbaar wanneer Source is ingesteld op iets anders dan EnvFollow 1−16,
EnvFollowAD of EnvFollowMst.

Auto Select

Display Filter

Edit Pitch Bend

Display Name (Assignable Knob Name)

Edit Motion Sequencer

Edit Envelope Follower

Page
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Selecteert de volgende pagina als er meer dan vier bestemmingen zijn. De volgende pagina
verschijnt niet als er vier of minder bestemmingen zijn.
Instellingen: 1−8

Stelt de parameter voor de destination (bestemming) in. Door op het pictogram [+] te tikken, kunt u
een nieuwe bestemming toevoegen.

Stelt de regelaar in voor het regelen van de parameters die zijn ingesteld voor de Destination.
Instellingen: PitchBend, ModWheel, Ch. AT, FootCtrl 1, FootCtrl 2, FootSwitch, Ribbon, Breath,

AsgnKnob 1–8, AsgnSw 1, AsgnSw 2, MS Lane 1–4, EnvFollow 1–16, EnvFollowAD,
EnvFollowMst

U kunt de regelaarinstelling voor elk element in- of uitschakelen.
Deze parameter wordt alleen weergegeven als de geselecteerde Destination gerelateerd is aan
elementen.
Wanneer de ExElemSw op het scherm General/Pitch - ElementSettings is ingesteld op On, kunt u het
schakelaarnummer wijzigen door het Display Element te wijzigen.
Het daadwerkelijke bereik van getallen dat u in de schakelaar kunt gebruiken, hangt af van de
waarde die is ingesteld in ElementCount op het scherm General/Pitch - ElementSettings.
Instellingen: Off, On

Wordt alleen weergegeven als ExElemSw op het scherm General/Pitch - ElementSettings is
ingesteld op On.
U kunt een andere groep van acht elementen selecteren die overeenkomen met ElementSw.
Instellingen: 1–8, 9–16, ..., 121–128 (tot aan de instelling Element Count)

Stelt de veranderingscurve van de parameterset in op Destination.
De horizontale as vertegenwoordigt de regelaarwaarde die is ingesteld in Source terwijl de verticale
as de parameterwaarde vertegenwoordigt die is ingesteld in Destination.
Instellingen: Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw,

Triangle, Square, Trapezoid, Tilt Sine, Bounce, Resonance, Sequence, Hold, Harmonic,
Steps, User 1–32 (wanneer een gebruikersbank is geselecteerd), Library 1–16 (wanneer
een bibliotheekbestand is geladen)

Destination

Source

Element Sw (Element Switch) 1–128

Display Element

Curve Type
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Past de curvevorm aan.
Deze instelling is mogelijk, afhankelijk van het curvetype, niet beschikbaar.

Param 1 (Curve Parameter 1)
Param 2 (Curve Parameter 2)

Destination to Name
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Kopieert de parameters die zijn ingesteld op Destination naar Display Name.
Deze parameter wordt niet weergegeven als Source is ingesteld op iets anders dan AsgnKnob 1–8.

Opent het instellingenscherm voor de gebruikerscurve.
U kunt een lineaire curve met acht punten of een curve met acht stappen maken.

Opent het scherm Control Assign voor Common Edit.

Verwijdert de geselecteerde Destination.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Mod/Control → After Touch

Selecteert de modus voor het verzenden van Aftertouch-berichten van het toetsenbord naar de
interne toongenerator.
Deze parameter is ingesteld op Channel op de MONTAGE M6 en MONTAGE M7, ongeacht de
instelling hier.
Instellingen: Poly (polyfone aftertouch), Channel (kanaal aftertouch)

Stelt de parameter voor de bestemming in. Door op het pictogram [+] te tikken, kunt u een nieuwe
bestemming toevoegen.

Kan niet worden gewijzigd vanuit dit scherm.
Deze parameter is vast ingesteld op Poly AT.

Edit User Curve

Edit Common Control Assign

Delete

After Touch

Keyboard AT Mode (After Touch Mode)

Destination

Source
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U kunt de regelaarinstelling voor elk element in- of uitschakelen.
Deze parameter wordt alleen weergegeven als de geselecteerde Destination gerelateerd is aan
elementen.
Wanneer de ExElemSw op het scherm General/Pitch - ElementSettings is ingesteld op On, kunt u het
schakelaarnummer wijzigen door het Display Element te wijzigen.
Het daadwerkelijke bereik van getallen dat u in de schakelaar kunt gebruiken, hangt af van de
waarde die is ingesteld in ElementCount op het scherm General/Pitch - ElementSettings.
Instellingen: Off, On

Wordt alleen weergegeven als ExElemSw op het scherm General/Pitch - ElementSettings is
ingesteld op On.
U kunt een andere groep van acht elementen selecteren die overeenkomen met ElementSw.
Instellingen: 1–8, 9–16, ..., 121–128 (tot aan de instelling Element Count)

Stelt de veranderingscurve van de parameterset in op Destination.
De horizontale as vertegenwoordigt de regelaarwaarde die is ingesteld in Source terwijl de verticale
as de parameterwaarde vertegenwoordigt die is ingesteld in Destination.
Instellingen: Standard, Sigmoid, Threshold, Bell, Dogleg, FM, AM, M, Discrete Saw, Smooth Saw,

Triangle, Square, Trapezoid, Tilt Sine, Bounce, Resonance, Sequence, Hold, Harmonic,
Steps, User 1–32 (wanneer een gebruikersbank is geselecteerd), Library 1–8 (wanneer
een bibliotheekbestand is geladen)

Element Sw (Element Switch) 1-128

Display Element

Curve Type
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Stelt de polariteit in van de curve die is ingesteld in Curve Type.
Instellingen: Uni, Bi

Uni: parameterwijzigingen vinden alleen plaats binnen het positieve bereik of het negatieve
bereik, afhankelijk van de curvevorm.
Bi: parameterwijzigingen vinden zowel in positieve als in negatieve bereiken plaats,
afhankelijk van de vorm van de curve.

Polarity (Curve Polarity)
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Stelt de verhouding van de parameterwaarden in.
Instellingen: −64−+63

Opent het instellingenscherm voor de gebruikerscurve.
U kunt een lineaire curve met acht punten of een curve met acht stappen maken.

Verwijdert de huidige Destination.

In het scherm Tx/Rx Switch kunt u de schakelaar voor het verzenden of ontvangen van MIDI-
berichten (zoals Control Change) aan- of uitzetten.

OPMERKING
Als CC (Control Change) is ingesteld op Off, kunnen de parameters die verband houden met Control Change-
berichten niet worden ingesteld.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Mod/Control → Tx/Rx Switch

Toont de verzendschakelaar.
Deze parameter is alleen beschikbaar als Part Mode is ingesteld op External of als Keyboard Sw is
ingesteld op Off.

Deze parameter is alleen beschikbaar als Part Mode is ingesteld op Internal.

Ratio (Curve Ratio)

Edit User Curve

Delete

Tx/Rx Switch

Transmit Sw (Transmit Switch)

Receive Sw (Receive Switch)

Keyboard Sw (Keyboard Control Switch)
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Keyboard Control wordt gebruikt voor het selecteren van partijen die op het toetsenbord moeten
worden gespeeld.
Als Keyboard Control op On staat, kunt u tegelijkertijd partijen bespelen waarvoor Keyboard Control
is ingesteld op On, als de partij is ingesteld op Common of als Keyboard Control voor de partij is
ingesteld op On.
Als Keyboard Control is ingesteld op Off, kunt u de partij alleen op het toetsenbord spelen als die
partij is geselecteerd.
Instellingen: Off, On

Stelt het kanaal in voor het verzenden en ontvangen van MIDI-berichten wanneer Part Mode is
ingesteld op Internal.
Instellingen: Ch1–Ch16, Off

Toont het kanaal voor het verzenden en ontvangen van MIDI-berichten.

Stelt het kanaal in voor het ontvangen van MIDI-berichten wanneer Part Mode is ingesteld op
External.

Hierdoor wordt het scherm met zone-instellingen opgeroepen.
Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via [EDIT/ ] →
General/Pitch → Zone Settings.

Zet de verzending en ontvangst van programmawijzigingsberichten aan of uit.
Instellingen: Off, On

Zet de verzending en ontvangst van bankselectie MSB- en LSB-berichten aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-pitchbendberichten aan of uit.
Instellingen: Off, On

Zet de verzending en ontvangst van kanaalaftertouch aan of uit.
Instellingen: Off, On

Zet de verzending en ontvangst van polyfone aftertouch aan of uit.

Tx/Rx Channel (Transmit/Receive Channel)

MIDI I/O Ch. (MIDI In-Out Channel)

Transmit Ch.

Zone Settings

PC (Program Change)

BankSelect (Bank Select)

Pitch Bend

CAT (Channel After Touch)

PAT (Polyphonic After Touch)
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Instellingen: Off, On

Zet de verzending en ontvangst van regelaarwijzigingsberichten aan of uit.
Instellingen: Off, On

Zet de verzending en ontvangst van de volume-instelling aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van de pan-instelling aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-modulatiewielberichten aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI Sustain- en Sostenuto-berichten aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-berichten voor de afzonderlijk verkrijgbare voetregelaars
aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-berichten voor de afzonderlijk verkrijgbare voetschakelaars
aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-berichten voor de knoppen [ASSIGN 1] en [ASSIGN 2] aan
of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

CC (Control Change)

Vol/Exp (Volume/Expression)

Pan

MW (Modulation Wheel)

Sustain

FC1 (Foot Controller 1)
FC2 (Foot Controller 2)

FS (Foot Switch)

A. Sw 1 (Assignable Function Switch 1)
A. Sw 2 (Assignable Function Switch 2)
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Zet de verzending en ontvangst van MIDI-berichten voor de knop [MSEQ TRIGGER] aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-lintregelaarberichten aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-ademregelaarberichten aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-berichten voor de knop [PORTAMENTO] aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-berichten voor de knop PORTAMENTO [TIME] aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Zet de verzending en ontvangst van MIDI-pitchbendberichten voor knoppen 1 t/m 8 aan of uit.
Deze parameter is niet beschikbaar als CC (Control Change) is ingesteld op Off.
Instellingen: Off, On

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Mod/Control → Control Settings

MS Trigger (Motion Sequencer Trigger)

RB (Ribbon Controller)

BC (Breath Controller)

Porta Sw (Portamento Switch)

Porta Time (Portamento Time)

A. Knob 1–8 (Assignable Knob)

Control Settings
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Stelt de richting van de schuifregelaars 1 t/m 8 in voor deze partij als de schuifregelaarmodus is
ingesteld op ELEM/OP/OSC.
Als die is ingesteld op Reverse, veranderen de volumeregelaars op het scherm in
orgelschuifregelaars. De orgelschuifregelaars worden weergegeven als u een partij selecteert en de
View Mode instelt op Part Info.
Instellingen: Normal (omhoog vanaf beneden), Reverse (omlaag vanaf boven)

In het scherm Part LFO kunt u instellingen definiëren voor de Part LFO.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Mod/Control → Part LFO

Selecteert de LFO-golfvorm en stelt het type cyclische veranderingen in de LFO's in.
Instellingen: Triangle, Triangle+, Saw Up, Saw Down, Squ1/4, Squ1/3, Square, Squ2/3, Squ3/4,

Trapezoid, S/H1, S/H2, User

Slider Direction

Part LFO

LFO Wave

Edit User LFO
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Opent het instellingenscherm voor de gebruikers-LFO.
U kunt een LFO-golfvorm van maximaal 16 stappen creëren.

Stelt de snelheid in van de LFO Wave-wijzigingen, zodat deze worden gesynchroniseerd met het
afspelen van arpeggio's of songs.
Instellingen: Off (niet gesynchroniseerd), On (gesynchroniseerd)

Stelt de snelheid van LFO Wave-wijzigingen in.
Deze parameter is niet beschikbaar als Tempo Sync is ingesteld op On.
Instellingen: 0−63

Verandert de LFO Speed willekeurig.
Deze parameter is niet beschikbaar als Tempo Sync is ingesteld op On.
Instellingen: 0−127

Deze parameter is niet beschikbaar wanneer Tempo Sync is ingesteld op On. U kunt de snelheid
van veranderingen in LFO Wave synchroniseren door muzieknootwaarden te gebruiken.
Instellingen: 1/16 (zestiende noten), 1/8 Tri. (achtstenoottriolen), 1/16 Dot. (gepunteerde

zestiende noten), 1/8 (achtste noten), 1/4 Tri. (kwartnoottriolen), 1/8 Dot. (gepunteerde
achtste noten), 1/4 (kwartnoten), 1/2 Tri. (halve-noottriolen), 1/4 Dot. (gepunteerde
kwartnoten), 1/2 (halve noten), Whole Tri. (hele-noottriolen), 1/2 Dot. (gepunteerde halve
noten), 1/4 x 4 (groepen van vier kwartnoten; vier kwartnoten per tel), 1/4 x 5 (groepen
van vijf kwartnoten; vijf kwartnoten per tel), 1/4 x 6 (groepen van zes kwartnoten; zes
kwartnoten per tel), 1/4 x 7 (groepen van zeven kwartnoten; zeven kwartnoten per tel),
1/4 x 8 (groepen van acht kwartnoten; acht kwartnoten per tel), 1/4 x 16 (zestien
kwartnoten per tel), 1/4 x 32 (32 kwartnoten per tel), 1/4 x 64 (64 kwartnoten per tel)

Stelt de vertragingstijd in tussen het moment waarop u een toets op het toetsenbord aanslaat en het
moment waarop de LFO actief wordt.
Hoe hoger de waarde, hoe langer de vertragingstijd, ofwel de tijd die verstrijkt voordat de LFO in
werking treedt.
Instellingen: 0−127

Stelt in na hoeveel tijd het LFO-effect gaat infaden nadat de vertragingstijd die is ingesteld in Delay
(LFO Delay Time) is verstreken.
Instellingen: 0−127

Hoe hoger de waarde, hoe langer het duurt voordat het LFO-effect het maximum bereikt.

Tempo Sync (LFO Tempo Sync)

Wanneer Tempo Sync is ingesteld op Off

Speed (LFO Speed)

Random Speed (Part LFO Random Speed Depth)

Wanneer Tempo Sync is ingesteld op On

Tempo Speed (LFO Tempo Speed)

Delay (LFO Delay Time)

Fade In (LFO Fade In Time)
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0: LFO verandert naar de maximale waarde zonder enige fade-in.

Lage waarde: snelle fade-in

Hoge waarde: langzame fade-in

Stelt de tijd in voor het behouden van het LFO-effect nadat het maximale niveau is bereikt.
Instellingen: 0–126, Hold

Hold: geen fade-out

Stelt in na hoeveel tijd het LFO-effect gaat uitfaden nadat de aanhoudduur die is ingesteld in Hold
(LFO Hold Time) is verstreken.
Hoe hoger de waarde, hoe langer het duurt voordat het LFO-effect uitfadet.
Instellingen: 0−127

Hold (LFO Hold Time)

Fade Out (LFO Fade Out time)
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Lage waarde: snelle fade-out

Hoge waarde: langzame fade-out

Zet de oscillatie van de LFO terug wanneer een toets wordt ingedrukt.
Instellingen: Off, Each-on, 1st-on

Zet de oscillatie van de LFO niet terug. Als op
een toets wordt gedrukt, wordt de LFO-golf
gestart, ongeacht de fase waarin de LFO zich
op dat moment bevindt.

Key On Reset (LFO Key On Reset)

Off
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Zet de oscillatie van de LFO telkens terug
wanneer een toets wordt ingedrukt en start de
golfvorm in de fase die is gespecificeerd door
de Phase-parameter.

Zet de oscillatie van de LFO telkens terug
wanneer een toets wordt ingedrukt en start de
golfvorm in de fase die is gespecificeerd door
de Phase-parameter.

Wanneer een tweede noot wordt gespeeld
terwijl de eerste noot wordt vastgehouden,
wordt het afspelen niet teruggezet.

Stelt de LFO Wave in op afspelen in een lus (herhaald) of one-shot (eenmalig) afspelen.
Instellingen: Off, On

U kunt de beginfase instellen voor de tijd dat LFO Wave wordt teruggezet.
Instellingen: 0°, 90°, 120°, 180°, 240°, 270°

Stelt de offsetwaarde in op Phase voor elk element.
Instellingen: 0°, 90°, 120°, 180 °, 240°, 270°

Each-on

1st-on

Loop (LFO Loop Switch)

Phase (LFO Phase)

Element Phase Offset (LFO Element Phrase Offset)
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Wordt alleen weergegeven als ExElemSw op het scherm General/Pitch - ElementSettings is
ingesteld op On.
U kunt een ander getal selecteren voor de groep van vier elementen die overeenkomen met de
ElementPhaseOffset en ElementDepthRatio.
Instellingen: 1–8, 9–16, ..., 121–128 (tot aan de instelling Element Count)

Dit wordt opgegeven als offsetwaarde voor de Phase (LFO Phase) voor elk element.
U kunt de beginfase instellen voor elk element als LFO Wave wordt teruggezet.
Wanneer de ExElemSw op het scherm General/Pitch - ElementSettings is ingesteld op On, kunt u het
elementnummer wijzigen door het Display Element te wijzigen.
Het daadwerkelijke bereik van getallen dat u voor Element Phase Offset kunt gebruiken, hangt af van
de waarde die is ingesteld in ElementCount in het scherm General/Pitch - ElementSettings.

Stelt de functie in die moet worden geregeld door de LFO Wave.
Instellingen: Insertion Effect A Parameter 1–24, Insertion Effect B Parameter 1–24, Level, Pitch,

Cutoff, Resonance, Pan, E.LFO Speed

Stelt de diepte in van de LFO Wave-regelaar voor elke Destination.
Instellingen: 0−127

Past de diepte van elk element aan.
Stel deze parameter in op Off om de LFO uit te schakelen.
Deze parameter wordt alleen weergegeven als de geselecteerde Destination gerelateerd is aan
elementen.
Wanneer de ExElemSw op het scherm General/Pitch - ElementSettings is ingesteld op On, kunt u het
elementnummer dat is ingesteld op Depth wijzigen door het Display Element te wijzigen.
Het daadwerkelijke bereik van getallen dat u voor de diepte kunt gebruiken, hangt af van de waarde
die is ingesteld in ElementCount in het scherm General/Pitch - ElementSettings.
Instellingen: Off, 0−127

Opent het instellingenscherm voor de gebruikers-LFO.
U kunt een LFO-golfvorm van maximaal 16 stappen creëren.

Display Element

Element Phase Offset (LFO Element Phase Offset)

Destination (LFO Destination)

Depth (LFO Depth)

Element Depth Ratio (LFO Element Depth Ratio)

User LFO Edit
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Stelt het aantal LFO-stappen in.
Instellingen: 2 steps, 3 steps, 4 steps, 6 steps, 8 steps, 12 steps, 16 steps

Stelt de wijzigingen in de helling in van de golfvorm die momenteel op het scherm wordt
weergegeven.
Instellingen: Off (geen helling), Up, Down, Up&Down

Stelt de waarde voor elke stap in.
Instellingen: −64−+63

Selecteert de sjabloon voor de LFO-golfvorm.

Cycle

Slope

User LFO Step Value

Template
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om02screenparameters0090

Inhoudsopgave

Op het scherm Osc/Tune kunt u de oscillator voor het element instellen.
Hier kunt u de golfvorm selecteren die als basis voor het geluid wordt gebruikt en het toetsbereik en
aanslagbereik van het element instellen.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Osc/Tune

Element Edit

Osc/Tune

Waveform Edit

Pitch EG

Filter

Type

Filter EG

Scale

Amplitude

Level/Pan

Amp EG

Scale

Element EQ

Element LFO

Osc/Tune (Oscillator/Tune)
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Zet het geselecteerde element aan of uit.
Instellingen: Off, On

Toont de naam van de golfvorm die voor het element is geselecteerd.
Bank geeft aan welk type golfvorm (Preset, User en Library) wordt toegewezen aan het element.
Instellingen: Raadpleeg de Data List.

XA (Expanded Articulation) is een functie voor het creëren van realistische geluiden zoals die op
akoestische instrumenten, en voor het creëren van nieuwe synthesizergeluiden.
U kunt dergelijke geluiden creëren door de XA Control in te stellen op de manier waarop het element
wordt gespeeld.

OPMERKING
De knoppen [ASSIGN 1] en [ASSIGN 2] kunnen worden ingesteld op On of Off door het Control Change number
dat is ingesteld in Control → Control Number van het scherm Common Audio Edit vanaf een extern apparaat te
verzenden.

Instellingen: Normal, Legato, Key Off, Cycle, Random, A.Sw1 On, A.Sw2 On, A.Sw Off
Normal: wordt afgespeeld als een normaal element.
Legato: wordt afgespeeld wanneer Mono/Poly is ingesteld op Mono. Als u in legato speelt,
wordt het element dat is ingesteld op Legato afgespeeld in plaats van het element dat is
ingesteld op Normal.
Key Off: wordt afgespeeld wanneer een vinger van de toets wordt gehaald.

Element Switch

Waveform Select

Bank (Waveform Bank)
Number (Waveform Number)
Category (Waveform Category)
Sub Category (Waveform Sub Category)
Name (Waveform Name)

XA Control

Voorbeeld van XA Control-instelling

Een vloeiende legato creëren
Laat het element wisselen tussen één element met XA Control ingesteld op Normal en nog een
element waarbij de XA Control is ingesteld op Legato.

Geluiden produceren wanneer de vingers van de toetsen worden gehaald
Een element maken met XA Control ingesteld op Key Off.

Willekeurigheid creëren voor dezelfde noot
Maak het element met XA Control ingesteld op Cycle en een ander element met XA Control
ingesteld op Random.

Geluiden produceren die uniek zijn voor akoestische instrumenten
Enkele voorbeelden van geluid dat uniek is voor akoestische instrumenten zijn boventonen en
handpalmdemping op de gitaar, tongslag op de fluit en grommen op de saxofoon.
Stel een element in met XA Control ingesteld op A.Sw1 On of A.Sw2 On of A.Sw Off, en bediening
via de knoppen [ASSIGN 1] en [ASSIGN 2] op het bovenpaneel.
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Cycle: wordt afgespeeld als er een reeks elementen is ingesteld in Cycle.
Random: speelt de elementen willekeurig af als meerdere elementen zijn ingesteld op
Random.
A.Sw Off: wordt afgespeeld als zowel de knoppen [ASSIGN 1] als [ASSIGN 2] is ingesteld
op Off.
A.Sw1 On: wordt afgespeeld als de knop [ASSIGN 1] is ingesteld op On.
A.Sw2 On: wordt afgespeeld als de knop [ASSIGN 2] is ingesteld op On.

Deze parameter is bedoeld om elementen met dezelfde XA Control-instelling in groepen te sorteren.
Wanneer XA Control van alle elementen is ingesteld op Normal, heeft deze instelling geen effect.
Instellingen: 1-8

Stelt de uitvoer van het element in op invoegeffect A of invoegeffect B.
Als u dit instelt op Thru worden de invoegeffecten omzeild.
Instellingen: Thru, InsA, InsB

Laadt het audiobestand dat als golfvorm op het USB-flashstation is opgeslagen.
Edit Waveform verschijnt wanneer een golfvorm is geladen.

Opent het scherm Waveform Edit.

Verschuift de toonhoogte van het element in halve tonen.
Instellingen: -48-+48

Past de toonhoogte van het element nauwkeurig aan.
Instellingen: -64-63

Stelt in hoe de toonhoogteverandering reageert op de snelheid of de kracht van de toetsaanslag.
Instellingen: -64-63

Positieve waarde: hogere snelheidswaarden produceren een hogere toonhoogte.
Negatieve waarde: hogere snelheidswaarden produceren een lagere toonhoogte.
0: geen verandering in toonhoogte.

Stelt in hoe de toonhoogteverandering in de fijnstemming reageert op de positie van de toets.
Instellingen: -64-63

Positieve waarden: de toonhoogte gaat omlaag als u een toets in de bassectie indrukt, en
de toonhoogte gaat omhoog als u een toets in de treblesectie indrukt.

Elem Group (Element Group Number)

Elem Connect (Element Connection Switch)

New Waveform

Edit Waveform

Coarse (Course Tune)

Fine (Fine Tune)

Pitch/Vel (Pitch Velocity Sensitivity)

Fine/Key (Fine Tune Key Follow Sensitivity)
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Negatieve waarden: de toonhoogte gaat omhoog als u een toets in de bassectie indrukt,
en de toonhoogte gaat omlaag als u een toets in de treblesectie indrukt.

Verandert de toonhoogte van het element willekeurig telkens wanneer een toets wordt ingedrukt.
Stel de parameter in op een hogere waarde om meer toonhoogteveranderingen te creëren. Als de
waarde op 0 wordt ingesteld, blijft de toonhoogte ongewijzigd.
Instellingen: 0-127

Stelt het uitgangsniveau van de oscillator zo in dat deze lager wordt naarmate de
aanslagsnelheidswaarden verder afwijken van de waarde die is ingesteld in Velocity Limit.
Als deze op 0 staat, wordt er geen geluid geproduceerd als de snelheid buiten de Velocity Limit ligt.
Hoe hoger de waarde, hoe geleidelijker het uitgangsniveau van de oscillator afneemt.
Instellingen: 0-127

(1) Als een grotere waarde wordt gebruikt, wordt de helling
naar links verschoven.

(2) Als Vel Cross Fade op 0 staat, wordt er geen geluid
geproduceerd buiten de Velocity Limit.

Stelt de timing in van de Key On Delay zodat deze synchroniseert met het tempo.
Instellingen: Off, On

Stelt de vertragingstijd in vanaf het moment dat de toets wordt ingedrukt tot het moment dat er geluid
wordt geproduceerd.
Deze parameter is niet beschikbaar wanneer Tempo Sync is ingesteld op On.
Instellingen: 0-127

Deze parameter is niet beschikbaar wanneer Tempo Sync is ingesteld op On. U kunt de timing voor
Key On Delay instellen met behulp van muzieknoten.

Random (Random Pitch Depth)

Vel Cross Fade (Velocity Cross Fade)

Als Level/Vel is ingesteld op +0

Tempo Sync (Key On Delay Tempo Sync Switch)

Length (lengte van Key On Delay Time)

Length (Key On Delay Note Length)
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Instellingen: 1/16 (zestiende noten), 1/8 Tri. (achtstenoottriolen), 1/16 Dot. (gepunteerde zestiende
noten), 1/8 (achtste noten), 1/4 Tri. (kwartnoottriolen), 1/8 Dot. (gepunteerde achtste
noten), 1/4 (kwartnoten), 1/2 Tri. (halve-noottriolen), 1/4 Dot. (gepunteerde kwartnoten), 1/2
(halve noten), Whole Tri. (hele-noottriolen), 1/2 Dot. (gepunteerde halve noten), 1/4 x 4
(groepen van vier kwartnoten; vier kwartnoten per tel), 1/4 x 5 (groepen van vijf kwartnoten;
vijf kwartnoten per tel), 1/4 x 6 (groepen van zes kwartnoten; zes kwartnoten per tel), 1/4 x
7 (groepen van zeven kwartnoten; zeven kwartnoten per tel), 1/4 x 8 (groepen van acht
kwartnoten; acht kwartnoten per tel)

Stelt het aanslagbereik (laagste en hoogste waarden) in voor het afspelen van de elementgolf.
Als dit zo is ingesteld dat de hogere waarde als eerste is en de lagere waarde als tweede
(bijvoorbeeld 93 tot 34), worden de elementgeluiden alleen afgespeeld met aanslagsnelheden van 1
tot 34 en 93 tot 127.
Instellingen: 1-127

Stelt het notenbereik (laagste en hoogste noten) in voor het element.
Als de eerst opgegeven noot hoger is dan de tweede (bjjvoorbeeld C5 tot C4), wordt het element
afgespeeld in de bereiken C-2 tot C4 en C5 tot G8.
Instellingen: C-2-G8

Stelt de referentienoot in voor Pitch/Key (Pitch Key Follow Sensitivity).
De toets die hier is ingesteld met het nootnummer wordt gespeeld op de normale toonhoogte,
ongeacht de instelling voor Pitch/Key.
Instellingen: C-2-G8

Stelt het verschil in toonhoogte in tussen twee naast elkaar liggende toetsen. Het referentiepunt is de
toets die is opgegeven in Center Key.
Deze parameter is handig voor het spelen van ongetoonde geluiden, zoals speciale effecten, of voor
het bespelen van een percussie-instrument als een normale partij, of voor andere gevallen waarin het
toonhoogteverschil niet in halve tonen hoeft te liggen.

Instellingen: -200%-+0%-+200%
+100% (normale instelling): het toonhoogteverschil tussen de twee toetsen naast elkaar
wordt ingesteld op een halve toon.
0%: er is geen toonhoogteverschil tussen de twee toetsen en alle toetsen worden gespeeld
op de toonhoogte die is ingesteld in Center Key.
Negatieve waarde: stelt een tegengestelde toonhoogterespons in, zodat lagere noten
resulteren in een hogere toonhoogte, en hogere noten resulteren in een lagere toonhoogte.

Velocity Limit

Note Limit

Center Key (Pitch Key Follow Sensitivity Center Key)

Pitch/Key (Pitch Key Follow Sensitivity)

Pitch/Key en Center Key
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A: Lagere noten
B: Center Key
C: Hogere noten
D: Verschil in toonhoogte
E: Wanneer Pitch/Key (Pitch Key Follow Sensitivity) is ingesteld
op +100%.
F: Hoger
G: Lager

Opent het scherm Waveform Edit.
Hier kunt u de verschillende keybanks instellen waaruit een golfvorm bestaat.

Een keybank bestaat uit digitale data die bestaan uit een kort audiosegment, zoals zang of andere
geluiden, die in het instrument zijn geladen. Het heeft dezelfde kenmerken als een wav-bestand.
Om verwarring te voorkomen, wordt echter een andere naam gebruikt om deze te onderscheiden
van de golfvorm.

Keybanks worden altijd opgeslagen als onderdeel van een golfvorm.
Eén golfvorm kan meerdere keybanks bevatten. U kunt bijvoorbeeld zelfs enkele tientallen
keybanks in één golfvorm opslaan. Als u meerdere keybanks in één golfvorm opslaat, kunt u voor
elke keybank een toetsbereik en aanslagbereik toewijzen door de Note Limit en Velocity Limit op te
geven. Door meerdere keybanks in te stellen, kunt u verschillende keybankgeluiden spelen,
afhankelijk van het gedeelte van het toetsenbord dat u gebruikt en de sterkte van uw toetsaanslag.

Voorbeeld van de set-up van een keybank en golfvorm

Waveform Edit

Key Banks

Keybanks en golfvormen
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Een golfvorm moet in een partij worden geladen voordat deze kan worden afgespeeld.
U kunt een golfvorm toewijzen aan een AWM2-partij vanuit Element Edit in Part Edit (AWM2), of
aan een drumpartij vanuit Key Edit in Drum Part Edit (AWM2).

Toont de naam van de geselecteerde golfvorm.

Stelt de hoofd- en subcategorie van de geselecteerde Waveform in.
Instellingen: Raadpleeg de Data List.

U kunt de golfvorm die u bewerkt onder een nieuwe naam opslaan. Deze naam mag uit maximaal 20
alfanumerieke tekens bestaan. Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen,
zodat u een naam kunt invoeren.

Toont het aantal keybanks in de golfvorm en de totale omvang van de datacapaciteit.

Partijen en golfvormen

Waveform

Category (Waveform Category)
Sub Category (Waveform Sub Category)

Name (Waveform Name)

Total
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Toont het keybanknummer.

Toont de totale omvang van de datacapaciteit.

Toont of de keybank stereo of mono is.

Stelt het aanslagbereik (laagste en hoogste waarden) in voor het afspelen van de keybank.
Instellingen: 1-127

Stelt het notenbereik (laagste en hoogste noten) in voor het afspelen van de keybank.
Instellingen: 1-127

Stelt de toets (toonhoogte) van de originele golfvormdata in.
Instellingen: C-2-G8

Stelt het volume van de keybank in.
Instellingen: 0-255

Stelt de pan-positie (in het stereoveld) van de keybank in.
Instellingen: L63 (links)–C (center)–R63 (rechts)

Verschuift de toonhoogte van de geselecteerde keybank in halve noten.
Instellingen: -64-+63

Voor fijne aanpassing van de toonhoogte van de keybank.
Instellingen: -64-+63

Verwijdert de keybank.

Voegt een keybank to aan de golfvorm.

Keybank (Keybank Number)

Size (Keybank Size)

Channel (Keybank Channel)

Velocity Limit

Note Limit

Center Note

Volume

Pan

Tune Coarse (Coarse Tune)

Tune Fine (Fine Tune)

Delete Keybank

Add Keybank

Pitch EG
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In het scherm Pitch EG kunt u de envelopegenerator voor de oscillator instellen.
Door de tijd en het niveau (de hoeveelheid verandering in toonhoogte) van de PEG (Pitch Envelope
Generator) in te stellen, kunt u instellen hoe het geluid verandert vanaf het moment dat u een toets
op het toetsenbord indrukt tot het moment waarop het geluid wegsterft.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Pitch EG

Stelt de tijdsduur in die nodig is om de toonhoogte op Hold Level te houden vanaf het moment dat u
een toets op het toetsenbord indrukt.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat de toonhoogte verandert vanaf het einde van de Hold Time
tot de Attack Level.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat de toonhoogte verandert vanaf de Attack Level tot de Decay
1 Level.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat de toonhoogte verandert vanaf de Decay 1 Level tot de
Decay 2 Level.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat de toonhoogte verandert vanaf het moment dat u de toets
loslaat totdat de Release Level wordt bereikt.
Instellingen: 0-127

Hold Time (PEG Hold Time)

Attack Time (PEG Attack Time)

Decay1 Time (PEG Decay 1 Time)

Decay2 Time (PEG Decay 2 Time)

Release Time (PEG Release Time)
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Stelt het toonhoogteniveau in voor het moment dat u de toets indrukt.
Instellingen: -128-+127

Stelt de toonhoogte in die verandert vanaf de Hold Level of vanaf het moment dat u een toets indrukt.
Instellingen: -128-+127

Stelt de volgende toonhoogtewaarde in die moet veranderen vanaf de Attack Level.
Instellingen: -128-+127

Stelt de volgende toonhoogtewaarde in die moet veranderen vanaf de Decay 1 Level.
Instellingen: -128-+127

Stelt de uiteindelijke toonhoogte in die moet worden bereikt nadat u de toets hebt losgelaten.
Instellingen: -128-+127

Stelt de referentienoot (of een toets die moet worden ingedrukt) in voor Time/Key.
Met de hier ingestelde noot (toets) wordt het resulterende geluid van de in PEG ingestelde
toonhoogteverandering gespeeld.
Instellingen: C-2-G8

Stelt in hoe de toonhoogtesnelheid van de PEG reageert op de positie van de toets.
De snelheidsverandering in PEG wordt gebruikt voor de opgegeven toets in Center Key.
Instellingen: -64-+63

Positieve waarde: hoe hoger de toets wordt ingedrukt, hoe sneller de toonhoogte van de
PEG verandert.
Negatieve waarde: hoe hoger de toets wordt ingedrukt, hoe langzamer de toonhoogte van
de PEG verandert.
0: geen PEG-veranderingen, ongeacht de toetspositie.

Hold Level (PEG Hold Level)

Attack Level (PEG Attack Level)

Decay1 Level (PEG Decay 1 Level)

Decay2 Level (PEG Decay 2 Level)

Release Level (PEG Release Level)

Center Note (PEG Time Key Follow Sensitivity Center Note)

Time/Key (PEG Time Key Follow Sensitivity)

Time/Key en Center Note
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A: Center Note
B: Langzaam
C: Snel
D: Lage toets
E: Hoge toets
F: Positieve waarde
G: Negatieve waarde

Stelt in hoe de snelheid van de toonhoogteverandering van de PEG reageert op de snelheid of de
kracht van de toetsaanslag.
Stel eerst de tijdswaarde in Segment in en stel vervolgens de aanslaggevoeligheidswaarde in
Time/Vel in.
Instellingen: Time/Vel: -64-+63

Positieve waarde: hoe sneller de aanslag, hoe sneller de veranderingen in de PEG.
Negatieve waarde: hoe sneller de aanslag, hoe langzamer de veranderingen in de PEG;
lage snelheden resulteren in snellere PEG-veranderingen.
0: geen PEG-veranderingen, ongeacht de aanslaginstelling.

Hoge snelheid (toonhoogteverandering is snel) Lage snelheid (toonhoogteverandering is
langzaam)

Time/Vel (PEG Time Velocity Sensitivity)
Segment (PEG Time Velocity Sensitivity Segment)
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Instellingen: Segment: Attack, Atk+Dcy, Decay, Atk+Rls, All
Attack: de Time/Vel-waarde is van invloed op Attack Time
Atk+Dcy: de Time/Vel-waarde beïnvloedt de Attack Time en Decay 1 Time.
Decay: de Time/Vel-waarde beïnvloedt de Decay Time.
Atk+Rls: de Time/Vel-waarde beïnvloedt de Attack Time en Release Time.
All: de Time/Vel-waarde beïnvloedt de tijdgerelateerde instellingen in PEG.

Stelt het dieptebereik in van toonhoogteveranderingen die door de PEG worden geregeld.
Instellingen: -64-+63

0: geen verandering van toonhoogte.
Hoe verder de diepte verwijderd is van een waarde van 0, hoe groter de verandering in
toonhoogte wordt.
Negatieve waarde: toonhoogteverandering is omgekeerd.

Stelt in hoe het dieptebereik van de toonhoogteverandering die wordt geregeld door de PEG reageert
op de snelheid of de kracht van de toetsaanslag.
Met de Curve-instelling kunt u ook instellen hoe de PEG Depth op de snelheid reageert. De verticale
as vertegenwoordigt de snelheid, terwijl de horizontale as het dieptebereik van de
toonhoogteveranderingen vertegenwoordigt.
Instellingen: Depth/Vel: -64-+63

Positieve waarde: hoge snelheid vergroot het dieptebereik van de PEG, terwijl lage
snelheid het dieptebereik verkleint.
Negatieve waarde: hoge snelheid verkleint het dieptebereik van de PEG, terwijl lage
snelheid het dieptebereik vergroot.
0: geen PEG-veranderingen, ongeacht de aanslaginstelling.

Hoge snelheid
(het dieptebereik bij toonhoogteverandering is

groter)

Lage snelheid
(het dieptebereik bij toonhoogteverandering is

kleiner)

Instellingen: Curve: 0-4

PEG Depth

Depth/Vel (PEG Depth Velocity Sensitivity)
Curve (PEG Depth Velocity Sensitivity Curve)

Filter

Type
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Op het scherm Type kunt u een filtertype voor het element selecteren.
Welke parameters beschikbaar zijn, is afhankelijk van het filtertype dat u hier hebt geselecteerd.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Filter → Type

Stelt het filter voor het element in.
De filters die beschikbaar zijn op dit instrument zijn gegroepeerd in vier typen: LPF, HPF, BPF en
BEF.

Instellingen: LPF24D, LPF24A, LPF18, LPF18s, LPF12+HPF12, LPF6+HPF12,
HPF24D, HPF12, BPF12D, BPFw, BPF6, BEF12, BEF6, DualLPF, DualHPF, DualBPF,
DualBEF, LPF12+BPF6, Thru

Dit filtertype kapt de signalen af boven de waarde die is ingesteld bij Cutoff Frequency.
Het geluid wordt helderder naarmate u de afsnijfrequentie verhoogt, omdat er meer hoogfrequente
signalen door het filter worden doorgelaten. Omgekeerd wordt het donkerder naarmate u de
afsnijfrequentie verlaagt, omdat meer hoogfrequente signalen door het filter worden afgekapt of
geblokkeerd. U kunt een karakteristiek 'scherp' geluid produceren door de Resonance te verhogen
zodat het signaalniveau wordt versterkt in de buurt van de afsnijfrequentie.
Dit filtertype is heel populair en handig voor het produceren van klassieke synthesizergeluiden.

Filter Type

LPF
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LPF24D: een dynamisch -24 dB/oct laagdoorlaatfilter met een karakteristiek digitaal geluid. In
vergelijking met het LPF24A-type kan dit filter een meer uitgesproken resonantie-effect produceren.

LPF24A: een digitaal dynamisch laagdoorlaatfilter met karakteristieken die lijken op die van een 4-
polig analoog synthesizerfilter.
LPF18: 3-polig -18 dB/oct laagdoorlaatfilter.
LPF18s: 3-polig -18 dB/oct laagdoorlaatfilter. Dit filter heeft een vloeiendere afsnijhelling dan het
LPF18-type.

Dit filtertype laat alleen signalen boven de afsnijfrequentie door.
U kunt een karakteristiek 'scherp' geluid produceren door de Resonance te verhogen zodat het
signaalniveau wordt versterkt in de buurt van de afsnijfrequentie.

LPF12+HPF12: een combinatie van een -12 dB/oct laagdoorlaatfilter en een -12 dB/oct
hoogdoorlaatfilter, serieel aangesloten. Als dit filtertype is geselecteerd, kunnen HPF Cutoff en HPF
Key Follow Sensitivity worden ingesteld.
LPF6+HPF12: een combinatie van een -6 dB/oct laagdoorlaatfilter en een -12 dB/oct
hoogdoorlaatfilter, serieel aangesloten. Als dit filtertype is geselecteerd, kunnen HPF Cutoff en HPF
Key Follow Sensitivity worden ingesteld.
HPF24D: een dynamisch -24 dB/oct hoogdoorlaatfilter met een karakteristiek digitaal geluid. Dit filter
kan een uitgesproken resonantie-effect produceren.

HPF
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HPF12: -12 dB/oct dynamisch hoogdoorlaatfilter.

Dit filtertype laat alleen signalen door voor een specifieke frequentieband (afsnijfrequentie) en
snijdt alle andere signalen af.

BPF12D: de combinatie van een -12 dB/oct hoog- en laagdoorlaatfilter met een karakteristiek digitaal
geluid.

BPFw: een -12 dB/oct banddoorlaatfilter dat hoogdoorlaatfilters en laagdoorlaatfilters combineert om
bredere bandbreedte-instellingen mogelijk te maken.

BPF
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BPF6: de combinatie van een -6 dB/oct hoogdoorlaat- en laagdoorlaatfilter.

Het Band-Eliminate-filter heeft het tegenovergestelde effect op het geluid vergeleken met het
Band-Pass-filter.
Als u dit filtertype selecteert, kunt u het bereik van de afsnijfrequentie instellen waarbinnen het
geluidssignaal wordt gedempt of geëlimineerd.

BEF12: -12 dB/oct bandsperfilter.
BEF6: -6 dB/oct bandsperfilter.
DualLPF: twee -12 dB/oct laagdoorlaatfilters die parallel zijn aangesloten. U kunt de afstand tussen
de twee afsnijfrequenties aanpassen. Het resultaat van het filter wordt weergegeven op het scherm.

Lagere afsnijfrequentie wordt rechtstreeks op de display ingesteld
(en Higher Cutoff Frequency wordt automatisch ingesteld)

DualHPF: twee -12 dB/oct hoogdoorlaatfilters, parallel aangesloten.
DualBPF: twee -6 dB/oct banddoorlaatfilters, parallel aangesloten.
DualBEF: twee -6 dB/oct bandsperfilters, serieel aangesloten.

BEF
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Lagere afsnijfrequentie wordt rechtstreeks op de display ingesteld
(en Higher Cutoff Frequency wordt automatisch ingesteld)

LPF12+BPF6: een combinatie van een -12 dB/oct laagdoorlaatfilter en een -6 dB/oct
banddoorlaatfilter, parallel aangesloten. U kunt de afstand tussen de twee afsnijfrequenties
aanpassen.

Lagere afsnijfrequentie wordt rechtstreeks op de display ingesteld
(en Higher Cutoff Frequency wordt automatisch ingesteld)

Stelt de afsnijfrequentie in.
De hier ingestelde frequentie wordt gebruikt door het filter dat is ingesteld in Type.
Instellingen: 0-1023

Stelt in hoe de afsnijfrequentie reageert op de snelheid of de kracht van de toetsaanslag.
Instellingen: -64-+63

Positieve waarden: hoe sneller de aanslag, hoe hoger de afsnijfrequentiewaarde wordt.
Negatieve waarden: hoe langzamer de aanslag, hoe hoger de afsnijfrequentiewaarde
wordt.
0: geen veranderingen voor de afsnijfrequentie op basis van de aanslagsnelheid.

De hier getoonde parameter varieert afhankelijk van de instelling voor Filter Type. Resonance wordt
weergegeven voor LPF, HPF, BPF (exclusief BPFw) of BEF, en Width wordt weergegeven voor
BPFw.
Voor Resonance geeft deze parameter de sterkte van de resonantie aan. Resonantie kan worden
gebruikt in combinatie met de parameter voor Cutoff om het geluid meer karakter te geven.
Voor het BPFw wordt deze parameter gebruikt om de breedte van de frequenties aan te passen die

Cutoff (Filter Cutoff Frequency)

Cutoff/Vel (Filter Cutoff Velocity Sensitivity)

Resonance (Filter Resonance)
Width (Filter Width)
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worden doorgelaten door het filter.
Deze parameter is mogelijk, afhankelijk van het filtertype, niet beschikbaar.
Instellingen: 0-127

Stelt in hoe het resonantieniveau reageert op de snelheid of de kracht van de toetsaanslag.
Deze parameter is mogelijk, afhankelijk van het filtertype, niet beschikbaar.

Instellingen: -64-+63
Positieve waarde: hoe hoger de snelheid, hoe groter de Resonance wordt.
Negatieve waarde: hoe lager de snelheid, hoe groter de Resonance wordt.
0: de waarde voor Resonance verandert niet.

Stelt in hoe het afsnijfrequentieniveau van het filter reageert op de toetspositie.
Het referentiepunt is de afsnijfrequentie voor de toets die is ingesteld in Center Key.
Instellingen: -200%-+200%

Positieve waarden: hoe lager de gespeelde toets, hoe lager de afsnijfrequentie wordt; hoe
hoger de gespeelde toets, hoe hoger de afsnijfrequentie wordt.
Negatieve waarden: hoe lager de gespeelde toets, hoe hoger de afsnijfrequentie wordt;
hoe hoger de gespeelde toets, hoe lager de afsnijfrequentie wordt.

Stelt de afstand in tussen de afsnijfrequenties voor de dubbele-filtertypen en het filter LPF12+BPF6.
Deze parameter is mogelijk, afhankelijk van het filtertype, niet beschikbaar.
Instellingen: -128-+127

Stelt de middenfrequentie in voor de functies die de filterafsnijding regelen en hoe snel de FEG
verandert volgens de Key Follow-instelling van HPF.
Het verhogen van de waarde resulteert in een hogere afsnijfrequentie, en de lage frequentiesignalen
worden afgekapt of geblokkeerd om het geluid helderder te maken. Het verlagen van de waarde
resulteert in een hogere afsnijfrequentie, en de lage frequentiesignalen worden doorgegeven om het
geluid dieper te maken.
Deze parameter is niet beschikbaar wanneer het filtertype is ingesteld op LPF12 + HPF12 of LPF6 +
HPF12.
Instellingen: 0-1023

Stelt het niveau van de afsnijfrequentie van het hoogdoorlaatfilter in, afhankelijk van de positie van de
toets.
Deze parameter is niet beschikbaar wanneer het Filter Type is ingesteld op LPF12 + HPF12 of LPF6
+ HPF12.
Instellingen: -200%-+200%

Positieve waarden: hoe lager de gespeelde toets, hoe lager de afsnijfrequentie wordt; hoe
hoger de gespeelde toets, hoe hoger de afsnijfrequentie wordt.

Res/Vel (Filter Resonance Velocity Sensitivity)

Cutoff/Key (Filter Cutoff Key Follow Sensitivity)

Distance

HPF Cutoff (HPF Cutoff Frequency)

HPF Cutoff/Key (HPF Cutoff Key Follow Sensitivity)
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Negatieve waarden: hoe lager de gespeelde toets, hoe hoger de afsnijfrequentie wordt;
hoe hoger de gespeelde toets, hoe lager de afsnijfrequentie wordt.

Stelt de versterking in (signalen verzonden naar de filtereenheid).
Als u de waarde verlaagt, neemt het volume van het element af.
Instellingen: 0-255

Op het scherm Filter EG kunt u de filterenvelopegenerator (FEG) voor het element instellen.
Met de FEG kunt u de mate (of het niveau) van veranderingen in de afsnijfrequentie instellen en hoe
deze veranderingen in de loop van de tijd evolueren, vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment dat het geluid wegsterft.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Filter → Filter EG

Stelt de tijdsduur in die nodig is om de afsnijfrequentie op Hold Level te houden vanaf het moment
dat u een toets op het toetsenbord indrukt.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat de afsnijfrequentie verandert vanaf het einde van de Hold
Time tot de Attack Level.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat de afsnijfrequentie verandert vanaf de Attack Level tot de
Decay 1 Level.
Instellingen: 0-127

Gain (Filter Gain)

Filter EG

Hold Time (FEG Hold Time)

Attack Time (FEG Attack Time)

Decay1 Time (FEG Decay 1 Time)
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Stelt de tijdsduur in die nodig is voordat de afsnijfrequentie verandert vanaf de Decay 1 Level tot de
Decay 2 Level.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat de afsnijfrequentie verandert vanaf het moment dat u uw
vinger van de toets haalt totdat de Release Level wordt bereikt.
Instellingen: 0-127

Stelt de afsnijfrequentie in op het moment dat u de toets indrukt.
Instellingen: -128-+127

Stelt in dat de afsnijfrequentiewaarde verandert nadat u op de toets hebt gedrukt.
Instellingen: -128-+127

Stelt de volgende afsnijfrequentiewaarde in die moet veranderen vanaf de Attack Level.
Instellingen: -128-+127

Stelt de afsnijfrequentie in die wordt aangehouden terwijl de toets ingedrukt wordt gehouden.
Instellingen: -128-+127

Stelt de volgende afsnijfrequentiewaarde in nadat u uw vinger van de toets hebt gehaald.
Instellingen: -128-+127

Stelt de referentienoot (of een toets die moet worden ingedrukt) in voor Time/Key.
Als de noot (toets) hier is ingesteld, wordt de snelheidsverandering van de in Filter EG ingestelde
afsnijfrequentie ongewijzigd gebruikt.

Stelt in hoe de snelheid van de frequentiewijziging in FEG reageert op de positie van de toets.
De snelheidsverandering in FEG wordt gebruikt voor de opgegeven toets in Center Key.
Instellingen: -64-+63

Positieve waarden: hoe lager de gespeelde toets, hoe langzamer de FEG-verandering
wordt; hoe hoger de gespeelde toets, hoe sneller de FEG-verandering wordt.
Negatieve waarden: hoe lager de gespeelde toets, hoe sneller de FEG-verandering wordt;
hoe hoger de gespeelde toets, hoe langzamer de FEG-verandering wordt.
0: geen veranderingen in de FEG, ongeacht de toetspositie.

Decay2 Time (FEG Decay 2 Time)

Release Time (FEG Release Time)

Hold Level (FEG Hold Level)

Attack Level (FEG Attack Level)

Decay1 Level (FEG Decay 1 Level)

Decay2 Level (FEG Decay 2 Level)

Release Level (FEG Release Level)

Center Key (FEG Time Key Follow Sensitivity Center Key)

Time/Key (FEG Time Key Follow Sensitivity)
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A: Center Key
B: Langzaam
C: Snel
D: Lage toets
E: Hoge toets
F: Positieve waarde
G: Negatieve waarde

Instellingen: C-2-G8

Stelt in hoe de afsnijfrequentie reageert op de snelheid of de kracht van de toetsaanslag.
Stel eerst de tijdswaarde in Segment in en stel vervolgens de aanslaggevoeligheidswaarde in
Time/Vel in.
Instellingen: Time/Vel: -64-+63

Positieve waarde: hoe sneller de aanslag, hoe sneller de FEG-veranderingen.
Negatieve waarde: hoe sneller de aanslag, hoe langzamer de FEG-veranderingen; een
lage snelheid resulteert in een snellere FEG-verandering.
0: geen veranderingen, ongeacht de aanslaginstelling.

Time/Key en Center Key

Time/Vel (FEG Time Velocity Sensitivity)
Segment (FEG Time Velocity Sensitivity Segment)
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Hoge snelheid
(snelle veranderingen in afsnijfrequentie)

Lage snelheid
(langzame veranderingen in afsnijfrequentie)

Instellingen: Segment: Attack, Atk+Dcy, Decay, Atk+Rls, All
Attack: de Time/Vel-waarde beïnvloedt de Attack Time.
Atk+Dcy: de Time/Vel-waarde beïnvloedt de Attack Time en Decay 1 Time.
Decay: de Time/Vel-waarde beïnvloedt de Decay Time.
Atk+Rls: de Time/Vel-waarde beïnvloedt de Attack Time en Release Time.
All: de Time/Vel-waarde beïnvloedt de tijdgerelateerde instellingen in FEG.

Stelt het dieptebereik in voor de afsnijfrequentie die wordt geregeld door de FEG.
Instellingen: -64-+63

0: geen wijzigingen voor de afsnijfrequentie door de Filter EG.
Het dieptebereik van de verandering van de afsnijfrequentie wordt breder als de instelling
ver van de waarde 0 ligt.
Voor negatieve waarden worden de veranderingen in de afsnijfrequentie omgekeerd.

Stelt in hoe het dieptebereik van de verandering van de afsnijfrequentie die wordt geregeld door de
FEG reageert op de snelheid (kracht van de toetsaanslag).
Met de Curve-instelling kunt u ook instellen hoe de FEG Depth op de snelheid reageert.
De verticale as vertegenwoordigt de snelheid, terwijl de horizontale as het dieptebereik van de
veranderingen in de afsnijfrequentie vertegenwoordigt.
Instellingen: Depth/Vel: -64-+63

Positieve waarden: hoge snelheid vergroot het dieptebereik van de Filter EG, terwijl lage
snelheid het dieptebereik verkleint.
Negatieve waarden: hoge snelheid verkleint het dieptebereik van de Filter EG, terwijl lage
snelheid het dieptebereik vergroot.
0: de afsnijfrequentie reageert niet op snelheid.

Hoge snelheid
(het dieptebereik bij verandering in de

afsnijfrequentie is groter)

Lage snelheid
(het dieptebereik bij verandering in de

afsnijfrequentie is kleiner)

Instellingen: Curve: 0-4

FEG Depth

Depth/Vel (FEG Depth Velocity Sensitivity)
Curve (FEG Depth Velocity Sensitivity Curve)
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Op het scherm Scale kunt u de filterschaal voor het element instellen.
Met de filterschaalfunctie kunt u de afsnijfrequentie van het filter wijzigen, afhankelijk van de
toonhoogte.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Filter → Scale

Stelt de nootnummers van vier punten in op Cutoff Offset.
Instellingen: C-2-G8

OPMERKING
De nootnummers voor Break Points 1 tot en met 4 worden automatisch in oplopende volgorde onderverdeeld.

Stelt de waarde in die het afsnijden op alle vier de breekpunten verhoogt of verlaagt.
Instellingen: -128-+127

OPMERKING

Scale

Break Point (Filter Cutoff Scaling Break Point) 1-4

Cutoff Offset (Filter Cutoff Scaling Offset) 1-4

Als de offsetwaarde boven of onder de afsnijwaarde wordt ingesteld, gaat de afsnijfrequentie nooit verder dan
de instellingen.
Voor alle noten onder Break Point 1 wordt de waarde ingesteld op de afsnijfrequentie van Break Point 1. Voor
alle noten boven Break Point 4 wordt de waarde ingesteld op de afsnijfrequentie van Break Point 4.
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Op het scherm Level/Pan kunt u voor elk element het niveau en pannen (positie in het stereoveld)
instellen.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Amplitude → Level/Pan

Stelt in hoe het volume van elk element reageert op de toetspositie. Het referentiepunt is het volume
dat is opgegeven in Center Key.
Instellingen: -64-+0-+63

Positieve waarden: hoe lager de gespeelde toets, hoe zachter het volume wordt; hoe
hoger de gespeelde toets, hoe luider het volume wordt.
Negatieve waarden: hoe lager de gespeelde toets, hoe luider het volume wordt; hoe
hoger de gespeelde toets, hoe zachter het volume wordt.

Stelt het uitgangsniveau (volume) in voor elk element.
Instellingen: 0-127

Amplitude

Level/Pan

Level/Key (Level Key Follow Sensitivity)

Level (Element Level)
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Stelt in hoe het niveau (volume) reageert op de snelheid of de kracht van de toetsaanslag. Offset
past alle instellingen aan die zijn opgegeven in Level/Vel. Als de waarde groter is dan 127, wordt de
snelheid ingesteld op 127. Met de instelling voor Curve kunt u ook instellen hoe het volume op de
snelheid reageert. De verticale as vertegenwoordigt de snelheid, terwijl de horizontale as het bereik
van de volumeveranderingen vertegenwoordigt.
Instellingen: Level/Vel: -64-+63

Positieve waarde: hoe hoger de snelheid, hoe luider het volume wordt.
Negatieve waarde: hoe langzamer de snelheid, hoe luider het volume wordt.
0: geen veranderingen, ongeacht de aanslaginstelling.

Instellingen: Offset, 0-127

Offset (Level Velocity Offset) =
0

Offset (Level Velocity Offset) =
64

Offset (Level Velocity Offset) =
96

A: Level/Vel (Level Velocity Sensitivity) = 0
B: Level/Vel (Level Velocity Sensitivity) = 32
C: Level/Vel (Level Velocity Sensitivity) = 64
X: snelheid van het moment dat de toets wordt ingedrukt
Y: snelheidswaarde verzonden naar de interne toongenerator

Instellingen: Curve: 0-4

Stelt de panpositie (in het stereoveld) voor het element in.
Als er rechter- en linkerpaninstellingen zijn voor de elementen binnen een partij, kan het moeilijk zijn
om het resultaat van de paninstelling te horen.
Instellingen: L63-C-R63

Stelt de hoeveelheid in waarmee het geluid beurtelings naar links en rechts wordt gepand voor elke
toets waarop u drukt.

Level/Vel (Level Velocity Sensitivity)
Offset (Level Velocity Offset)
Curve (Level Sensitivity Key Curve)

Pan (Element Pan)

Alternate Pan (Alternate Pan Depth)
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De waarde die is ingesteld in Pan is de middenpositie voor de rechter- en linkerbeweging van de pan.
Instellingen: L64-C-R63

Stelt de hoeveelheid in waarmee het geluid willekeurig naar links en rechts wordt gepand voor elke
toets waarop u drukt.
De waarde die is ingesteld in Pan is de middenpositie in het stereoveld.
Instellingen: 0-127

Stelt in hoe de positie van de toets die u indrukt de positie van de pan-instelling beïnvloedt.
De waarde die is ingesteld in Pan is de positie voor C3.
Instellingen: -64-+0-+63

Positieve waarden: de panpositie wordt naar links geschaald voor lagere toetsen en naar
rechts voor hogere toetsen.
Negatieve waarden: de panpositie wordt naar rechts geschaald voor lagere toetsen en
naar links voor hogere toetsen.

Op het scherm Amp EG kunt u de AEG-tijd (Amplitude Envelope Generator) voor het element
instellen. Hiermee kunt u bepalen hoe het volume verandert vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment waarop het geluid wegsterft.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Amplitude → Amp EG

Stelt de tijdsduur in die nodig is voordat het volume verandert vanaf het moment dat u een toets op
het toetsenbord indrukt tot het moment waarop de Attack Level-waarde wordt bereikt.
Instellingen: 0-127

Random Pan (Random Pan Depth)

Scaling Pan (Scaling Pan Depth)

Amp EG

Attack Time (AEG Attack Time)

Decay 1 Time (AEG Decay 1 Time)
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Stelt de tijdsduur in die nodig is voordat het volume verandert vanaf de Attack Level tot de Decay 1
Level.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat het volume verandert vanaf de Decay 1 Level tot de Decay 2
Level.
Instellingen: 0-127

Stelt de tijdsduur in die verstrijkt totdat het geluid wegsterft nadat u de toets hebt losgelaten.
Instellingen: 0-127

Stelt het volume in voor het moment dat u de toets indrukt.
Instellingen: 0-127

Stelt het volume in dat moet worden gewijzigd nadat u een toets hebt ingedrukt.
Instellingen: 0-127

Stelt de volgende volumewaarde in die moet veranderen vanaf de Attack Level.
Instellingen: 0-127

Stelt het volume in dat wordt aangehouden terwijl de toets ingedrukt wordt gehouden.
Instellingen: 0-127

Stelt de referentienoot (of een toets die moet worden ingedrukt) in voor Time/Key. In
overeenstemming met de hier ingestelde noot (toets) wordt het resulterende geluid van de in PEG
ingestelde toonhoogteverandering gespeeld.
Instellingen: C-2-G8

Stelt in hoe de snelheid van de volumeveranderingen in AEG reageert op de toetspositie. De
snelheidsverandering in AEG wordt gebruikt voor de opgegeven toets in Center Note.
Instellingen: -64-+63

Positieve waarden: hoe lager de gespeelde toets, hoe langzamer het AEG-volume
verandert; hoe hoger de gespeelde toets, hoe sneller het AEG-volume verandert.
Negatieve waarden: hoe lager de gespeelde toets, hoe sneller het AEG-volume verandert;
hoe hoger de gespeelde toets, hoe langzamer het AEG-volume verandert.
0: geen veranderingen in het AEG-volume, ongeacht de toetspositie.

Decay 2 Time (AEG Decay 2 Time)

Release Time (AEG Release Time)

AEG Initial Level

AEG Attack Level

AEG Decay 1 Level

AEG Decay 2 Level

Center Note (AEG Time Key Follow Center Note)

Time/Key (AEG Time Key Follow Sensitivity)
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A: Center Note
B: Langzaam
C: Snel
D: Lage toetsen
E: Hoge toetsen
F: Positieve waarden
G: Negatieve waarden

Past de gevoeligheid van de AEG Time Key Follow Sensitivity aan in AEG Release.
Hoe lager de waarde is, hoe lager de gevoeligheid.
Instellingen: 0-127

127: AEG Time Key Follow Sensitivity is hetzelfde als Decay 1 en Decay 2.
0: AEG Time Key Follow Sensitivity heeft geen invloed op de AEG Release.

Stelt in hoe de tijd voor volumeveranderingen in AEG reageren op de snelheid of de kracht van de
toetsaanslag.
Stel eerst de tijdswaarde in Segment in en stel vervolgens de aanslaggevoeligheidswaarde in
Time/Vel in.
Instellingen: Time/Vel: -64-+63

Positieve waarde: hoe sneller de aanslag, hoe sneller het AEG-volume verandert.
Negatieve waarde: hoe sneller de aanslag, hoe langzamer het AEG-volume verandert;

Time/Key (AEG Time Key Follow Sensitivity) en Center Note
(AEG Time Key Follow Center Note)

Release Adj (AEG Time Key Follow Sensitivity Release Adjustment)

Time/Vel (AEG Time Velocity Sensitivity)
Segment (AEG Time Velocity Segment)
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hoe lager de snelheid, hoe sneller het AEG-volume verandert.
0: geen veranderingen, ongeacht de aanslaginstelling.

Snelle aanslag (snelle volumeverandering) Langzame aanslag (langzame
volumeverandering)

Instellingen: Segment: Attack, Atk+Dcy, Decay, Atk+Rls, All
Attack: de Time/Vel-waarde is van invloed op Attack Time
Atk+Dcy: de Time/Vel-waarde beïnvloedt de Attack Time en Decay 1 Time.
Decay: de Time/Vel-waarde beïnvloedt de Decay Time.
Atk+Rls: de Time/Vel-waarde beïnvloedt de Attack Time en Release Time.
All: de Time/Vel-waarde beïnvloedt de tijdgerelateerde instellingen in AEG.

Door deze schakelaar op On te zetten, kunt u de apart verkrijgbare voetregelaar FC3A aansluiten op
de [SUSTAIN]-aansluiting op het achterpaneel en de halfdemperfunctie gebruiken voor uw
toetsenspel.
De halfdemperfunctie geeft u een grotere expressieve controle over het wegsterven van het geluid,
waardoor u de werking van het demperpedaal kunt gebruiken net zoals u dat op een akoestische
piano zou doen: continu en niet alleen als een aan/uit-schakelaar.
Instellingen: Off, On

Stelt de tijd in vanaf het moment dat u een toets hebt losgelaten terwijl u de voetregelaar FC3A
volledig ingedrukt houdt tot wanneer het geluid wegsterft wanneer de Half Damper (Half Damper
Switch) op On is ingesteld. Deze parameter wordt niet weergegeven als Half Damper (Half Damper
Switch) is ingesteld op Off.
U kunt de wegsterftijd van de Half Damper Time aanpassen tot de Release Time door te wijzigen
hoeveel u op het pedaal drukt.
Wanneer u het pedaal loslaat, wordt de Release Time gebruikt voor wegstervend geluid. Door de
Release Time op een lage waarde in te stellen, en Half Damper Time op een hoge waarde, kunt u
een natuurlijk wegstervend geluid spelen, zoals op een akoestische piano.

Instellingen: 0-127

Op het scherm Scale kunt u de amplitudeschaal voor het element instellen.
Hierdoor verandert het volume afhankelijk van de toetspositie op het toetsenbord.

Gebruik

Half Damper (Half Damper Switch)

Time (Half Damper Time)

Scale
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[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Amplitude → Scale

Stelt het nootnummer in voor Level Offset.
Instellingen: C-2-G8

OPMERKING
De nootnummers voor Break Points 1 tot en met 4 worden automatisch in oplopende volgorde onderverdeeld.

Stelt de waarden in van vier breekpunten voor het regelen van de Level.
Instellingen: -128-+127

Op het scherm Element EQ kunt u de equalizer voor het element instellen.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Element EQ

Break Point (Level Scaling Break Point) 1-4

Level Offset (Level Scaling Offset) 1-4

Element EQ

EQ Type (Element EQ Type)
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Selecteert het gewenste EQ-type.
Instellingen: 2-band, P.EQ, Boost6, Boost12, Boost18, Thru

2-band: Shelving EQ die de signaalband boven of onder een bepaalde frequentie versterkt
of afsnijdt (Low Freq of High Freq).
P.EQ: parametrische EQ die het signaalniveau versterkt of verzwakt (Gain) rond de
middenfrequentie (Freq).
Boost6: verhoogt het niveau met 6 dB.
Boost12: verhoogt het niveau met 12 dB.
Boost18: verhoogt het niveau met 18 dB.
Thru: negeert de equalizer en laat het volledige signaal onbeïnvloed.

Stelt het signaalniveau van de Low-band in.
Instellingen: -12,00 dB-+12,00 dB

Stelt de frequentie van de Low-band in.
Instellingen: 50,1Hz-2,00kHz

Stelt het signaalniveau van de High-band in.
Instellingen: -12,00 dB-+12,00 dB

Stelt de frequentie van de High-band in.
Instellingen: 503,8Hz-10,1kHz

Als EQ Type is ingesteld op 2-band

EQ Low Gain (Element EQ Low Gain)

EQ Low Freq (Element EQ Low Frequency)

EQ Hi Gain (Element EQ High Gain)

EQ Hi Freq (Element EQ High Frequency)

Als EQ Type is ingesteld op P.EQ
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Stelt het signaalniveau in voor het frequentiebereik dat is ingesteld in EQ Freq.
Instellingen: -12,00 dB-+12,00 dB

Stelt de frequentie in die moet worden afgekapt of versterkt.
Instellingen: 139,7Hz-12,9kHz

Door het signaalniveau van de frequentie die is ingesteld in EQ Freq te versterken of te verzwakken,
kunt u verschillende frequentieresponscurves creëren.
Instellingen: 0,7-10,3

Op het scherm Element LFO kunt u de LFO (oscillator voor lage frequenties) voor het element
instellen. De LFO (oscillator voor lage frequenties) voor het element genereert signalen in de lage
band en u kunt deze gebruiken voor modulatie (cyclische variatie) van de toonhoogte, het filter en de
amplitude.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part-selectie → Element-selectie → Element LFO

EQ Gain (Element EQ Gain)

EQ Freq (Element EQ Frequency)

EQ Q (Element EQ Q)

Element LFO
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Selecteert een LFO-golfvorm, voor het creëren van verschillende typen modulatie.
Instellingen: Saw, Triangle, Square

Saw (zaagtandgolf) Triangle (driehoekgolf) Square (blokgolf)

Schakelt tussen de oude set instellingen (Uit: 0-63) en een nieuwe set instellingen met een hogere
resolutie (Aan: 0-415) voor Speed (LFO Speed).
Om de compatibiliteit van data die met de oude instellingen zijn gemaakt te behouden, stelt u deze
parameter in op Off.
Instellingen: Off, On

Stelt de snelheid van LFO Wave-wijzigingen in. Hoe hoger de waarde van deze parameter, hoe
hoger de snelheid wordt.
Instellingen: 0-63 (ExtendedLFO ingesteld op Off), 0-415 (ExtendedLFO is ingesteld op On)

Stelt de vertragingstijd in tussen het moment waarop u een toets op het toetsenbord aanslaat en het
moment waarop de LFO actief wordt.
Instellingen: 0-127

Stelt de tijdsduur in voor het infaden van het LFO-effect nadat u de toets hebt losgelaten en de
wegsterftijd die is ingesteld in Delay is verstreken.
Instellingen: 0-127

Hoe hoger de waarde, hoe langer het duurt voordat het LFO-effect het maximum bereikt.
0: LFO verandert naar de maximale waarde zonder enige fade-ins.

Lage waarde: snelle fade-in

LFO Wave

Extended LFO

Speed (LFO Speed)

Delay (LFO Delay Time)

Fade In (LFO Fade In Time)
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Hoge waarde: langzame fade-in

Zet de oscillatie van de LFO terug wanneer een toets wordt ingedrukt.
Instellingen: Off, On

Deze parameter creëert een vibrato-effect (cyclische veranderingen in de toonhoogte) door gebruik
te maken van LFO-golven.
Het instellen van de parameter op hogere waarden resulteert in een grotere verandering in het
volume.
Instellingen: 0-127

Deze parameter creëert een wah-effect (cyclische veranderingen in de filterafsnijfrequentie) door
gebruik te maken van LFO-golven.
Hogere waarden resulteren in een groter bereik voor veranderingen in de afsnijfrequentie.
Instellingen: 0-127

Deze parameter creëert een tremolo-effect (cyclische veranderingen in het volume) door gebruik te
maken van LFO-golven.
Het instellen van de parameter op hogere waarden resulteert in een grotere verandering in het
volume.
Instellingen: 0-127

Key On Reset (LFO Key On Reset)

Pitch Mod (LFO Pitch Modulation Depth)

Filter Mod (LFO Filter Modulation Depth)

Amp Mod (LFO Amplitude Modulation Depth)
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De drumpartij (AWM2) bestaat uit 73 drumtoetsen.
Drum Part Edit (AWM2) bevat Part Common Edit (voor het instellen van parameters voor de gehele
partij) en Key Edit (voor het instellen van parameters voor afzonderlijke drumtoetsen).

Drum Part Edit (AWM2)-scherm (Drumpartij bewerken)
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Inhoudsopgave

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → Part Settings

Part Common Edit

General/Pitch

Part Settings

Zone Settings

Pitch

Filter/Amp

Filter EG

Amp EG

Effect

Routing

Ins A

Ins B

3-band EQ

2-band EQ

Arpeggio

Common

Individual

Advanced

Motion Seq

Common

Lane

Mod/Control

Control Assign

Tx/Rx Switch

Control Settings

General/Pitch

Part Settings
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Stelt de hoofd- en subcategorie van de geselecteerde partij in.
Instellingen: Raadpleeg de Data List.

U kunt de partij die u bewerkt onder een nieuwe naam opslaan. Deze naam mag uit maximaal 20
alfanumerieke tekens bestaan.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u een naam kunt invoeren.

Stelt het volume van de geselecteerde partij in.
Instellingen: 0-127

Stelt de pan in voor de geselecteerde partij.
Instellingen: L63-C (midden)-R63

Stelt het droge niveau van de geselecteerde partij in.
Deze parameter is alleen beschikbaar als Part Output is ingesteld op MainL&R of Drum.
Instellingen: 0-127

Stelt de variation-zend van de geselecteerde partij in.
Deze parameter is alleen beschikbaar als Part Output is ingesteld op MainL&R of Drum.
Instellingen: 0-127

Stelt de reverb-zend van de geselecteerde partij in.
Deze parameter is alleen beschikbaar als Part Output is ingesteld op MainL&R of Drum.
Instellingen: 0-127

Main Category (Part Main Category)
Sub Category (Part Sub Category)

Part Name

Volume

Pan

Dry Level

Var Send (Variation Send)

Rev Send (Reverb Send)
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Stelt de uitvoerbestemming in voor de audiosignalen van de geselecteerde partij.
Instellingen: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30, Off, Drum

MainL&R: uitgang in stereo (twee kanalen) naar de OUTPUT [L/MONO]- en OUTPUT [R]-
aansluitingen.
AsgnL&R: uitgang in stereo (twee kanalen) naar de ASSIGNABLE OUTPUT [L]- en
ASSIGNABLE OUTPUT [R]-aansluitingen.
USB1&2–USB29&30: uitgang in stereo (kanalen 1 en 2, naar kanalen 29 en 30) naar de
[USB TO HOST]-aansluiting.
AsgnL: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [L]-aansluiting.
AsgnR: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [R]-aansluiting.
USB1–30: uitgang in mono (kanaal 1–30) naar de [USB TO HOST]-aansluiting.
Off: geen uitgang van het audiosignaal voor de partij.
Drum: u kunt de uitvoer voor elke drumtoets instellen.

Stelt de partij in die alleen met het arpeggio moet worden gespeeld.
De partij die op On is ingesteld, wordt gespeeld door de noot-aan-berichten die voor het arpeggio
worden verzonden.
Instellingen: Off, On

Stelt de Pan in op On of Off vanuit Key Edit ([EDIT/ ]→Part-selectie→Key-
selectie→Level/Pan→Pan).
Als deze parameter is ingesteld op Off, wordt de panpositie in Key Edit ingesteld op C (het midden).
Instellingen: Off, On

Stelt het aanslagbereik (laagste en hoogste waarden) in voor de partij.
Instellingen: 1-127

Stelt het notenbereik (laagste en hoogste noten) in voor de partij.
Instellingen: C-2-G8

Verhoogt of verlaagt de aanslagsnelheidswaarde die naar de interne toongenerator wordt verzonden.
Instellingen: 0-127

Als Depth = 64 en Offset = 32 Als Depth = 64 en Offset = 64 Als Depth = 64 en Offset = 96

Part Output (Part Output Select)

Arp Play Only (Arpeggio Play Only)

Element Pan

Velocity Limit

Note Limit

Velocity Offset (Velocity Sensitivity Offset)
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(1) Resulterende werkelijke aanslagsnelheid (van invloed op de toongenerator)
(2) Aanslagsnelheid waarmee u een noot speelt

Stelt in hoe het niveau van de aanslagsnelheidswaarde (die naar de interne toongenerator wordt
verzonden) op de snelheid of de sterkte van de toetsaanslag reageert.
Instellingen: 0-127

(1) Resulterende werkelijke
aanslagsnelheid (van invloed op de
toongenerator)

(2) Aanslagsnelheid waarmee u een
noot speelt

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via General/Pitch → Zone
Settings in Part Edit (AWM2).

Op het scherm Pitch kunt u de toonhoogte voor de partij instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → Pitch

Velocity Depth (Velocity Sensitivity Depth)

Als Offset is ingesteld op 64:

Zone Settings

Pitch
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Past de toonhoogte aan in stappen van een halve toon.
Instellingen: -24-+0-+24

Past de toonhoogte van de partij aan in stappen van 0,1 Hz.
Door de toonhoogte iets te verschuiven, kunt u het geluid ontstemmen.
Instellingen: -12,8Hz-+0,0Hz-+12,7Hz

Partijen die aan dezelfde groep zijn toegewezen, krijgen dezelfde toonhoogte.
Echter, Portamento, Mono/Poly en Micro Tuning zijn niet beschikbaar voor de drumpartij.

Stelt het bereik in van de veranderingen die met het pitchbendwiel worden gecreëerd in halve tonen.
Instellingen: -48-+0-+24

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Filter/Amp → Filter EG
in Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Filter/Amp → Amp EG
in Part Edit (AWM2).

Note Shift

Detune

Pitch Control Group

Pitch Bend↓(Pitch Bend Range Lower)
Pitch Bend↑(Pitch Bend Range Upper)

Filter/Amp

Filter EG

Amp EG

Effect

Routing
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Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Effect → Routing

In principe is dit hetzelfde scherm als Effect → Routing in Part Edit (AWM2.)
De parameters die zijn toegevoegd aan Drum Part Edit (AWM2) worden hieronder weergegeven.

Toont de naam van de geselecteerde drumtoets.
Instellingen: C0-C6

Stelt de toets die moet worden uitgevoerd in op invoegeffect A of invoegeffect B.
Als u dit instelt op Thru worden de invoegeffecten omzeild.
Instellingen: Thru, InsA, InsB

U kunt het toetsenbord gebruiken om direct een drumtoets te selecteren door deze parameter op On
te zetten.
Instellingen: Off, On

Stelt het niveau in van de drumtoetssignalen die worden verzonden van invoegeffect A of
invoegeffect B naar het Reverb- of Variation-effect.
Deze instelling wordt toegepast op de gehele drumpartij (alle drumtoetsen).
Deze parameter is alleen beschikbaar wanneer Connect (Drum Key Connection Switch) is ingesteld
op InsA of InsB, en Part Output is ingesteld op MainL&R of Drum.
Instellingen: 0-127

Stelt het niveau in van de drumtoetssignalen die worden verzonden van invoegeffect A of
invoegeffect B naar het Reverb- of Variation-effect.

Drum Key (Drum Key Select)

Connect (Drum Key Connection Switch)

Keyboard Select

InsRev (Insertion to Reverb Send Level)
InsVar (Insertion to Variation Send Level)

KeyRev (Drum Key Reverb Send Level)
KeyVar (Drum Key Variation Send Level)
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Deze parameter kan voor elke drumtoets worden ingesteld.
Deze parameter is beschikbaar wanneer Connect (Drum Key Connection Switch) is ingesteld op
Thru, en ook wanneer Part Output is ingesteld op Main, of wanneer Part Output is ingesteld op Drum
en Drum Key Out is ingesteld op MainL&R.
Instellingen: 0-127

Hiermee wordt de uitgangsbestemming voor elke drumtoets ingesteld.
Deze parameter wordt alleen weergegeven als Part Output is ingesteld op Drum.
Instellingen: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30

MainL&R: uitgang in stereo (twee kanalen) naar de OUTPUT [L/MONO]- en OUTPUT [R]-
aansluitingen.
AsgnL&R: uitgang in stereo (twee kanalen) naar de ASSIGNABLE OUTPUT [L]- en
ASSIGNABLE OUTPUT [R]-aansluitingen.
USB1&2–USB29&30: uitgang in stereo (kanalen 1 en 2, naar kanalen 29 en 30) naar de
[USB TO HOST]-aansluiting.
AsgnL: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [L]-aansluiting.
AsgnR: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [R]-aansluiting.
USB1–30: uitgang in mono (kanaal 1–30) naar de [USB TO HOST]-aansluiting.

OPMERKING
Wanneer Connect (Drum Key Connection Switch)is ingesteld op InsA of InsB, en deze parameter vast is ingesteld
op MainL&R.

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → InsA of InsB in
Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → 3-band EQ in
Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → 2-band EQ in
Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Arpeggio → Common in
Part Edit (AWM2).

Drum Key Out (Drum Key Output Select)

Ins A
Ins B

3-band EQ

2-band EQ

Arpeggio

Common
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Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Arpeggio → Individual in
Part Edit (AWM2).

Het scherm hier is in principe hetzelfde als het scherm dat wordt geopend vanuit Arpeggio →
Advanced in Part Edit (AWM2); de onderstaande parameter is echter toegevoegd.

Als deze parameter is ingesteld op On, wordt bij het afspelen van arpeggio C1 gebruikt voor de
basdrum en D1 voor de snaredrum.
Bij de meeste drumkits is de basdrum toegewezen aan C1 en de snaredrum toegewezen aan D1. Bij
sommige drumkits zijn de basdrum en de snaredrum echter aan een aantal andere toetsen
toegewezen. In dat geval zou het arpeggio in plaats daarvan de toegewezen toetsen gebruiken voor
het afspelen.
Om deze reden wordt het arpeggio mogelijk niet goed afgespeeld, afhankelijk van de specifieke
combinatie van drumkit en arpeggiotype. Wanneer dergelijke problemen optreden, kan het instellen
van Fixed SD/BD (Arpeggio Fixed SD/BD) op On mogelijk het probleem oplossen.
Instellingen: Off, On

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Motion Seq → Common
in Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Motion Seq → Lane in
Part Edit (AWM2).

Individual

Advanced

Fixed SD/BD (Arpeggio Fixed SD/BD)

Motion Seq

Common

Lane

Mod/Control

Control Assign
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Het scherm hier is in principe hetzelfde als het scherm dat wordt geopend via Mod/Control → Control
Assign in Part Edit (AWM2), behalve dat de beschikbare instellingen voor Destination anders zijn.
Voor de lijst van instellingen voor Destination raadpleegt u de Control List op de Data List.

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Mod/Control → Tx/Rx
Switch in Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Mod/Control → Control
Settings in Part Edit (AWM2).

Tx/Rx Switch

Control Settings
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Inhoudsopgave

Op het Osc/Tune-scherm kunt u de oscillator voor elke toets binnen de drumpartij instellen.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part selectie → Key selectie → Osc/Tune

Stelt de geselecteerde drumtoets in die moet worden gebruikt.
Instellingen: Off, On

Toont de naam van de golfvorm die voor de drumtoets is geselecteerd.
Bank geeft aan welk type golfvorm (Preset, User en Library) wordt toegewezen aan het element.

Key Edit

Osc/Tune

Filter

Level/Pan

Element EQ

Osc/Tune

Drum Key Switch

Bank (Waveform Bank)
Number (Waveform Number)
Category (Waveform Category)
Sub Category (Waveform Sub Category)
Name (Waveform Name)
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Instellingen: Raadpleeg de Data List.

Stelt in hoe geluid wordt geproduceerd wanneer de interne toongenerator twee keer achter elkaar
een noot-aan-bericht met hetzelfde geluid ontvangt.
Instellingen: Single, Multi

Single: stopt de eerste noot en speelt dezelfde noot vervolgens opnieuw.
Multi: speelt de tweede noot over de eerste noot heen. Deze instelling zorgt ervoor dat
roffels natuurlijk klinken, aangezien vooral crashcimbalen of andere percussie-
instrumenten een lange wegsterftijd hebben.

Stelt de toets die moet worden uitgevoerd in op invoegeffect A (InsA of invoegeffect BIns B, of omzeilt
het invoegeffect (Thru).
Deze parameter is in principe hetzelfde als Connect (Drum Key Connection Switch) in Effect →
Routing in de Drum Part Edit (AWM2).
Settings: Thru, InsA, InsB

Laadt een audiobestand dat als golfvorm op het USB-flashstation is opgeslagen.
Edit Waveform verschijnt wanneer een golfvorm is geladen.

Opent het scherm Waveform Edit.

Verschuift de toonhoogte van de golfvorm die aan de drumtoets is toegewezen.
Instellingen: -48-+48

Past de toonhoogte van de golfvorm die aan de drumtoets is toegewezen nauwkeurig aan.
Instellingen: -64-+63

Stelt in hoe de toonhoogte reageert op de aanslagsnelheid of de kracht van de toetsaanslag.
Instellingen: -64-+63

Positieve waarde: hoe hoger de snelheid, hoe hoger de toonhoogte wordt.
Negatieve waarde: hoe sneller de aanslagsnelheid, hoe lager de toonhoogte wordt.
0: blijft ongewijzigd

Stelt de drumtoets in om MIDI-noot-uit-berichten te ontvangen.
Instellingen: Off, On

On: het geluid stopt wanneer u de toets loslaat. Gebruik deze instelling voor percussie-
instrumentgeluiden, als u wilt dat deze voortduren zonder wegsterven.
Off: het geluid sterft weg nadat u de toets loslaat.

Assign Mode (Key Assign Mode)

Connect (Drum Key Connection)

New Waveform

Edit Waveform

Coarse (Coarse Tune)

Fine (Fine Tune)

Pitch/Vel (Pitch Velocity Sensitivity)

Rcv Note Off (Receive Note Off)
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Deze instelling helpt u te voorkomen dat onjuiste of onnatuurlijke combinaties van drumtoetsen
samen worden gespeeld.
U kunt bijvoorbeeld open en gesloten hi-hats aan dezelfde groep toewijzen, zodat u kunt voorkomen
dat ze samen worden bespeeld.
Voor drumtoetsen die op natuurlijke wijze met elke combinatie kunnen worden bespeeld, stelt u deze
parameter in op Off.
Instellingen: Off, 1-127

Stelt het niveau in van de drumtoetssignalen die worden verzonden via invoegeffect A of invoegeffect
B naar het Reverb- of Variation-effect.
Deze parameter kan voor elke drumtoets worden ingesteld.
Deze parameter is mogelijk niet beschikbaar, afhankelijk van Connect (Drum Key Connection), Part
Output en instellingen voor Drum Key Output.
Instellingen: 0-127

Hiermee wordt de uitgangsbestemming voor de drumtoets ingesteld.
Deze parameter is mogelijk niet beschikbaar, afhankelijk van de instellingen voor Connect (Drum Key
Connection) en Part Output.
Instellingen: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–30

MainL&R: uitgang in stereo (twee kanalen) naar de OUTPUT [L/MONO]- en OUTPUT [R]-
aansluitingen.
AsgnL&R: uitgang in stereo (twee kanalen) naar de ASSIGNABLE OUTPUT [L]- en
ASSIGNABLE OUTPUT [R]-aansluitingen.
USB1&2–USB29&30: uitgang in stereo (kanalen 1 en 2, naar kanalen 29 en 30) naar de
[USB TO HOST]-aansluiting.
AsgnL: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [L]-aansluiting.
AsgnR: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [R]-aansluiting.
USB1–30: uitgang in mono (kanaal 1–30) naar de [USB TO HOST]-aansluiting.

Zet de toetsenbordselectie-instelling aan of uit.
Als deze parameter is ingesteld op On, kunt u de gewenste drumtoets voor bewerking selecteren
door op een toets op het toetsenbord te drukken.
Instellingen: Off, On

Stelt het filter voor de drumpartij in.
U kunt de toonkwaliteit wijzigen door op elke drumtoets een laagdoorlaatfilter en een
hoogdoorlaatfilter te gebruiken.

Gebruik

Group (Alternate Group)

KeyRev (Drum Key Reverb Send Level)
KeyVar (Drum Key Variation Send Level)

Drum Key Out (Drum Key Output Select)

Keyboard Select

Filter
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[PERFORMANCE] → [EDIT/ ] → Part selectie → Key selectie → Filter

Stelt de afsnijfrequentie in voor het laagdoorlaatfilter.
Instellingen: 0-1023

Stelt de aanslaggevoeligheid van de afsnijfrequentie in van het laagdoorlaatfilter.
Voor positieve waarden van deze parameter geldt: hoe sterker (hogere aanslagsnelheid) u de toets
speelt, hoe hoger de afsnijfrequentie wordt.
Voor negatieve waarden van deze parameter geldt: hoe sterker u de toets speelt, hoe lager de
afsnijfrequentie wordt.
Instellingen: -64-+63

Stelt het niveau in van het resonantie-effect op het laagdoorlaatfilter.
Instellingen: 0-127

Stelt de afsnijfrequentie in van het hoogdoorlaatfilter.
Instellingen: 0-1023

Stelt het niveau en de pan (positie in het stereoveld) in voor elke drumtoets.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part selectie → Key selectie → Level/Pan

Cutoff (LPF Cutoff Frequency)

Cutoff/Vel (LPF Cutoff Velocity Sensitivity)

Resonance (LPF Resonance)

HPF Cutoff (HPF Cutoff Frequency)

Level/Pan
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Stelt de tijdsduur in die nodig is voordat het volume verandert vanaf het moment dat u een toets op
het toetsenbord indrukt tot het moment waarop het volume de waarde bereikt die is ingesteld bij
Attack Level.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat het volume verandert vanaf de Attack Level tot de Decay 1
Level.
Instellingen: 0-127

Stelt de tijdsduur in die nodig is voordat het volume verandert vanaf de Decay 1 Level tot de Decay 2
Level.
Instellingen: 0-126, Hold

Stelt de volgende volumewaarde in die moet veranderen vanaf de Attack Level.
Instellingen: 0-127

Decay2 Time = 0 – 126 Decay2 Time = Hold

Hiermee wordt het uitgangsniveau van de drumtoets ingesteld.
Met deze parameter kunt u de niveaubalans tussen de drumtoetsen aanpassen.
Instellingen: 0-127

Attack Time (AEG Attack Time)

Decay 1 Time (AEG Decay 1 Time)

Decay 2 Time (AEG Decay 2 Time)

Decay 1 Level (AEG Decay 1 Level)

Level (Drum Key Level)
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Stelt in hoe het niveau (volume) reageert op de aanslagsnelheid of de kracht van de toetsaanslag.
Instellingen: -64-+63

Positieve waarden: hoe hoger de snelheid, hoe luider het volume wordt.
Negatieve waarden: hoe langzamer de snelheid, hoe luider het volume wordt.
0: geen veranderingen, ongeacht de aanslaginstelling.

Stelt de pan voor de drumtoets in.
U kunt de positie in het stereoveld voor de drumpartij (drumkit) aanpassen.
Instellingen: L63 (links)–C (center)–R63 (rechts)

Stelt de hoeveelheid in waarmee het geluid beurtelings naar links en rechts wordt gepand voor elke
toets waarop u drukt.
De waarde die is ingesteld in Pan is de middenpositie voor de rechter- en linkerbeweging van de pan.
Instellingen: L64-C-R63

Stelt de hoeveelheid in waarmee het geluid willekeurig naar links en rechts wordt gepand voor elke
toets waarop u drukt.
De waarde die is ingesteld in Pan is de middenpositie in het stereoveld.
Instellingen: 0-127

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → Element EQ in
Part Edit (AWM2) Element Edit.

Level/Vel (Level Velocity Sensitivity)

Pan

Alternate Pan (Alternate Pan Depth)

Random Pan (Random Pan Depth)

Element EQ
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om02screenparameters0130

De normale partij (FM-X) bestaat uit maximaal acht operators.
Part Edit (FM-X) bevat Part Common Edit (voor het instellen van parameters voor de gehele partij) en
Operator Edit (voor het instellen van parameters voor elke operator).

Part Edit (FM-X)-scherm
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om02screenparameters0140

Inhoudsopgave

Part Common Edit

General / Pitch

Part Settings

Zone Settings

FM-X Settings

Pitch

PEG/Scale

Filter/Amp

Filter Type

Filter EG

Filter Scale

Amp EG

Effect

Routing

Ins A

Ins B

3-band EQ

2-band EQ

Arpeggio

Common

Individual

Advanced

Motion Seq

Common

Lane

Mod/Control

Control Assign

After Touch

Tx/Rx Switch

Control Settings

Part LFO

2nd LFO
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Op het scherm Part Settings kunt u de algemene parameters (zoals partijnamen en toongeneratie)
voor de partij instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → Part Settings

Het scherm hier is in principe voor het grootste deel hetzelfde als het scherm dat wordt geopend via
General/Pitch → Part Settings in Part Edit (AWM2); de hieronder weergegeven parameters zijn
echter toegevoegd.

Stelt in hoe het geluid willekeurig naar links en rechts wordt gepand voor elke gespeelde toets.
De waarde die is ingesteld in Pan is de middenpositie in het stereoveld.
Instellingen: 0-127

Stelt in hoe het geluid beurtelings naar links en rechts wordt gepand voor elke gespeelde toets.
De waarde die is ingesteld in Pan is de middenpositie voor de rechter- en linkerbeweging van de pan.
Instellingen: L64-C-R63

General / Pitch

Part Settings

Random Pan (Random Pan Depth)

Alternate Pan (Alternate Pan Depth)
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Stelt in hoe de positie van de toets die u indrukt de positie van de pan-instelling beïnvloedt.
De pan voor nootnummer C3 is het stereoveld dat is ingesteld in Pan.
Door deze parameter op een positieve waarde in te stellen, wordt Pan naar links ingesteld voor
lagere toetsen, en naar rechts voor hogere toetsen.
Als deze parameter is ingesteld op de waarde 0, zijn er geen wijzigingen in de pan-instelling. Als de
parameter op een negatieve waarde is ingesteld, wordt de pan naar links ingesteld voor lagere
toetsen, en naar rechts voor hogere toetsen.
Instellingen: -64-+0-+63

Stelt de timing in van de Key On Delay zodat deze synchroniseert met het tempo.
Instellingen: Off, On

Stelt de vertragingstijd in vanaf het moment dat de toets wordt ingedrukt tot het moment dat er geluid
wordt geproduceerd.
Deze parameter is niet beschikbaar wanneer KeyOnDly Sync is ingesteld op On.
Instellingen: 0-127

Deze parameter is beschikbaar wanneer KeyOnDly Sync is ingesteld op On. U kunt de timing voor
Key On Delay instellen met behulp van nootwaarden.
Instellingen: 1/16 (zestiende noten), 1/8 Tri. (achtstenoottriolen), 1/16 Dot. (gepunteerde zestiende

noten), 1/8 (achtste noten), 1/4 Tri. (kwartnoottriolen), 1/8 Dot. (gepunteerde achtste
noten), 1/4 (kwartnoten), 1/2 Tri. (halve-noottriolen), 1/4 Dot. (gepunteerde kwartnoten), 1/2
(halve noten), Whole Tri. (hele-noottriolen), 1/2 Dot. (gepunteerde halve noten), 1/4 x 4
(groepen van vier kwartnoten; vier kwartnoten per tel), 1/4 x 5 (groepen van vijf kwartnoten;
vijf kwartnoten per tel), 1/4 x 6 (groepen van zes kwartnoten; zes kwartnoten per tel), 1/4 x
7 (groepen van zeven kwartnoten; zeven kwartnoten per tel), 1/4 x 8 (groepen van acht
kwartnoten; acht kwartnoten per tel)

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via General/Pitch → Zone
Settings in Part Edit (AWM2).

Op het scherm FM-X Settings kunt u de parameters voor FM Color instellen als handig
bewerkingshulpmiddel voor de FM-X-geluiden en het algoritme (of hoe de operators zijn
gerangschikt).

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → FM-X Settings

Scaling Pan (Scaling Pan Depth)

KeyOnDly Sync (Key On Delay Tempo Sync)

Delay Length (Key On Delay Time Length)

Delay Length (Key On Delay Note Length)

Zone Settings

FM-X Settings
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Regelt de aanslagtijd van de EG, waardoor de diepte van de frequentiemodulatie in de loop van de
tijd verandert.
Instellingen: -99-+99

Regelt de wegsterftijd van de EG, waardoor de diepte van de frequentiemodulatie in de loop van de
tijd verandert.
Instellingen: -99-+99

Regelt het sustainniveau van de EG, waardoor de diepte van de frequentiemodulatie in de loop van
de tijd verandert.
Instellingen: -99-+99

Regelt de releasetijd van de EG, waardoor de diepte van de frequentiemodulatie in de loop van de
tijd verandert.
Instellingen: -99-+99

Verandert het algoritme.
Instellingen: Raadpleeg de Data List.

Feedback zorgt ervoor dat de operator zichzelf moduleert door een deel van de uitgangssignalen
terug te sturen.
Hier kunt u met deze parameter de mate van een dergelijke modulatie instellen.
Instellingen: 0-7

Verandert de diepte van de frequentiemodulatie.
Instellingen: -99-+99

FM Attack

FM Decay

FM Sustain

FM Release

Algorithm (Algorithm Number)

Feedback (feedbackniveau)

FM Depth
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Verandert de frequentie van de harmonische boventonen van FM-synthese.
Instellingen: -99-+99

Verandert de textuur van FM-synthese.
Instellingen: -99-+99

Opent het scherm Algorithm Search.

Stelt het bereik in van de verandering van de afsnijfrequentie door de FEG.
Instellingen: -64-+63

Wijzigt het geluid door de afsnijfrequentie van het filter in te stellen. Wanneer het laagdoorlaatfilter is
geselecteerd, resulteren hogere waarden hier in een helderder geluid, en resulteren lagere waarden
in een donkerder geluid.
Deze parameter wordt gespecificeerd als een offsetwaarde voor de afsnijfrequentie voor het filter.
Instellingen: -64-+63

Voegt speciale kenmerken toe aan het geluid door het signaalniveau dichtbij de afsnijfrequentie aan
te passen.
Dit wordt opgegeven als een offsetwaarde voor de filterresonantie.
Instellingen: -64-+63

Opent het instellingenscherm voor het filtertype.

Opent het scherm Filter EG.

Het scherm hier is in principe hetzelfde als het scherm dat wordt geopend vanuit General/Pitch →
Pitch op het scherm Part Edit (AWM2), behalve dat Legato Slope (Portamento Legato Slope)
ongeldig is.

Op het scherm PEG/Scale kunt u de toonhoogte-envelopegenerator en schaal voor de partij
instellen.

FM Harmonics

FM Texture

Algorithm Search

Filter Offset FEG Depth

Filter Offset Cutoff (Filter Cutoff Frequency)

Filter Offset Resonance (Filter Offset Resonance/Width)

Filter Type

Filter EG

Pitch

PEG/Scale
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Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → PEG/Scale

Stelt de tijdsduur in die nodig is voordat de toonhoogte verandert vanaf het moment dat u een toets
op het toetsenbord indrukt tot het moment waarop de toonhoogte de waarde bereikt die is ingesteld
op Attack Level.
Instellingen: 0-99

Stelt de tijdsduur in die nodig is voordat de toonhoogte verandert vanaf de Attack Level tot de Decay
1 Level.
Instellingen: 0-99

Stelt de tijdsduur in die nodig is voordat de toonhoogte verandert vanaf de Decay 1 Level tot de
Decay 2 Level.
Instellingen: 0-99

Stelt de tijdsduur in die nodig is voordat de toonhoogte verandert vanaf het moment dat u de toets
hebt losgelaten totdat de Release Level wordt bereikt.
Instellingen: 0-99

Stelt de toonhoogte in voor het moment dat u de toets indrukt.
Instellingen: -50-+50

Stelt in dat de toonhoogte verandert van Initial Level nadat u een toets hebt ingedrukt.
Instellingen: -50-+50

Attack Time (PEG Attack Time)

Decay1 Time (PEG Decay 1 Time)

Decay2 Time (PEG Decay 2 Time)

Release Time (PEG Release Time)

Initial Level (PEG Initial Level)

Attack Level (PEG Attack Level)

Decay1 Level (PEG Decay 1 Level)
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Stelt de volgende toonhoogtewaarde in die moet veranderen vanaf de Attack Level.
Instellingen: -50-+50

Stelt de volgende toonhoogtewaarde in die moet veranderen vanaf de Decay 1 Level.
Instellingen: -50-+50

Stelt de uiteindelijke toonhoogte in die moet worden bereikt nadat u de toets hebt losgelaten.
Instellingen: -50-+50

Stelt de hoeveelheid toonhoogteverandering in die door de PEG wordt geregeld.
Instellingen: 8 oct, 2 oct, 1 oct, 0.5 oct

Als deze parameter bijvoorbeeld is ingesteld op 8 oct kunt u de kleinste waarde voor het
EG-niveau van de toonhoogte specificeren om een toonhoogteverandering van -4 octaven
te creëren door de toonhoogtewaarde 0 naar de interne toongenerator te sturen, en door
de grootste waarde te specificeren om een toonhoogteverandering van +4 octaven te
creëren.

Stelt in hoe de tijd van de toonhoogteverandering in PEG reageert op de snelheid of de kracht van de
toetsaanslag.
Instellingen: 0-7

Stelt in hoe de snelheid van de toonhoogteverandering in PEG reageert op de toetspositie.
De snelheidsverandering in PEG wordt gebruikt voor de opgegeven toets in Center Key (vastgezet
op C3).
Instellingen: 0-7

Positieve waarden: hoe lager de gespeelde toets, hoe langzamer de verandering in de
PEG wordt; hoe hoger de gespeelde toets, hoe sneller de verandering in de PEG wordt.
0: geen PEG-veranderingen, ongeacht de toetspositie.

Verandert de toonhoogte van het element willekeurig telkens wanneer de toets wordt ingedrukt.
Instellingen: 0-127

Stelt in hoe de toonhoogte reageert op de aanslagsnelheid of de kracht van de toetsaanslag.
Instellingen: -64-+63

Positieve waarde: hoe hoger de snelheid, hoe hoger de toonhoogte wordt.
Negatieve waarde: hoe sneller de aanslagsnelheid, hoe lager de toonhoogte wordt.
0: geen verandering van toonhoogte

Decay2 Level (PEG Decay 2 Level)

Release Level (PEG Release Level)

PEG Depth

Depth/Vel (PEG Depth Velocity Sensitivity)

Time/Key (PEG Time Key Follow Sensitivity)

Random Pitch (Random Pitch Depth)

Pitch/Vel (Pitch Velocity Sensitivity)
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Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Filter → Type in Part
Edit (AWM2) Element Edit.

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Filter → Filter EG in
Part Edit (AWM2) Element Edit.

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Filter → Scale in Part
Edit (AWM2) Element Edit.

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Filter/Amp → Amp EG
in Part Edit (AWM2).

Het scherm hier is in principe hetzelfde als het scherm dat wordt geopend via Effect → Routing in
Part Edit (AWM2). Er zijn echter enkele verschillen, zoals hieronder weergegeven.

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → InsA of InsB in
Part Edit (AWM2).

Filter / Amp

Filter Type

Filter EG

Filter Scale

Amp EG

Effect

Routing

Geen uitvoerinstelling voor elk element

Kan Parallel niet selecteren voor Ins Connect

Ins A
Ins B
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Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → 3-band EQ in
Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → 2-band EQ in
Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Arpeggio → Common in
Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Arpeggio → Individual in
Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Arpeggio → Advanced
in Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Motion Seq → Common
in Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Motion Seq → Lane in
Part Edit (AWM2).

3-band EQ

2-band EQ

Arpeggio

Common

Individual

Advanced

Motion Seq

Common

Lane
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Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Mod/Control → Control Assign

Het scherm hier is in principe hetzelfde als het scherm dat wordt geopend via Mod/Control → Control
Assign in Part Edit (AWM2), behalve dat de beschikbare instellingen voor Destination anders zijn.
Voor een lijst met instellingen raadpleegt u de Data List.
Ook zijn de onderstaande parameters beschikbaar, in plaats van ElementSw.

U kunt de regelaarinstelling voor elke operator in- of uitschakelen. Deze parameter wordt alleen
weergegeven als de geselecteerde Destination gerelateerd is aan operators.
Instellingen: Off, On

Stelt de gevoeligheid in van de regelaar die is geselecteerd voor de Destination.
Deze parameter wordt alleen weergegeven als de Destination is ingesteld op OP Freq of OP AEG
Offset.
Instellingen: -7-+7

Mod/Control

Control Assign

Operator Sw (Operator Switch)

Operator Rate

Sw/Rate
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Schakelt tussen de Operator Sw en Operator Rate.
Deze parameter wordt alleen weergegeven als de Destination is ingesteld op OP Freq of OP AEG
Offset.
Instellingen: Off, On

Het scherm hier is in principe hetzelfde als het scherm dat wordt geopend via Mod/Control → After
Touch in Part Edit (AWM2), behalve dat de beschikbare instellingen voor Destination anders zijn.

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Mod/Control → Tx/Rx
Switch in Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Mod/Control → Control
Settings in Part Edit (AWM2).

Op het scherm Part LFO kunt u de Part LFO instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Mod/Control → Part LFO

Selecteert de LFO-golfvorm en stelt het type cyclische veranderingen voor de LFO's in.
Instellingen: Triangle, Triangle+, Saw Up, Saw Down, Squ1/4, Squ1/3, Square, Squ2/3, Squ3/4,

Trapezoid, S/H1, S/H2, User

After Touch

Tx/Rx Switch

Control Settings

Part LFO

LFO Wave

Edit User LFO
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Opent het instellingenscherm voor de gebruikers-LFO.
U kunt een LFO-golfvorm van maximaal 16 stappen creëren.

Stelt de snelheid in van de LFO Wave-wijzigingen, zodat deze worden gesynchroniseerd met het
afspelen van arpeggio's of songs.
Instellingen: Off (niet gesynchroniseerd), On (gesynchroniseerd)

Stelt de snelheid van LFO Wave-wijzigingen in.
Deze parameter is niet beschikbaar wanneer Tempo Sync is ingesteld op On.
Instellingen: 0-63

Verandert de LFO Speed willekeurig.
Deze parameter is niet beschikbaar wanneer Tempo Sync is ingesteld op On.
Instellingen: 0-127

Deze parameter is niet beschikbaar wanneer Tempo Sync is ingesteld op On. U kunt de snelheid
van veranderingen in LFO Wave instellen door muzieknootwaarden te gebruiken.
Instellingen: 1/16 (zestiende noten), 1/8 Tri. (achtstenoottriolen), 1/16 Dot. (gepunteerde

zestiende noten), 1/8 (achtste noten), 1/4 Tri. (kwartnoottriolen), 1/8 Dot. (gepunteerde
achtste noten), 1/4 (kwartnoten), 1/2 Tri. (halve-noottriolen), 1/4 Dot. (gepunteerde
kwartnoten), 1/2 (halve noten), Whole Tri. (hele-noottriolen), 1/2 Dot. (gepunteerde halve
noten), 1/4 x 4 (groepen van vier kwartnoten; vier kwartnoten per tel), 1/4 x 5 (groepen
van vijf kwartnoten; vijf kwartnoten per tel), 1/4 x 6 (groepen van zes kwartnoten; zes
kwartnoten per tel), 1/4 x 7 (groepen van zeven kwartnoten; zeven kwartnoten per tel),
1/4 x 8 (groepen van acht kwartnoten; acht kwartnoten per tel), 1/4 x 16 (zestien
kwartnoten per tel), 1/4 x 32 (32 kwartnoten per tel), 1/4 x 64 (64 kwartnoten per tel)

Stelt de vertragingstijd in tussen het moment waarop u een toets op het toetsenbord aanslaat en het
moment waarop de LFO actief wordt.
Hoe hoger de waarde, hoe langer de wegsterftijd voordat de LFO in werking treedt.
Instellingen: 0-127

Stelt in na hoeveel tijd het LFO-effect gaat infaden nadat de vertragingstijd die is ingesteld in Delay
(LFO Delay Time) is verstreken.
Instellingen: 0-127

Hoe hoger de waarde, hoe langer het duurt voordat het LFO-effect het maximum bereikt.
0: LFO verandert naar de maximale waarde zonder enige fade-in.

Tempo Sync (LFO Tempo Sync)

Als Tempo Sync is ingesteld op Off

Speed (LFO Speed)

Random Speed (Part LFO Random Speed Depth)

Als Tempo Sync is ingesteld op On

Tempo Speed (LFO Tempo Speed)

Delay (LFO Delay Time)

Fade In (LFO Fade In Time)
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Lage waarde: snelle fade-in

Hoge waarde: langzame fade-in

Stelt de tijd in voor het behouden van het LFO-effect nadat het maximale niveau is bereikt.
Instellingen: 0-126, Hold

Hold: geen fade-out

Stelt in na hoeveel tijd het LFO-effect gaat uitfaden nadat de aanhoudduur die is ingesteld in Hold
(LFO Hold Time) is verstreken.
Hoe hoger de waarde, hoe langer het duurt voordat het LFO-effect uitfadet.
Instellingen: 0-127

Hold (LFO Hold Time)

Fade Out (LFO Fade Out time)
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Lage waarde: snelle fade-out

Hoge waarde: langzame fade-out

Zet de oscillatie van de LFO terug wanneer een toets wordt ingedrukt.
Instellingen: Off, Each-on, 1st-on

Zet de oscillatie van de LFO niet terug. Als op
een toets wordt gedrukt, wordt de LFO-golf
gestart, ongeacht de fase waarin de LFO zich
op dat moment bevindt.

Key On Reset (LFO Key On Reset)

Off
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Zet de oscillatie van de LFO telkens terug
wanneer een toets wordt ingedrukt en start de
golfvorm in de fase die is gespecificeerd door
de Phase-parameter.

Zet de oscillatie van de LFO telkens terug
wanneer een toets wordt ingedrukt en start de
golfvorm in de fase die is gespecificeerd door
de Phase-parameter.

Wanneer de tweede noot wordt gespeeld
terwijl de eerste noot wordt vastgehouden,
wordt het afspelen niet teruggezet.

Stelt de LFO Wave in op afspelen in een lus (herhaald) of one-shot (eenmalig) afspelen.
Instellingen: Off, On

Stelt de initiële fase in voor wanneer LFO Wave wordt gereset.
Instellingen: 0°, 90°, 120°, 180°, 240°, 270°

Stelt de functie in die moet worden geregeld door de LFO Wave.

Each-on

1st-on

Loop (LFO Loop Switch)

Phase (LFO Phase)

Destination (LFO Destination)
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Instellingen: Insertion Effect A Parameter1–24, Insertion Effect B Parameter1–24 (afhankelijk van
het Insertion Effect)

Stelt de diepte in van de LFO Wave-regelaar voor iedere Destination.
Instellingen: 0-127

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Mod/Control → 2nd LFO

Selecteert de tweede LFO-golf.
Instellingen: Triangle, Saw Down, Saw Up, Square, Sine, S/H

OPMERKING
De amplitudemodulatiefrase wordt verschoven met Sine.

Schakelt tussen de oude set instellingen (Uit: 0-99) en een nieuwe set instellingen met een hogere
resolutie (Aan: 0-415) voor Speed (2nd LFO Speed).
Om de compatibiliteit van data die met de oude instellingen zijn gemaakt te behouden, stelt u deze
parameter in op Off.
Instellingen: Off, On

Stelt de snelheid van veranderingen in de LFO Wave (2nd LFO Wave) in.
Instellingen: 0-99 (wanneer Extended is ingesteld op Off), 0-415 (wanneer Extended is ingesteld op

On)

Stelt de initiële fase in voor wanneer LFO Wave (2nd LFO Wave) wordt gereset.

Depth (LFO Depth)

2nd LFO

LFO Wave (2nd LFO Wave)

Extended LFO (2nd LFO Extended LFO)

Speed (2nd LFO Speed)

Phase (2nd LFO Phase)
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Instellingen: 0°, 90°, 180°, 270°

Stelt de tijdsduur in voor het infaden van het 2e LFO-effect nadat u de toets hebt losgelaten en de
wegsterftijd die is ingesteld in Delay is verstreken.
Instellingen: 0-99

Zet de oscillatie van de 2e LFO terug wanneer een toets wordt ingedrukt.
Instellingen: Off, On

Deze parameter creëert een vibrato-effect (cyclische veranderingen in de toonhoogte) door gebruik
te maken van de LFO Wave (2nd LFO Wave), en laat u de diepte van de toonhoogtemodulatie door
de LFO specificeren.
Instellingen: 0-99

Stelt de diepte van de modulatie in via LFO-signalen die zijn ingesteld in Pitch Modulation Depth (2nd
LFO Pitch Modulation Depth).
Instellingen: 0-7

Deze parameter creëert cyclische veranderingen in het volume door gebruik te maken van de LFO
Wave (2nd LFO Wave), en laat u de diepte van de volumemodulatie door de LFO specificeren.
Instellingen: 0-99

Stelt de diepte van de modulatie in via LFO-signalen die zijn ingesteld in Amplitude Modulation Depth
(2nd LFO Amplitude Modulation Depth).
Instellingen: 0-7

Deze parameter creëert cyclische veranderingen in de filterafsnijfrequentie door gebruik te maken
van de LFO Wave (2nd LFO Wave), en laat u de diepte van de filtermodulatie door de LFO
specificeren.
Instellingen: 0-99

Delay (2nd LFO Delay Time)

Key On Reset (2e LFO Key On Reset)

Pitch Modulation Depth (2nd LFO Pitch Modulation Depth)

Pitch Modulation Operator Depth Ratio (2nd LFO Pitch Modulation Depth Offset)

Amplitude Modulation Depth (2nd LFO Amplitude Modulation Depth)

Amplitude Modulation Operator Depth Ratio (2nd LFO Amplitude Modulation Depth Offset)

Filter Modulation Depth (2nd LFO Filter Modulation Depth)
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Inhoudsopgave

Op het Form/Freq-scherm kunt u de golfvorm en frequentie van de Operator instellen.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part selectie → Operator selectie → Form/Freq

Stelt de tijd in die nodig is voordat de toonhoogte de waarde bereikt die is ingesteld bij Attack Level.
Instellingen: 0-99

Stelt de tijdsduur in die nodig is voordat de toonhoogte verandert van de waarde die is ingesteld bij
het Attack Level tot het moment dat de PEG verandert naar de waarde 0.
Instellingen: 0-99

Stelt de toonhoogte in voor het moment dat u de toets indrukt.
Instellingen: -50-+50

Operator Edit

Form/Freq

Level

Algorithm Search

Form/Freq

Attack Time (PEG Attack Time)

Decay Time (PEG Decay Time)

Initial Level (PEG Initial Level)
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Stelt de verandering in toonhoogte in vanaf het Hold Level of vanaf het moment dat u een toets
indrukt.
Instellingen: -50-+50

(1) Pitch (frequency) ingesteld op Coarse Tune en Fine Tune

Stelt de golfvorm in voor de geselecteerde operator.
Instellingen: Sine, All 1, All 2, Odd 1, Odd 2, Res 1, Res 2

Sine: sinusgolf zonder harmonische boventonen
All 1: golf met harmonische boventonen in een breed Spectral bereik
All 2: golf met harmonische boventonen in een nauw Spectral bereik
Odd 1: golf met oneven harmonischen in een breed Spectral bereik
Odd 2: golf met oneven harmonischen in een nauw Spectral bereik
Res 1: golf met een piek op een bepaalde harmonische in een breed Spectral bereik
Res 2: golf met een piek op een bepaalde harmonische in een nauw Spectral bereik

Stelt de breedte van de overgangsband (skirt) in.
Hoe kleiner de waarde, hoe smaller de skirt wordt om een ​​bepaalde harmonische te versterken.
Deze parameter is niet beschikbaar wanneer Spectral is ingesteld op Sine.
Instellingen: 0-7

Stelt de gevoeligheid van het resonantie-effect in Spectral in.
De middenfrequentie wordt verschoven naar harmonischen van hogere orde, zodat u het resonantie-
effect kunt creëren of speciale kenmerken aan het geluid kunt toevoegen.
Deze parameter is alleen beschikbaar wanneer Spectral is ingesteld op Res 1 of Res 2.
Instellingen: 0-99

Sine is een eenvoudige golfvorm die alleen de grondgolf bevat, zonder harmonischen, terwijl andere
golfvormen harmonische boventonen bevatten. Als u Form dus op een andere golf dan Sine hebt

Attack Level (PEG Attack Level)

Spectral (Spectral Form)

Skirt (Spectral Skirt)

Resonance (Spectral Resonance)
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ingesteld, zijn de parameters die verband houden met de harmonischen en de "piek"-waarden
(formanten) beschikbaar. Hieronder staan enkele specifieke parameters voor het besturen van elke
golf, uitgelegd in Spectral.

U kunt het aantal harmonische boventonen vergroten door een grotere waarde voor Skirt in te stellen
om het spectrumbereik uit te breiden.

Als u een grotere waarde voor Resonance instelt, verschuift de middenfrequentie naar harmonischen
van hogere orde.
Resonance wordt ingesteld op 0: verschuift naar de eerste harmonische.
Resonance wordt ingesteld op 99: verschuift naar de 100e harmonische.

Zet de oscillatie van de oscillator terug wanneer een toets wordt ingedrukt.
Key On Reset (Oscillator Key On Reset)
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Instellingen: Off, On
Off: reset de oscillatie van de oscillator niet. Als op een toets wordt gedrukt, wordt de LFO-
golf gestart, ongeacht de fase waarin de LFO zich op dat moment bevindt.

Stelt in hoe de toonhoogte reageert op de aanslagsnelheid of de kracht van de toetsaanslag.
Deze parameter is alleen beschikbaar als Freq Mode is ingesteld op Fixed.
Instellingen: -7-+7

Positieve waarde: hoe hoger de snelheid, hoe hoger de toonhoogte wordt.
Negatieve waarde: hoe sneller de aanslagsnelheid, hoe lager de toonhoogte wordt.
0: ongewijzigd gebleven

Hiermee wordt de uitgangstoonhoogte van de operator ingesteld.
Instellingen: Ratio, Fixed

Ratio: stelt de uitgangstoonhoogte in volgens de toonsoort.
Fixed: stelt de toonhoogte in op Coarse of Fine, ongeacht de toonhoogte van de toets die
wordt ingedrukt.

Hiermee wordt de uitgangstoonhoogte aangepast van elke operator.
Instellingen: Wanneer Freq Mode wordt ingesteld op Ratio: 0-31

Wanneer Freq Mode wordt ingesteld op Fixed: 0-21

Hiermee wordt de uitgangstoonhoogte van elke operator nauwkeurig aangepast.
Instellingen: Wanneer Freq Mode wordt ingesteld op Ratio: 0-99

Wanneer Freq Mode wordt ingesteld op Fixed: 0-127

Stelt de uitvoertoonhoogte van elke operator iets hoger of later in.
Als dezelfde waarde is ingesteld op Coarse en Fine, zal de Operator met de instellingDetune kleine
toonhoogteverschillen vertonen. Hierdoor kunt u een warmer geluid of choruseffect creëren.
Instellingen: −15–+15

Stelt het verschil in toonhoogte in tussen twee naast elkaar liggende toetsen.
Deze parameter is alleen beschikbaar als Freq Mode is ingesteld op Fixed.
Instellingen: 0-99

0: er is geen toonhoogteverschil tussen de twee aangrenzende toetsen en alle toetsen
worden gespeeld op de toonhoogte die is ingesteld in Coarse of Fine.
99: het toonhoogteverschil tussen twee aangrenzende toetsen wordt ingesteld op een
halve toon.

Pitch/Vel (Pitch Velocity Sensitivity)

Freq Mode (Oscillator Frequency Mode)

Coarse (Coarse Tune)

Fine (Fine Tune)

Detune

Pitch/Key (Pitch Key Follow Sensitivity)

Level
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Op het scherm Level kunt u de algemene parameters voor de operator instellen.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part selectie → Operator selectie → Level

Stelt de tijdsduur in die nodig is voordat de waarde verandert vanaf het moment dat u een toets op
het toetsenbord indrukt tot het moment waarop de waarde het Hold Level bereikt.
Instellingen: 0-99

Stelt de tijdsduur in die nodig is voordat de waarde verandert vanaf het moment dat u een toets op
het toetsenbord indrukt tot het moment waarop de waarde het Attack Level bereikt.
Instellingen: 0-99

Stelt de tijdsduur in die nodig is voordat de waarde verandert vanaf het Attack Level tot het Decay 1
Level.
Instellingen: 0-99

Stelt de tijdsduur in die nodig is voordat de waarde verandert vanaf het Decay 1 Level tot het Decay
2 Level.
Instellingen: 0-99

Stelt de tijdsduur in die nodig is voordat de waarde verandert vanaf het moment dat u een toets op
het toetsenbord indrukt tot het moment waarop de waarde het Hold (Release) Level bereikt.
Instellingen: 0-99

Stelt de waarde in die moet worden gewijzigd na het indrukken van een toets.
Instellingen: 0-99

Hold Time (AEG Hold Time)

Attack Time (AEG Attack Time)

Decay 1 Time (AEG Decay 1 Time)

Decay 2 Time (AEG Decay 2 Time)

Release Time (AEG Release Time)

AEG Attack Level
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Stelt de volgende waarde in die moet veranderen vanaf het Attack Level.
Instellingen: 0-99

Stelt de waarde in die wordt aangehouden terwijl de toets ingedrukt wordt gehouden.
Instellingen: 0-99

Stelt de uiteindelijke waarde in die moet worden bereikt nadat u de toets hebt losgelaten.
Instellingen: 0-99

Stelt het uitgangsniveau voor de operator in.
Instellingen: 0-99

Stelt in hoe het niveau reageert op de aanslagsnelheid of de kracht van de toetsaanslag.
Instellingen: -7-+7

Positieve waarden: hoe hoger de snelheid, hoe luider het volume wordt.
Negatieve waarden: hoe langzamer de snelheid, hoe luider het volume wordt.
0: geen veranderingen, ongeacht de aanslagsnelheidsinstelling.

Stelt in hoe de snelheid van de niveauverandering in AEG reageert op de toetspositie.
Instellingen: 0-7

Positieve waarden: hoe lager de gespeelde toets, hoe langzamer het AEG-volume
verandert; hoe hoger de gespeelde toets, hoe sneller het AEG-volume verandert.
0: geen veranderingen in het AEG-volume, ongeacht de toetspositie.

AEG Decay 1 Level

AEG Decay 2 Level

Rel (Hold) Level (AEG Release (Hold) Level)

Level (Operator Level)

Level/Vel (Level Velocity Sensitivity)

Time/Key (AEG Time Key Follow Sensitivity)
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Stelt het nootnummer in voor het Break Point van de amplitudeschaling.
Instellingen: A−1–C8

Stelt de steilheid van de veranderingscurve in.
Instellingen: 0-99

Stelt de veranderingscurve in voor de amplitudeschaal.
Instellingen: −Linear, −Exp, +Exp, +Linear

Het toetsenbord is in twee gedeelten verdeeld bij het Break Point. Stel Curve Lo in voor de steilheid
van de curve aan de linkerkant van het Break Point en Lvl/Key Lo voor de steilheid van de curve aan
de rechterkant van het Break Point.
Stel op dezelfde manier Curve Hi in om de curve voor de rechterkant van het Break Point te
selecteren, en Lvl/Key Hi tot de steilheid van de curve (zoals hieronder weergegeven.)

Het toets op het Break Point is dezelfde als het uitgangsniveau dat is ingesteld in het Operator Level.
Met de toetsen aan de linkerkant van het Break Point wordt het uitgangsniveau gecorrigeerd naar de
curve die is ingesteld in Curve Lo (Level Scaling Low Curve) en Lvl/Key Lo (Level Scaling Low
Depth). Met de toetsen aan de rechterkant van het Break Point wordt het uitgangsniveau
gecorrigeerd naar de curve die is ingesteld in Curve Hi (Level Scaling High Curve) en Lvl/Key Hi
(Level Scaling High Depth). Het uitgangsniveau van Exp-curven verandert exponentieel, terwijl het
uitgangsniveau van Liner-curven lineair verandert. In beide gevallen geldt dat hoe verder een toets
van het Break Point ligt, hoe groter de verandering in uitgangsniveau.

Break Point (Level Scaling Break Point)

Lvl/Key Lo (Level Scaling Low Depth)
Lvl/Key Hi (Level Scaling High Depth)

Curve Lo (Level Scaling Low Curve)
Curve Hi (Level Scaling High Curve)

Algorithm Search
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Hiermee opent u het scherm Algorithm Search.
U kunt het zoekresultaat filteren op basis van het aantal operators verbonden in ketens en het aantal
draaggolven.

U kunt het zoekresultaat filteren op basis van het aantal operators dat is verbonden in ketens.
Instellingen: 1-8

U kunt het zoekresultaat filteren op basis van het aantal draaggolven.
Instellingen: 1-8

Chain

Carrier
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Het normale gedeelte (AN-X) bestaat uit drie oscillatoren en ruis.
De Part Edit (AN-X) bevat Part Common Edit voor het instellen van parameters voor de gehele partij
en Oscillator Edit voor het instellen van parameters voor elke oscillator en Noise Edit voor het
bewerken van ruis.

Part Edit (AN-X)-scherm
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Inhoudsopgave

Part Common Edit

General/Pitch

Part Settings

Zone Settings

AN-X Settings

Pitch

Pitch EG

Pitch LFO

Modifier

Wave Folder

Modifier EG

Modifier LFO

Filter/Amp

Mixing

Filter Type

Filter EG

Filter LFO

Amp EG

Amp LFO

Effect

Routing

Ins A

Ins B

3-band EQ

2-band EQ

Arp/MS

Arp Common

Individual

Advanced

MS Common

Lane

Mod/Control

Control Assign
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Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via General/Pitch → Part
Settings in het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via General/Pitch → Zone
Settings in het scherm Part Edit (AWM2).

In het scherm AN-X Settings kunt u de parameters instellen die specifiek zijn voor de AN-X-
soundengine.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → AN-X Settings

Creëert dikte door meerdere geluiden in lagen te plaatsen.
Instellingen: Off, 2, 4

Stelt in hoe de toonhoogte van het gelaagde geluid moet worden verschoven.

After Touch

Tx/Rx Switch

Control Settings

Part LFO

General/Pitch

Part Settings

Zone Settings

AN-X Settings

Unison

Unison Detune
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Instellingen: 0−15

Stelt in hoe de gelaagde geluiden in het stereoveld worden verspreid.
Instellingen: 0−15

Specificeert hoe de oscillator moet worden gereset.
Instellingen: Off, Phase, Tune, Full

Off: wordt niet gereset.
Phase: de fase van OSC 1-3 wordt gereset bij het inschakelen.
Tune: maakt de toonhoogte van OSC 1-3 uniform.
Full: schakelt Phase en Tune tegelijkertijd in.

Geeft de toonhoogte van de oscillator en de variatie van Filter Cutoff op.
Oscillatortoonhoogte en variatie van Filter Cutoff worden beïnvloed door Ageing.
Instellingen: 0−127

0: geen variatie
64: standaard
127: maximale variatie

Unison Spread

OSC Reset

Voltage Drift

Ageing
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Past de frequentierespons aan, evenals OSC Pitch, Filter Cutoffen EG Time volgens de virtuele
leeftijd van het instrumentmodel.
Instellingen: −100 (oud)−+100 (nieuw)

(1) Variaties in Cutoff of Pitch

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via General/Pitch → Pitch
in scherm Part Edit (AWM2), behalve dat Legato Slope (Portamento Legato Slope) ongeldig is.

In het scherm Pitch EG kunt u de Pitch Envelope Generator instellen.
U kunt het gebruiken om in te stellen hoe het geluid in de loop van de tijd verandert, vanaf het
moment dat u op een toets op het toetsenbord drukt tot wanneer het geluid wegsterft.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → Pitch EG

Correlatie tussen Voltage Drift en Ageing

Pitch

Pitch EG
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Stelt de tijdsduur in die nodig is voordat de EG het maximum bereikt.
Instellingen: 0−255

Stelt de tijdsduur in die nodig is voordat de EG de Sustain-waarde bereikt.
Instellingen: 0−255

Hiermee stelt u het sustainniveau in.
Instellingen: 0−511

Stelt de tijdsduur in die nodig is nadat u de toets hebt losgelaten, totdat de EG de waarde 0 bereikt.
Instellingen: 0−255

Stelt in hoe de snelheid de EG in de loop van de tijd verandert.
Hoe hoger de waarde, hoe sneller de EG in de loop van de tijd verandert als de toetsen met hoge
snelheid worden bespeeld.
Instellingen: −255-0−+255

Stelt de maximale hoeveelheid toonhoogteverandering in voor de EG (in cents).
Instellingen: −4800−+4800 cent

0: geen toonhoogteverandering
Hoe verder de diepte verwijderd is van de waarde 0, hoe breder het bereik van de
toonhoogteverandering wordt.
Negatieve waarde: toonhoogteverandering is omgekeerd.

Stelt in hoe het dieptebereik van de toonhoogteverandering die wordt geregeld door de PEG reageert
op de snelheid of de kracht van de toetsaanslag.
Met de Curve-instelling kunt u ook instellen hoe de PEG Depth op de aanslag reageert. De verticale
as vertegenwoordigt de snelheid, terwijl de horizontale as het dieptebereik van de
toonhoogteverandering vertegenwoordigt.
Instellingen: −255−+255

Positieve waarde: hogere snelheidswaarden vergroten het dieptebereik van de PEG,
terwijl langzamere waarden het dieptebereik verkleinen.
Negatieve waarde: hogere snelheidswaarden verkleinen het dieptebereik van de PEG,
terwijl langzamere waarden het dieptebereik vergroten.
0: geen PEG-veranderingen, ongeacht de aanslaginstelling.

Attack (Pitch EG Attack Time)

Decay (Pitch EG Decay Time)

Sustain (Pitch EG Sustain Level)

Release (Pitch EG Release Time)

Time/Vel (Pitch EG Time Velocity Sensitivity)

PEG Depth - Osc 1–3 (Oscillator 1–3 Pitch EG Depth)

PEG Depth/Vel - Osc 1–3 (Oscillator 1–3 Pitch EG Depth Velocity Sensitivity)
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Hoge snelheid
(het dieptebereik bij toonhoogteverandering is

groter)

Lage snelheid
(het dieptebereik bij toonhoogteverandering is

kleiner)

Op het scherm Pitch LFO kunt u de Pitch LFO instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → General/Pitch → Pitch LFO

Selecteert de LFO-golfvorm en stelt het type cyclische veranderingen in de LFO's in.
Instellingen: Saw, Square, Triangle, Sine, Random

Zet de fase van de LFO terug wanneer een toets wordt ingedrukt.
Instellingen: Off, On

Pitch LFO

LFO Wave (Pitch LFO Wave)

Key On Reset (Pitch LFO Key On Reset)
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Stelt de snelheid van LFO Wave-wijzigingen in.
Instellingen: 0−415

Stelt de vertragingstijd in tussen het moment waarop u een toets op het toetsenbord aanslaat en het
moment waarop de LFO actief wordt.
Instellingen: 0−127

Stelt de tijdsduur in die nodig is voordat LFO-effect infadet nadat u de toets hebt losgelaten en de
vertragingstijd die is ingesteld in Delay, is verstreken.
Instellingen: 0−214

Hoe hoger de waarde, hoe langer het duurt voordat het LFO-effect het maximum bereikt.
0: de LFO verandert naar de maximale waarde zonder enige fade-ins.

Lage waarde: snelle fade-in

Hoge waarde: langzame fade-in

Speed (Pitch LFO Speed)

Delay (Pitch LFO Decay Time)

Fade In (Pitch LFO Fade In Time)
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Stelt de fase in voor het resetten van de golfvorm wanneer een toets wordt ingedrukt.
Instellingen: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Fase van de golf

Stelt het dieptebereik in van toonhoogteverandering die door de LFO worden geregeld.
Instellingen: −4800−+4800 cent

0: geen toonhoogteverandering
Hoe verder de diepte verwijderd is van de waarde 0, hoe breder het bereik van de
toonhoogteverandering wordt.
Negatieve waarde: toonhoogteverandering is omgekeerd.

Modifier is een functieblok om vervorming toe te voegen aan de signaaluitvoer van het OSC-blok en
om boventonen toe te voegen aan het geluid.

Wave folder is een effect dat wordt gecreëerd door golfvormen te vouwen volgens de opgegeven
waarde. Met dit effect kunt u vloeiende veranderingen creëren, van delicate vervorming tot
akoestische vernietiging. Met de AN-X-geluidsengine kunt u dit effect op elke noot afzonderlijk
gebruiken.

Phase (Pitch LFO Phase)

Pitch LFO Depth - Osc 1–3 (Oscillator 1–3 Pitch LFO Depth)

Modifier

Wave Folder
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Er zijn verschillende regelaars beschikbaar, waaronder EG, LFO, aanslag en polyfone aftertouch, om
dit effect in realtime te regelen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Modifier → Wave Folder

Geeft de mate van golfvormvouwing op.
Instellingen: 0–255

Stelt in hoe de Wave Folder reageert op de Velocity.
Instellingen: −255–0–+255

Wijzigt de textuur van de Wave Folder.
Instellingen: 0–255

Wijzigt het type Wave Folder.
Instellingen: Soft, Hard

Opent het instellingenscherm voor Modifier EG.

Wave Folder (Modifier Wave Folder)

Folder/Vel (Modifier Wave Folder Velocity Sensitivity)

Texture (Modifier Wave Folder Texture)

Folder Type (Modifier Wave Folder Type)

Modifier EG Settings
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Opent het instellingenscherm voor Modifier LFO.

In het scherm Modifier EG kunt u de envelopegenerator voor de modifier instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Modifier → Modifier EG

Stelt de tijdsduur in die nodig is voordat de EG verandert vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment waarop het maximum wordt bereikt.
Instellingen: 0–255

Stelt de tijdsduur in die nodig is voordat de EG verandert vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment waarop de EG de waarde van het Sustain-niveau bereikt.
Instellingen: 0–255

Stelt het sustainniveau in.
Instellingen: 0–511

Stelt de tijdsduur in die nodig is voordat de EG een waarde van 0 bereikt nadat u de toets hebt
losgelaten.
Instellingen: 0–255

Stelt in hoe de snelheid de EG in de loop van de tijd verandert.
velocity meterHoe hoger de waarde, hoe sneller de EG in de loop van de tijd verandert als de toetsen
met snelle aanslag worden bespeeld.

Modifier LFO Settings

Modifier EG

Attack (Modifier EG Attack)

Decay (Modifier EG Decay)

Sustain (Modifier EG Sustain Level)

Release (Modifier EG Release Time)

Time/Vel (Modifier EG Velocity Sensitivity)
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Instellingen: −255-0−+255

Stelt in hoe de Wave Folder reageert op Modifier EG.
Instellingen: −127–+127

In het scherm Modifier LFO kunt u de Modifier LFO instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Modifier → Modifier LFO

Selecteert de LFO-golfvorm en stelt het type cyclische veranderingen voor de LFO's in.
Instellingen: Saw, Square, Triangle, Sine, Random

Zet de fase van de LFO terug wanneer een toets wordt ingedrukt.
Instellingen: Off, On

EG Depth Wave Folder (Modifier Wave Folder EG Depth)

Modifier LFO

Wave (Modifier LFO Wave)

Key On Reset (Modifier LFO Key On Reset)
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Stelt de snelheid van LFO-golfvormwijzigingen in.
Instellingen: 0–415

Stelt de vertragingstijd in tussen het moment waarop u een toets op het toetsenbord aanslaat en het
moment waarop de LFO actief wordt.
Instellingen: 0–127

Stelt de tijdsduur in die nodig is voordat LFO-effect infadet nadat u de toets hebt losgelaten en de
vertragingstijd die is ingesteld in Delay, is verstreken.
Instellingen: 0–214

Hoe hoger de waarde, hoe langer het duurt voordat het LFO-effect het maximum bereikt.
0: de LFO verandert naar de maximale waarde zonder enige fade-ins.

Lage waarde: snelle fade-in

Hoge waarde: langzame fade-in

Stelt de LFO-fase in voor het resetten van de golfvorm wanneer een toets wordt ingedrukt.
Instellingen: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Speed (Modifier LFO Speed)

Delay (Modifier LFO Delay Time)

Fade In Time (Modifier LFO Fade In Time)

Phase (Modifier LFO Phase)
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Fase van de golf

Stelt het dieptebereik in van toonhoogteverandering die door de LFO wordt geregeld.
Instellingen: −127–+127

0: geen verandering van toonhoogte
Hoe verder de diepte verwijderd is van de waarde 0, hoe breder het bereik van de
toonhoogteverandering wordt.
Negatieve waarde: toonhoogteverandering is omgekeerd.

In het scherm Mixing kunt u de uitvoer van elke oscillator instellen terwijl u het signaalstroomdiagram
voor de AN-X-partij controleert.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Filter / Amp → Mixing

LFO Depth (Modifier LFO Depth)

Filter/Amp

Mixing
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Stelt in hoe OSC3 OSC1 en OSC2 moduleert met behulp van frequentiemodulatie (FM).
Instellingen: 0−255

Hiermee opent u het scherm OSC/Tune voor Oscillator Edit.

Hiermee opent u het scherm Noise.
Handig voor het creëren van verschillende SFX-geluiden door filters zoals VCF en HPF op de
ruissignalen te gebruiken.

Stelt in hoe de OSC3 OSC1 en OSC2 moduleert met behulp van ringmodulatie (FM).
Instellingen: 0−255

1, 2 en 3 zijn voor het instellen van het oscillatorvolume.
Noise is voor het aanpassen van het niveau van de signaaluitvoer van de ruiseenheid. U kunt de
niveaubalans regelen met andere signalen, zoals OSC 1, OSC 2 en Ring Modulator.
Instellingen: 0−511

Stelt de uitvoerbestemming in voor de oscillatoren en ruis.
Instellingen: Filter, Amp

Hiermee opent u het scherm Filter/Amp → Filter Type voor Part Edit (AN-X).

Hiermee opent u het scherm Filter/Amp → Amp EG voor Part Edit (AN-X).

FM 3 → 1 (Oscillator 1 FM Level)
FM 3 → 2 (Oscillator 2 FM Level)

Osc 1 (Oscillator 1)
Osc 2 (Oscillator 2)
Osc 3 (Oscillator 3)

Noise

Ring 3 → 1 (Oscillator 1 Ring Level)
Ring 3 → 2 (Oscillator 2 Ring Level)

1 (Oscillator 1 Out Level)
2 (Oscillator 2 Out Level)
3 (Oscillator 3 Out Level)
Noise (Noise Out Level)

Connect 1 (Oscillator 1 Out Select)
Connect 2 (Oscillator 2 Out Select)
Connect 3 (Oscillator 3 Out Select)
Noise Connect (Noise Out Select)

Filter 1
Filter 2

Amplifier

Filter Type
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In het scherm Filter Type kunt u het filtertype selecteren.
Welke parameters beschikbaar zijn, is afhankelijk van het filtertype dat u hier hebt geselecteerd.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Filter / Amp → Filter Type

Stelt het filter in.
De filters die beschikbaar zijn voor de AN-X zijn gegroepeerd in drie typen: LPF, HPF en BPF.
Instellingen: Thru, LPF24, LPF18, LPF12, LPF6, HPF24, HPF18, HPF12, HPF6, BPF12, BPF6

Kapt de signalen af boven de waarde die is ingesteld bij de afsnijfrequentie.
Het geluid wordt helderder naarmate u de afsnijfrequentie verhoogt, omdat er meer signalen door
het filter worden doorgelaten.
Het geluid wordt donkerder naarmate u de afsnijfrequentie verlaagt, omdat signalen door het filter
worden afgesneden of geblokkeerd.
U kunt een karakteristiek 'scherp' geluid produceren door de resonantie te verhogen zodat het
signaalniveau wordt versterkt in de buurt van de afsnijfrequentie.
Dit filtertype is heel populair en handig voor het produceren van klassieke synthesizergeluiden.

Filter 1 Type
Filter 2 Type

LPF
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LPF24: -24 dB/oct
LPF18: -18 dB/oct
LPF12: -12 dB/oct
LPF6: -6 dB/oct

Een filtertype dat alleen signalen boven de afsnijfrequentie doorlaat.
U kunt een karakteristiek 'scherp' geluid produceren door de resonantie te verhogen zodat het
signaalniveau wordt versterkt in de buurt van de afsnijfrequentie.

HPF24: -24 dB/oct
HPF18: -18 dB/oct
HPF12: -12 dB/oct
HPF6: -6 dB/oct

Een filtertype dat alleen signalen doorlaat voor een specifieke frequentieband (afsnijfrequentie) en
alle andere signalen afsnijdt.

BPF12: -12 dB/oct
BPF6: -6 dB/oct

Stelt de afsnijfrequentie in. De hier ingestelde frequentie wordt gebruikt door het filter dat is ingesteld
in Type.
Instellingen: 0−1023

HPF

BPF

Cutoff (Filter Cutoff)

Resonance (Filter Resonance)
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Stelt de grootte van de resonantie in.
Instellingen: 0−255

Stelt in hoe de afsnijfrequentie reageert op de snelheid of de kracht van de toetsaanslag.
Instellingen: −255−+255

Positieve waarde: hoe sneller de aanslag, hoe hoger de afsnijfrequentiewaarde.
Negatieve waarde: hoe langzamer de aanslag, hoe hoger de afsnijfrequentiewaarde.
0: de afsnijfrequentie reageert niet op snelheid.

Stelt in hoe het resonantieniveau reageert op de snelheid of de kracht van de toetsaanslag.
Deze parameter is mogelijk, afhankelijk van het filtertype, niet beschikbaar.
Instellingen: −255−+255

Positieve waarde: hoe hoger de snelheid, hoe groter de resonantie wordt.
Negatieve waarde: hoe lager de snelheid, hoe groter de resonantie wordt.
0: de resonantiewaarde verandert niet als reactie op de snelheid.

Stelt in hoe het afsnijfrequentieniveau van het filter reageert op de toetspositie. Als de waarde is
ingesteld op 1oct, veranderen zowel de toonhoogte als de afsnijfrequentie in dezelfde mate.
Instellingen: Off, 1/3oct, 1/2oct, 2/3oct, 1oct, 2oct

Stelt de hoeveelheid vervorming in die wordt geregeld door het Saturator-gedeelte van het filter.
Instellingen: 0,0−60,0 (dB) (in eenheden van 0,75 dB)

Stelt in hoe de Drive reageert op de aanslag.
Instellingen: −255-0−+255

Hiermee stelt u uitgangsniveau van het filter in.
Instellingen: -12,0-+12,0 (dB) (in eenheden van 0,375 dB)

In het scherm Filter EG kunt u de filterenvelopegenerator instellen.
U kunt instellen hoe de Filter Cutoff in de loop van de tijd verandert, vanaf het moment dat u een
toets op het toetsenbord indrukt tot het moment waarop het geluid wegsterft.

Gebruik

Cutoff/Vel (Filter Cutoff Velocity Sensitivity)

Res/Vel (Filter Resonance Velocity Sensitivity)

Cutoff/Key (Filter Cutoff Key Follow)

Filter 1 Drive (Filter 1 Saturator Drive)
Filter 2 Drive (Filter 2 Saturator Drive)

Filter 1 Drive/Vel (Filter 1 Saturator Drive Velocity Sensitivity)
Filter 2 Drive/Vel (Filter 2 Saturator Drive Velocity Sensitivity)

F1 Out Level (Filter 1 Out Level)
F2 Out Level (Filter 2 Out Level)

Filter EG
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[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Filter / Amp → Filter EG

Stelt de tijdsduur in die nodig is voordat de EG het maximum bereikt.
Instellingen: 0−255

Stelt de tijdsduur in die nodig is voordat de EG verandert vanaf het maximum tot het Sustain-niveau.
Instellingen: 0−255

Hiermee stelt u het sustainniveau in.
Instellingen: 0−511

Stelt de tijd in die de EG nodig heeft om een waarde van 0 te bereiken nadat u de toets hebt
losgelaten.
Instellingen: 0−255

Stelt in hoe de afsnijfrequentie reageert op de snelheid of de kracht van de toetsaanslag.
Instellingen: −255-0−+255

Positieve waarden: hoe hoger de snelheid, hoe sneller de FEG verandert.
Negatieve waarde: hoge aanslagsnelheidswaarden resulteren in langzamere FEG-
veranderingen, terwijl lage aanslagsnelheidswaarden resulteren in snellere FEG-
veranderingen.
0: geen veranderingen, ongeacht de aanslaginstelling.

Stelt het dieptebereik in voor de afsnijfrequentie die wordt geregeld door de FEG.
Instellingen: −9600−+9600 cent (in eenheden van 50 cent)

0: geen veranderingen in de afsnijfrequentie door de Filter EG.
Het dieptebereik van de wijziging van de afsnijfrequentie wordt groter naarmate de

Attack (Filter Cutoff EG Attack Time)

Decay (Filter Cutoff EG Decay Time)

Sustain (Filter Cutoff EG Sustain Level)

Release (Filter Cutoff EG Release Time)

Time/Vel (Filter Cutoff EG Time Velocity Sensitivity)

FEG Depth - Filter 1–2 (Filter 1–2 Cutoff EG Depth)
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instelling verder verwijderd is van een waarde van 0.
Negatieve waarden: veranderingen van de afsnijfrequentie worden omgekeerd.

Stelt in hoe het dieptebereik van de verandering van de afsnijfrequentie die wordt geregeld door de
FEG reageert op de snelheid of de kracht van de toetsaanslag.
Instellingen: −255-0−+255

Positieve waarden: hogere snelheidswaarden vergroten het dieptebereik van de Filter
EG, terwijl langzamere waarden het dieptebereik verkleinen.
Negatieve waarden: hogere snelheidswaarden verkleinen het dieptebereik van de Filter
EG, terwijl langzamere waarden het dieptebereik vergroten.
0: de afsnijfrequentie reageert niet op de snelheid.

In het scherm Filter LFO kunt u de Filter LFO instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Filter / Amp → Filter LFO

Selecteert een LFO-golfvorm. Door de golfvorm te gebruiken die u hier hebt geselecteerd, kunt u
verschillende soorten modulatie creëren.
Instellingen: Saw, Square, Triangle, Sine, Random

FEG Depth/Vel - Filter 1–2 (Filter 1–2 Cutoff EG Depth Velocity Sensitivity)

Filter LFO

LFO Wave (Filter Common Cutoff LFO Wave)

Key On Reset (Filter Common Cutoff LFO Key On Reset)
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Zet de oscillatie van de LFO terug wanneer een toets wordt ingedrukt.
Instellingen: Off, On

Stelt de snelheid van LFO Wave-wijzigingen in.
Instellingen: 0−415

Stelt de vertragingstijd in tussen het moment waarop u een toets op het toetsenbord aanslaat en het
moment waarop de LFO actief wordt.
Hoe hoger de waarde, hoe langer het wegsterven voordat de LFO in werking treedt.
Instellingen: 0−127

Stelt de tijdsduur in die nodig is voordat LFO-effect infadet nadat u de toets hebt losgelaten en de
vertragingstijd die is ingesteld in Delay, is verstreken.
Instellingen: 0−214

Hoe hoger de waarde, hoe langer het duurt voordat het LFO-effect het maximum bereikt.
0: de LFO verandert naar de maximale waarde zonder enige fade-ins.

Lage waarde: snelle fade-in

Speed (Filter Common Cutoff LFO Speed)

Delay (Filter Common Cutoff LFO Delay Time)

Fade In (Filter Common Cutoff LFO Fade In Time)
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Hoge waarde: langzame fade-in

U kunt de beginfase instellen voor het moment waarop de LFO Wave wordt teruggezet.
Instellingen: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Fase van de golf

Stelt de diepte in van de LFO Wave-regelaar voor Filter 1 en Filter 2.
Instellingen: −9600−+9600 (cent) (in eenheden van 50 cent)

In het scherm Amp EG kunt u de AEG (Amplitude Envelope Generator) instellen.
Door de Amp EG in te stellen, kunt u instellen hoe het volume verandert vanaf het moment dat u een
toets op het toetsenbord indrukt tot het moment waarop het geluid wegsterft.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Filter / Amp → Amp EG

Phase (Filter Common Cutoff LFO Phase)

Depth (Filter Cutoff LFO Depth)

Amp EG
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Stelt de tijdsduur in die nodig is vanaf het moment dat u op een toets op het toetsenbord drukt tot
wanneer de Amplitude Level wordt bereikt.
Instellingen: 0−255

Stelt de tijdsduur in die nodig is voordat het volume verandert vanaf het Amplitude Level tot het
Sustain Level.
Instellingen: 0−255

Stelt het volume in dat wordt aangehouden terwijl de toets ingedrukt wordt gehouden.
Instellingen: 0−511

Stelt de tijdsduur in die verstrijkt nadat u de toets hebt losgelaten totdat het geluid wegsterft.
Instellingen: 0−255

Stelt de tijdsduur in die nodig is voordat volumeveranderingen in AEG reageren op de snelheid of de
kracht van de toetsaanslag.
Instellingen: −255−+255

Positieve waarde: hoe sneller de aanslag, hoe sneller het AEG-volume verandert.
Negatieve waarde: hoge snelheidswaarden resulteren in langzamere AEG-
volumeveranderingen, terwijl lage snelheidswaarden resulteren in snellere AEG-
volumeveranderingen.
0: geen veranderingen, ongeacht de aanslaginstelling.

Snelle aanslag (snelle volumeverandering)

Attack (Amplitude EG Attack Time)

Decay (Amplitude EG Decay Time)

Sustain (Amplitude EG Sustain Level)

Release (Amplitude EG Release Time)

Time/Vel (Amplitude EG Time Velocity Sensitivity)
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Langzame aanslag (langzame
volumeverandering)

Stelt het volumeniveau van de amplitude in.
Instellingen: 0−511

Stelt in hoe het amplitudeniveau reageert op de aanslag.
Instellingen: −255-0−+255

Stelt in hoe Amp Level reageert op de toonhoogte.
Wanneer Amplitude Level Key is ingesteld op 127, gaat Amp Level met 6 dB omlaag terwijl de
toonhoogte één octaaf omhoog gaat.
Instellingen: 0−127

Stelt de hoeveelheid vervorming in die wordt geregeld door de Saturator-gedeelte van het
amplitudegedeelte.
Instellingen: 0,0−60,0 (dB) (in eenheden van 0,75 dB)

In het scherm Amp LFO kunt u de Amplitude LFO instellen.

Gebruik

[PERFORMANCE] → Part Common-selectie → [EDIT/ ] → Filter / Amp → Amp LFO

Selecteert een LFO-golfvorm. Door de golfvorm te gebruiken die u hier hebt geselecteerd, kunt u
verschillende soorten modulatie creëren.
Instellingen: Saw, Square, Triangle, Sine, Random

Level (Amplitude Level)

Level/Vel (Amplitude Level Velocity Sensitivity)

Level/Key (Amplitude Level Key Follow)

Drive (Amplitude Saturator Drive)

Amp LFO

LFO Wave (Amplitude LFO Wave)
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Zet de oscillatie van de LFO terug wanneer een toets wordt ingedrukt.
Instellingen: Off, On

Stelt de snelheid van LFO Wave-wijzigingen in.
Instellingen: 0−415

Stelt de vertragingstijd in tussen het moment waarop u een toets op het toetsenbord aanslaat en het
moment waarop de LFO actief wordt.
Hoe hoger de waarde, hoe langer de wegsterftijd voordat de LFO in werking treedt.
Instellingen: 0−127

Stelt de tijdsduur in die nodig is voordat LFO-effect infadet nadat u de toets hebt losgelaten en de
vertragingstijd die is ingesteld in Delay, is verstreken.
Instellingen: 0−214

Hoe hoger de waarde, hoe langer het duurt voordat het LFO-effect het maximum bereikt.
0: de LFO verandert naar de maximale waarde zonder enige fade-ins.

Lage waarde: snelle fade-in

Key On Reset (Amplitude LFO Key On Reset)

Speed (Amplitude LFO Speed)

Delay (Amplitude LFO Delay Time)

Fade In (Amplitude LFO Fade In Time)
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Hoge waarde: langzame fade-in

U kunt de beginfase instellen voor het moment waarop de LFO-golfvorm wordt gereset.
Instellingen: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Fase van de golf

Stelt het dieptebereik in van volumeveranderingen die door de LFO worden geregeld.
Instellingen: −127−+127

Het hier getoonde scherm is bijna hetzelfde als het scherm dat wordt geopend via Effect → Routing
in het scherm Part Edit (AWM2), met de hieronder genoemde uitzonderingen.

Phase (Amplitude LFO Phase)

Depth (Amplitude Level LFO Depth)

Effect

Routing

Geen uitvoerinstelling voor elk Element

Kan Parallel niet selecteren voor Ins Connect

Ins A
Ins B

380



Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → InsA of InsB in
het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → 3-band EQ in
het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Effect → 2-band EQ in
het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Arpeggio → Common in
het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Arpeggio → Individual in
het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Arpeggio → Advanced
in het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Motion Seq → Common
in het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Motion Seq → Lane in
het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Mod/Control → Control
Assign in het scherm Part Edit (AWM2), behalve dat de beschikbare instellingen voor Destination
anders zijn.

3-band EQ

2-band EQ

Arp/MS

Arp Common

Individual

Advanced

MS Common

Lane

Mod/Control

Control Assign
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Gebruik de onderstaande parameters in plaats van ElementSw en andere.

U kunt de regelaarinstelling voor elke oscillator in- of uitschakelen. Deze parameter wordt alleen
weergegeven als de geselecteerde Destination gerelateerd is aan oscillators.
Normaal gesproken worden er drie schakelaars weergegeven, maar als de Destination is ingesteld
op OSC FM of OSC Ring, worden er slechts twee getoond.
Instellingen: Off, On

U kunt de regelaarinstelling voor elk filter in- of uitschakelen.
Deze parameter wordt alleen weergegeven als de geselecteerde Destination gerelateerd is aan
filters.
Instellingen: Off, On

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Mod/Control → After
Touch in het scherm Part Edit (AWM2), behalve dat de beschikbare instellingen voor Destination
anders zijn.

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Mod/Control → Tx/Rx
Switch in het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Mod/Control → Control
Settings in het scherm Part Edit (AWM2).

Het hier getoonde scherm is hetzelfde als het scherm dat wordt geopend via Mod/Control → Part
LFO in het scherm Part Edit (AWM2), behalve dat de enige beschikbare instelling voor Destination
Ins is.

Oscillator Sw (Oscillator Switch)

Filter Sw

After Touch

Tx/Rx Switch

Control Settings

Part LFO
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om02screenparameters0180

Inhoudsopgave

Op het scherm Osc/Tune kunt u de algemene parameters voor de oscillator instellen.
De modulatie- en golfvormingsfuncties die op dit scherm beschikbaar zijn, zijn FM
(frequentiemodulatie), ringmodulatie, oscillatorsynchronisatie, Pulse Width en Wave Shaper.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part selectie → Oscillator selectie → Osc/Tune

Stelt de golfvorm voor de oscillator in.
Instellingen: Saw1, Saw2 (variatie van Saw1 met 'dikker' geluid), Square, Triangle, Sine

Oscillator Edit

Osc/Tune

Osc EG

Osc LFO

Osc/Tune

Wave (Oscillator Wave)

Out Level (Oscillator Out Level)
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Stelt het volume van de oscillators in.
Instellingen: 0-511

Stelt in hoe het oscillatorvolume reageert op de aanslagsnelheid.
Instellingen: −255–+0-+255

Voert een negatieve/positieve omkering uit van de oscillatoruitgang.
Instellingen: Off, On

Stelt de uitvoerbestemming voor de oscillators in.
Instellingen: Filter, Amp

Stelt de toonhoogte in van de oscillator in octaven.
Instellingen: 64’, 32’, 16’, 8’, 4’, 2’, 1’

Past de toonhoogte van de oscillator nauwkeurig aan.
Instellingen: −1200-+0-+1200 (cent)

Moduleert de frequentie van de oscillator door een andere oscillator te gebruiken.

Stelt het niveau van de frequentiemodulatie in.
Instellingen: 0-255

Stelt in hoe frequentiemodulatie reageert op aanslagsnelheid.
Instellingen: −255–+0-+255

Door twee oscillatorsignalen te mengen, kunt u een metaalachtig, onharmonisch geluid creëren.

Stelt het niveau van ringmodulatie in.
Instellingen: 0-255

Stelt in hoe ringmodulatie reageert op aanslagsnelheid.
Instellingen: −255–+0-+255

Out Level/Vel (Oscillator Out Level Velocity Sensitivity)

Invert (Oscillator Out Invert Enable)

Connect (Oscillator Out Select)

Octave (Oscillator Octave)

Pitch (Oscillator Pitch)

FM (Frequency Modulation)

FM Level (Oscillator FM Level)

FM Level/Vel (Oscillator FM Level Velocity Sensitivity)

Ring Modulation

Ring Level (Oscillator Ring Level)

Ring Level/Vel (Oscillator Ring Level Velocity Sensitivity)
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Oscillator Sync is een systeem dat complexe golven creëert door twee oscillatoren te dwingen te
synchroniseren.
Dankzij de AN-X-soundengine kan elke oscillator zijn synchronisatietiming instellen, zodat u één
enkele oscillator kunt gebruiken voor het creëren van complexe golfvormen.

Stelt het niveau van de Oscillator Sync in.
Instellingen: 0-4800 (cents) (in eenheden van 25 cents)

Hiermee wordt ingesteld hoe Sync Pitch reageert op de aanslagsnelheid.
Instellingen: −255–+0-+255

Pulse Width is de verhouding tussen de negatieve en positieve delen van de Square (vierkante) golf.

Wanneer Pulse Width is
ingesteld op een kleine

waarde

Wanneer Pulse Width is
ingesteld op 50%

Wanneer Pulse Width is
ingesteld op een grote waarde

Met de AN-X-soundengine kunt u Pulse Width niet alleen op Square golven gebruiken, maar ook op
andere golven.

Modulatie van de LFO met behulp van Pulse Width wordt pulsbreedtemodulatie (PWM) genoemd,
waarmee u een karakteristiek wervelend geluid kunt creëren.

Met de AN-X-soundengine kunt u PWM gebruiken door gebruik te maken van Osc EG en Osc LFO
en kunt u het PWM-niveau opgeven op het Osc EG-scherm en Osc LFO-scherm.

Stelt de Pulse Width van de golf in.
Instellingen: 1,0%-50,0%-99,0%

Stelt in hoe Pulse Width reageert op aanslagsnelheid.
Instellingen: −255–+0-+255

Creëert een karakteristieke vervorming en veranderingen in de harmonische inhoud door de vorm
van de golfvorm te veranderen.

Oscillator Sync

Sync Pitch (Oscillator Self Sync Pitch)

Sync Pitch/Vel (Oscillator Self Sync Pitch Velocity Sensitivity)

Pulse Width

Pulse Width (Oscillator Pulse Width)

PulseWidth/Vel (aanslagsnelheidsgevoeligheid pulsbreedte oscillator)

Wave Shaper
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Stelt het niveau van de Wave Shaper in.
Door Wave Shaper te gebruiken, verandert de golf dynamisch.
Instellingen: 0-255

Stelt in hoe de Wave Shaper reageert op de aanslagsnelheid.
Instellingen: −255–+0-+255

Hiermee opent u het scherm General/Pitch → Pitch EG voor Part Edit (AN-X).

Hiermee opent u het scherm General/Pitch → Pitch LFO voor Part Edit (AN-X).

Opent het scherm Osc EG voor Oscillator Edit.

Opent het scherm Osc LFO voor Oscillator Edit.

In het scherm Osc EG kunt u de envelopgenerator voor de oscillator instellen.

U kunt instellen hoe de synchronisatie, Pulse Width en Wave Shaper veranderen in de loop van de
tijd, vanaf het moment dat u op een toets op het toetsenbord drukt tot wanneer het geluid wegsterft.

Gebruik Pitch EG om in te stellen hoe de toonhoogte in de loop van de tijd verandert.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part selectie → Oscillator selectie → Osc EG

Shaper (Oscillator Wave Shaper)

Shaper/Vel (Oscillator Wave Shaper Velocity Sensitivity)

Pitch EG-instellingen

Pitch LFO Settings

Osc 1–3 EG Settings

Osc 1–3 LFO Settings

Osc EG
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Stelt de tijdsduur in die nodig is voordat de EG verandert vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment waarop de EG de waarde van het aanslagniveau bereikt.
Instellingen: 0-255

Stelt de tijdsduur in voor het veranderen van de EG vanaf het moment dat u een toets op het
toetsenbord indrukt tot het moment waarop de EG de waarde van het wegsterfniveau bereikt.
Instellingen: 0-255

Hiermee stelt u het sustainniveau in.
Instellingen: 0-511

Stelt de tijd in voor de EG om een waarde van 0 te bereiken nadat u de toets hebt losgelaten.
Instellingen: 0-255

Stelt in hoe de synchronisatie reageert op Osc EG.
Instellingen: −4800-+4800 (cent)

Stelt in hoe de Pulse Width reageert op Osc EG.
Instellingen: −127–+0-+127

Stelt in hoe de Shaper reageert op Osc EG.
Instellingen: −127–+0-+127

Op het scherm Osc LFO kunt u de Oscillator LFO instellen.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part selectie → Oscillator selectie → Osc LFO

Attack (Oscillator EG Attack Time)

Decay (Oscillator EG Decay Time)

Sustain (Oscillator EG Sustain Level)

Release (Oscillator EG Release Time)

Osc EG Depth Sync (Oscillator Self Sync EG Depth)

Osc EG Depth Pulse Width (Oscillator Pulse Width EG Depth)

Osc EG Depth Shaper (Oscillator Wave Shaper EG Depth)

Osc LFO
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Selecteert een LFO-golfvorm.
Door de golfvorm te gebruiken die u hier hebt geselecteerd, kunt u verschillende soorten modulatie
creëren.
Instellingen: Saw, Square, Triangle, Sine, Random

Zet de oscillatie van de LFO terug wanneer een toets wordt ingedrukt.
Instellingen: Off, On

Stelt de snelheid van LFO Wave-wijzigingen in.
Instellingen: 0-415

Stelt de vertragingstijd in tussen het moment waarop u een toets op het toetsenbord aanslaat en het
moment waarop de LFO actief wordt.
Instellingen: 0-127

LFO Wave (Oscillator LFO Wave)

Key On Reset (Oscillator LFO Key On Reset)

Speed (Oscillator LFO Speed)

Delay (Oscillator LFO Delay Time)

Fade In (Oscillator LFO Fade In Time)
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Stelt de tijdsduur in voor het infaden van het LFO-effect nadat u de toets hebt losgelaten en de
wegsterftijd die is ingesteld in Delay is verstreken.
Instellingen: 0-214

Stelt de LFO-fase in voor het resetten van de golfvorm wanneer een toets wordt ingedrukt.
Instellingen: 0, 30, 45, 60, 90, 120, 135, 150, 180, 210, 225, 240, 270, 300, 315, 330 (°)

Stelt in hoe de Sync reageert op Osc LFO.
Instellingen: −4800-+4800 (cent)

Stelt in hoe de Pulse Width reageert op Osc LFO.
Instellingen: −127–+0-+127

Stelt in hoe de Shaper reageert op Osc LFO.
Instellingen: −127–+0-+127

Oscillator LFO Phase

Osc LFO Depth Sync (Oscillator Self Sync LFO Depth)

Osc LFO Depth Pulse Width (Oscillator Pulse Width LFO Depth)

Osc LFO Depth Shaper (Oscillator Wave Shaper LFO Depth)
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Op het Noise-scherm kunt u de Noise Generator instellen.

Gebruik

[PERFORMANCE] → [EDIT/ ] → Part selectie → Oscillator selectie → Noise

Stelt de frequentierespons in voor de Noise.
Instellingen: 0-64–127

0-63: snijdt de hoge tonen af
64: witte ruis
65–127: snijdt de bastonen af

Stelt het volume van de Noise in.
Instellingen: 0-511

Stelt in hoe het Noise-volume reageert op de aanslagsnelheid.
Instellingen: −255–+0-+255

Stelt de uitvoerbestemming voor de Noise in.
Instellingen: Filter, Amp

Noise Edit

Noise

Noise Tone (Ruisgeneratortoon)

Out Level (Uitgangsniveau ruisgenerator)

Out Level/Vel (Snelheidsgevoeligheid uitgangsniveau ruisgenerator)

Connect (Uitgangsselectie ruisgenerator)
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Category Search is een handige functie waarmee u snel een specifieke performance, partij, arpeggio
of golfvorm kunt vinden die u wilt gebruiken in een opgegeven categorie.

Inhoudsopgave

Category Search-scherm (Zoeken in categorie)

Performance Category Search

Performance Merge

Part Category Search

Rhythm Pattern

Arp Category Search (Arpeggio Category Search)

Waveform Search (Waveform Category Search)
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Op het scherm Performance Category Search kunt u naar performances zoeken en deze selecteren.
Terwijl het scherm Category Search wordt weergegeven, kunt u de knoppen op het bovenpaneel
gebruiken om de Part Select-, Mute- of Solo-instellingen te wijzigen.

Gebruik

Selecteer een filter dat u bij een zoekopdracht wilt gebruiken.
Instellingen: Category, Attribute

Filtert op categorie.
Door het selectievakje Main of Sub uit te schakelen, kunt u het filteren op categorie annuleren.
Instellingen: Raadpleeg de Data List.

Filtert op kenmerk.
Door het selectievakje Attribute uit te schakelen, kunt u het filteren op kenmerk annuleren.
Instellingen: AWM2, FM-X, AN-X, MC, SSS, Smart Morph, Single, Multi, MOTIF XF, MONTAGE,

MONTAGE M

Filtert op bank of favorieten.
Als Favorite is geselecteerd, verschijnen alleen performances die als favoriet zijn gemarkeerd in de

Performance Category Search

Druk op de knop [CATEGORY].

Tik op de performancenaam → Selecteer Category Search in het contextmenu

Filter

Main (Main Category)
Sub (Sub Category)

Attribute

Bank/Favorite (Bank/Favorite Select)
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lijst.
Als het scherm Category Search wordt weergegeven, kunt u op de knop [CATEGORY] drukken om
van bank te wisselen in de volgorde All → Favorite → Preset → User → Library-naam (wanneer een
bibliotheekbestand is geladen).
Als u de knop [CATEGORY] ingedrukt houdt, wordt de selectie teruggezet naar All.
Instellingen: All, Favorite, Preset, User, Library-naam (wanneer een bibliotheekbestand is geladen)

Hiermee kunt u bepaalde tekens in de naam invoeren, zodat u gemakkelijk kunt zoeken.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u tot 20 alfanumerieke tekens
kunt invoeren.

Roept het Job-menu op.

Hiermee bepaalt u de sorteervolgorde van de performancelijst.
Instellingen: Default, Name, Date

Name: sorteert op naam. De pijl-omlaag geeft aan dat de lijst is gesorteerd in oplopende
volgorde (A tot Z). De pijl-omhoog geeft aan dat de lijst in aflopende volgorde is gesorteerd.
Date: sorteert op de datum waarop de instelling is opgeslagen. De pijl-omlaag geeft aan
dat de lijst in aflopende volgorde is gesorteerd (nieuw tot oud). De pijl-omhoog geeft aan
dat de lijst in oplopende volgorde is gesorteerd.

Zet het afspelen van de auditiefrase aan of uit.
Deze parameter is niet beschikbaar wanneer Audition Lock is ingesteld op On bij: [UTILITY] →
Settings → Advanced.
Instellingen: Off, On

Hiermee verwijdert u de geselecteerde inhoud.
Deze parameter is alleen beschikbaar als er een performance in de gebruikersbank is geselecteerd.

Hiermee wordt de naam van de geselecteerde inhoud veranderd.
Deze parameter is alleen beschikbaar als er een performance in de gebruikersbank is geselecteerd.

Wist alle markeringen als favoriet uit de performances.
Deze parameter is niet beschikbaar als er geen performances zijn die als favoriet zijn gemarkeerd.

Toont de naam van de performance, samen met de actieve partijen, kenmerken en favorietstatus.

Name Search

Job

Sort

Audition

Delete

Rename

Favorite All Clear

List
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In het scherm Performance Merge kunt u meerdere partijen van de geselecteerde performance
toewijzen aan lege partijen van een andere performance. U kunt bijvoorbeeld een vierdelige
pianoperformance en een tweedelige strijkersperformance samenvoegen in lagen om een rijke
zesdelige performance te creëren.

Gebruik

[PERFORMANCE] → Selecteer een partij (wanneer de geselecteerde partij en alle daaropvolgende
partijen leeg zijn) → Tik op [+]

Wanneer u een performance selecteert, wordt het geluid van de hier gespecificeerde partij
toegewezen aan de momenteel geselecteerde partij.
Instellingen: All, Part 1–16

All: alle partijen in de geselecteerde performance worden (zoveel mogelijk) toegewezen
aan lege partijen van de andere geselecteerde performance.
Part 1–16: alleen het geluid van de gespecificeerde partij wordt aan de andere
geselecteerde partij toegewezen.

Als dit is uitgeschakeld, worden de partijen gedempt die op het scherm worden weergegeven voordat
u het scherm Performance Merge hebt geopend.
Instellingen: Off, On

Als dit is uitgeschakeld, worden de partijen gedempt die zijn toegevoegd op het scherm Performance
Merge.
Instellingen: Off, On

Performance Merge

Source

Mute Org (Original Part Mute)

Mute Add (Additional Part Mute)
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Op het scherm Part Category Search kunt u naar partijen zoeken en deze selecteren.

Gebruik

Wanneer u een performance selecteert, wordt het geluid van de hier gespecificeerde partij
toegewezen aan de momenteel geselecteerde partij.
De initiële instelling is Part 1.
Instellingen: Part 1–16

Schakelt de solofunctie in/uit
Als deze schakelaar is ingeschakeld, wordt de geselecteerde partij op solo gezet.
Instellingen: Off, On

Laadt een groep parameterwaarden wanneer een performance wordt geselecteerd.
De parameters die op Off zijn ingesteld, behouden hun huidige instellingen, zelfs als er een nieuwe
performance wordt geselecteerd.
Parametergroepen: Mixing, Arp/MS, Scene, Zone
Instellingen: Off, On

Part Category Search

[SHIFT] + [CATEGORY]

(Wanneer u een partij selecteert waaraan al een geluid is toegewezen) Tik op de naam van de
performance → Selecteer Category Search in het contextmenu

(Wanneer u een lege partij selecteert) Tik op [+]

Source (Source Part)

Solo

Param. with Part (Parameter with Part)
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Op het Rhythm Pattern-scherm kunt u ritmepatronen zoeken en selecteren.

De functie Rhythm Pattern biedt een snelle manier om een ritmepartij aan de huidige performance
toe te voegen. Door ritmepatronen te combineren met envelopvolgeffecten kunt u het geluid verder
veranderen.

Gebruik

[SHIFT] + [SONG/PATTERN]

Selecteert Arpeggio-weergave of Envelope Follower-weergave.

Filtert op bank of favorieten.
Wanneer Favorite is geselecteerd, verschijnen alleen ritmepatronen die als favoriet zijn gemarkeerd
in de lijst.
Instellingen: All, Favorite, Preset, User, Library-naam (wanneer een bibliotheekbestand is geladen)

Hiermee kunt u bepaalde tekens in de naam invoeren, zodat u gemakkelijk kunt zoeken.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u tot 20 alfanumerieke tekens
kunt invoeren.

Hiermee bepaalt u de sorteervolgorde van de lijst met ritmepatronen.

Rhythm Pattern

Arp (Arpeggio)
Envelope Follower

Bank/Favorite (Bank/Favorite Select)

Name Search

Sort
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Instellingen: Default, Name, Date
Name: sorteert op naam. De pijl-omlaag geeft aan dat de lijst is gesorteerd in oplopende
volgorde (A tot Z). De pijl-omhoog geeft aan dat de lijst in aflopende volgorde is gesorteerd.
Date: sorteert op de datum waarop de instelling is opgeslagen. De pijl-omlaag geeft aan
dat de lijst in aflopende volgorde is gesorteerd (nieuw tot oud). De pijl-omhoog geeft aan
dat de lijst in oplopende volgorde is gesorteerd.

Als dit is uitgeschakeld, wordt de partij gedempt die op het scherm wordt weergegeven voordat u het
scherm Rhythm Pattern hebt geopend.
Instellingen: Off, On

Als dit is uitgeschakeld, worden de partijen gedempt die zijn toegevoegd op het scherm Rhythm
Pattern.
Instellingen: Off, On

Toont de ritmepatroonlijst.

Annuleert de bewerking.

Veelgebruikte parameters voor arpeggio-instellingen worden aan de linkerkant van het scherm
weergegeven.

Hiermee stelt u het tempo in.
Instellingen: 5-300

Stelt het volume van het ritmepatroon in.
Instellingen: 0-127

Mute Org (Original Part Mute)

Mute Add (Additional Part Mute)

List

Cancel

Wanneer Arp in ingesteld op On

Tempo

Volume
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Toont de momenteel geselecteerde arpeggiocategorie, subcategorie en naam.
Door op de naam te tikken, ziet u het contextmenu voor Arpeggio Category Search en kunt u cijfers
invoeren.
Instellingen: Raadpleeg de Data List.

Wijzigt de arpeggioselectie.
Instellingen: 1-8

Veelgebruikte parameters voor Envelope Follower worden aan de linkerkant van het scherm
weergegeven.
Hierdoor kunt u snel parameters bewerken die vaak voor ritmepatronen worden gebruikt.
Als u andere parameters wilt wijzigen, gebruikt u Edit om het instellingenscherm voor de Envelope
Follower te openen.

Schakelt Envelope Follower in.
Instellingen: Off, On

Stelt de ingangsversterking voor de ingangsbron in.
Instellingen: −24,0 dB–0,0 dB–24,0 dB

Stelt de bestemming in voor de Envelope Follower.
Instellingen: Volume, Cutoff, Resonance, Pitch, Pan, Reverb Send, Variation Send, LFO Speed,

LFO Depth 1, LFO Depth 2, LFO Depth 3

Category (Arpeggio Main Category)
Sub Category (Arpeggio Sub Category)
Name

Arp Select (Arpeggio Select)

Wanneer Envelope Follower aanstaat

Quick Assign

Gain (Envelope Follower Gain)

Destination

Curve Type
Polarity (Curve Polarity)
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Hetzelfde als het scherm Control Assign.

Het scherm Envelope Follower Edit verschijnt.

Hier tonen we een voorbeeld van hoe u het ritmepatroon 8Z Trance Basics 1 aan de performance
Supertrance kunt toevoegen en vervolgens het geluid met de Envelope Follower kunt wijzigen.

1 Selecteer de gewenste performance voor het toevoegen van de ritmepartij.

Selecteer hier Supertrance.

2 Druk op de [SHIFT]-knop + [SONG/PATTERN]-knop.

Het scherm Rhythm Pattern verschijnt.
Wanneer alle partijen 1-8 worden gebruikt, wordt PartFull weergegeven en kunnen er geen
ritmepatronen worden toegevoegd.

3 Tik in de lijst met ritmepatronen op de ritmepatroonkit die u wilt gebruiken.

Tik hier op 8Z Trance Basics 1.

De ritmepartij is toegevoegd.

4 Bespeel het toetsenbord en het ritmepatroon wordt afgespeeld.

Ratio (Curve Ratio)
Param1 (Curve Parameter 1)
Param2 (Curve Parameter 2)

Edit

Hoe u de functie Rhythm Pattern kunt gebruiken

Een ritmepartij toevoegen (eenvoudige manier)
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5 Druk op de [PERFORMANCE]-knop of de [EXIT]-knop om het ritmepatroon te
bevestigen.

Het scherm Rhythm Pattern wordt gesloten.

OPMERKING
U kunt de selectie ook bevestigen door op het  (Home)-pictogram te tikken.

6 Als u het ritmepatroon wilt stoppen, drukt u op de knop [ARP ON/OFF] of de
knop [ ] (Stop).

De Envelope Follower is een functie die de envelop (of amplitude-envelop) van een golfvorm uit het
ingangssignaal extraheert en u vervolgens die envelop als een regelaar voor het wijzigen van
geluiden laat gebruiken. Als u bijvoorbeeld een ritmepatroon aan een partij toewijst en de Envelope
Follower van de partij als een Source instelt, worden de geluiden van andere partijen overeenkomstig
gewijzigd. Dit is vooral handig voor automatische 'ducking' waarbij u het volume van andere
instrumenten wilt verlagen terwijl een bepaald instrumentgeluid dat u wilt benadrukken, wordt
afgespeeld.

1 Tik op de knop Envelope Follower op het scherm Rhythm Pattern.

Het scherm Envelope Follower verschijnt.

2 Zet de schakelaar van de Envelope Follower op On.

Hier kunt u het toetsenbord bespelen om het geluid met de ingeschakelde Envelope Follower
te beluisteren.

De Envelope Follower instellen
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3 Pas indien nodig de instellingen aan.

Stel in dit voorbeeld de Polarity in op Bi, de Ratio op -63 en de Gain op -12dB.

Voor meer gedetailleerde aanpassingen tikt u op de knop Edit op het scherm om het
instellingenscherm voor Envelope Follower te openen.

Als u de ritmepatroonkit of het arpeggiotype wilt wijzigen, drukt u op de knop [SHIFT] +
[SONG/PATTERN] om terug te gaan naar het scherm Rhythm Pattern. De instellingen van de
Envelope Follower blijven behouden, zelfs nadat de nieuwe kit of het arpeggiotype wordt
gewijzigd.
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Op het scherm Arp Category Search kunt u naar arpeggiotypen zoeken en deze selecteren.

Gebruik

Schakelt de Classic-weergave in.
In de Classic-weergave worden alleen algemene arpeggio's weergegeven en zijn er geen filters
beschikbaar om te zoeken.
Instellingen: Off, On

Filtert op categorie.
Door het selectievakje Main of Sub uit te schakelen, kunt u het filteren op categorie annuleren.
Instellingen: Raadpleeg de Data List.

Filtert op kenmerk.
Door het selectievakje Attribute uit te schakelen, kunt u het filteren op kenmerk annuleren.
Instellingen: Note, Chord, Other, Intro, Main, Fill, Ending, AF, Accent, Random SFX, Mg, aantal

maten, maatsoort, tempo

Arp Category Search (Arpeggio Category Search)

[PERFORMANCE] → Part Common selectie → [EDIT/ ] → Arpeggio → Individual →
[CATEGORY]

[PERFORMANCE] → Common selectie → [EDIT/ ] → Arp / MS → Arp Overview → Part
selectie → [CATEGORY]

Classic (Klassieke schakelaar)

Main (Main Category)
Sub (Sub Category)

Attribute

Bank/Favorite (Bank/Favorite Select)
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Filtert op bank of favorieten.
Wanneer Favorite is geselecteerd, verschijnen alleen arpeggiotypen die als favoriet zijn gemarkeerd
in de lijst.
Instellingen: All, Favorite, Preset, User, Library-naam (wanneer een bibliotheekbestand is geladen)

Hiermee kunt u bepaalde tekens in de naam invoeren, zodat u gemakkelijk kunt zoeken.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u tot 20 alfanumerieke tekens
kunt invoeren.

Roept het Job-menu op.

Hiermee verwijdert u de geselecteerde inhoud.
Deze parameter is alleen beschikbaar als het arpeggio in de gebruikersbank is geselecteerd.

Hiermee wordt de naam van de geselecteerde inhoud veranderd.
Deze parameter is alleen beschikbaar als het arpeggio in de gebruikersbank is geselecteerd.

Wist alle markeringen als favoriet uit de arpeggiolijst.
Deze parameter is niet beschikbaar als er geen arpeggiotypen zijn die als favoriet zijn gemarkeerd.

Hiermee bepaalt u de sorteervolgorde van de lijst met arpeggiotypen.
Instellingen: Default, Name, Date

Name: sorteert op naam. De pijl-omlaag geeft aan dat de lijst is gesorteerd in oplopende
volgorde (A tot Z). De pijl-omhoog geeft aan dat de lijst in aflopende volgorde is gesorteerd.
Date: sorteert op de datum waarop de instelling werd geladen. De pijl-omlaag geeft aan
dat de lijst in aflopende volgorde is gesorteerd (nieuw tot oud). De pijl-omhoog geeft aan
dat de lijst in oplopende volgorde is gesorteerd.

Toont de arpeggionaam, maatsoort, tellen, aanbevolen tempo, kenmerken en favorietstatus.

Name Search

Job

Delete

Rename

Favorite All Clear

Sort

List (Lijst)
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Op het scherm Waveform Search kunt u golfvormen zoeken en selecteren.

Gebruik

Waveform-gerelateerd scherm → Part-selectie → Waveform-selectie → [CATEGORY]

Filtert op bank of favorieten.
Als Favorite is geselecteerd, verschijnen alleen golfvormen die als favoriet zijn gemarkeerd in de lijst.
Instellingen: All, Favorite, Preset, User, Library-naam (wanneer een bibliotheekbestand is geladen)

Hiermee kunt u bepaalde tekens in de naam invoeren, zodat u gemakkelijk kunt zoeken.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u tot 20 alfanumerieke tekens
kunt invoeren.

Filtert op categorie.
Door het selectievakje Main of Sub uit te schakelen, kunt u het filteren op categorie annuleren.
Instellingen: Raadpleeg de Data List.

Roept het Job-menu op.

Hiermee verwijdert u de geselecteerde inhoud.
Deze parameter is alleen beschikbaar als er een golfvorm in de gebruikersbank is geselecteerd.

Waveform Search (Waveform Category Search)

Bank/Favorite (Bank/Favorite Select)

Zoeken op naam

Main (Main Category)
Sub (Sub Category)

Job

Delete
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Hiermee wordt de naam van de geselecteerde inhoud veranderd.
Deze parameter is alleen beschikbaar als er een golfvorm in de gebruikersbank is geselecteerd.

Wist alle markeringen als favoriet uit de golfvormlijst.
Deze parameter is niet beschikbaar als er geen golfvormen zijn die als favoriet zijn gemarkeerd.

Stelt de sorteervolgorde van de golfvormlijst in.
Instellingen: Default, Name, Date

Name: sorteert op naam. De pijl-omlaag geeft aan dat de lijst is gesorteerd in oplopende
volgorde (A tot Z). De pijl-omhoog geeft aan dat de lijst in aflopende volgorde is gesorteerd.
Date: sorteert op de datum waarop de instelling is opgeslagen. De pijl-omlaag geeft aan
dat de lijst in aflopende volgorde is gesorteerd (nieuw tot oud). De pijl-omhoog geeft aan
dat de lijst in oplopende volgorde is gesorteerd.

Rename

Favorite All Clear

Sort
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Live Sets zijn handig voor situaties waarin u live speelt, waarbij u de performance direct wilt
veranderen, samen met de nummers die u speelt.

Inhoudsopgave

Live Set-scherm

Live Set

Live Set Register

Live Set Edit
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Op het scherm Live Set kunt u een performance oproepen.
Als u op [SHIFT] + [EDIT/ ] drukt terwijl de gebruikersbank is geselecteerd, wordt een
dialoogvenster weergegeven en kunt u pagina's of banken kopiëren of uitwisselen.

Gebruik

Selecteert de Live Set-bank.
Instellingen: Preset, User 1–8 (standaard) of Library-naam (als een bibliotheekbestand is geladen)

Selecteert de Live Set-pagina.

Toont een lijst met performances die op de geselecteerde Live Set-pagina zijn geregistreerd.

Opent het scherm Performance Category Search.

Toont de naam van de performance die in de geselecteerde sleuf is geregistreerd.

Live Set

Druk op de knop [LIVE SET]

Tik op het pictogram  (Liveset).

Bank (Bank Name)

Page

Live Set Slot 1-16

Category Search

Current Performance Name

Current Slot Name
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Toont de naam van de geselecteerde sleuf.
Als een patroon, song of audio aan een sleuf is toegewezen, wordt de naam van het patroon of de
song of het audiobestand weergegeven.

Geeft het attribuut/de attributen van de performance aan die in de geselecteerde sleuf is
geregistreerd.

Op het scherm Live Set verandert het PTN-pictogram in PTN CHAIN wanneer een patroon met keten
aan een sleuf is toegewezen.

: wordt weergegeven voor een sleuf waaraan een patroon is toegewezen.
: wordt weergegeven voor een sleuf waaraan een patroon is toegewezen.

: wordt weergegeven voor een sleuf waaraan een song is toegewezen.
: wordt weergegeven voor een song waaraan audio is toegewezen.

Het scherm Live Set Edit wordt weergegeven.
Edit verschijnt alleen wanneer User Bank is geselecteerd.

Performance Attribute

Edit
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Op het scherm Live Set Register kunt u performances registreren voor Live Set-sleuven.

Gebruik

Slaat de huidige performance op als een nieuwe performance en registreert deze in de
geselecteerde sleuf.

Opent het scherm Data Utility.

Slaat de nieuwe performance op over de bestaande performance en registreert deze in de
geselecteerde sleuf.

Registreert een performance zonder deze op te slaan.

Live Set Register

[SHIFT] + [LIVE SET]

Houd de [SHIFT]-knop ingedrukt en tik op de knop <Live Set> op de Navigation Bar

Store as New Perf. and Register (Store as New Performance and Register)

Jump to Data Utility

Overwrite Current Perf. and Register (Overwrite Current Performance and Register)

Register without Storing

409



om02screenparameters0310

Op het scherm Live Set Edit kunt u Live Sets bewerken.
Alleen Live Sets in de gebruikersbank kunnen worden bewerkt.

Gebruik

[LIVE SET] → [EDIT/ ]

Slaat de geselecteerde Live Set-bank op onder een nieuwe naam. U kunt maximaal 20
alfanumerieke tekens gebruiken.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u een naam kunt invoeren.

Slaat de geselecteerde Live Set-pagina op onder een nieuwe naam. U kunt maximaal 20
alfanumerieke tekens gebruiken.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u een naam kunt invoeren.

Tik op Done om het scherm Live Set Edit te sluiten en het scherm Live Set weer te geven.

Toont een lijst met performances die voor de geselecteerde Live Set zijn geregistreerd.

Selecteert het sleuftype.
Instellingen: Perform, Song, Audio, Pattern

Perform: registreert alleen de performance in de sleuf
Song: registreert de performance en de song in de sleuf

Live Set Edit

Bank (Bank Name)

Page (Page Name)

Done

Live Set Slot 1-16

Slot Type
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Audio: registreert de performance en het audiobestand in de sleuf
Pattern: registreert de performance en het patroon in de sleuf

Toont de Slot Name wanneer het Slot Type Perform is.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u een naam kunt invoeren
voor de huidige sleuf. U kunt maximaal 20 alfanumerieke tekens gebruiken.
Als het Slot Type Pattern is, wordt de Pattern Name weergegeven; als het Slot Type Song is, wordt
de Song Name weergegeven; en als het Slot Type Audio is, wordt de Audio Name weergegeven. Het
geregistreerde patroon, de geregistreerde song of de geregistreerde audio wordt weergegeven.
Wanneer u op de naam tikt, verschijnt het scherm Utility Load. Vervolgens kunt u het patroon, de
song of de audio selecteren die u wilt registreren.

Toont de naam van de performance die in de geselecteerde sleuf is geregistreerd.
Wanneer u op de naam tikt, verschijnt het scherm Performance Category Search.

Stelt de kleur in voor de geselecteerde sleuf.
Instellingen: Black, Red, Yellow, Green, Blue, Azure, Pink, Orange, Purple, Sakura, Cream, Lime,

Aqua, Beige, Mint, Lilac

Stelt het volume in van de performance die in de geselecteerde sleuf is geregistreerd.

Roept het Job-menu op.

Schakelt de kopieerfunctie in.
U kunt instellingen kopiëren door een sleuf te selecteren waaruit u wilt kopiëren, op Copy te tikken en
vervolgens de sleuf te selecteren waarnaar u wilt kopiëren.
Instellingen: Off, On

Schakelt de uitwisselfunctie in.
U kunt instellingen uitwisselen door de eerste sleuf te selecteren, op Exchange te tikken en
vervolgens de tweede sleuf te selecteren.
Instellingen: Off, On

Selecteer de sleuf en tik vervolgens op Delete om geregistreerde performances en andere
instellingen uit de sleuf te verwijderen.

Slot Name
Pattern Name
Song Name
Audio Name

Performance (Performance Name)

Color

Volume

Job

Copy

Exchange

Delete
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Tik op [+] om de geselecteerde performance in die sleuf te registreren.

Gebruik

Tik op [LIVE SET] (of tik op het Live Set-pictogram) → User bank-selectie → Slot-selectie → de knop
[ ] (Play)

OPMERKING

[+] (Add)

Het patroon, de song of het audiobestand afspelen vanuit het scherm Live Set

Performance en sleuf kunnen niet worden gewijzigd terwijl het patroon of de song wordt afgespeeld. Als u
probeert deze te wijzigen, verschijnt er een foutmelding.
Als u op de knop [ ] (Play) drukt terwijl het patroon, de song of het audiobestand wordt afgespeeld, wordt het
afspeelscherm voor het patroon, de song of het audiobestand geopend.
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om02screenparameters0320

Het Utility-scherm wordt gebruikt voor het instellen van algemene items voor het gehele instrument.

Inhoudsopgave

Het scherm Sound wordt gebruikt om de geluidsuitvoer van het instrument in te stellen.

Gebruik

[UTILITY] → Settings → Sound

Utility-scherm

Settings

Sound

Edit User Micro Tuning

Quick Setup

Audio I/O

MIDI I/O

Advanced

System

Contents

Load

Save

Data Utility

Library Import

Tempo Settings

Effect Switch

Other Info

Shift Function

Legal Notices

Settings

Sound
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Stelt het algemene volume in van de geluidsuitvoer van het instrument.
Instellingen: 0−127

Past de toonhoogte aan van het totaalgeluid dat door het toongeneratorblok van het instrument wordt
geproduceerd in halve tonen.
Instellingen: −24semi−+24semi

Past de stemming aan van het totaalgeluid dat door het toongeneratorblok van het instrument wordt
geproduceerd in halve tonen. U kunt de toonhoogte nauwkeurig afstellen in cents.
Instellingen: −102,4−+102,3

Verschuift de toonhoogte van de toetsen in octaven.
Dit is gerelateerd aan de knoppen OCTAVE [-]/[+] op het bovenpaneel.
Instellingen: −3−+3

OPMERKING
De instelling voor Keyboard Octave Shift wordt bij de volgende keer opstarten teruggezet op 0.

Verschuift de toonhoogte van de toetsen in halve noten.
Instellingen: −11semi–+11semi

OPMERKING

Bepaalt hoe de werkelijke aanslagsnelheid wordt gegenereerd en verzonden in overeenstemming
met de aanslagsnelheid waarmee u noten op het toetsenbord speelt.

Tone Generator Volume

Tone Generator Note Shift

Tone Generator Tune

Keyboard Octave Shift

Keyboard Transpose

Voor alle noten buiten het bereik tussen C-2 en G8 (het bereik dat op de toongenerator van dit instrument kan
worden gespeeld), wordt de noot een octaaf hoger (of lager) gespeeld.
De instelling voor Keyboard Transpose wordt bij de volgende keer opstarten teruggezet op +0 semi.

Keyboard Velocity Curve
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De grafiek die in de display wordt weergegeven geeft de responscurve van de aanslagsnelheid weer.
De horizontale as geeft de ontvangen aanslagsnelheidswaarde (of de kracht waarmee u op de toets
hebt gedrukt) weer, terwijl de verticale as de werkelijke aanslagsnelheidswaarde weergeeft die naar
de interne of externe toongenerators wordt verzonden.
Instellingen: Normal, Soft 1, Soft 2, Hard 1, Hard 2, Wide, Fixed

Normal: veelgebruikte instelling waarbij de lineaire 'curve' ervoor zorgt dat de sterkte
waarmee u speelt (aanslag) rechtstreeks van invloed is op de werkelijke geluidswijziging.
Soft 1: zorgt voor een toegenomen respons
Soft 2: een curve tussen Soft 1 en Normal
Hard 1: zorgt voor een afgenomen respons
Hard 2: een curve tussen Hard 1 en Normal
Wide: accentueert uw speelsterkte door lagere aanslagsnelheden te produceren wanneer
u zachter speelt en hogere (luidere) aanslagsnelheden wanneer u harder speelt. Op die
manier kunt u deze instelling gebruiken om uw dynamisch bereik uit te breiden.
Fixed: produceert dezelfde aanslagwaarde, ongeacht hoe hard u speelt. De waarde die is
ingesteld in Keyboard Fixed Velocity, wordt hier gebruikt.

Verzendt een vaste aanslagsterkte naar de toongenerator, ongeacht hoe hard of zacht u op het
toetsenbord speelt.
Deze parameter is alleen beschikbaar wanneer Keyboard Velocity Curve is ingesteld op Fixed.
Instellingen: 1−127

Selecteert het type aftertouch-uitvoer naar externe apparaten.
Instellingen: Off, Channel, Poly

Stelt de curve in die het niveau van de aftertouchwaarde bepaalt in verhouding tot de sterkte
wanneer u de toets indrukt.
Instellingen: Normal, Soft 1, Soft 2, Hard 1, Hard 2

Selecteert het type voetschakelaar dat is aangesloten op de aansluiting FOOT SWITCH [SUSTAIN]
op het achterpaneel.

Selecteer FC3A (Half On).
Selecteer FC3A (Half Off) als u de halfdemperfunctie niet hoeft te gebruiken.

Selecteer FC4A of FC5.
De halfdemperfunctie is niet beschikbaar met FC4, FC4A en FC5.

Keyboard Fixed Velocity

AT MIDI Out (After Touch MIDI Out)

AT Curve (Poly After Touch Curve)

Sustain Pedal (Sustain Pedal Select)

FC3, FC3A (halfdemperfunctie ingeschakeld)

FC4, FC4A, FC5

Pedaal met omgekeerde polariteit
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Selecteer Reverse Polarity.
De halfdemperfunctie is niet beschikbaar.

Instellingen: FC3A (Half On), FC3A (Half Off), FC4A/FC5, Reverse Polarity

OPMERKING
De instelling Sustain Pedal (Sustain Pedal Select) is niet nodig als u de halfdemperfunctie gebruikt door de
besturingswijziging vanaf het externe MIDI-apparaat te verzenden.

Als deze parameter is ingeschakeld, krijgen de fijnstemmingsinstellingen in de algemene instellingen
voorrang op de fijnstemmingsinstellingen voor elke partij van de performance.
Dit geldt voor alle partijen behalve de drumpartij.
Instellingen: Off, On

OPMERKING
De instelling Global Tuning wordt de volgende keer dat het instrument wordt ingeschakeld teruggezet op Off.

Toont de naam van de geselecteerde fijnstemming.
Door op de naam te tikken, roept u het menu op voor het selecteren van de fijnstemming.
Instellingen: Equal Temperament, Pure Major, Pure Minor, Weckmeister, Kirnberger, Vallotti &

Young, 1/4 Shift, 1/4 tone, 1/8 tone, Indian, Arabic1, Arabic2, Arabic3
User: User1–8
Library: Library-naam (als een bibliotheekbestand is geladen)

Stelt de grondtoon in voor het fijnstemmen.
Deze parameter wordt niet weergegeven als het geselecteerde type in Micro Tuning Name geen
grondtoon vereist.
Instellingen: C−B

Opent het instellingenscherm voor User Micro Tuning.

Dit is het instellingenscherm voor User Micro Tuning.

Global Tuning

Micro Tuning Name (Global Micro Tuning Name)

Micro Tuning Root (Global Micro Tuning Root)

Edit User Tuning

Edit User Micro Tuning
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Geeft het geselecteerde gebruikersmicrostemmingnummer aan.
Instellingen: 1−8

U kunt de User Micro Tuning die u bewerkt onder een nieuwe naam opslaan.
Als u op de naam tikt, wordt het schermtoetsenbord opgeroepen, zodat u een naam kunt invoeren.

U kunt de toonhoogte van elke noot aanpassen in stappen van 1 cent en zo de fijnstemming
instellen.
Instellingen: −99−+99

Initialiseert de geselecteerde fijnstemming van de gebruiker.

Met deze functie kunt u alle noodzakelijke instellingen instellen om het externe apparaat aan te
sluiten met de optimale waarden door eenvoudigweg een groep instellingen te selecteren.
Parameters op verschillende instellingenschermen kunnen in één keer worden ingesteld.

Gebruik

Tuning No. (Micro Tuning Number)

Tuning Name (Micro Tuning Name)

C, C♯, D, D♯, E, F, F♯, G, G♯, A, A♯, B

Initialize

Quick Setup

[QUICK SETUP]

[UTILITY] → Settings → Quick Setup
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Geeft het stroomdiagram van het audiosignaal weer.
De getoonde signaalstroom verandert afhankelijk van de verbinding van de [USB TO HOST]-
aansluiting en de andere instellingen van het instrument.

Geeft het stroomdiagram van het MIDI-signaal weer.
Het signaalstroomdiagram verandert afhankelijk van de instellingen van het instrument.

Wordt ingesteld op één via Quick Setup.
Instellingen: Standalone, 1–3

De parameters voor Quick Setup zijn als volgt.

Audio-instellingen Direct Monitor Switch

MIDI-instellingen Local Control

Performance-instellingen

Part 1–16 Output Select
A/D In Output Select
Digital In Output Select
Part 1–8 Keyboard Control Switch
Part 1–16 Part Mode
Part 1–16 Tx Channel

Zie Audio I/O voor audio-instellingen. Zie MIDI I/O voor MIDI-instellingen.

Instellingen voor het zelfstandig gebruiken van het instrument en voor het bedienen van het
externe apparaat vanaf het instrument

Audio Signal Flow

MIDI Signal Flow

Quick Setup (Quick Setup Select)

Standaardinstellingen voor Quick Setup

Standalone
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Local Control Direct Monitor Output Select Keyboard Sw Part Mode Tx Channel

On On Main L&R Part 1–8: On Part 1–16: Int Part 1–16: Ch 1–16

Instellingen voor het opnemen van uw performance in MIDI op DAW-software

Local Control Direct Monitor Output Select Keyboard Sw Part Mode Tx Channel

Off On Main L&R Part 1–8: On Part 1–16: Int Part 1–16: Ch 1–16

Instellingen voor het opnemen van elke partij op de interne toongenerator op DAW-software als
een individuele audiotrack

Local Control Direct Monitor Output Select Keyboard Sw Part Mode Tx Channel

On Off Different for each Part Part 1–8: On Part 1–16: Int Part 1–16: Ch 1–16

Instellingen voor het gebruik van de interne toongenerator met een geluidsgeneratorplug-in op een
computer

Local Control Direct Monitor Output Select Keyboard Sw Part Mode Tx Channel

On On Main L&R
Part 1–5: On
Part 6–8: Off

Part 1–4: Int
Part 5–16: Ext

Part 1–4: Ch 1–4
Part 5–8: Ch 1–4
Part 9–16: Ch 9–16

Slaat de huidige instellingen op in Quick Setup 1 tot 3.

In het scherm Audio I/O kunt u de invoer en uitvoer van het audiosignaal instellen.

Gebruik

[UTILITY] → Settings → Audio I/O

MIDI Rec on DAW

Audio Rec on DAW

With Plugin Host App

Store Current Settings

Audio I/O
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Geeft het huidige stroomdiagram van het audiosignaal weer.
Het stroomdiagram verandert afhankelijk van de verbinding van de [USB TO HOST]-aansluiting en
de andere instellingen van het instrument.

Wanneer u op Main Monitor Volume in de Audio Signal Flow tikt, wordt de cursor verplaatst naar
Main, en wanneer u op Assign tikt, wordt de cursor verplaatst naar Assign.

Stelt de ingangsversterking voor de A/D INPUT-aansluiting in op Mic of Line.
Instellingen: Mic, Line

Mic: bedoeld voor een apparaat met een laag uitgangsniveau, zoals een microfoon.
Line: bedoeld voor een apparaat met een hoog uitgangsniveau, zoals een synthesizer of
audioapparaat.

OPMERKING
Een gitaar of bas met een actieve pickup kan rechtstreeks worden aangesloten. Als u daarentegen een passieve
pickup gebruikt, sluit u het instrument aan via een effectapparaat of directbox.

Hiermee kunt u het volumeniveau aanpassen van de audiosignaalingang van de aansluiting [USB TO
HOST]. Dit wordt toegepast op de uitgangssignalen van zowel de OUTPUT (BALANCED)-
aansluitingen als de ASSIGNABLE OUTPUT (BALANCED)-aansluitingen.
Instellingen: 0−127

OPMERKING
USB Input Volume wordt opgeslagen als een algemene instelling en niet voor elke performance.

Wisselt de modus van voor het audiosignaal dat wordt uitgevoerd via de [USB TO HOST]-aansluiting.
Het instrument moet opnieuw worden opgestart om deze instelling actief te maken.
Instellingen: 16 Stereo/44.1kHz, 4 Stereo/44.1–192kHz

16 Stereo/44.1kHz: maximaal 32 kanalen (of 16 stereokanalen) gebruiken bij een
samplingfrequentie van 44,1 kHz

Audio Signal Flow

A/D Input (A/D Input Gain)

USB Volume

Audio I/O Mode
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4 Stereo/44.1–192kHz: maximaal 8 kanalen (of 4 stereokanalen) bij een
samplingfrequentie van 44,1 kHz tot 192 kHz.

OPMERKING
Als 4 Stereo/44.1–192kHz is ingesteld, zijn de beschikbare frequenties 44,1 kHz, 48 kHz, 96 kHz en 192 kHz.

Stelt de uitgangsversterking van de OUTPUT (BALANCED)-aansluitingen in.
Instellingen: −6 dB, +0 dB, +6 dB, +12 dB

Stelt de uitgangsversterking van de ASSIGNABLE OUTPUT (BALANCED)-aansluitingen in.
Instellingen: −6 dB, +0 dB, +6 dB, +12 dB

Stelt de uitgangsversterking in van het Main L&R-kanaal van de [USB TO HOST]-aansluiting.
Instellingen: −6 dB, +0 dB, +6 dB, +12 dB

Stelt de uitgangsversterking van de kanalen 1-30 kanalen van de [USB TO HOST]-aansluiting in.
Instellingen: −6 dB, +0 dB, +6 dB, +12 dB

Stelt de audiosignaaluitvoer in van Main L&R (USB Out)- en USB 1–30-kanalen naar het externe
apparaat (zoals een computer) dat ook via dit instrument kan worden afgespeeld (direct monitoring).
Als deze parameter is ingesteld op On, wordt het audiosignaal dat wordt uitgevoerd naar het Main
L&R (USB Out)-kanaal en de USB 1–30-kanalen ook verzonden naar de OUTPUT (BALANCED)-
aansluitingen en [PHONES]-aansluiting van dit instrument.
Als er geen USB-verbinding is, wordt de Direct Monitor-schakelaar automatisch ingeschakeld.
Instellingen: Off, On

Toont het scherm Monitor Volume.

In het scherm MIDI I/O kunt u de MIDI-ingang en -uitgang instellen.

Gebruik

[UTILITY] → Settings → MIDI I/O

Main L&R (Analog Output L&R Output Gain)

Assign L&R (Assignable Output L&R Output Gain)

USB Main (USB Main L&R Output Gain)

USB 1–30 (USB Individual Output Gain)

Direct Monitor

Monitor Volume

MIDI I/O
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Geeft het huidige stroomdiagram van het MIDI-signaal weer.
Het stroomdiagram verandert afhankelijk van de instellingen van het instrument.
Door bij de Local Control-schakelaar op de MIDI Signal Flow te tikken, kunt u Local Control in- of
uitschakelen.

Selecteert de aansluiting(en) voor het verzenden en ontvangen van MIDI-berichten.
Instellingen: MIDI, USB

Schakelt lokale besturing in of uit.
Als de Local Control uitstaat, worden het regelaarblok en het toongeneratorblok losgekoppeld en
wordt er geen geluid geproduceerd als u het toetsenbord bespeelt. Ongeacht deze instelling worden
de toetsenspeldata op dit instrument echter verzonden als MIDI-berichten, en worden MIDI-berichten
die vanaf het externe apparaat worden verzonden, verwerkt door het toongeneratorblok.
Instellingen: Off, On

Stelt het MIDI-kanaal in voor invoer en uitvoer van de partij met Common en de partij waarbij de
Keyboard Control Switch is ingesteld op On.
Instellingen: Ch1–Ch16

Selecteert het type aftertouch-uitvoer naar externe apparaten.
Instellingen: Off, Channel, Poly

Stelt de parameters in die gerelateerd zijn aan de synchronisatie met het aangesloten externe
apparaat.
Selecteer de interne klok van dit instrument of de externe MIDI-klok van DAW-software op de
computer of het externe MIDI-apparaat, of de audiosignaalinvoer van de A/D INPUT-aansluitingen
voor het afspelen van de arpeggio's, motionsequencer, songs en patronen.

MIDI Signal Flow

MIDI IN/OUT

Local Control

MIDI I/O Channel

AT MIDI Out (After Touch MIDI Out)

MIDI Sync
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Instellingen: Internal, MIDI, A/D In (ABS)
Internal: synchroniseert met de interne klok. Voor gebruik van dit instrument op zichzelf of
als primaire klokbron voor andere apparaten.
MIDI: synchroniseert met de MIDI-klok die wordt ontvangen van het externe MIDI-
apparaat. Voor gebruik van het externe apparaat als de primaire klokbron.
A/D In: synchroniseert met het tempo, geëxtraheerd door de Audio Beat Sync-functie, van
het audiosignaal dat wordt ingevoerd via de A/D INPUT-aansluitingen.

Stelt de MIDI-klokberichten in die moeten worden verzonden.
Instellingen: Off, On

Ontvangt de MIDI-berichten voor het starten en stoppen van de song.
Instellingen: Off, On

Verzendt de MIDI-berichten voor het starten en stoppen van de song.
Instellingen: Off, On

Stelt in of de huidige instellingen van de regelaars, zoals modulatiewiel, aftertouch, voetregelaar en
ademregelaar (Hold) moeten worden gebruikt of dat ze worden teruggezet naar hun oorspronkelijke
instellingen (Reset) wanneer u tussen performances schakelt.
Instellingen: Hold, Reset

Wanneer ingesteld op Reset, worden de regelaars gereset als u tussen performances schakelt, zoals
hieronder weergegeven:

Pitchbend Midden

Modulatiewiel Minimum

After Touch Minimum

Voetregelaar Maximum

Voetschakelaar Uit

Lintregelaar Midden

Ademregelaar Maximum

Expressie Maximum

Toewijsbare schakelaars 1 en
2

Off

Clock Out (MIDI Clock Out)

Receive (Receive Sequencer Control)

Transmit (Transmit Sequencer Control)

Controller Reset
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Elke lane van
motionsequencer

Als de Motion Seq Polarity voor de lane is ingesteld op Unipolar: de waarde is 0
(minimum)
Als de Motion Seq Polarity voor de lane is ingesteld op Bipolar: de waarde is 64
(midden)

Stelt het regelaarwijzigingsnummer in dat wordt gegenereerd door de bediening van de
voetschakelaar die is aangesloten op de FOOT SWITCH [ASSIGNABLE]-aansluiting. Wanneer dit
instrument een MIDI-bericht ontvangt met hetzelfde regelaarwijzigingsnummer dat hier is opgegeven
van het externe MIDI-apparaat, gedraagt het instrument zich alsof de voetschakelaar is bediend.
Instellingen: Off, 1–95, Arp Sw, MS Sw, Play/Stop, Live Set+, Live Set−, Oct Reset, Tap Tempo

Stelt het regelaarwijzigingsnummer in dat wordt gegenereerd door het gebruik van de Super Knob.
Wanneer dit instrument het MIDI-bericht ontvangt met hetzelfde regelaarwijzigingsnummer dat hier is
opgegeven van het externe MIDI-apparaat, gedraagt het instrument zich alsof de Super Knob is
gebruikt.
Instellingen: Off, 1−95

OPMERKING
Als deze parameter is ingesteld op Off, wordt de SysEx (systeemeigen) gebruikt voor het afhandelen van MIDI-
berichten.

Stelt het regelaarwijzigingsnummer in dat wordt gegenereerd wanneer u tussen scènes schakelt.
Ook zal de scène veranderen als een MIDI-bericht met hetzelfde regelaarwijzigingsnummer dat hier
is ingesteld van het externe MIDI-apparaat wordt ontvangen.
Instellingen: Off, 1−95

OPMERKING

Opent het scherm Control → Control Number voor de Common Edit.

In het scherm Advanced kunt u de gedetailleerde instellingen voor het instrument opgeven.

Gebruik

[UTILITY] → Settings → Advanced

FS Assign (FootSwitch Assign Control Number)

Super Knob CC (Super Knob Control Change Number)

Scene CC (Scene Control Change Number)

Afhankelijk van het regelaarwijzigingsnummer wordt een van de scènes 1−8 geselecteerd.
0−15: scène 1, 16−31: scène 2, 32−47: scène 3, 48−63: scène 4, 64−79: scène 5, 80−95: scène 6, 96−111:
scène 7, 112−127: scène 8
Als het regelaarwijzigingsnummer van de Super Knob en het regelaarwijzigingsnummer van de scène op
dezelfde waarde zijn ingesteld, wordt een uitroepteken (!) weergegeven voor de waarde. In dat geval krijgt de
regelaarwijzigingsnummer van de scène voorrang en wordt het regelaarwijzigingsnummer van de Super Knob
uitgeschakeld.

Control Number

Advanced
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Schakelt de auditievergrendeling in of uit.
Als deze is ingeschakeld, is de auditiefunctie uitgeschakeld.
Instellingen: Off, On

Als deze parameter is ingeschakeld, wordt de auditiefrase in een lus afgespeeld.
Als dit is ingeschakeld, stopt het afspelen van de auditiefrase automatisch nadat deze tot het einde is
afgespeeld.
Instellingen: Off, On

Auto Power Off is een functie die het instrument automatisch uitschakelt wanneer het gedurende een
bepaalde tijd inactief is, om het energieverbruik te verminderen.
Hier kunt u de tijdsduur instellen totdat het instrument automatisch wordt uitgeschakeld.
Instellingen: Off (Auto Power Off uitgeschakeld), 5 min, 10 min, 15 min, 30 min, 60 min, 120 min

Stelt het MIDI-apparaatnummer in.
Voor het verzenden en ontvangen van systeemeigen berichten zoals bulkdump- en
parameterwijzigingsberichten naar en van een extern MIDI-apparaat, moet u dit nummer zo instellen
dat het overeenkomt met het apparaatnummer van het andere apparaat.
Instellingen: 1–16, All, Off

Stelt de ontvangst en verzending in van bankselectieberichten tussen het instrument en het externe
MIDI-apparaat.
Als dit is ingeschakeld, ontvangt of herkent het instrument bankselectieberichten die vanaf het
externe MIDI-apparaat worden verzonden.
Instellingen: Off, On

Stelt de ontvangst en verzending in van programmawijzigingsberichten tussen het instrument en het
externe MIDI-apparaat.

Audition Lock

Audition Loop

Auto Power Off (Auto Power Off Time)

Device Number

Bank Select (Receive/Transmit Bank Select)

Pgm Change (Receive/Transmit Program Change)
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Als dit is ingeschakeld, ontvangt of herkent het instrument programmawijzigingsberichten die vanaf
het externe MIDI-apparaat worden verzonden.
Instellingen: Off, On

Stelt de ontvangst van bulkdumpberichten in.
Instellingen: Protect (niet ontvangen), On (ontvangen)

Stelt de intervaltijd in voor de verzending van bulkdata wanneer dit instrument het bulkverzoekbericht
van het externe apparaat ontvangt.
Instellingen: 0−900 ms

Dit zorgt ervoor dat bepaalde events correct worden herkend wanneer bijvoorbeeld een song vanuit
het midden wordt afgespeeld, of bij de bewerkingen Vooruit (snel vooruitspoelen) en Terug
(terugspoelen).
Events die met MIDI Event Chase zijn ingesteld, zullen dan correct functioneren met de Vooruit- en
Terug-bewerkingen.
Instellingen: Off, PC (programmawijziging), PC+PB+Ctrl (programmawijziging + pitchbend +

regelaarwijziging)

Initialiseert de gebruikersdata wanneer het instrument wordt ingeschakeld.
Instellingen: Off, On

Stel dit in op Vendor voor aansluiting op de computer waarop de Yamaha Steinberg USB Driver is
geïnstalleerd.
Stel dit in op Generic als u dit instrument aansluit op een computer die voldoet aan de operationele
vereisten van MIDI 2.0 of als u een smartphone of ander apparaat gebruikt waarop de Yamaha
Steinberg USB Driver niet kan worden geïnstalleerd.
Instellingen: Vendor, Generic

Initialiseert de instellingen in het scherm Advanced.

In het scherm System kunt u de parameters instellen die betrekking hebben op het gehele
instrument.

Gebruik

Receive Bulk

Bulk Interval

Event Chase (Song Event Chase)

Init On Boot (Initialize User Data on Boot-up)

USB Driver Mode

Initialize Advanced Settings

System

[UTILITY] → Settings → System

[UTILITY] + [DAW REMOTE] (→ Calibrate Touch Panel-instellingen)
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Stelt het scherm in dat op de display wordt weergegeven wanneer het instrument wordt
ingeschakeld.
Instellingen: Perform, Live Set

Opent het scherm voor kalibratie van de lintregelaar.
Gebruik dit wanneer de lintregelaar niet correct reageert.

Opent het scherm voor kalibratie van het aanraakscherm.
Gebruik dit wanneer het aanraakscherm niet correct reageert.

Wanneer Power On Mode is ingesteld op Live Set, gebruik dan deze parameter om de initiële Live
Set-sleuf in te stellen die moet worden geselecteerd na het opstarten.

OPMERKING
U kunt de sleuf ook instellen door een performance te selecteren in het scherm Live Set, dit scherm te openen en
vervolgens op de knop Set Current Slot te tikken.

Stelt de huidige performance in op de Live Set-sleuf die na het opstarten is geselecteerd.

Initialiseert alle instellingen van het scherm Utility.

Schakelt het bedieningsgeluid van het aanraakscherm in of uit.
Instellingen: Off, On

Power on Mode

Calibrate Ribbon Controller

Calibrate Touch Panel

Initial Live Set Bank (Initial Live Set Bank)
Initial Live Set Page (Initial Live Set Page)
Initial Live Set Slot (Initial Live Set Slot)

Set Current Slot (Set Current Slot to Initial Live Set)

Initialize All Settings

Beep

Part Display
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Stelt de partijnaam in om de categorie en het partijtype weer te geven, of alleen de partijnaam.
Instellingen: Type, Name

Bepaalt de lettergrootte van de inhoudsnamen en categorienamen in het scherm Live Set en het
scherm Category Search.
Instellingen: Normal, Large

Initialiseert alle data in het gebruikersgedeelte van het gebruikersgeheugen (Performances, Motion
Sequences, Live Sets en dergelijke) en alle instellingen in het scherm Utility.

LET OP

Wanneer Initialize User Data wordt uitgevoerd, worden alle toepasselijke data en
systeeminstellingen die u hebt gemaakt, teruggezet naar de fabrieksinstellingen.
Zorg ervoor dat u geen belangrijke data verliest. Het wordt ook aanbevolen om de benodigde
instellingen vooraf op een USB-flashstation op te slaan.

Schakelt de knipperfunctie van de Super Knob in of uit.
Instellingen: Off, On

Stelt de helderheid van verlichting in op de Super Knob.
Instellingen: 0-128

Regelt het dimmen van de knoplampjes.
Instellingen: Off, 1/4, 1/2

Initialiseert alle data in het gebruikersgeheugen en alle instellingen in het scherm Utility.

LET OP

Wanneer Initialize User Data wordt uitgevoerd, worden alle toepasselijke data en
systeeminstellingen die u hebt gemaakt, teruggezet naar de fabrieksinstellingen.
Zorg ervoor dat u geen belangrijke data verliest. Het wordt ook aanbevolen om de benodigde
instellingen vooraf op een USB-flashstation op te slaan.

Geeft de firmwareversie van het instrument aan.

Live Set Font

Initialize User Data

Knob Flash (Super Knob LED Blink)

KnobBrightness

Half Glow (LED Half Glow Brightness)

Initialize All Data

Product Info

Contents
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Op het scherm Load kunt u bestanden en data laden.

Gebruik

Alle data of een specifieke set data worden geladen vanuit één bestand dat is opgeslagen op een
USB-flashstation of een instelling die op het instrument is opgeslagen.
Hier kunt u selecteren welke dataset in een bestand u wilt laden.
De beschikbare instellingen variëren afhankelijk van de route die u neemt om het scherm te openen.

Instellingen: u kunt de volgende bestandstypen laden.

Load

[UTILITY] → Contents → Load

[SHIFT] + [STORE]

Content Type
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Content Type Apparaattype Bestandsextensie Omschrijving

User File File

.Y2U
(.Y2W)

.X7U

.X8U

Een gebruikersbestand dat op een USB-
flashstation is opgeslagen, wordt in het
gebruikersgedeelte van het
gebruikersgeheugen geladen.

Wanneer het gebruikersbestand is gesplitst,
moeten zowel .Y2U als .Y2W op het USB-
flashstation worden opgeslagen.

De volgende instellingen zijn opgenomen in
een gebruikersbestand.

Library File File

.Y2L
(.Y2M)

.X7L

.X8L

Bibliotheekbestanden die op een USB-
flashstation zijn opgeslagen, worden in het
bibliotheekgedeelte van het
gebruikersgeheugen geladen.

Wanneer een bibliotheekbestand is gesplitst,
moeten zowel .Y2L als .Y2M op het USB-
flashstation worden opgeslagen.

De volgende instellingen zijn opgenomen in
een bibliotheekbestand.

Performance
Arpeggio
Motion Sequence
Curve
Live Set
Micro Tuning
Waveform
Audition
Utility-instellingen (alleen .Y2U)
Quick Setup (alleen .Y2U)

Performance
Arpeggio
Motion Sequence
Curve
Live Set (slechts één bank)
Micro Tuning
Waveform
Audition
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Content Type Apparaattype Bestandsextensie Omschrijving

Backup File File

.Y2A
(.Y2B)

.X7A

.X8A

Back-upbestanden die op een USB-flashdrive
zijn opgeslagen, worden in het
gebruikersgeheugen geladen.
Een back-upbestand bevat alles in de
gebruikers- en bibliotheekgebieden, evenals
songs en patronen.

Wanneer een back-upbestand is gesplitst,
moeten zowel .Y2A als .Y2B op het USB-
flashstation worden opgeslagen.

Song&Perf
(Song &
Performance)

Interne data

Alleen de opgegeven song wordt geladen uit
de songs die zijn opgeslagen in het
gebruikersgebied van het
gebruikersgeheugen.
Zowel MIDI-sequences als performances
kunnen worden geladen.

Song Interne data

Alleen de opgegeven song wordt geladen uit
de songs die zijn opgeslagen in het
gebruikersgebied van het
gebruikersgeheugen.
Alleen MIDI-sequences kunnen worden
geladen.

.mid File File .MID
Standaard MIDI-bestanden (SMF) die op een
USB-flashstation zijn opgeslagen, worden
geladen (in indeling 0 of indeling 1).

.wav File File .WAV
Audiobestanden die op een USB-flashstation
zijn opgeslagen, worden geladen.

Pattern&Perf
(Pattern &
Performance)

Interne data

Alleen het opgegeven patroon wordt geladen
uit de patronen die zijn opgeslagen in het
gebruikersgebied van het
gebruikersgeheugen.
Zowel MIDI-sequences als performances
kunnen worden geladen.

Pattern Interne data

Alleen het opgegeven patroon wordt geladen
uit de patronen die zijn opgeslagen in het
gebruikersgebied van het
gebruikersgeheugen.
Alleen MIDI-sequences kunnen worden
geladen.

Audio File * File
.WAV
.AIF

Audiobestanden die op een USB-flashstation
zijn opgeslagen, worden geladen als
golfvormen.

Voorbeeld: [PERFORMANCE] → [EDIT/
] → Part-selectie → Element-selectie →
Osc/Tune
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Content Type Apparaattype Bestandsextensie Omschrijving

Motion Seq
(Motion Sequence) *

Interne data

Alleen de opgegeven sequence wordt geladen
uit de motionsequences die zijn opgeslagen in
het gebruikersgebied van het
gebruikersgeheugen.

Smart Morph * Interne data

Alleen Smart Morph-data worden geladen
vanuit de performance die is opgeslagen in
het gebruikersgebied van het
gebruikersgeheugen.

OPMERKING
Inhoudstypen gemarkeerd met een asterisk (*) worden niet weergegeven wanneer dit scherm wordt geopend vanuit
het scherm Utility.

Geeft de naam van de bovenliggende map en de naam van de huidige map aan.
Zodra u op de naam van de bovenliggende map tikt, is dit de huidige map.

Stelt in of de functie Job ingeschakeld (On) of uitgeschakeld (Off) is.
Als deze parameter is ingeschakeld, wordt door op het huidige bestand, de huidige map of de huidige
inhoud te tikken het contextmenu voor Rename of Delete geopend.
Wanneer u op het aangesloten USB-flashstation tikt, verschijnt het contextmenu voor Format.
Instellingen: Off, On

Geeft de gebruikte capaciteit en de totale capaciteit van de geselecteerde opslag aan.
De manier waarop dit wordt aangegeven varieert afhankelijk van het type inhoud.

Geeft de mappen en bestanden in de huidige map aan.

Stelt de sorteervolgorde van de bestanden in het scherm File select in.
Instellingen: Name, Size, Date, Default (afhankelijk van het inhoudstype)

Name: sorteert op naam. De pijl-omlaag geeft aan dat de lijst is gesorteerd in oplopende
volgorde (A tot Z). De pijl-omhoog geeft aan dat de lijst in aflopende volgorde is gesorteerd.
Size: sorteert op volgorde van datagrootte. De pijl-omlaag geeft aan dat de lijst in
oplopende volgorde is (van klein naar groot). De pijl-omhoog geeft aan dat de lijst in
aflopende volgorde is. Dit is niet beschikbaar als het inhoudstype Motion Seq, Song,
Song&Perf, Pattern, Pattern&Perf, Performance of Smart Morph is.
Date: sorteert op de datum waarop de instelling is opgeslagen. De pijl-omlaag geeft aan
dat de lijst in aflopende volgorde is gesorteerd (nieuw tot oud). De pijl-omhoog geeft aan
dat de lijst in oplopende volgorde is gesorteerd. Dit is alleen beschikbaar als het
inhoudstype Motion Seq, Song, Song&Perf, Pattern, Pattern&Perf, Performance of Smart
Morph is.

Parent Folder Name
Current Folder Name

Job

Free Storage

Folder and file select

Sort
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Default: sorteert op volgorde van inhoudsnummer. Dit is alleen beschikbaar als het
inhoudstype Song, Song&Perf, Pattern, Pattern&Perf, Performance, Motion Seq of Smart
Morph is.

Selecteert de laadmodus.
Dit wordt alleen weergegeven voor een gebruikersbestand of een bibliotheekbestand.
Instellingen: Default, 1 Perf

Default: laadt alle performances.
1 Perf: laadt alleen een opgegeven performance.

Selecteer de toets waaraan het geladen WAV-bestand of AIFF-bestand moet worden toegewezen.
Dit wordt alleen weergegeven voor audiobestanden.
Instellingen: Keyboard Select (C−2–G8), All

Stelt in of Center Key wordt bijgewerkt door bediening van het toetsenbord.
Dit wordt alleen weergegeven voor audiobestanden.

Wanneer de bestanden die verschijnen in File select niet op één pagina passen, verschijnt er een
scrollknop waarmee u een pagina kunt selecteren.

Op het scherm Save kunt u bestanden en data opslaan.

Gebruik

[UTILITY] → Contents → Save

Dit is in principe hetzelfde als het scherm Load.

Mode

Key (Center Key)

Keyboard Select

Page

Save
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Alle data of een specifieke set data worden opgeslagen op een USB-flashstation of op het instrument
opgeslagen.
Hier kunt u instellen welke data u wilt opslaan of opslaan.
De beschikbare instellingen variëren afhankelijk van de route die u neemt om het scherm te openen.
Instellingen: de volgende tabel toont de inhoudstypen die kunnen worden opgeslagen of

opgeslagen.

Content Type Apparaattype Bestandsextensie Omschrijving

Performance Interne data
Slaat de performance op in het
gebruikersgebied van het
gebruikersgeheugen.

User File File
.Y2U
(.Y2W)

Instellingen die in het gebruikersgedeelte van
het gebruikersgeheugen zijn opgeslagen,
worden als gebruikersbestand op een USB-
flashstation opgeslagen.

De volgende instellingen zijn opgenomen in
een gebruikersbestand.

Wanneer de bestandsgrootte groter is dan 2
GB en het bestand is gesplitst, moeten zowel
.Y2U als .Y2W als een set worden behandeld.

Content Type

Performance
Arpeggio
Motion Sequence
Curve
Live Set
Micro Tuning
Waveform
Audition
Utility-instellingen
Quick Setup
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Content Type Apparaattype Bestandsextensie Omschrijving

Library File File
.Y2L
(.Y2M)

Instellingen die in het bibliotheekgedeelte van
het gebruikersgeheugen zijn opgeslagen,
worden als bibliotheekbestand op een USB-
flashstation opgeslagen.

De instellingen in het bibliotheekbestand zijn
als volgt (hetzelfde als het gebruikersbestand,
behalve de Utility-instellingen).

Wanneer de bestandsgrootte groter is dan 2
GB en het bestand is gesplitst, moeten zowel
.Y2L als .Y2M als een set worden behandeld.

Backup File File
.Y2A
(.Y2B)

Instellingen die in het gebruikersgeheugen zijn
opgeslagen, worden als back-upbestand op
een USB-flashstation opgeslagen.

Een back-upbestand bevat alles in de
gebruikers- en bibliotheekgebieden, songs en
patronen.

Wanneer de bestandsgrootte groter is dan 2
GB en het bestand is gesplitst, moeten zowel
.Y2A als .Y2B als een set worden behandeld.

.mid File File .MID

MIDI-data die zijn opgeslagen in het song- en
patroongebied van het gebruikersgeheugen,
worden op een USB-flashstation opgeslagen
als een standaard MIDI-bestand (SMF; alleen
in formaat 1).

Motion Seq
(Motion Sequence) *

Interne data
Slaat de motionsequence op die wordt
bewerkt in het gebruikersgebied.

OPMERKING
Inhoudstypen gemarkeerd met een asterisk (*) worden niet weergegeven wanneer dit scherm wordt geopend vanuit
het scherm Utility.

In het scherm Data Utility kunt u bestanden en data in het gebruikersgeheugen beheren.

Gebruik

Performance
Arpeggio
Motion Sequence
Curve
Live Set (slechts één bank)
Micro Tuning
Waveform
Audition

Data Utility
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[UTILITY] → Contents → Data Utility

Dit is in principe hetzelfde als het scherm Load.

Geeft de inhoudstypen in het gebruikersgeheugen als mappen weer. Tik op de map die u wilt
openen.

Als u op de naam tikt, wordt het contextmenu voor Rename en Delete geopend.

Wanneer Job is ingeschakeld, worden de volgende drie items weergegeven.

Selecteert alle inhoud in de map.
Wordt weergegeven als er niets is geselecteerd.

Maakt de selectie van alle inhoud in de map ongedaan.
Wordt weergegeven wanneer inhoud is geselecteerd.

Folder select

Arp

Audition

Curve

Library

Live Set

MicroTuning

Motion Seq

Pattern

Performance

Song

Waveform

Content Select

Select All

Unselect All
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Verwijdert alle geselecteerde inhoud.
Wordt weergegeven wanneer inhoud is geselecteerd.

In het scherm Library Import kunt u specifieke performances in de bibliotheek naar de
gebruikersbank kopiëren.

Gebruik

[UTILITY] → Contents → Library Import

Dit is in principe hetzelfde als het scherm Load.

Selecteert alle performances in de huidige bibliotheekmap.
Wordt alleen weergegeven als er geen performance is geselecteerd.

Maakt de selectie van alle performances in de huidige bibliotheekmap ongedaan.
Wordt alleen weergegeven als er een performance is geselecteerd.

Kopieert de geselecteerde performance naar de gebruikersbank.
Wanneer deze handeling wordt uitgevoerd, worden de gebruikersgolfvormen en
gebruikersarpeggio's, gebruikerscurves, gebruikersmicrostemmingen en gebruikersaudities die in de
geselecteerde performance worden gebruikt, ook naar de gebruikersbank gekopieerd.
Wordt alleen weergegeven als er een performance is geselecteerd.

In het scherm Tempo Settings kunt u de parameters instellen met betrekking tot tempo en
synchronisatie.

Delete

Library Import

Select All

Unselect All

Import to User Bank

Tempo Settings
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Gebruik

Stelt het tempo van de performance in.
Wanneer MIDI Sync is ingesteld op MIDI of A/D In en het instrument is ingesteld om te
synchroniseren met een extern apparaat, wordt Ex.Tempo weergegeven in plaats van de
instellingswaarde.
Instellingen: 5−300

Schakelt het knipperen van de Super Knob in of uit.
Instellingen: Off, On

Als deze parameter is uitgeschakeld, wordt voor elke performance een tempo-instelling gebruikt.
Als deze parameter is ingeschakeld, wordt het huidige tempo behouden als u de performance wijzigt.
Instellingen: Off, On

U kunt het gewenste tempo instellen door op het gebied op het scherm te tikken of door op de knop
[ENTER] op het bovenpaneel te drukken (tikken) terwijl de cursor op deze parameter staat.
Of u kunt de knop [TEMPO/TAP] gebruiken om het tempo op dezelfde manier in te stellen.
Deze parameter is niet beschikbaar als MIDI Sync is ingesteld op MIDI en het instrument is ingesteld
voor synchronisatie met een extern apparaat.

OPMERKING
Wanneer MIDI Sync is ingesteld op A/D In, begint het zoeken naar het tempo bij de eerste tikactie.

[TEMPO/TAP]

[UTILITY] → Tempo Settings

 (Tempo-instellingen-pictogram)

Tempo

Knob Flash (Super Knob LED Blink)

Global Tempo

Tap Tempo

MIDI Sync
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Stelt de parameters in die gerelateerd zijn aan de synchronisatie met het aangesloten externe
apparaat.
Selecteer Internal voor gebruik van de interne klok van dit instrument, MIDI voor gebruik van de
externe DAW-klok van de MIDI-software op de computer of het externe MIDI-apparaat of A/D In
(ABS) voor gebruik van de audiosignaalingang van de A/D INPUT-aansluitingen voor het afspelen
van de arpeggio's, motionsequencer en songs.
Instellingen: Internal, MIDI, A/D In (ABS)

Internal: synchroniseert met de interne klok. Voor gebruik van dit instrument op zichzelf of
als primaire klokbron voor andere apparaten.
MIDI: synchroniseert met de MIDI-klok die wordt ontvangen van het externe MIDI-
apparaat. Voor gebruik van het externe apparaat als de primaire klokbron.
A/D In: synchroniseert met het tempo van het audiosignaal dat binnenkomt via de A/D
INPUT-aansluitingen.

Stelt de MIDI-klokberichten in die moeten worden verzonden.
Instellingen: Off, On

Stelt in wanneer het klikgeluid (metronoom) moet worden afgespeeld.
Instellingen: Off, Rec, Rec/Play, Always

Off: er wordt geen klikgeluid afgespeeld.
Rec: het klikgeluid wordt gespeeld tijdens de opname van een song of patroon.
Rec/Play: het klikgeluid wordt gespeeld tijdens de opname en het afspelen van een song
of patroon.
Always: het klikgeluid wordt altijd afgespeeld.

Stelt het aantal aftelmaten in vanaf het moment dat de knop [ ] (Play) wordt ingedrukt totdat de
opname daadwerkelijk begint bij het opnemen van een song of patroon.
Instellingen: Off (de opname start wanneer u op de knop [ ] (Play) drukt), 1meas–8meas

OPMERKING
Aangezien het klikgeluid de interne toongenerator gebruikt, is het gebruik van het klikgeluid van invloed op de
algehele polyfonie van het instrument.

Stelt het volume van het klikgeluid in.
Instellingen: 0−127

Stelt de tel in waarop het klikgeluid wordt gespeeld.
Instellingen: 1/16 (zestiende noten), 1/8 (achtste noten), 1/4 (kwartnoten), 1/2 (halve noten), Whole

(hele noten)

Selecteert het type klikgeluid.

Clock Out (MIDI Clock Out)

Mode (Click Mode)

Precount (Click Precount)

Volume (Click Volume)

Beat (Click Beat)

Type (Click Type)
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Instellingen: 1−10

Past de timing aan voor het starten van het volgende arpeggio bij het afspelen van een arpeggio voor
meerdere partijen. Als deze is ingesteld op Off, wordt het arpeggio gespeeld wanneer u de partij op
het toetsenbord speelt.
Instellingen: Off, 60 (tweeëndertigste noot), 80 (zestiende noottriool), 120 (zestiende noot), 160

(achtste noot triool), 240 (achtste noot), 320 (kwartnoottriool), 480 (kwartnoot)

Stelt de uitvoerbestemming voor het klikgeluid in.
Instellingen: MainL&R, AsgnL&R, USB1&2–USB29&30, AsgnL, AsgnR, USB1–USB30

MainL&R: uitgang in stereo (twee kanalen) naar de OUTPUT [L/MONO]- en [R]-
aansluitingen.
AsgnL&R: uitgang in stereo (twee kanalen) naar de ASSIGNABLE OUTPUT [L]- en [R]-
aansluitingen.
USB1&2–USB29&30: uitgang in stereo (kanalen 1 en 2, naar kanalen 29 en 30) naar de
[USB TO HOST]-aansluiting.
AsgnL: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [L]-aansluiting.
AsgnR: uitgang in mono (één kanaal) naar de ASSIGNABLE OUTPUT [R]-aansluiting.
USB1–30: uitgang in mono (kanaal 1–30) naar de [USB TO HOST]-aansluiting.

In het scherm Effect Switch kunt u de parameters instellen die gerelateerd zijn aan effectbypass.
De instellingen op dit scherm worden niet opgeslagen, dus de instellingen worden teruggezet naar de
standaardinstellingen wanneer het instrument opnieuw wordt opgestart.

Gebruik

Sync Quantize (Arpeggio Synchro Quantize Value)

Click Out (Click Output Select)

Effect Switch

[UTILITY] → Effect Switch

Tik op het pictogram  (Effect)

[SHIFT] + [QUICK SETUP]
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Schakelt het invoegeffect in of uit.
Instellingen: Off, On

Schakelt het systeemeffect in of uit.
Instellingen: Off, On

Schakelt het Master-effect in of uit.
Instellingen: Off, On

Zet de Master EQ aan of uit.
Instellingen: Off, On

Schakelt de arpeggiobypass in of uit.
Als deze parameter is ingeschakeld, worden alle arpeggiatorbedieningen uitgeschakeld.
Instellingen: Off, On

OPMERKING

Schakelt de vergrendeling in voor de toetsenbordbesturing in of uit.
Als dit is ingeschakeld, is de toetsenbordbesturing voor alle partijen vergrendeld.
Als u dit uitschakelt, wordt de toetsenbordbesturing ontgrendeld.

Dit is handig als u elke MIDI-track afzonderlijk wilt maken of bewerken, bijvoorbeeld als u het
instrument gebruikt als een 16-delige multitimbrale geluidsmodule met de DAW-software.

OPMERKING
Als de toetsenbordbesturing voor elke partij wordt gewijzigd terwijl Keyboard Control Lock is ingeschakeld, wordt de
toetsenbordbesturing ontgrendeld.

Instellingen: Off, On

Als deze parameter is ingeschakeld, blijft het volume van de A/D-partij hetzelfde als u de
performance wijzigt, en blijven andere parameters die gerelateerd zijn aan de A/D-part ook hetzelfde.
Als deze parameter is uitgeschakeld, wordt het volume dat is ingesteld voor de performance gebruikt

Insertion FX (Insertion Effect)

System FX (System Effect)

Master FX (Master Effect)

Master EQ

Arp Bypass (Arpeggio Bypass)

Wanneer arpeggiobypass is ingeschakeld knippert de knop [ARP ON/OFF].
Als arpeggiobypass is ingeschakeld, wordt arpeggiobypass uitgeschakeld als u de arpeggioschakelaar voor
een willekeurige partij wijzigt.
Bij de songs die zijn opgenomen met de arpeggiofunctie is de arpeggiosequence in de data opgenomen.
Wanneer u dergelijke songs in de DAW-software bewerkt, kunt u arpeggiobypass instellen op On om te
voorkomen dat het afspelen van het arpeggio tweemaal wordt beïnvloed.

Kbd Ctrl Lock (Keyboard Control Lock)

Global A/D
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als u van performance verandert, en zullen andere parameters die gerelateerd zijn aan de A/D-partij
dienovereenkomstig veranderen.
Master FX en Master EQ worden gelijktijdig in- en uitgeschakeld.
Instellingen: Off, On

In het scherm Other Info kunt u andere informatie vinden.

Toont de lijst met snelkoppelingsbewerkingen voor het gelijktijdig indrukken van de [SHIFT]-knop en
andere knoppen.

Toont inhoud zoals auteursrechten.

Other Info

Shift Function

Legal Notices

442



om02screenparameters0330

Inhoudsopgave

Schermen die worden weergegeven door op specifieke knoppen te
drukken

Paneelvergrendeling

Split Job

NOTE RANGE

NAVIGATION

FX OVERVIEW

Store

DAW REMOTE

Control Assign

Control View
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om02screenparameters0340

Het gebruik van de paneelvergrendelingsfunctie voorkomt onbedoelde bediening tijdens live
optredens.

Gebruik

Druk wanneer het scherm Home of het scherm Live Set wordt weergegeven op [SHIFT] +
[TEMPO/TAP]

Wanneer de paneelvergrendelingsfunctie is ingeschakeld, is er geen enkele bediening beschikbaar
behalve het toetsenbord, de pedalen, het mastervolume, de Superknop, het pitchbendwiel, het
modulatiewiel, de lintregelaar en uiteraard de ontgrendelingsbediening. Deze vergrendeling geldt ook
voor bediening van het aanraakscherm.

Wanneer de paneelvergrendelingsfunctie is ingeschakeld, drukt u nogmaals op [SHIFT] +
[TEMPO/TAP] om de paneelvergrendelingsfunctie uit te schakelen.

Paneelvergrendeling
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om02screenparameters0350

Stelt de splitfunctie in (voor het verdelen van het gehele toetsenbord in secties, zodat u elke sectie
met een ander geluid kunt spelen).

Gebruik

[SPLIT]

Geeft het aantal splitpunten aan.
Instellingen: 1-3

Geeft de toonsoort voor het splitpunt aan.
Instellingen: C#−2–G8

Toont de partijnaam en de splitgroep. Als u op de partij tikt, wordt het menu voor Category Search en
Delete geopend.
Druk op een groepknop om de partij aan de groep toe te wijzen.
Tik op de groepknoppen terwijl u de [SHIFT]-knop ingedrukt houdt om een enkele partij aan
meerdere groepen toe te wijzen.

Wanneer u op [+] tikt, wordt het scherm Part Category Search of het scherm Performance Merge
geopend, zodat u een partij aan de performance kunt toevoegen.

Split Job

Split Points

Split Point 1-3

Part Name
Group A–D

[+] (Add)

X (Cancel)
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Annuleert groeptoewijzingen.

Bevestigt de instellingen en sluit het scherm.
Als u op de  (sluiten) linksboven tikt, wordt de instelling geannuleerd en wordt het scherm
gesloten.

Done
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Gebruik

[SHIFT]+[SPLIT]

De weergave Part—Note wordt weergegeven op het scherm Home.
De cursor wordt verplaatst naar TG Note Limit Low van de geselecteerde partij en u kunt het
toetsenbord van het instrument gebruiken om de waarde voor de Note Range in te voeren.

NOTE RANGE
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Dit is het scherm Navigation, dat handige en directe navigatie biedt bij het bewerken van de
verschillende parameters.

Gebruik

Als u op de pictogrammen tikt, worden de bijbehorende instellingenschermen opgeroepen.
Als u tijdens het bewerken op de knop [NAVIGATION] drukt, wordt het huidige locatiepictogram 
opgeroepen.
Vanuit het scherm NAVIGATION kunt u springen naar Filter en Amp EG van de elementen en van
Part Common.

NAVIGATION

[NAVIGATION]

(Met de View Mode op het Home-scherm ingesteld op Default) Tik op de knop Navigation die op de
display wordt weergegeven
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Op het scherm FX OVERVIEW kunt u de status van effectinstellingen controleren en eenvoudig
toegang krijgen tot schermen voor geavanceerde instellingen.

Gebruik

Wisselt de partijen die worden weergegeven.
Instellingen: 1–4, 5–8, 9–12, 13–16, A/D in

Schakelt alle invoegeffecten (A en B) in of uit.
Instellingen: Off, On

Schakelt de Variation- en Reverb-effecten in of uit.
Instellingen: Off, On

Toont het bijbehorende scherm voor gedetailleerde instellingen.

FX OVERVIEW

[SHIFT]+[NAVIGATION]

(Met de View Mode op het scherm Home ingesteld op Default) Tik op de knop Fx Overview die op
de display wordt weergegeven

Switching Parts for display

All Ins

Var + Rev

Ins A
Ins B
Var
Rev
MFX
MEQ
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Schakelt elk effect in of uit.
Instellingen: Off, On

Stelt het type en de voorinstelling in voor elk effect.
Instellingen: Effect Type: Zie de Effect types.

Preset: Raadpleeg de Data List.

Effect switch

Type

Preset
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Dit is het bevestigingsscherm bij het opslaan van de huidige performance in het gebruikersgebied.

Gebruik

[STORE]

Wordt als nieuwe performance geregistreerd.

Als er een sleuf in de gebruikerslivesetbank wordt geselecteerd, verschijnt er een bericht waarin de
update van de Live Set-sleuf wordt bevestigd. Om door te gaan met de update, vinkt u het vakje aan
en selecteert u Store As New Performance.

Slaat de performance die u bewerkt op over de bestaande instellingen (Bank, MSB, LSB en
programmawijzigingsnummer) die op de display worden weergegeven.

Wordt weergegeven wanneer opslaan niet mogelijk is vanwege een fout zoals 'Performance full'. Het
scherm
[UTILITY] → Contents → Data Utility wordt weergegeven.

Store

Opslaan als nieuwe performance

Update Current Live Set Slot

Overwrite Current Perf.

Jump to Data Utility
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Als u op de knop [DAW REMOTE] drukt, wordt de remote-functie van DAW ingeschakeld, zodat u uw
favoriete DAW gemakkelijk kunt bedienen met de regelaars op het instrument.

Gebruik

[DAW REMOTE]

Selecteer de remote-functie van DAW uit drie bedieningsmodi.
U kunt ook van modus wisselen door op [DAW Remote] + een van de selectieknoppen voor het
sleufnummer en de categorienaam te drukken (zoals [Piano], [Keyboard] en [Organ]).
Instellingen: Track, Plugin, Transport

Track: modus voor het tegelijk regelen van meerdere tracks op de DAW. Knop- en
schuifregelaarbewerkingen worden verzonden als met Mackie Control compatibele
protocollen vanaf poort 2.
Plugin: modus voor het regelen van een specifieke plug-in op de DAW. Knop- en
schuifregelaarbewerkingen worden verzonden als berichten in regelaarwijzigingsnummers
voor remote-functies vanaf poort 1.
Transport: modus voor het bespelen van het toetsenbord terwijl de opgenomen data op de
DAW worden afgespeeld of uw toetsenspel op de DAW wordt opgenomen. U kunt de
sequencertransportknoppen gebruiken om het afspelen op de DAW te starten of te
stoppen. Alle regelaars behalve de sequencertransportknoppen werken zoals ze normaal
doen.

Opent het instellingenscherm voor elke regelaar en de remote-functie.
Instellingen: Knob/Slider, Scene Sw, Display Knob, AS/Ribbon, Pedal, Settings

DAW REMOTE

Mode (Remote Control Mode)

Schakelen tussen schermen
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Schakelt lokale besturing in of uit.
Dit is dezelfde instelling die kan worden ingesteld via: [UTILITY] → Settings → het scherm MIDI I/O.

Stelt de datadraaiknop en cursorknoppen op het bovenpaneel in voor het besturen van de DAW.

Voert de trackgroepselectie uit (met acht tracks tegelijk).

Regelaars Op de DAW

1 Knoppen 1-8 Regelt de pan van de track.

2 Schuifregelaars 1-8 Regelt het volume van de track.

3
PART-knoppen, [PART SELECT]-knop,
[KEYBOARD CONTROL]-knop

Selecteert een of meer tracks en schakelt dempen en solo
van de geselecteerde track(s) in of uit.

Local (Local Control)

Use for Remote

Aan: voor het regelen van de DAW.

Uit: voor het regelen van het hoofddisplay op het bovenpaneel.

Track (Track Select)

Voor het gebruik van regelaars

Track-modus

Regelaars
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Regelaars Op de DAW

4 SCENE-knoppen Functie

5 Datadraaiknop, cursorknoppen Verplaatst de cursorpositie of songpositie.

6 sequencertransportknoppen Regelt de transportacties (opnemen en afspelen).

7 BANK-knoppen Selecteert een trackgroep (acht tracks tegelijk).

8 PAGE-knoppen Selecteert een trackgroep (één track tegelijk).

9 [SONG/PATTERN]-knop Zet afspelen in een lus aan of uit.

Andere regelaars zijn zo ingesteld dat ze de regelaarwijzigingsberichten verzenden die in de
afstandsmodus zijn ingesteld.

Regelaars DAW-bediening

Knoppen 1-8 Elke regelaarwijziging die u hebt geselecteerd.
(Het regelaarwijzigingsnummer dat is ingesteld met Edit in het scherm DAW Remote wordt
uitgevoerd.)

Schuifregelaars 1-
8

* PART-knoppen, [PART SELECT]-knop, [KEYBOARD CONTROL]-knop, datadraaiknop,
cursorknoppen, sequencertransportknoppen, BANK-knoppen en PAGE-knoppen gedragen zich op
dezelfde manier als in de Track-modus.

Plugin-modus

Regelaars

454



Regelaars Op de DAW

Datadraaiknop, cursorknoppen Verplaatst de cursorpositie of songpositie.

Sequencer Transport-knop Regelt de transportacties (opnemen en afspelen).

[SONG/PATTERN]-knop Zet afspelen in een lus aan of uit.

* Andere regelaars werken zoals normaal.

Stelt het regelaarwijzigingsbericht in, zoals het regelaarnummer en de kanaalmodus, dat wordt
uitgevoerd via poort 1.
De instellingen op elk tabblad zijn als volgt:

Schakelt lokale besturing in of uit.
Dit is dezelfde instelling die kan worden ingesteld via: [UTILITY] → Settings → het scherm MIDI I/O.

Stelt de datadraaiknop en cursorknoppen op het bovenpaneel in voor het besturen van de DAW.

Transport-modus

Regelaars

Voor bewerking

Edit

Common

Local (Local Control)

Use for Remote
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Stelt het regelaarnummer in voor de knoppen en schuifregelaars.
Instellingen: 1-95

Stelt het regelaarnummer voor de SCENE-knoppen in.
Instellingen: 1-95

Verandert de bedieningsmodus van de SCENE-knoppen.
Instellingen: Momentary, Latch

Stelt het regelaarnummer voor de Display-knoppen in.
Instellingen: 1-95

Stelt het regelaarnummer voor de [PORTAMENTO]-knop in.
Instellingen: 1-95

Verandert de bedieningsmodus van de [PORTAMENTO]-knop.
Instellingen: Momentary, Latch

Stelt het regelaarnummer voor de PORTAMENTO [TIME]-knop in.
Instellingen: 1-95

Stelt het regelaarnummer voor de lintregelaar in.
Instellingen: 1-95

Verandert de bedieningsmodus van de lintregelaar.
Instellingen: Hold, Reset

Aan: voor het regelen van de DAW..

Uit: voor het regelen van het hoofddisplay op het bovenpaneel.

Knob/Slider

CC Num. (Control Change Number)

Scene SW

Scene1-8 (Scene 1-8 Control Number)

Latch (Scene 1 Switch Mode)
Momentary (Scene 1 Switch Mode)

Display Knob

Display Knob 1–8CC# (Display Knob 1-6 Control Number)

AS / Ribbon

Portamento Switch

Portamento Switch Latch

Porta Knob (Portamento Knob)

Ribbon Ctrl (Ribbon Controller Control Number)

RB Mode
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Stelt het regelaarnummer in voor de [ASSIGN 1]-knop, [ASSIGN 2]-knop en [MSEQ TRIGGER]-
knop.
Instellingen: 1-95

Verandert de bedieningsmodus van de [ASSIGN 1]-knop, [ASSIGN 2]-knop en [MSEQ TRIGGER]-
knop.
Instellingen: Momentary, Latch

Stelt het regelaarnummer in voor voetregelaar 1 en voetregelaar 2.
Instellingen: 1-95

Toont het regelaarnummer voor de voetregelaar.
Instellingen: 1-95

Verandert de bedieningsmodus van de voetregelaar.
Instellingen: Momentary, Latch

Selecteert de specifieke DAW voor gebruik met dit instrument.
Instellingen: Cubase, Logic Pro, Pro Tools, Live

Stelt het MIDI-kanaal in voor invoer en uitvoer van de Common en de partij waarbij de Keyboard
Control Switch is ingesteld op On.
Het hier ingestelde MIDI-kanaal wordt ook gebruikt voor het verzenden van het
regelaarwijzigingsbericht via DAW op afstand.
Dit is dezelfde instelling die kan worden ingesteld via: [UTILITY] → Settings → het scherm MIDI I/O.
Instellingen: Ch1-Ch16

Assign SW 1 (Assignable Switch 1 Control Number)
Assign SW 2 (Assignable Switch 2 Control Number)
MS Trigger (Motion Seq Trigger Switch Control Number)

Assign SW 1 Latch (Assignable Switch 1 Mode)
Assign SW 2 Latch (Assignable Switch 2 Mode)
MS Trigger Latch (Motion Seq Trigger Switch Control Number)

Pedal

Foot Ctrl 1 (Foot Controller 1 Control Number)
Foot Ctrl 2 (Foot Controller 2 Control Number)

FS (Foot Switch Control Number)

FS Mode (Foot Switch Mode)

Settings

DAW

MIDI I/O Ch.
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Registreert de combinatie van Source en Destination in de Controller Set.

Gebruik

(Als de cursor op de parameter staat) Druk op de knop [CONTROL ASSIGN].

Beweeg de regelaar die u wilt gebruiken om de parameter te wijzigen, of selecteer er een in de
Motion Sequencer Lane of Envelope Follower.

OPMERKING
Als u de Superknop verplaatst, maar er geen ongebruikte toewijsbare knoppen zijn om door te gaan met de
instelling, verschijnt er een foutmelding.

Als een Part-parameter is geselecteerd, kunt u de Assignable knobs instellen om de Common-
parameters te wijzigen door een Assignable Knob te bedienen terwijl u de [COMMON]-knop
ingedrukt houdt.

Control Assign

458



om02screenparameters0420

U kunt de instellingen controleren van de regelaar die wordt bediend.

Gebruik

Wanneer u de regelaar verplaatst die u wilt controleren, wordt het scherm Control Assign geopend en
wordt de configuratie-informatie weergegeven.

Control View

[SHIFT] + [CONTROL ASSIGN]

(Met de View Mode op het scherm Home ingesteld op Default) Tik op de knop Control View die op
de display wordt weergegeven
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Inhoudsopgave

Overige informatie

Effecttypen

Effectparameters

Snelkoppelingen

Berichtenlijst

Problemen oplossen

De oorspronkelijke fabrieksinstellingen terugzetten (Initialize All Data)
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No Effect Schakelt de effecten uit. Het geluid wordt niet uitgevoerd.

Thru
Stelt het effect in op Thru. Het ingangsgeluid wordt uitgevoerd zonder dat er
effecten worden toegepast.

HD Hall Simuleert de natuurlijke akoestiek van een concertzaal.

REV-X Hall Zaal-reverb die gebruikmaakt van het REV-X-reverb-algoritme.

R3 Hall
Zaal-reverb die gebruikmaakt van het reverb-algoritme van de ProR3 Digitale
Reverb-processor.

SPX Hall Zaal-reverb van de klassieke SPX1000.

HD Room Simuleert de natuurlijke akoestiek van een kamer.

REV-X Room Kamer-reverb die gebruikmaakt van het REV-X-reverb-algoritme.

R3 Room
Kamer-reverb die gebruikmaakt van het reverb-algoritme van de ProR3
Digitale Reverb-processor.

SPX Room Kamer-reverb van de klassieke SPX1000.

HD Plate Simuleert een plaat-reverb.

R3 Plate
Plaat-reverb die gebruikmaakt van het reverb-algoritme van de ProR3
Digitale Reverb-processor.

SPX Stage Podium-reverb van de klassieke SPX1000.

Space Simulator Hiermee kunt u de breedte, hoogte en diepte van de kamergrootte opgeven.

Gated Reverb Produceert een gated reverb.

Reverse Reverb Produceert het omgekeerd afspelen van een gated reverb.

Shimmer Reverb
Creëert mystieke zwevende effecten door in toonhoogte veranderde reverb-
geluiden toe te voegen.

Cross Delay
De feedback van het vertraagde geluid op elk van de twee kanalen wordt
naar het tegenoverliggende kanaal geleid. Produceert afwisselend
vertraagde geluiden rechts en links.

Tempo Cross Delay Gekruiste vertraging met temposynchronisatie.

Tempo Delay Mono Monovertraging met temposynchronisatie.

Tempo Delay Stereo Stereovertraging met temposynchronisatie.

Control Delay
Vertraging voor het creëren van scratch-geluiden door de delay-lengte in real
time te wijzigen.

Effecttypen

Reverb

Delay
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Delay LR
Produceert twee vertraagde geluiden links en rechts, met twee
feedbackvertragingen.

Delay LCR Produceert drie vertraagde geluiden links, midden en rechts.

Analog Delay Retro
Simuleert een analoge vertraging van de bucket-brigade, ingesteld op korte
vertraging.

Analog Delay Modern
Simuleert een analoge vertraging van de bucket-brigade, ingesteld op lange
vertraging.

G Chorus Creëert een diep geluid met complexe modulatie.

2 Modulator
Hiermee kunt u de toonhoogtemodulatie en amplitudemodulatie instellen.
Verspreidt het geluid op natuurlijke wijze.

SPX Chorus
Choruseffect dat een driefasige LFO gebruikt om modulatie en ruimtelijkheid
aan het geluid toe te voegen.

Symphonic Multiplext de modulaties om meer ruimtelijkheid te creëren.

Ensemble Detune
Choruseffect zonder modulatie, geproduceerd door het toevoegen van een
geluid met kleine toonhoogteverschuiving.

VCM Flanger Flanger met VCM-technologie.

Classic Flanger Flanger met typische wervelende geluiden.

Tempo Flanger Flanger met tempogesynchroniseerde LFO.

Dynamic Flanger
Flanger die de vertragingsmodulatie in real time regelt, afhankelijk van het
niveau van het ingangsgeluid.

Control Flanger Maakt handmatige bediening mogelijk in plaats van de LFO.

VCM Phaser Mono Mono Phaser met VCM-technologie.

VCM Phaser Stereo Stereo Phaser met VCM-technologie.

Tempo Phaser Phaser met tempogesynchroniseerde LFO.

Dynamic Phaser
Effect dat de fase in real time regelt, afhankelijk van het niveau van het
ingangsgeluid.

Control Phaser Maakt handmatige bediening mogelijk in plaats van de LFO.

Auto Pan Verplaatst de pan naar links en rechts.

Tremolo Creëert cyclische veranderingen in het volume.

Rotary Speaker 1 Simuleert een roterende luidspreker.

Rotary Speaker 2 Simuleert een roterende luidspreker inclusief versterker.

Chorus

Flanger

Phaser

Trem/Rtr (Tremolo & Rotary)
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VCM Rotary Speaker Classic
Standaard roterend luidsprekereffect met VCM-technologie. Geschikt voor
orgels.

VCM Rotary Speaker Overdrive
Roterend luidsprekereffect met VCM-technologie. Simuleert het vervormde
geluid van een roterende luidspreker waarop een transistorvoorversterker is
aangesloten.

VCM Rotary Speaker Studio
Roterend luidsprekereffect met VCM-technologie, met driedimensionale
rotatie.

Amp Simulator 1 Simuleert een gitaarversterker.

Amp Simulator 2 Simuleert een gitaarversterker.

Comp Distortion Een combinatie van compressor en vervorming.

Comp Distortion Delay Een combinatie van compressor, vervorming en vertraging.

U.S. Combo Amerikaanse combo-versterkersimulator.

Jazz Combo Jazzcombo-versterkersimulator.

U.S. High Gain Amerikaanse versterkersimulator met hoge versterking.

British Lead Simulator van Britse stapelversterker.

Multi FX Multi-effectprocessor voor gitaren.

Small Stereo Stereovervorming voor gitaargeluiden.

British Combo Simulator van Britse comboversterker.

British Legend Simulator van Britse stapelversterker.

VCM Compressor 376 Compressor met VCM-technologie.

Classic Compressor
Eenvoudige, gebruiksvriendelijke compressor. Geschikt voor solo-
instrumenten.

Multi-band Comp
Splitst het geluid in drie banden en past afzonderlijk een compressor toe op
die banden.

Uni Comp Down Compressor met een neerwaarts algoritme dat harde geluiden onderdrukt.

Uni Comp Up Compressor met een opwaarts algoritme dat zachte geluiden versterkt.

Parallel Comp
Compressor die parallelle verwerking van de gecomprimeerde geluiden en
droge geluiden toepast

VCM Auto Wah
Auto Wah met VCM-technologie. Creëert cyclische veranderingen in de
middenfrequentie van het filter.

VCM Touch Wah
Touch Wah met VCM-technologie. Verandert de middenfrequentie van het
filter, afhankelijk van het niveau van het ingangsgeluid.

Dist (Distortion)

Comp (Compressor)

Wah
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VCM Pedal Wah
Pedal Wah met VCM-technologie. Verandert de middenfrequentie van het
filter door regelaars, zoals een pedaal, te bedienen.

Lo-Fi Vermindert de geluidskwaliteit van de audio-ingang voor een lo-fi geluid.

Noisy Voegt ruis toe aan het geluid.

Digital Turntable Voegt draaitafelruis toe aan het geluid.

Bit Crusher
Produceert vervorming door de resolutie of bandbreedte van het digitale
geluid te verminderen.

Ring Modulator Verandert de invoer in een metaalachtig geluid.

Dynamic Ring Modulator
De OSC Freq-parameter voor de Ring Modulator wordt in real time geregeld,
afhankelijk van het niveau van het ingangsgeluid.

Dynamic Filter
De filterafsnijfrequentie wordt in real time geregeld, afhankelijk van het
niveau van het ingangsgeluid.

Auto Synth Hersynthetiseert het ingangssignaal met behulp van vertraging en modulatie.

Spiralizer P
Speciaal op phaser gebaseerd filter met schijnbaar eindeloze
toonhoogteveranderingen omhoog of omlaag.

Tempo Spiralizer P Spiralizer met tempogesynchroniseerde LFO.

Spiralizer F
Speciaal op flanger gebaseerd filter met schijnbaar eindeloze
toonhoogteveranderingen omhoog of omlaag.

Tempo Spiralizer F Spiralizer met tempogesynchroniseerde LFO.

Isolator Regelt het volume van elke band met behulp van een krachtig filter.

Slice Segmenteert de amplitude-EG van het ingangsgeluid.

Tech Modulation Past speciale modulatie toe.

Control Filter Een filter dat handmatige bediening van de afsnijfrequentie mogelijk maakt.

Vinyl Break
Zorgt ervoor dat de toonhoogte geleidelijk daalt, waardoor het geluidseffect
ontstaat van een draaitafel die met de hand wordt gestopt of het apparaat
wordt uitgeschakeld.

Beat Repeat (even)
Creëert mechanische beats door gesamplede geluiden herhaaldelijk af te
spelen. De lengte van de herhaling wordt gespecificeerd als een fractie van
een tel met als noemer een even getal, zoals 1/2, 1/4, 1/8, 1/16, enzovoort.

Beat Repeat (triplet)

Creëert mechanische beats door gesamplede geluiden herhaaldelijk af te
spelen. De lengte van de herhaling wordt gespecificeerd als een fractie van
een tel, waarbij de noemer een veelvoud van drie is, zoals 1/3, 1/6, 1/12,
enzovoort.

Beat Repeat (even+tri.)
Creëert mechanische beats door gesamplede geluiden herhaaldelijk af te
spelen. Bevat zowel even- als trioolinstellingen.

Lo-Fi

Tech
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Beat Repeat (free)
Creëert mechanische beats door gesamplede geluiden herhaaldelijk af te
spelen. De lengte van de herhaling wordt gespecificeerd als een decimaal
getal.

VCM EQ 501 5-bands EQ met VCM-technologie.

Presence Geeft een grotere sonische aanwezigheid aan het ingangsgeluid.

Harmonic Enhancer Voegt harmonische boventonen toe om het ingangsgeluid te laten opvallen.

Stereophonic Optimizer Past de stereolocatie in het geluidsveld aan.

Talking Modulator Hersynthetiseert het ingangsgeluid om klinkerformanten te creëren.

Wave Folder
Regelt de harmonische boventonen om een rijk geluid te creëren dat in de
loop van de tijd verandert.

VCM Mini Filter
Filter dat dikte en diepte aan het geluid toevoegt. Simuleert analoge
synthesizercircuits.

VCM Mini Booster
Booster met onderscheidende eigenschappen. Simuleert analoge
synthesizercircuits.

Damper Resonance Simuleert de resonantie van open-snaarnoten van een akoestische piano.

Pitch Change Verandert de toonhoogte van het ingangsgeluid.

Early Reflection
Een effect dat wordt gecreëerd door de eerste weerkaatsingen van de reverb
te isoleren.

Vocoder

Ontleent eigenschappen aan het microfoongeluid en past deze toe op de
partij die via het toetsenbord wordt bespeeld. Creëert een karakteristiek
'robotvoice'-effect als u het toetsenbord bespeelt en tegelijkertijd in de
microfoon zingt of spreekt.

NoiseGate+Comp+Eq Bevat Noisegate, compressor en 3-band EQ. Vooral geschikt voor zang.

Misc
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A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam Naam van
parameter

Effecttypen die de parameter gebruiken Omschrijving

AEG Phase AEG Phase Slice
Verschuift de fase
van de amplitude
EG.

AM Depth AM Depth
2 Modulator, Tremolo, Noisy, Auto Synth,
Shimmer Reverb

Stelt de diepte van
de
amplitudemodulatie
in.

AM Freq AM Frequency Shimmer Reverb

Stelt de snelheid van
de
amplitudemodulatie
in.

AM Inverse R AM Inverse R Auto Synth

Stelt de fase van de
amplitudemodulatie
voor het
rechterkanaal in.

AM LR Phase AM LR Phase Shimmer Reverb

Stelt de fase van de
amplitudemodulatie
tussen de L- en R-
kanalen in.

AM Speed AM Speed Noisy, Auto Synth

Stelt de snelheid van
de
amplitudemodulatie
in.

AM Wave AM Wave Auto Synth

Selecteert het
golftype voor het
moduleren van de
amplitude.

AM Waveform AM Waveforms Shimmer Reverb

Selecteert het
golftype voor het
moduleren van de
amplitude.

Amp Type Amp Type Amp Simulator 2
Selecteert het type
versterker dat u wilt
simuleren.

Analog Feel Analog Feel Classic Flanger

Voegt de kenmerken
van een analoge
flanger aan het
geluid toe.

Effectparameters
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Attack Attack
Comp Distortion, VCM Compressor 376,
Classic Compressor, Downward
Compressor, Upward Compressor

Stelt de tijdsduur in
die nodig is voordat
de compressor het
maximum bereikt.

Attack Offset Attack Offset VCM Touch Wah

Stelt de tijd in die
nodig is voordat het
wah-effect wordt
toegepast.

Attack Time Attack Time

Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Stelt de aanslagtijd
van de
envelopefollower in.

Beat Repeat

Stelt de Attack-tijd
van de Gate in die
wordt toegepast op
het gehele geluid.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Balance Balance U.S. Combo
Past de balans
tussen de bas en de
hoge tonen aan.

Bass Bass
British Combo, British Lead, British Legend,
Jazz Combo, U.S. High Gain

Past de toonkwaliteit
van de bas aan.

Bit Bit Bit Crusher
Vermindert de
bitprecisie.

Bit Assign Bit Assign Lo-Fi

Stelt in hoe Word
Length wordt
toegepast op het
geluid.

Bit Link Bit Link Bit Crusher

Stelt het niveau in
van de Side-
instelling die volgt op
de Mid-waarde
wanneer M/S is
ingesteld op On.

BPF 1–10 Gain BPF1–10 Gain Vocoder
Stelt de Gain van
BPF's 1−10 van het
Vocoder-effect in.

Break Break Vinyl Break Stelt Break in op On.

Brilliant Brilliant British Combo

Past het volume aan
van het geluid
waarvoor de bas
wordt weggelaten.
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Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Chorus Chorus Jazz Combo
Selecteert het
chorustype.

Click Density Click Density Digital Turntable
Stelt de frequentie in
van het klikgeluid dat
moet worden herhaald.

Click Level Click Level Digital Turntable Stelt het klikniveau in.

Clipper Clipper
Upward Compressor, Downward
Compressor

Stelt het
vervormingsniveau van
de clipper in dat het
maximale niveau
bepaalt voor het
beperken van de golf.

Clipper Source Clipper Source
Upward Compressor, Downward
Compressor

Selecteert het signaal
waarop het clipper-
effect wordt toegepast.

Color Color

Control Phaser, VCM Phaser Mono,
VCM Phaser Stereo

Stelt de vaste-
fasemodulatie in.

Shimmer Reverb
Stelt de kenmerken van
het resulterende geluid
in.

Com Release Common Release Multi Band Comp

Stelt de releasetijd in
(de tijd die nodig is
voordat het compressor-
effect wegsterft) die
gewoonlijk op drie
banden wordt gebruikt.

Comp Attack Comp Attack NoiseGate+Comp+Eq
Stelt de tijdsduur in
waarin de compressor
moet worden toegepast.

Comp Level Comp Level Small Stereo
Past het uitgangsniveau
van de compressor aan.

Comp Out Lvl Comp Output Level NoiseGate+Comp+Eq
Stelt het uitgangsniveau
van de compressor in.
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Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Comp Ratio Comp Ratio NoiseGate+Comp+Eq
Stelt de verhouding van
de compressor in.

Comp Release Comp Release NoiseGate+Comp+Eq

Stelt de tijd in die nodig
is voordat het
compressoreffect
wegsterft.

Comp Sustain Comp Sustain Multi FX, Small Stereo

Past de tijdsduur aan
waarin de compressor
moet worden
aangehouden.

Comp Sw Comp SW Small Stereo
Schakelt de compressor
in of uit.

Comp Threshold Comp Threshold NoiseGate+Comp+Eq
Stelt het ingangsniveau
in voor het toe te
passen effect.

Compress Compress Comp Distortion Delay

Stelt de drempelwaarde
(of het minimale
ingangsniveau) in
waarop de compressor
moet worden toegepast.

Compression Compression Parallel Compressor
Stelt de mate in waarin
de compressor wordt
toegepast.

Control Type Control Type Control Delay

Wanneer deze
parameter is ingesteld
op Normal, wordt het
vertragingseffect altijd
op het geluid toegepast.
Wanneer de parameter
is ingesteld op Scratch,
wordt het
vertragingseffect niet
toegepast als de
controllerwaarde 0 is
ingesteld op Delay
Time. De vertraging
wordt toegepast op
andere gevallen.
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Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Cross-Feedback Cross-Feedback Shimmer Reverb

Stelt de balans in van
het geluid met
toonhoogteverschuiving
op de eerste routering
en het geluid met
standaard toonhoogte
op de tweede routering
die naar de
tegenovergestelde
routering wordt gestuurd
voor de terugkoppeling
van het geluid met
toonhoogteverschuiving.

Crush Type Crush Type Bit Crusher
Stelt in hoe de
bitprecisie wordt
verminderd.

Cut Cut British Combo
Stelt de snelheidscurve
tegen het einde van de
noot in.

Cutoff

Cutoff Frequency

Beat Repeat
Verwijdert de hoge
frequenties.

VCM Mini Filter
Stelt de afsnijfrequentie
van het filter voor het
effectgeluid in.

Cutoff Frequency
Control

Control Filter
Stelt de
filterafsnijfrequentie in.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Damper Control Damper Control Damper Resonance
Stelt de hoeveelheid
resonantie voor de
pianodemper in.

Decay Decay REV-X Hall, REV-X Room
Bepaalt hoe het
reverbgeluid wegsterft.

Delay Control Delay Control Multi FX

Past de diepte of
hoeveelheid van het
effect aan dat is
ingesteld op Delay SW.

Delay Input Lvl Delay Input Level
Analog Delay Retro, Analog Delay
Modern

Stelt het ingangsniveau
in op de vertraging.

Delay Level Delay Level Auto Synth
Stelt het niveau van het
vertraagde geluid in.
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Naam van
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Effecttypen die de parameter
gebruiken Omschrijving

Delay Level C Delay Level C Delay LCR
Stelt het niveau van het
vertraagde geluid voor
het middenkanaal in.

Delay Mix Delay Mix Comp Distortion Delay
Stelt het mixniveau van
het vertraagde geluid
in.

Delay Offset Delay Offset
G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tempo
Flanger, Dynamic Flanger

Stelt de offsetwaarde
voor de
vertragingsmodulatie
in.

Delay Sw Delay SW Multi FX
Stelt het
vertragingstype of
modulatietype in.

Delay Time Delay Time

Tempo Delay Mono, Tempo Delay Stereo
Specificeert de
vertragingslengte in de
nootduur.

Control Delay, Auto Synth, Tech
Modulation, Multi FX, Analog Delay
Retro, Analog Delay Modern

Stelt de
vertragingslengte in.

Delay Time C Delay Time C Delay LCR
Stelt de
vertragingslengte voor
het middenkanaal in.

Delay Time L Delay Time L
Delay LR, Delay LCR, Comp Distortion
Delay

Stelt de
vertragingslengte voor
het linkerkanaal in.

Delay Time L>R Delay Time L>R Cross Delay, Tempo Cross Delay

Stelt de vertragingstijd
in voor het geluid dat
van links wordt
ingevoerd om van
rechts te worden
uitgevoerd.

Delay Time R Delay Time R
Delay LR, Delay LCR, Comp Distortion
Delay

Stelt de
vertragingslengte voor
het rechterkanaal in.

Delay Time R>L Delay Time R>L Cross Delay, Tempo Cross Delay

Stelt de vertragingstijd
voor het geluid dat van
links wordt ingevoerd in
om vanaf rechts te
worden uitgevoerd.

Delay Tm Ofs R Delay Time Offset R Auto Synth, Tech Modulation
Stelt de offset in op de
vertragingslengte voor
het rechterkanaal.
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Naam van
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Effecttypen die de parameter
gebruiken Omschrijving

Density Density

R3 Hall, R3 Room, R3 Plate, SPX Hall,
SPX Room, SPX Stage, Space Simulator

Stelt de dichtheid van
de reverb in.

Early Reflection, Gated Reverb, Reverse
Reverb

Stelt de dichtheid van
de reflecties in.

Depth Depth

Space Simulator
Stelt de diepte van de
gesimuleerde kamer in.

VCM Flanger

Stelt de amplitude in
van de LFO-golf die de
cyclische verandering
van de
vertragingsmodulatie
regelt.

VCM Phaser Mono, VCM Phaser Stereo

Stelt de
amplitudewaarde in van
de LFO-golf die de
cyclische verandering
van de fasemodulatie
regelt.

Jazz Combo
Stelt de diepte van het
chorus/de vibrato in.

Detune Detune Ensemble Detune
Stelt de mate in waarin
de toonhoogte wordt
ontstemd.

Device Device Amp Simulator 1, Comp Distortion Delay
Stelt het apparaat in
voor het creëren van
vervormingsgeluiden.

Diffusion Diffusion

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room,
SPX Stage, Space Simulator, Gated
Reverb, Reverse Reverb, Shimmer
Reverb

Stelt de verspreiding
van de reverb in.

Tempo Phaser, Early Reflection
Stelt de spreiding in
van het geselecteerde
effect.

Direction Direction

Dynamic Flanger, Dynamic Phaser, VCM
Touch Wah, VCN Pedal Wah, Dynamic
Ring Modulator, Dynamic Filter

Stelt de richting in van
de modulatie die wordt
geregeld door de
envelopefollower.

Tempo Spiralizer P, Tempo Spiralizer F
Stelt de richting van de
toonhoogteverschuiving
in.

Dist Drive Dist Drive Multi FX, Small Stereo
Regelt de hoeveelheid
vervorming.
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Naam van
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Effecttypen die de parameter
gebruiken Omschrijving

Dist EQ Dist EQ Multi FX, Small Stereo

Schakelt tussen EQ-
typen voor het
aanpassen van de
toonkwaliteit van de
vervorming.

Dist Presence Dist Presence Multi FX, Small Stereo
Past de toonkwaliteit
voor elk
vervormingstype aan.

Dist Sw Dist SW Multi FX
Stelt het
vervormingstype in.

Dist Tone Dist Tone Multi FX, Small Stereo
Past de toonkwaliteit
van de vervorming aan.

Dist Type Dist Type Small Stereo
Stelt het
vervormingstype in.

Distortion Distortion Jazz Combo
Stelt het
vervormingsniveau in.

Divide Freq Hi Divide Freq High Multi Band Comp

Stelt de Mid/High-
frequentie zo in dat
deze in drie banden
wordt verdeeld.

Divide Freq Low Divide Freq Low Multi Band Comp

Stelt de Low/Mid-
frequentie zo in dat
deze in drie banden
wordt verdeeld.

Divide Min Lvl Divide Min Level Slice

Stelt het
minimumniveau van de
gesegmenteerde sectie
in.

Divide Type Divide Type Slice
Specificeert de timing
voor het segmenteren
op nootduur.

Drive Drive

Noisy, Slice, Rotary Speaker 2, VCM
Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Stelt het
vervormingsniveau in.

Harmonic Enhancer, Talking Modulator
Stelt het niveau van het
effect in.

Drive Horn Drive Horn Rotary Speaker 1

Stelt de diepte van de
modulatie die wordt
gegenereerd door het
draaien van de hoorn
(hoge tonen).
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Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Drive Rotor Drive Rotor Rotary Speaker 1

Stelt de diepte van de
modulatie die wordt
gegenereerd door het
draaien van de rotor
(woofer).

Dry Level Dry Level Digital Turntable
Stelt het niveau van het
droge geluid in.

Dry LPF Cutoff
Dry LPF Cutoff
Frequency

Digital Turntable

Stelt in dat de
frequentie wordt
afgesneden met behulp
van het
laagdoorlaatfilter dat op
het droge geluid wordt
toegepast.

Dry Mix Level Dry Mix Level Auto Synth
Stelt het niveau van het
droge geluid in.

Dry/Wet Dry/Wet Balance All
Stelt de verhouding in
tussen het droge geluid
en het effectgeluid.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Edge Edge Comp Distortion

Hiermee stelt u de
curve in die bepaalt
hoe het geluid wordt
vervormd.

Emphasis Emphasis Lo-Fi

Stelt de verandering
van de kenmerken
bij hoge frequenties
in.

EQ 1 Freq
EQ1(LSH)
Frequency

VCM EQ 501

Stelt de
afsnijfrequentie in
van EQ1 (Low
Shelving).

EQ 1 Gain EQ1(LSH) Gain VCM EQ 501
Stelt de versterking
in van EQ1 (Low
Shelving).

EQ 2 Freq EQ2 Frequency VCM EQ 501
Stelt de
middenfrequentie
van EQ2 in.

EQ 2 Gain EQ2 Gain VCM EQ 501
Stelt de versterking
van EQ2 in.
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EQ 2 Q EQ2 Q VCM EQ 501
Stelt de Q van EQ2
in.

EQ 3 Freq EQ3 Frequency VCM EQ 501
Stelt de
middenfrequentie
van EQ3 in.

EQ 3 Gain EQ3 Gain VCM EQ 501
Stelt de versterking
van EQ3 in.

EQ 3 Q EQ3 Q VCM EQ 501
Stelt de Q van EQ3
in.

EQ 4 Freq EQ4 Frequency VCM EQ 501
Stelt de
middenfrequentie
van EQ4 in.

EQ 4 Gain EQ4 Gain VCM EQ 501
Stelt de versterking
van EQ4 in.

EQ 4 Q EQ4 Q VCM EQ 501
Stelt de Q van EQ4
in.

EQ 5 Freq
EQ5(HSH)
Frequency

VCM EQ 501

Stelt de
afsnijfrequentie in
van EQ5 (High
Shelving).

EQ 5 Gain EQ5(HSH) Gain VCM EQ 501
Stelt de versterking
in van EQ5 (High
Shelving).

EQ Frequency EQ Frequency

Noisy

Stelt de frequentie in
die moet worden
versterkt of verzwakt
met behulp van de
EQ.

VCM Mini Booster
Stelt de frequentie
van de EQ in op
Type.

EQ Gain EQ Gain Noisy

Stelt de versterking
in die moet worden
versterkt of verzwakt
met behulp van de
EQ.
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Naam van
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EQ High Freq EQ High Frequency

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo, Control
Delay, Delay LR, Delay LCR, G Chorus, 2
Modulator, SPX Chorus, Symphonic,
Ensemble Detune, Classic Flanger, Tempo
Flanger, Dynamic Flanger, Tempo Phaser,
Dynamic Phaser, Auto Pan, Tremolo, Rotary
Speaker 1, Ring Modulator, Dynamic Ring
Modulator, Dynamic Filter, Slice, HD Hall,
HD Room, HD Plate, NoiseGate+Comp+Eq

Stelt de frequentie in
van de hoge band
die moet worden
versterkt of verzwakt
met behulp van de
EQ.

EQ High Gain EQ High Gain

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo, Control
Delay, Delay LR, Delay LCR, G Chorus, 2
Modulator, SPX, Chorus, Symphonic,
Ensemble Detune, Classic Flanger, Tempo
Flanger, Dynamic Flanger, Tempo Phaser,
Dynamic Phaser, Auto Pan, Tremolo, Rotary
Speaker 1, Ring Modulator, Dynamic Ring
Modulator, Dynamic Filter, Slice, HD Hall,
HD Room, HD Plate, NoiseGate+Comp+Eq

Stelt de versterking
in van de hoge band
die moet worden
versterkt of verzwakt
met behulp van de
EQ.

EQ Low Freq EQ Low Frequency

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo, Control
Delay, Delay LR, Delay LCR, G Chorus, 2
Modulator, SPX Chorus, Symphonic,
Ensemble Detune, Classic Flanger, Tempo
Flanger, Dynamic Flanger, Tempo Phaser,
Dynamic Phaser, Auto Pan, Tremolo, Rotary
Speaker 1, Ring Modulator, Dynamic Ring
Modulator, Dynamic Filter, Slice, Comp
Distortion, HD Hall, HD Room, HD Plate

Stelt de frequentie in
van de lage band die
moet worden
versterkt of verzwakt
met behulp van de
EQ.

EQ Low Gain EQ Low Gain

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo, Control
Delay, Delay LR, Delay LCR, G Chorus, 2
Modulator, SPX Chorus, Symphonic,
Ensemble Detune, Classic Flanger, Tempo
Flanger, Dynamic Flanger, Tempo Phaser,
Dynamic Phaser, Auto Pan, Tremolo, Rotary
Speaker 1, Ring Modulator, Dynamic Ring
Modulator, Dynamic Filter, Slice, Comp
Distortion, HD Hall, HD Room, HD Plate

Stelt de versterking
in van de lage band
die moet worden
versterkt of verzwakt
met behulp van de
EQ.

EQ Mid Freq EQ Mid Frequency

G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tempo
Flanger, Auto Pan, Tremolo, Comp
Distortion, NoiseGate+Comp+EQ

Stelt de frequentie in
van de middelste
band die moet
worden versterkt of
verzwakt met behulp
van de EQ.
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parameter Effecttypen die de parameter gebruiken Omschrijving

EQ Mid Gain EQ Mid Gain

G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tempo
Flanger, Auto Pan, Tremolo, Comp
Distortion, NoiseGate+Comp+EQ

Stelt de versterking
in van de middelste
band die moet
worden versterkt of
verzwakt met behulp
van de EQ.

EQ Mid Width EQ Mid Width

G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tempo
Flanger, Auto Pan, Tremolo, Comp
Distortion, NoiseGate+Comp+EQ

Stelt de breedte in
van de middelste
band die moet
worden versterkt of
verzwakt met behulp
van de EQ.

EQ Width EQ Width Noisy

Stelt de breedte in
die moet worden
versterkt of verzwakt
met behulp van de
EQ.

ER/Rev Balance ER/Rev Balance
R3 Hall, R3 Room, R3 Plate, SPX Hall, SPX
Room, SPX Stage, Space Simulator

Stelt de
niveaubalans in van
het eerste
weerkaatsings- en
reverb-geluid.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

F/R Depth F/R Depth Auto Pan

Stelt de diepte van de
pan aan de voor- en
achterkant in
(beschikbaar wanneer
PAN Direction is
ingesteld op L Turn of R
Turn).

FB Hi Dmp Ofs R FB Hi Damp Offset R Tech Modulation

Stelt de offset in op de
mate van wegsterven in
de hoge band voor het
R-kanaal.

FB High Damp
Feedback High
Damp

R3 Hall, R3 Room, R3 Plate, SPX Hall,
SPX Room, SPX Stage, Space
Simulator, Cross Delay, Tempo Cross
Delay, Tempo Delay Mono, Tempo Delay
Stereo, Control Delay, Delay LR, Delay
LCR, Classic Flanger, Early Reflection,
Gated Reverb, Reverse Reverb, Comp
Distortion Delay, Tech Modulation

Past de verzwakking
van
hogefrequentiegeluid
aan met behulp van het
feedbackgeluid. Hoe
lager de waarde, hoe
sneller de verzwakking
van de
hogefrequentiegeluiden.
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FB Level Ofs R FB Level Offset R Auto Synth, Tech Modulation
Stelt de offset in op het
feedbackniveau voor
het R-kanaal.

FB Time L Feedback Time L Delay LR
Stelt de lengte van
feedback voor
vertraging links in.

FB Time R Feedback Time R Delay LR
Stelt de lengte van
feedback voor
vertraging rechts in.

Feedback Feedback

VCM Flanger, VCM Phaser Mono, VCM
Phaser Stereo, Control Flanger, Control
Phaser

Stelt het niveau in van
het signaal dat wordt
teruggestuurd naar het
effectblok.

Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Stelt het niveau in van
het signaal dat wordt
teruggestuurd naar het
effectblok.

Feedback Feedback Level

R3 Hall, R3 Room, R3 Plate, SPX Hall,
SPX Room, SPX Stage, Space
Simulator, Early Reflection, Gated
Reverb, Reverse Reverb

Stelt het
feedbackniveau in van
de aanvangsvertraging.

Cross Delay, Tempo Cross Delay, Tempo
Delay Mono, Tempo Delay Stereo,
Control Delay, Delay LR, Delay LCR, G
Chorus, 2 Modulator, SPX Chorus,
Classic Flanger, Tempo Flanger,
Dynamic Flanger, Comp Distortion Delay,
Auto Synth, Teck Modulation

Stelt het niveau in van
het vertragingsgeluid
dat terug naar de
ingang wordt
teruggestuurd. (Fase
wordt omgekeerd voor
negatieve waarden.)

Analog Delay Retro, Analog Delay
Modern

Stelt het
feedbackniveau van het
vertraagde geluid in.

Tempo Phaser, Dynamic Phaser

Stelt het niveau in van
het signaal dat wordt
uitgevoerd vanuit de
phaser en
teruggestuurd naar de
ingang. (Wordt
omgekeerd voor
negatieve waarden.)

Feedback Lvl 1 Feedback Level 1 Pitch Change

Stelt het
feedbackniveau in van
het vertraagde geluid
op de eerste routering.
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Feedback Lvl 2 Feedback Level 2 Pitch Change

Stelt het
feedbackniveau in van
het vertraagde geluid
op de tweede routering.

Feedback Time Feedback Time Delay LCR, Comp Distortion Delay
Stelt de
vertragingslengte van
de feedback in.

Filter Type Filter Type

Lo-Fi
Selecteert het
effecttype.

Dynamic Filter, Control Filter Stelt het filtertype in.

Beat Repeat
Stelt het filtertype voor
het effectgeluid in.

Fine 1 Fine 1 Pitch Change, Shimmer Reverb
Stemt de toonhoogte op
de eerste routering
nauwkeurig af.

Fine 2 Fine 2 Pitch Change, Shimmer Reverb
Stemt de toonhoogte op
de tweede routering
nauwkeurig af.

Flanger Control Flanger Control Control Flanger

Stelt de
vertragingswaarde (de
waarde van de Comb
Filter) van de
vertragingsmodulatie in.

Fold Fold Wave Folder Vervormt het geluid.

Fold Type Fold Type Wave Folder
Selecteert het
vervormingsniveau.

Formant Offset Formant Offset Vocoder

Voegt de offsetwaarde
toe aan de
afsnijfrequentie van de
BPF voor de ingang van
het instrumentgeluid.

Formant Shift Formant Shift Vocoder

Verschuift de
afsnijfrequentie van
elke BPF voor de
ingang van het
instrumentgeluid.

Freeze Freeze Beat Repeat
Als deze parameter is
ingesteld op On, wordt
de tel herhaald.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

479



Weergegeven naam
Naam van
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Gain Gain

U.S. High Gain
Stelt de versterking
van de
voorversterker in.

VCM Mini Booster
Past de Gain van de
ShelfEQ aan.

Gain Boost Gain Boost U.S. Combo
Schakelt de
versterking van de
vermogensversterker.

Gain Limit Gain Limit Upward Compressor
Stelt het maximale
Gain-niveau in.

Gate Time Gate Time

Slice
Stelt de gatetijd van
een slice in.

Beat Repeat
Stelt de gatetijd van
het gehele geluid in.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Height Height Space Simulator
Stelt de hoogte van de
gesimuleerde kamer
in.

Hi Damp Freq
High Damp
Frequency

HD Hall, HD Room, HD Plate
Past de verzwakking
van de hoge band
aan.

High Attack High Attack Multi Band Comp

Stelt de tijdsduur in
waarin de compressor
op de hoge band moet
worden toegepast.

High Cut High Cut U.S. Combo
Snijdt de hoge band
af.

High Gain High Gain Multi Band Comp

Hiermee wordt het
uitgangsniveau voor
de hoge band
ingesteld.

High Gain L
High Subband Gain
Lch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
High-band in na de
aanpassing van het
stereogeluid (L-
kanaal).
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High Gain R
High Subband Gain
Rch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
High-band in na de
aanpassing van het
stereogeluid (R-
kanaal).

High Level High Level Isolator
Stelt het niveau van
de hoge band in.

High Mute High Mute Isolator
Schakelt de demping
voor de hoge band
om.

High Ratio High Ratio

REV-X Hall, REV-X Room, HD Hall, HD
Room, HD Plate

Past de verhouding
van de hoge
frequenties aan.

Multi Band Comp

Stelt de
compressieverhouding
in voor de hoge
frequenties.

High Threshold High Threshold Multi Band Comp

Stelt het minimale
ingangsniveau in voor
het effect dat op de
hoge band moet
worden toegepast.

High Treble High Treble Jazz Combo

Past de toonkwaliteit
in de frequentie aan in
een waarde die hoger
is dan de Treble-
instelling.

Horn Accel Horn Acceleration
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Stelt in hoe de rotatie
van de hoorn (hoge
tonen) verandert van
Slow in Fast.

Horn Decel Horn Deceleration
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Stelt in hoe de rotatie
van de hoorn (hoge
tonen) verandert van
Fast in Slow.

Horn Fast Horn Speed Fast

Rotary Speaker 1, Rotary Speaker 2, VCM
Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Stelt de
rotatiesnelheid van de
hoorn (hoge tonen) in
voor de Fast-instelling.

Horn Level Horn Level
VCM Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Stelt het volume van
de hoorn (hoge tonen)
in.
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Horn Slow Horn Speed Slow

Rotary Speaker 1, Rotary Speaker 2, VCM
Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Stelt de
rotatiesnelheid van de
hoorn (hoge tonen) in
voor de Slow-
instelling.

Horn Slow/Fast Horn Slow/Fast Time Rotary Speaker 1

Stelt de
overgangsduur in voor
de rotatiesnelheid van
de hoorn (hoge tonen)
om te veranderen van
Slow in Fast.

HPF Cutoff
HPF Cutoff
Frequency

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room,
SPX Stage, Space Simulator, Ring
Modulator, Dynamic Ring Modulator, Auto
Synth, Harmonic Enhancer, Early
Reflection, Gated Reverb, Reverse Reverb

Stelt de lage
frequentie in die moet
worden afgekapt met
behulp van het
hoogdoorlaatfilter.

Vocoder

Stelt de
afsnijfrequentie in van
het hoogdoorlaatfilter
dat wordt toegepast
op de geluidsinvoer
van de microfoon.

HPF Output Lvl HPF Output Level Vocoder

Stelt de mate in
waarin de uitvoer van
het hoogdoorlaatfilter
wordt gemengd met
de uitvoer van de
vocoder.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Initial Delay Initial Delay

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room,
SPX Stage, Space Simulator, Early
Reflection, HD Hall, HD Room, HD Plate,
Gated Reverb, Reverse Reverb

Stelt de vertragingstijd
in voor de eerste
weerkaatsingen.

Initial Delay 1 Initial Delay 1 Pitch Change

Stelt de
vertragingslengte van
de eerste reeks
effecten in.

Initial Delay 2 Initial Delay 2 Pitch Change

Stelt de
vertragingslengte van
de tweede reeks
effecten in.
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Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Initial Delay L Initial Delay Lch Ensemble Detune
Stelt de lengte van de
linkerkanaalvertraging
in.

Initial Delay R Initial Delay Rch Ensemble Detune
Stelt de lengte van de
rechterkanaalvertraging
in.

Input Level Input Level

Bit Crusher, VCM Compressor 376,
Rotary Speaker 2, Parallel Compressor,
Wave Folder, VCM Mini Filter, VCM Mini
Booster

Stelt het ingangsniveau
in.

Input Mode Input Mode
G Chorus, 2 Modulator, SPX Chorus,
Auto Pan, Tremolo, Lo-Fi

Selecteert of het
ingangsgeluid mono of
stereo is.

Input Select Input Select Cross Delay, Tempo Cross Delay Selecteert een ingang.

Inst Level Inst Level Vocoder
Stelt het ingangsniveau
van het
instrumentgeluid in.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Knee Knee
Upward Compressor, Downward
Compressor

Stelt de curve rond
de Threshold in. Hoe
hoger de waarde,
hoe ondieper de
curve.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

L/R Depth L/R Depth Auto Pan
Stelt de diepte van de
linker- en rechterpan
in.

L/R Diffusion L/R Diffusion Tempo Delay Mono, Tempo Delay Stereo

Stelt het verschil in
tussen de vertraging
rechts en links om
ruimtelijkheid te
creëren.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Lag Lag
Tempo Cross Delay, Tempo Delay Mono,
Tempo Delay Stereo

Stelt een extra
vertragingslengte in
die wordt toegepast
op het vertraagde
geluid dat wordt
gespecificeerd door
een nootduur.

Length Length Beat Repeat
Stelt de lengte van
een herhaling in.

Level Offset Dyna Level Offset
Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Stelt de offsetwaarde
die wordt toegevoegd
aan de uitvoer van de
envelopefollower.

LFO Depth LFO Depth

SPX Chorus, Symphonic, Classic Flanger,
Tempo Flanger, Ring Modulator

Stelt de diepte van de
modulatie in.

Tempo Phaser
Stelt de diepte van de
fasemodulatie in.

Wave Folder
Past de diepte van het
LFO-effect aan.

LFO Shape LFO Shape Wave Folder
Past de vorm van de
LFO aan.

LFO Speed LFO Speed

G Chorus, 2 Modulator, SPX Chorus,
Symphonic, Classic Flanger, Tremolo,
Ring Modulator, Multi FX

Stelt de frequentie van
de modulatie in.

Tempo Flanger, Tempo Phaser

Specificeert de
modulatiesnelheid op
basis van de
nootduur.

Auto Pan
Stelt de frequentie van
de automatische pan
in.

Wave Folder
Past de LFO-snelheid
aan.

LFO Wave LFO Wave

Classic Flanger, Ring Modulator
Selecteert de golfvorm
voor modulatie.

Auto Pan
Hiermee stelt u de
pancurve in.

VCM Auto Wah
Selecteert de
golfvorm: sinus of
vierkant.

Liveness Liveness
Gated Reverb, Reverse Reverb, Early
Reflection

Stelt de verzwakking
van de eerste
weerkaatsingen in.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Ln Chg Quantz
Length Change
Quantize

Beat Repeat

Kwantiseert de timing
voor het veranderen
van de
lengteparameter.

Low Attack Low Attack Multi Band Comp

Stelt de tijdsduur in
waarin de compressor
op de lage band moet
worden toegepast.

Low Cut Low Cut U.S. Combo Snijdt de lage band af.

Low Gain Low Gain Multi Band Comp
Stelt het
uitgangsniveau van de
lage band in.

Low Gain L
Low Subband Gain
Lch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
Low-band in na de
aanpassing van het
stereogeluid (L-
kanaal).

Low Gain R
Low Subband Gain
Rch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
Low-band in na de
aanpassing van het
stereogeluid (R-
kanaal).

Low Level Low Level Isolator
Stelt het niveau van
de lage band in.

Low Mute Low Mute Isolator
Schakelt de demping
voor de lage band om.

Low Ratio Low Ratio

REV-X Hall, REV-X Room
Stelt de aanpassing
van de lage
frequenties in.

Multi Band Comp

Stelt de
compressieverhouding
in voor de lage
frequenties.

Low Threshold Low Threshold Multi Band Comp

Stelt het minimale
ingangsniveau in voor
het effect dat op de
lage band moet
worden toegepast.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Lower Range Lower Range

VCM Auto Wah, VCM Touch Wah, VCM
Pedal Wah

Stelt de maximale
waarde in voor het
variabele bereik van
het wah-filter.

Control Flanger

Stelt de maximale
waarde in voor het
variabele bereik van
het Flanger Control.

Control Phaser

Stelt de maximale
waarde in voor het
variabele bereik van
de Phase Control.

LPF Cutoff
LPF Cutoff
Frequency

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room,
SPX Stage, Space Simulator, Amp
Simulator 2, Comp Distortion, Noisy, Ring
Modulator, Dynamic Ring Modulator, Auto
Synth, Early Reflection, Gated Reverb,
Reverse Reverb, Auto Synth, Noisy

Stelt het
hogefrequentiebereik
in dat moet worden
afgekapt met behulp
van het
laagdoorlaatfilter.

LPF Resonance LPF Resonance Noisy
Voegt kenmerken toe
aan de ingang van het
laagdoorlaatfilter.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

M/S M/S Bit Crusher

Als deze parameter is
ingeschakeld,
verandert elk geluid in
het midden, links en
rechts afzonderlijk.

Make Up Gain Make Up Gain
Upward Compressor, Downward
Compressor

Stelt het niveau in van
het signaal dat wordt
uitgevoerd vanuit de
compressor.

Manual Manual

VCM Flanger

Stelt de offsetwaarde
van de
vertragingsmodulatie
in.

VCM Phaser Mono, VCM Phaser Stereo
Stelt de offsetwaarde
van de fasemodulatie
in.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Master Volume Master Volume
U.S. High Gain, British Lead, British
Legend

Past de versterking
van de
vermogensversterker
in.

Mic Input Level Mic Input Level Vocoder
Stelt het niveau van
de ingang van de
microfoon in.

Mic L-R Angle Mic L-R Angle

Rotary Speaker 1, Rotary Speaker 2, VCM
Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Stelt de L/R-hoek van
de microfoon in voor
het extraheren van
geluid uit de uitgang.

Mic Out Gate
Mic Output Gate
Switch

Vocoder

Off: geeft altijd HPF-
uitvoer en Noise
Generator-uitvoer
door.
On: geeft HPF-uitvoer
en Noise Generator-
uitvoer door wanneer
er audio-invoer van
het instrumentgeluid
is.

Mic Position Mic Position
U.S. Combo, Jazz Combo, U.S. High Gain,
British Lead, British Combo, British
Legend, Rotary Speaker 2

Stelt de relatieve
positie van de
microfoon ten opzichte
van de luidspreker in.

Mid Middle
British Lead, British Legend, Jazz Combo,
U.S. High Gain

Stelt de toonkwaliteit
van de middelste band
in.

Mid 1 Gain L
Mid1 Subband Gain
Lch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
Mid1-band in na de
aanpassing van het
stereogeluid (L-
kanaal).

Mid 1 Gain R
Mid1 Subband Gain
Rch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
Mid1-band in na de
aanpassing van het
stereogeluid (R-
kanaal).

Mid 2 Gain L
Mid2 Subband Gain
Lch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
Mid2-band in na de
aanpassing van het
stereogeluid (L-
kanaal).
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Mid 2 Gain R
Mid2 Subband Gain
Rch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
Mid2-band in na de
aanpassing van het
stereogeluid (R-
kanaal).

Mid 3 Gain L
Mid3 Subband Gain
Lch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
Mid3-band in na de
aanpassing van het
stereogeluid (L-
kanaal).

Mid 3 Gain R
Mid3 Subband Gain
Rch

Stereophonic Optimizer

Stelt de resulterende
versterking van de
Mid3-band in na de
aanpassing van het
stereogeluid (R-
kanaal).

Mid Attack Mid Attack Multi Band Comp

Stelt de tijdsduur in
waarin de compressor
op de
middenfrequenties
moet worden
toegepast.

Mid Cut Mid Cut U.S. Combo
Snijdt de
middenfrequenties af.

Mid Gain Mid Gain Multi Band Comp

Stelt het
uitgangsniveau voor
de middenfrequenties
in.

Mid Level Mid Level Isolator
Stelt het niveau voor
de middenfrequenties
in.

Mid Mute Mid Mute Isolator

Schakelt de demping
van de
middenfrequenties in
of uit.

Mid Ratio Mid Ratio Multi Band Comp

Stelt de
compressieverhouding
in voor de
middenfrequenties.

Mid Sweep Mid Sweep U.S. Combo

Past het
frequentiebereik aan
waarover de
middenfrequenties
worden afgesneden.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Mid Threshold Mid Threshold Multi Band Comp

Stelt het minimale
ingangsniveau in voor
het effect dat op de
middelste band moet
worden toegepast.

Mid Width Mid Width U.S. Combo

Stelt de bandbreedte
voor het verwijderen
van de
middenfrequenties in.

Mix Mix VCM Flanger, Control Flanger
Stelt het volume van
het effectgeluid in.

Mix Level Mix Level Harmonic Enhancer

Stelt het niveau van
het effectgeluid,
gemengd met het
droge geluid in.

Mod Depth

Mod Depth
Noisy, Auto Synth, Tech Modulation,
Shimmer Reverb

Stelt de diepte van de
modulatie in.

Modulation Depth Rotary Speaker 2

Stelt de diepte in van
cyclische
veranderingen in het
volume.

Mod Dpt Ofs R Mod Depth Offset R Auto Synth

Stelt de offset in op de
diepte van de
modulatie voor het R-
kanaal.

Mod Feedback Mod Feedback Noisy
Stelt het niveau van
de feedback naar de
modulatie in.

Mod Gain Mod Gain Tech Modulation
Stelt het
versterkingsniveau
van de modulatie in.

Mod LPF Cutoff
Mod LPF Cutoff
Frequency

Tech Modulation

Stelt de
afsnijfrequentie van
het laagdoorlaatfilter
in dat op het
gemoduleerde geluid
wordt toegepast.

Mod LPF Res Mod LPF Resonance Tech Modulation

Voegt kenmerken toe
aan het gemoduleerde
geluid met behulp van
het laagdoorlaatfilter.

Mod Mix Mod Mix Balance Noisy, Tech Modulation
Stelt de mixbalans van
het gemoduleerde
geluid in.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Mod Phase Modulation Phase Classic Flanger
Stelt het L/R-
faseverschil van de
gemoduleerde golf in.

Mod Speed Mod Speed Noisy, Auto Synth, Tech Modulation
Stelt de
modulatiesnelheid in.

Mod Wave Type Mod Wave Type Auto Synth
Selecteert het golftype
voor modulatie.

Mode Mode

VCM Phaser Mono, VCM Phaser Stereo,
Control Phaser

Stelt een element in
voor het wijzigen van
het phasertype, of
specifieker, de factor
voor het vormen van
het phasereffect.

British Combo
Schakelt de
voorversterker.

Modulator Lvl
Modulator Input
Level

Ring Modulator
Stelt het
modulatorniveau in.

Move Speed Move Speed Talking Modulator

Stelt in hoe lang het
duurt voordat het
geluid wordt gewijzigd
dat is opgegeven door
de Vowel-parameter.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Noise Level
Background Noise
Level

VCM Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Stelt de hoeveelheid
achtergrondgeluid in.

Noise Level Noise Level

Vocoder
Stelt het niveau van
de ruisinvoer in.

Digital Turntable
Hiermee stelt u het
ruisniveau in.

Noise LPF Q Noise LPF Q Digital Turntable

Stelt de resonantie in
van het
laagdoorlaatfilter dat
op de ruis wordt
toegepast.

Noise Switch
Background Noise
Off/On

VCM Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Zet het
achtergrondgeluid
aan of uit.

Noise Tone Noise Tone Digital Turntable
Stelt de toonkwaliteit
van de ruis in.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Normal Normal British Combo

Past het volume van
het geluid aan met
een vlakke EQ-
respons.

Ns Gate Atk Noise Gate Attack NoiseGate+Comp+Eq

Stelt de tijdsduur in
waarin de noisegate
moet worden
toegepast.

Ns Gate Rls Noise Gate Release NoiseGate+Comp+Eq
Stelt de tijdsduur in
waarin de noisegate
inactief moet zijn.

Ns Gate Thrs
Noise Gate
Threshold

NoiseGate+Comp+Eq

Stelt het minimale
ingangsniveau in
voor de toe te
passen noisegate.

Ns LPF Cutoff
Noise LPF Cutoff
Frequency

Digital Turntable

Stelt in dat de
frequentie wordt
afgesneden met
behulp van het
laagdoorlaatfilter dat
op de ruis wordt
toegepast.

Ns Mod Depth Noise Mod Depth Digital Turntable
Stelt de diepte van
de ruismodulatie in.

Ns Mod Speed Noise Mod Speed Digital Turntable
Stelt de snelheid van
de ruismodulatie in.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Offset Filter Offset
Spiralizer P, Spiralizer F, Tempo Spiralizer
P, Tempo Spiralizer F

Stelt de initiële
toonhoogtewaarde in
halve tonen in.

Ofs Transition
Offset Transition
Rate

Spiralizer P, Spiralizer F, Tempo Spiralizer
P, Tempo Spiralizer F

Stelt de
overgangsduur in
waarna de
offsetwaarde
verandert in de
nieuwe waarde.

On/Off Switch On/Off Switch

Isolator
Schakelt de isolator
in of uit.

Stereophonic Optimizer
Schakelt het effect in
of uit.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Osc Freq
OSC Frequency
Coarse

Ring Modulator
Stelt de frequentie in
voor het moduleren
van de ingangsgolf.

Osc Freq Fine OSC Frequency Fine Ring Modulator

Past de frequentie
voor het moduleren
van de ingangsgolf
nauwkeurig aan.

Output Output
VCM Auto Wah, VCM Touch Wah, VCM
Pedal Wah

Stelt het
uitgangsniveau in.

Output Level Filter Output Level Control Filter
Stelt het
uitgangsniveau van
het filter in.

Output Level Output Level

Amp Simulator 1, Amp Simulator 2, Comp
Distortion, Comp Distortion Delay, U.S.
Combo, Jazz Combo, U.S. High Gain,
British Combo, British Lead, British Legend,
Multi FX, Small Stereo, VCM Compressor
376, Classic Compressor, VCM EQ 501,
Talking Modulator, Lo-Fi, Bit Crusher, Vinyl
Break, Beat Repeat, Rotary Speaker 2,
Downward Compressor, Upward
Compressor, Parallel Compressor,
Presence, Wave Folder, VCM Mini Filter,
VCM Mini Booster

Stelt het
uitgangsniveau in.

Vocoder
Stelt het
uitgangsniveau van
de Vocoder in.

Output Level 1 Output Level1 Pitch Change

Stelt het
uitgangsniveau op
de eerste routering
in.

Output Level 2 Output Level2 Pitch Change

Stelt het
uitgangsniveau op
de tweede routering
in.

Overdrive Overdrive

Amp Simulator 1, Amp Simulator 2, Comp
Distortion, Comp Distortion Delay, VCM
Auto Wah, VCM Touch Wah, VCN Pedal
Wah

Stelt het
vervormingsniveau
in.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Pan 1 Pan 1 Pitch Change
Stelt de pan op de
eerste routering in.
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Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Pan 2 Pan 2 Pitch Change
Stelt de pan op de
tweede routering in.

Pan AEG Min Lvl Pan AEG Min Level Slice

Stelt het
minimumniveau in van
de Amplitude EG die op
het gepande geluid
wordt toegepast.

Pan AEG Type Pan AEG Type Slice

Stelt het type Amplitude
EG in die op het
gepande geluid wordt
toegepast.

Pan Depth Pan Depth Slice
Stelt de diepte van de
pan in.

Pan Direction Pan Direction Auto Pan
Stelt het type
automatische pan in.

Pan Type Pan Type Slice Stelt het type pan in.

Panning Panning Jazz Combo
Stelt de spreiding van
het chorus/de vibrato
in.

Pedal Control Pedal Control VCM Pedal Wah
Bepaalt de
afsnijfrequentie van het
wah-filter.

Phase Control Phase Control Control Phaser
Stelt de diepte van de
fasemodulatie in.

Phase Differ
LFO Phase
Difference

Tempo Flanger, Tremolo

Stelt het L/R-
faseverschil van de
gemoduleerde golf in.
(Geen faseverschil voor
0 graden of de waarde
64.)

Phase Reset LFO Phase Reset Tempo Flanger, Tempo Phaser, Slice
Stelt in hoe de initiële
fase van de LFO wordt
gereset.

Phase Shift Ofs Phase Shift Offset Tempo Phaser
Stelt de offsetwaarde
van de fasemodulatie
in.

Phaser Sw Phaser SW Multi FX Stelt het phasertype in.

Pitch 1 Pitch 1 Pitch Change, Shimmer Reverb

Stelt de toonhoogte
voor de eerste
routering in halve tonen
in.
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Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Pitch 2 Pitch 2 Pitch Change, Shimmer Reverb

Stelt de toonhoogte
voor de tweede
routering in halve tonen
in.

P1/P2 Balance
Pitch 1/Pitch 2
Balance

Shimmer Reverb

Stelt de volumebalans
in van het geluid met
toonhoogteverschuiving
op de eerste routering
en het geluid met
toonhoogteverschuiving
op de tweede routering.

P1&P2 Dly Ofs
Pitch 1 & Pitch 2
Delay Offset

Shimmer Reverb

Stelt de offsetwaarde
van vertraging in van
het geluid met
toonhoogteverschuiving
op de eerste routering
en het geluid met
toonhoogteverschuiving
op de tweede routering.

P1&P2 Panning
Pitch 1/Pitch 2
Panning

Shimmer Reverb

Stelt de pan in van het
geluid met
toonhoogteverschuiving
op de eerste routering
en het geluid met
toonhoogteverschuiving
op de tweede routering.

Pitch Sweep Pitch Sweep Beat Repeat

Stelt de toonhoogte zo
in deze bij elke
herhaling geleidelijk
verandert.

Plate Type Plate Type HD Plate
Stelt in hoe het geluid
resoneert.

Play Speed Play Speed Beat Repeat
Stelt de
afspeelsnelheid in.

PM Depth PM Depth G Chorus, 2 Modulator, Tremolo
Stelt de diepte van de
toonhoogtemodulatie
in.

Post-comp HPF Post-comp HPF
Upward Compressor, Downward
Compressor

Stelt de afsnijfrequentie
in van het
hoogdoorlaatfilter dat
na de compressor
volgt.

Pre Mod HPF F
Pre Mod HPF Cutoff
Frequency

Tech Modulation

Stelt de afsnijfrequentie
in van het
hoogdoorlaatfilter
voordat modulatie
wordt toegepast.
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Weergegeven naam
Naam van
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Effecttypen die de parameter
gebruiken Omschrijving

Preamp Preamp British Lead
Stelt de versterking van
de voorversterker in.

Pre-Delay Pre-Delay Shimmer Reverb
Stelt de vertragingstijd
in voor de eerste
weerkaatsingen.

Pre-LPF Cutoff
Pre-LPF Cutoff
Frequency

Lo-Fi

Stelt de afsnijfrequentie
van het
laagdoorlaatfilter in
voor het afsnijden van
de hoge frequentie.

Pre-LPF Res Pre-LPF Resonance Lo-Fi
Voegt kenmerken toe
aan de ingang van het
laagdoorlaatfilter.

Presence Presence

Presence
Stelt het niveau van het
effect in.

Amp Simulator 1, Comp Distortion Delay
U.S. Combo, U.S. Hi Gain, British Lead,
British Legend

Versterkt de hoge
frequenties.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

R/H Balance Rotor/Horn Balance Rotary Speaker 1, Rotary Speaker 2

Stelt de
volumebalans van de
hoorn (hoge tonen)
en rotor (woofer) in.

Random Random Beat Repeat
Creëert willekeurige
herhaling.

Ratio Ratio
Comp Distortion, VCM Compressor 376,
Classic Compressor, Downward
Compressor, Upward Compressor

Stelt de verhouding
van de compressor
in.

Release Release
Comp Distortion, VCM Compressor 376,
Classic Compressor, Downward
Compressor, Upward Compressor

Stelt de tijd in die
nodig is voordat het
compressoreffect
wegsterft.

Release Curve Release Curve
Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Stelt de releasecurve
van de
envelopefollower in.
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parameter Effecttypen die de parameter gebruiken Omschrijving

Release Time Release Time

Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Stelt de releasetijd
van de
envelopefollower in.

Beat Repeat
Stelt de releasetijd
van de gate voor het
gehele geluid in.

Repeat Repeat Beat Repeat
Zet herhaling aan of
uit.

Resonance Resonance

Dynamic Filter, Control Filter, VCM Mini
Filter, VCM Mini Booster

Voegt kenmerken toe
aan het filter.

Beat Repeat
Stelt de resonantie
van het filter voor het
effectgeluid in.

Resonance Ofs Resonance Offset
VCM Auto Wah, VCM Touch Wah, VCN
Pedal Wah

Stelt de offsetwaarde
in op de resonantie.

Retrigger Cycle Retrigger Cycle Beat Repeat

Stelt de cyclus in
voor het opnieuw
triggeren van de
herhaling.

Reverb Delay Reverb Delay
R3 Hall, R3 Room, R3 Plate, SPX Hall, SPX
Room, SPX Stage, Space Simulator

Stelt de
vertragingstijd in
vanaf de eerste
weerkaatsingen tot
de reverb.

Reverb Time Reverb Time

REV-X Hall, REV-X Room, R3 Hall, R3
Room, R3 Plate, SPX Hall, SPX Room, SPX
Stage, Space Simulator, HD Hall, HD
Room, HD Plate

Stelt de reverb-
lengte in.

Room Size Room Size
REV-X Hall, REV-X Room, Early Reflection,
HD Hall, HD Room, Gated Reverb, Reverse
Reverb

Stelt de grootte van
de kamer in.

Rotor Accel Rotor Acceleration
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Stelt de
rotatiesnelheid van
de rotor (woofer) zo
in dat deze verandert
van Slow in Fast.

Rotor Decel Rotor Deceleration
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Stelt de
rotatiesnelheid van
de rotor (woofer) zo
in dat deze verandert
van Fast in Slow.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Rotor Fast Rotor Speed Fast

Rotary Speaker 1, Rotary Speaker 2, VCM
Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Stelt de
rotatiesnelheid van
de rotor (woofer) in
voor de Fast-
instelling.

Rotor Level Rotor Level
VCM Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Stelt het volume van
de rotor (woofer) in.

Rotor Slow Rotor Speed Slow

Rotary Speaker 1, Rotary Speaker 2, VCM
Rotary Speaker Classic, VCM Rotary
Speaker Overdrive, VCM Rotary Speaker
Studio

Stelt de
rotatiesnelheid van
de rotor (woofer) in
voor de Slow-
instelling.

Rotor Slow/Fast
Rotor Slow/Fast
Time

Rotary Speaker 1

Stelt de
overgangsduur in
voor de
rotatiesnelheid van
de rotor (woofer) om
te veranderen van
Slow in Fast.

Rtg Attack T
Retrigger Attack
Time

Beat Repeat

Stelt de Attack-tijd
van de Gate in die
wordt toegepast op
het gehele geluid.

Rtg Gate Time Retrigger Gate Time Beat Repeat
Stelt de gatetijd van
het gehele geluid in.

Rtg Quantize Retrigger Quantize Beat Repeat

Wanneer deze
parameter is
ingesteld op On,
wordt het geluid
herhaald aan het
begin van de maat
die is ingesteld in de
ingebouwde
sequencer.

Rtg Release T
Retrigger Release
Time

Beat Repeat
Stelt de releasetijd
van de gate voor het
gehele geluid in.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Sample Rate Sample Rate Bit Crusher
Verlaagt de Sample
Rate.

497



Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Sampling Freq
Sampling Frequency
Control

Lo-Fi
Hiermee regelt u de
samplefrequentie.

SC EQ Freq
Side Chain EQ
Frequency

Downward Compressor, Upward
Compressor

Stelt de frequentie in
van de EQ die wordt
gebruikt voor het
detecteren van het
compressorniveau.

SC EQ Gain Side Chain EQ Gain
Downward Compressor, Upward
Compressor

Stelt de versterking in
van de EQ die wordt
gebruikt voor het
detecteren van het
compressorniveau.

SC EQ Q Side Chain EQ Q
Downward Compressor, Upward
Compressor

Stelt de Q in van de EQ
die wordt gebruikt voor
het detecteren van het
compressorniveau.

Scale Type
Spiral Step Scale
Type

Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Stelt in hoe u
wijzigingen kunt
aanbrengen als de Step
Mode is ingesteld op
Scale.

Semitones
Spiral Step
Semitones

Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Geeft de variatiebreedte
in halve tonen op als de
Step Mode is ingesteld
op Semitone.

Send to Noise Dry Send to Noise Digital Turntable

Stelt het niveau in van
het droge signaal dat
naar het ruiseffect wordt
gezonden.

Sensitivity Sensitivity

Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Stelt de gevoeligheid in
van de modulatie die op
de ingangswijziging
wordt toegepast.

VCM Touch Wah

Stelt de gevoeligheid
van de wah-
filterwijziging die op de
ingangswijziging wordt
toegepast.

SEQ Clock SEQ Clock Wave Folder
Past de snelheid van de
ingebouwde sequencer
aan.

SEQ Depth SEQ Depth Wave Folder
Past de diepte van het
effect op de ingebouwde
sequencer aan.
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Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

SEQ Pattern SEQ Pattern Wave Folder
Selecteert het patroon
op de ingebouwde
sequencer.

SEQ Ph Reset SEQ Phase Reset Wave Folder
Stelt de modus in voor
het resetten van de
ingebouwde sequencer.

SEQ Variation SEQ Variation Wave Folder
Verandert het gedrag
van de ingebouwde
sequencer.

Shimmer Fdbk Shimmer Feedback Shimmer Reverb

Past het feedbackniveau
van het geluid met
toonhoogteverschuiving
aan.

Shimmer Gain Shimmer Gain Shimmer Reverb

Past het niveau van het
geluid met
toonhoogteverschuiving
aan.

Shimmer HPF
Shimmer HPF
Frequency

Shimmer Reverb

Stelt de afsnijfrequentie
van het
hoogdoorlaatfilter in
voor het afsnijden van
de lage frequentie van
het geluid met
toonhoogteverschuiving.

Shimmer LPF
Shimmer LPF
Frequency

Shimmer Reverb

Stelt de afsnijfrequentie
van het laagdoorlaatfilter
in voor het afsnijden van
de hoge frequentie van
het geluid met
toonhoogteverschuiving.

Side Bit Side Bit Bit Crusher
Vermindert de bitprecisie
voor de zijketen.

Side Chain EQ
Side Chain EQ
Switch

Downward Compressor, Upward
Compressor

Zet de EQ die wordt
gebruikt voor het
detecteren van het
compressorniveau aan
of uit.

Side Chain Lvl
Side Chain Input
Level

VCM Compressor 376, Classic
Compressor, Dyna Flanger, Dyna
Phaser, Dyna Ring Mod, Dyna Filter,
Multi Band Comp

Stelt het niveau in van
de ingang naar het
regelaarcircuit voor de
zijketen.

Side Smpl Rate Side Sample Rate Bit Crusher
Vermindert de Sample
Rate voor de zijketen.

Size Size Shimmer Reverb
Stelt de schijnbare
grootte van de
reverbruimte in.
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Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Smpl Rate Link Sample Rate Link Bit Crusher

Stelt het niveau in van
de Side-instelling die
volgt op de Mid-waarde
wanneer M/S is
ingesteld op On.

Space Type Space Type Space Simulator
Selecteer het
ruimtesimulatietype.

Speaker Air Speaker Air
U.S. Combo, Jazz Combo, U.S. High
Gain, British Lead, British Combo, British
Legend

Benadruk de
karakteristieken van de
luidsprekerkast.

Speaker Type Speaker Type

Amp Simulator 1, Comp Distortion Delay
Selecteer het
luidsprekersimulatietype.

U.S. Combo, Jazz Combo, U.S. High
Gain, British Lead, Small Stereo, British
Combo, British Legend, Multi FX

Stelt het luidsprekertype
in.

Speed Speed

VCM Flanger

Stelt de frequentie in
van de LFO-golf die de
cyclische verandering
van de
vertragingsmodulatie
regelt.

VCM Phaser Mono, VCM Phaser Stereo

Stelt de frequentie in
van de LFO-golf die de
cyclische verandering
van de fasemodulatie
regelt.

VCM Auto Wah
Stelt de snelheid van de
LFO in.

Vinyl Break
Stelt de tijdsduur in
waarna het geluid stopt.

Speed Adjust Speed Adjust Vinyl Break
Past de snelheid
nauwkeurig aan.

Speed Control Speed Control

Rotary Speaker 1, Rotary Speaker 2
Verandert de
rotatiesnelheid (Slow of
Fast).

VCM Rotary Speaker Classic, VCM
Rotary Speaker Overdrive, VCM Rotary
Speaker Studio

Verandert de
rotatiesnelheid (Slow,
Stop of Fast).

Spiral Spiral Switch
Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Schakelt de LFO in of
uit.

Spiral Speed Spiral Speed
Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Stelt de snelheid van de
toonhoogteverandering
in.
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Weergegeven naam
Naam van
parameter

Effecttypen die de parameter
gebruiken Omschrijving

Spiral Sync Spiral Sync
Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Stelt de standaardcyclus
in voor het stapsgewijs
wijzigen van de
toonhoogte.

Spread Spread
Ensemble Detune, VCM Flanger, VCM
Phaser Stereo, Control Phaser

Stelt in hoe het geluid
zich verspreidt.

Stage Stage
VCM Phaser Mono, VCM Phaser
Stereo, Tempo Phaser, Dynamic Phaser,
Control Phaser

Stelt het aantal stappen
in voor de
faseverschuiver.

Step Mode Spiral Step Mode
Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Stelt de toonhoogte zo
in dat deze continu
(vloeiend) of in stappen
verandert.

Step Transition
Spiral Step
Transition Rate

Spiralizer P, Spiralizer F, Tempo
Spiralizer P, Tempo Spiralizer F

Stelt de overgangsduur
in waarin de toonhoogte
in stappen verandert.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Texture Texture
Parallel Compressor, Presence, VCM Mini
Filter, VCM Mini Booster

Maakt verschillende
wijzigingen in de
textuur van het
effect.

Threshold Threshold
Comp Distortion, Classic Compressor,
Downward Compressor, Upward
Compressor

Stelt het
ingangsniveau in
voor het toe te
passen effect.

Threshold Level
Dyna Threshold
Level

Dynamic Flanger, Dynamic Phaser,
Dynamic Ring Modulator, Dynamic Filter

Stelt het
minimumniveau in
waarop de
envelopefollower
begint.

Time Sweep Time Sweep Beat Repeat

Maakt een
geleidelijke
verandering in de
tijdsduur bij elke
herhaling.

Tone Tone
Rotary Speaker 2, VCM Rotary Speaker
Classic, VCM Rotary Speaker Overdrive,
VCM Rotary Speaker Studio

Stelt de toonregeling
in.

Tone Shift Tone Shift British Lead
Schakelt de
karakteristieken van
de toonregeling.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Transition Rate
Delay Transition
Rate

Control Delay

Stelt de
overgangstijd in voor
het wijzigen van de
huidige Delay Time
in de nieuwe waarde.

Treble Treble
British Combo, British Lead, British Legend,
Jazz Combo, U.S. High Gain

Past de toonkwaliteit
van de hoge tonen
aan.

Type Type

VCM Flanger, Control Flanger
Selecteert het
flangertype.

VCM Auto Wah, VCM Touch Wah, VCN
Pedal Wah

Selecteert het wah-
type.

Early Reflection, Gated Reverb, Reverse
Reverb

Selecteert het
weerkaatsingstype.

US High Gain, British Lead
Selecteert het type
versterker.

Analog Delay Retro, Analog Delay Modern
Stelt het kenmerk
van de vertraging in.

Parallel Compressor
Stelt het
compressortype in.

Mini Filter, Mini Boost Stelt het filtertype in.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Upper Range Upper Range

VCM Auto Wah, VCM Touch Wah, VCN
Pedal Wah

Stelt de maximale
waarde in voor het
variabele bereik van
het wah-filter.

Control Flanger

Stelt de maximale
waarde in voor het
variabele bereik van
het Flanger Control.

Control Phaser

Stelt de maximale
waarde in voor het
variabele bereik van
de Phase Control.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Vib Speed Vib Speed Jazz Combo

Stelt de snelheid van
de vibrato in.
Beschikbaar als
Chorus is ingesteld
op Vib.

Vocoder Attack Vocoder Attack Vocoder

Stelt de
aanslagwaarde van
de Vocoder-uitgang
in.

Vocoder Rls Vocoder Release Vocoder

Stelt de
releasewaarde van
de Vocoder-uitgang
in.

Volume Volume U.S. Combo, Jazz Combo
Stelt het niveau van
de voorversterker in.

Vowel Vowel Talking Modulator
Selecteert een
stemtype.

A B C D E F G H I J K L M N O P Q R S T U V W X Y Z

Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Wah Pedal Wah Pedal Multi FX
Stelt de positie van
het wah-pedaal in.

Wah Sw Wah SW Multi FX Stelt het wah-type in.

Wall Vary Wall Vary Space Simulator

Stelt het muurtype
van de gesimuleerde
kamer in. Hogere
waarden produceren
een grotere
verstrooiing van de
reflecties.

Width Width Space Simulator
Stelt de breedte van
de gesimuleerde
kamer in.

Width High Width High Stereophonic Optimizer
Past de stereobalans
van de High-band
aan.

Width Low Width Low Stereophonic Optimizer
Past de stereobalans
van de Low-band
aan.

Width Mid 1 Width Mid1 Stereophonic Optimizer
Past de stereobalans
van de Mid1-band
aan.
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Weergegeven naam
Naam van
parameter Effecttypen die de parameter gebruiken Omschrijving

Width Mid 2 Width Mid2 Stereophonic Optimizer
Past de stereobalans
van de Mid2-band
aan.

Width Mid 3 Width Mid3 Stereophonic Optimizer
Past de stereobalans
van de Mid3-band
aan.

Word Length Word Length Lo-Fi
Stelt de resolutie van
het geluid in, of hoe
‘grof’ het geluid is.
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Door tegelijkertijd op de knop [SHIFT] en een andere knop te drukken, kunt u de snelkoppelingen
gebruiken om direct toegang te krijgen tot de hieronder getoonde functies.

Gebruik Functie

[SHIFT] + knop 1-8
Schakelt de knoppen naar de hoge-precisiemodus of in
kleinere stappen (vertraagt waardeveranderingen).
Handig bij het maken van fijne aanpassingen aan waarden.

[SHIFT] + [EDIT/ ] Roept het scherm Copy/Exchange op.

[SHIFT] + KNOB POSITION [LEFT] Registreert de Assign 1–8-waarde die aan de knop is
toegewezen, onder de knop KNOB POSITION [LEFT].

[SHIFT] + KNOB POSITION [MID] Registreert de waarde voor Assign 1–8 die aan de knop is
toegewezen, onder de knop KNOB POSITION [MID].

[SHIFT] + KNOB POSITION [RIGHT] Registreert de waarde voor Assign 1–8 die aan de knop is
toegewezen, onder de knop KNOB POSITION [RIGHT].

[SHIFT] + [PAGE JUMP] Roept de parameter die wordt bewerkt op het hoofddisplay op
het sub-display op.

[SHIFT] + [PART SELECT] Schakelt de PART-knoppen in voor het in- of uitschakelen van
de solo-instelling.

[SHIFT] + [KEYBOARD CONTROL] Schakelt de PART-knoppen in voor het in- of uitschakelen van
de dempingsinstelling.

[SHIFT] + [1-8/9-16] Zorgt ervoor dat de PART-knoppen en schuifregelaars
kunnen schakelen tussen partijen 9-16.

[SHIFT] + [COMMON] Selecteert Common voor elementen, operators en oscillators.

[SHIFT] + PART [1]-[8] Maakt één selectie uit Element 1-8, Operator 1-8, Oscillator
1-3 en Noise.

[SHIFT] + OCTAVE [−] Stelt de transponeerwaarde in op −1 (verlagen).

[SHIFT] + OCTAVE [+] Stelt de transponeerwaarde in op +1 (verhogen).

[SHIFT] + OCTAVE [−] + OCTAVE [+] Stelt de transponeerwaarde in op 0 (resetten).

[SHIFT] + SCENE [1]-[8] Registreert de gemaakte scène op een van de SCENE-
knoppen [1]-[8].

[SHIFT] + [DEC/NO]
Stelt de geselecteerde parameterwaarde in op −10
(verlagen).
Keert terug naar de vorige pagina op het scherm Live Set.

Snelkoppelingen

De knop [SHIFT] gebruiken
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Gebruik Functie

[SHIFT] + [INC/YES]
Stelt de geselecteerde parameterwaarde in op +10
(verhogen).
Gaat naar de volgende pagina op het scherm Live Set.

[SHIFT] + [ARP ON/OFF] Roept het scherm Arp Edit op.

[SHIFT] + [MSEQ ON/OFF] Roept het scherm Motion Seq Edit op.

[SHIFT] + [CONTROL ASSIGN] Roept het scherm Control View op.

[SHIFT] + [LATCH] Roept het scherm Ribbon Settings op.

[SHIFT] + [PERFORMANCE] Roept het scherm Property op (alleen het scherm Home).

[SHIFT] + [LIVE SET] Gaat naar het scherm Live Set Register.

[SHIFT] + [CATEGORY SEARCH]
Opent het scherm Part Category Search voor de
geselecteerde partij.

[SHIFT] + [UTILITY] Geeft de parameterwaarde weer.

[SHIFT] + [NAVIGATION] Roept het FX OVERVIEW-scherm op.

[SHIFT] + [QUICK SETUP] Roept het scherm Effect Switch op.

[SHIFT] + [STORE] Roept het scherm Load op.

[SHIFT] + [SPLIT]
Roept het scherm Home op met de weergave Part—Note
geselecteerd.

[SHIFT] + [SONG/PATTERN] Roept het scherm Rhythm Pattern op.

[SHIFT] + [TEMPO/TAP]
Zet de paneelvergrendelingsfunctie aan of uit. (Alleen op het
scherm Home of het scherm Live Set.)

[SHIFT] + Slot number [1]
Selecteert het eerste tabblad in de eerste kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [2]
Selecteert het tweede tabblad in de eerste kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [3]
Selecteert het derde tabblad in de eerste kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [4]
Selecteert het vierde tabblad in de eerste kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [5]
Selecteert het vijfde tabblad in de eerste kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [6]
Selecteert het zesde tabblad in de eerste kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [9]
Selecteert het eerste tabblad in de tweede kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [10]
Selecteert het tweede tabblad in de tweede kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [11]
Selecteert het derde tabblad in de tweede kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [12]
Selecteert het vierde tabblad in de tweede kolom aan de
linkerkant van het scherm.
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Gebruik Functie

[SHIFT] + Slot number [13]
Selecteert het vijfde tabblad in de tweede kolom aan de
linkerkant van het scherm.

[SHIFT] + Slot number [14]
Selecteert het zesde tabblad in de tweede kolom aan de
linkerkant van het scherm.

[SHIFT] + [A/D INPUT ON/OFF] Roept het scherm Audio In Edit op.

[SHIFT] + [PORTAMENTO] Roept het scherm Pitch Edit op.

[SHIFT] + [ASSIGN 1]/[ASSIGN 2] Roept het scherm Control Settings op.

Gebruik Functie

[DAW REMOTE] + Slot number [1] Roept het scherm DAW Remote op in de Track-modus.

[DAW REMOTE] + Slot number [2] Roept het scherm DAW Remote op in de Plugin-modus.

[DAW REMOTE] + Slot number [3] Roept het scherm DAW Remote op in de Transport-modus.

[UTILITY] + [DAW REMOTE] Gaat naar het scherm Touch Panel Calibration Setting.

Gebruik Functie

[QUICK SETUP] + Slot number [5] Selecteert Standalone voor Quick Setup.

[QUICK SETUP] + Slot number [6] Selecteert Quick Setup 1.

[QUICK SETUP] + Slot number [7] Selecteert Quick Setup 2.

[QUICK SETUP] + Slot number [8] Selecteert Quick Setup 3.

Gebruik Functie

OCTAVE [−] + OCTAVE [+] Zet de octaafverschuiving terug.

[SHIFT] + OCTAVE [−] Stelt de transponeerwaarde in op −1 (verlagen).

[SHIFT] + OCTAVE [+] Stelt de transponeerwaarde in op +1 (verhogen).

[SHIFT] + OCTAVE [−] + OCTAVE [+] Zet de transponeerwaarde terug.

U kunt schakelen tussen Internal en External door tweemaal snel op de overeenkomstige PART-knop
te drukken.
Wanneer u overschakelt naar External, wordt de partijnaam blauw weergegeven.

Gebruik Functie

[CATEGORY] Zet Bank/Favorite terug op All.

De knop [DAW REMOTE] gebruiken

De knop [QUICK SETUP] gebruiken

OCTAVE-knoppen

Tweemaal snel op de knop drukken

De knop omlaag houden
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Gebruik Functie

[QUICK EDIT] Zet de geselecteerde partij terug.

[A/D INPUT ON/OFF] Schakelt de functie in.
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Bericht Omschrijving Vereiste handeling

** library will be
overwritten.

Het bibliotheekbestand met dezelfde
naam is al geladen toen u probeerde een
bibliotheek te laden. De bestaande data
worden overschreven wanneer de nieuwe
data worden geladen.
De naam van het bibliotheekbestand dat u
probeert te laden wordt weergegeven in
plaats van **.

** Control Assign
full.

Kan de bewerking niet uitvoeren omdat er
geen regelaarset beschikbaar is. De
partijnaam die u probeert toe te voegen
aan de regelaarset wordt weergegeven in
plaats van '**'.

Verwijder de onnodige regelaarset en voer
de bewerking opnieuw uit.

** will be deleted.
Als gevolg van deze bewerking worden
data verwijderd.

** will be loaded to
Pattern.

Het .mid-bestand wordt in het patroon
geladen.

** will be loaded to
Song.

Het .mid-bestand wordt in de song
geladen.

** will be loaded. Het bestand wordt geladen.

** will be overwritten.

Bij het opslaan bestaat de performance,
het bestand, de map of de snelle
configuratie met dezelfde naam al. Bij het
opslaan worden de bestaande data
overschreven.
De naam van de performance, het
bestand, de map of de snelle configuratie
die u probeert op te slaan, wordt
weergegeven in plaats van '**'.

Activate the source
controller to assign.

U kunt parameters toewijzen aan de
regelaar die u gaat bedienen.

Bedien de regelaar die u wilt toewijzen.

Advanced settings
will be initialized.

Initialiseert de instellingen van [UTILITY]
→ Settings → tabblad Advanced.

All data and libraries
will be initialized.
Unsaved user data
will be lost.

Herstelt de fabrieksinstellingen.
Het wordt aanbevolen om alle noodzakelijke
instellingen die wilt bewaren van tevoren op
een USB-flashstation op te slaan.

Berichtenlijst
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Bericht Omschrijving Vereiste handeling

All data is initialized
upon power-on.

Het instrument is zo ingesteld dat de
fabrieksinstellingen worden hersteld
wanneer het instrument wordt
ingeschakeld.

All data will be
overwritten by **

Wanneer het laden wordt uitgevoerd,
worden alle data overschreven.
De naam van het back-upbestand dat u
probeert te laden wordt weergegeven in
plaats van '**'.

All Favorite Marks
will be cleared.

Alle markeringen als favoriet worden
gewist.

All settings will be
initialized. User data
is kept.

De instellingen voor het instrument
worden geïnitialiseerd. De gebruikersdata
worden niet verwijderd.

All sound will be
stopped during
optimization.

Het interne geheugen wordt hersteld.

All user data will be
initialized. Unsaved
user data will be lost.

Het gebruikersgebied in het
gebruikersgeheugen wordt geïnitialiseerd.
Het wordt aanbevolen om alle
noodzakelijke instellingen die wilt
bewaren van tevoren op een USB-
flashstation op te slaan.

Arpeggio bypass
disabled.

De arpeggio-bypass is verwijderd.

Arpeggio full.
Kan de handeling niet uitvoeren omdat
het arpeggio vol is.

Assignable knob full.
Kan de bewerking niet uitvoeren omdat
alle toewijsbare knoppen in de regelaarset
worden gebruikt.

Verwijder alle onnodige regelaarsets
waarvoor een toewijsbare knop als bron is
ingesteld en voer de handeling opnieuw uit.

Audio file is not
found.

Het opgegeven audiobestand is niet
gevonden.

Audio Rec stopped
due to lack of
memory space.

De audio-opname is automatisch gestopt
omdat het USB-flashstation vol is.

Gebruik een nieuw USB-flashstation of
verwijder onnodige bestanden en probeer
deze bewerking opnieuw.

Audition full.
Kan de handeling niet uitvoeren omdat de
User Audition-data vol zijn.

Verwijder onnodige User Audition-data uit:
[UTILITY] → Contents → het scherm Data
Utility.

Auto power off
disabled.

De functie Auto Power Off is
uitgeschakeld.

Bulk data protected.
Bulkdata kunnen niet worden ontvangen
vanwege de instelling.

Can’t process.
Kan de aangevraagde bewerking niet
uitvoeren.
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Bericht Omschrijving Vereiste handeling

Can’t register
unstored
performance.

Kan de performance niet registreren bij de
Live Set omdat het bank- of
programmanummer dat wordt bewerkt
nog niet is ingesteld.

Completed.
De opgegeven taak voor het laden,
opslaan, formatteren of een andere taak
is afgerond.

Connecting to USB
device...

Het USB-flashstation wordt aangesloten
op het instrument.

Converting Pattern
to Song.

Het patroon wordt geconverteerd.

CPU Fan Error De ingebouwde koelventilator is gestopt.

Deze situatie kan ertoe leiden dat de interne
temperatuur stijgt en dat het instrument niet
meer werkt.
Maak onmiddellijk een back-up van alle
noodzakelijke data, schakel het instrument
uit en neem contact op met uw Yamaha-
dealer.

Current user data
will be overwritten by
**.

Er bestaan al gebruikersdata op de
bestemming waar het bestand moet
worden geladen. Als u doorgaat, worden
de bestaande gebruikersdata
overschreven.
De naam van het gebruikersbestand dat u
probeert te laden wordt weergegeven in
plaats van '**'.

Curve full
Kan de handeling niet uitvoeren omdat de
User Curve-data vol zijn.

Verwijder onnodige User Curve-data uit:
[UTILITY] → Contents → het scherm Data
Utility.

Data memory full.

(Bij het laden van een bibliotheekbestand)
De inhoudsdata in de bibliotheek kunnen
niet worden opgeslagen omdat het
instrumentgeheugen vol is.

Device number is off.
De bulkdata kunnen niet worden
verzonden of ontvangen omdat het
apparaatnummer is ingesteld op 'off'.

Device number
mismatch.

De bulkdata kunnen niet worden
verzonden of ontvangen omdat het
apparaatnummer niet overeenkomt.

Dividing the drum
track makes new
performance data.
Performance full.

Kan de bewerking niet uitvoeren omdat er
geen performance is voor het gebruik van
Divide Drum Track.
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Bericht Omschrijving Vereiste handeling

Dividing the drum
track makes new
performance data.
You can’t undo this
operation.

Er wordt een nieuwe performance
gemaakt met Divide Drum Track. Deze
bewerking kan niet ongedaan worden
gemaakt.

File is not found.
Er zijn geen bestanden voor het
geselecteerde type.

File or folder already
exists.

Er bestaat al een bestand of map met
dezelfde naam.

File or folder path is
too long.

Kan het opgegeven bestand of de
opgegeven map niet openen omdat de
padnaam te lang is.

Folder is not empty.
U probeert een map te verwijderen die
data bevat.

Folder is too deep.
Kan de map niet openen omdat deze te
diep in de mapstructuur is genest.

Illegal bulk data.
Er is een fout opgetreden tijdens het
ontvangen van bulkdata of bulkverzoeken.

Illegal file name. De bestandsnaam is ongeldig.

Illegal file.
Het opgegeven bestand kan niet worden
verwerkt of in dit instrument worden
geladen.

Illegal parameters. Er zijn onjuiste parameters opgegeven.

Illegal sample data.
De opgegeven voorbeelddata worden niet
ondersteund.

Illegal smart morph
data.

De opgegeven Smart Morph-data worden
niet ondersteund.

Keybank full.
Tijdens het laden overschrijdt het totale
aantal keybanks het maximale aantal.

Keyboard control
lock disabled.

De Keyboard Lock is uitgeschakeld.

Knob value stored. De Knob Value is opgeslagen.

Library full.
Het totale aantal bibliotheken overschrijdt
het maximale aantal.

Micro Tuning full
Kan niet worden geladen omdat de User
Micro Tuning-data vol zijn.

Verwijder onnodige User Micro Tuning-data
uit: [UTILITY] → Contents → het scherm
Data Utility.

MIDI buffer full.
Kan niet worden verwerkt omdat er een
buitensporig grote hoeveelheid MIDI-data
tegelijk is ontvangen.

MIDI checksum error.
De checksum (controle-optelling) van het
ontvangen systeemeigen bericht klopt
niet.
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Bericht Omschrijving Vereiste handeling

No data.
Er zijn geen data in de geselecteerde
track of het opgegeven bereik.
Selecteer het bereik opnieuw.

No read/write
authority to the file.

Geen lees- of schrijfrechten voor dit
bestand.

Note ranges will be
initialized.

Het notenbereik wordt geïnitialiseerd.

Now initializing all
data…

De fabrieksinstellingen worden hersteld.

Now initializing… Sommige data worden geïnitialiseerd.

Now loading... Het bestand wordt geladen.

Now receiving MIDI
bulk data...

Het instrument ontvangt MIDI-bulkdata.

Now saving... Het bestand wordt opgeslagen.

Now transmitting
MIDI bulk data...

Het instrument verzendt MIDI-bulkdata.

Panel unlocked. De paneelvergrendeling is uitgeschakeld.

Part *** will be
overwritten.

Er is al een partij op de
kopieerbestemming. Als u doorgaat met
de bewerking, wordt de bestaande partij
op de kopieerbestemming overschreven.

Part full.
Kan het scherm Rhythm Pattern niet
openen omdat er geen partijen
beschikbaar zijn.

Verwijder de onnodige partij(en) en voer de
bewerking opnieuw uit.

Pattern full.
Kan de handeling niet uitvoeren omdat
het patroon vol is.

Pattern will be
converted to Song.

Het patroon wordt geconverteerd naar
een song.

Performance data in
*** will be loaded.

De Performance Data in het bestand voor
een eerder model worden geladen.

Performance full.
Kan de handeling niet uitvoeren omdat de
performance vol is.

Please connect USB
device.

Sluit een USB-flashstation aan.

Please keep power
on.

Er worden data naar het flash-ROM
geschreven.

Schakel het instrument niet uit terwijl dit
bericht wordt weergegeven.
Als het instrument wordt uitgeschakeld
terwijl dit wordt weergegeven, kunnen
gebruikersdata verloren gaan of kan het
systeem beschadigd raken, waardoor het
systeem de volgende keer dat het
instrument wordt ingeschakeld niet correct
kan opstarten.
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Bericht Omschrijving Vereiste handeling

Please reboot to
enable the new
Audio I/O Mode.

Start het instrument opnieuw op om de
wijzigingen in de audio-ingang- en -
uitgangsinstellingen in te schakelen.

Please reboot to
enable the new USB
Driver Mode.

Start het instrument opnieuw op om de
wijzigingen in de instellingen van de USB-
stuurprogrammamodus in te schakelen.

Please reboot to
maintain internal
memory.

Start het instrument opnieuw op om het
instrumentgeheugen te herstellen.

Please stop audio
play/rec.

Stop met het opnemen of afspelen van
audio en probeer het opnieuw.

Please stop
sequencer.

Stop de sequencer (patroon of song) en
probeer het opnieuw.

Please store the
pattern to change the
chain play mode.

Sla het patroon op voordat u de modus
voor ketengewijs afspelen wijzigt.

Please wait… Bezig met verwerken. Een ogenblik geduld.

Press [SHIFT] +
[TEMPO/TAP] to
unlock panel.

Paneelvergrendeling is geactiveerd. Druk
op [SHIFT] + [TEMPO/TAP] om het
paneel te ontgrendelen.

Quick Setup ** is
loaded.

Quick Setup is geladen.

Recall latest edits.
Roept de laatst bewerkte
performancedata op en plaatst deze in de
bewerkingsbuffer.

Redo **.

Voert de bewerking die ongedaan was
gemaakt opnieuw uit (Redo).
De naam van de bewerking wordt
weergegeven in plaats van '**'.

Sample is protected.
De sample is beveiligd en kan niet worden
gewijzigd.

Sample is too long.
De samplegrootte is te groot en kan niet
worden geladen.

Sample is too short.
De samplegrootte is te klein en kan niet
worden geladen.

Sample memory full.
Het geheugen voor samples is vol en kan
niet worden geladen.

Scene stored.
De scène is opgeslagen naar onder de
[SCENE]-knop.

Selected items will
be copied to user
bank.

De performance wordt gekopieerd naar
de gebruikersbank.

Smart Morph full.
Het totale aantal performances met Smart
Morph overschrijdt het maximale aantal.
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Bericht Omschrijving Vereiste handeling

Some keybanks were
not loaded.

Sommige keybanks zijn in de oude
indeling en kunnen niet worden geladen.

Song/Pattern data
overload.

De song of het patroon kan niet worden
afgespeeld omdat deze overbelast is.

Song full.
Het totale aantal songs overschrijdt het
maximale aantal.

SSS disabled. SSS is uitgeschakeld.

SSS enabled. SSS is ingeschakeld.

Touch the white
square.

(Tijdens kalibratie van het
aanraakscherm) Tik op het witte vierkant
dat op de display verschijnt.

Turn on Memory
Switch to memorize
** into this scene.

Om een functie voor een scène te
registreren, moet Memory (Memory
Switch) vooraf worden ingeschakeld voor
de functie.

Zet de schakelaar van: [PERFORMANCE]
→ Scene.

Undo **.
Annuleert de laatste actie (Undo).
De naam van de bewerking wordt
weergegeven in plaats van '**'.

Unsupported USB
device.

Dit USB-apparaat wordt niet ondersteund
door dit instrument.

USB connection
terminated.

Het USB-flashstation is uitgeschakeld
vanwege een abnormale huidige stroom.

Koppel het USB-flashstation los en druk
vervolgens op een willekeurige knop op het
bovenpaneel.

USB device is full.
Het USB-flashstation is vol en bestanden
kunnen niet worden opgeslagen.

Gebruik een nieuw USB-flashstation of
verwijder onnodige bestanden en probeer
deze bewerking opnieuw.

USB device is write-
protected.

Het USB-flashstation dat u gebruikt is
tegen schrijven beveiligd.

USB device
read/write error.

Er is een fout opgetreden tijdens het
lezen/schrijven naar het USB-flashstation.

USB device will be
formatted.

Het USB-flashstation wordt
geformatteerd.

User auditions will
be overwritten with
stored songs.

De bestaande User Audition wordt
overschreven door de momenteel
opgeslagen song.

VCM Rotary is
disabled except in
Part 1.

De VCM Rotary kan alleen worden
gebruikt met partij 1. Deze kan niet
worden gebruikt in andere partijen.

Voice data in *** will
be loaded.

De Voice Data in een bestand voor een
vorig model worden geladen.

Waveform full.
Het totale aantal golfvormen overschrijdt
het maximale aantal.

515



om02screenparameters0480

Geen geluid? Verkeerd geluid? Als een dergelijk probleem zich voordoet, controleert u eerst het
gedeelte voor probleemoplossing voordat u ervan uitgaat dat het product niet in orde is.
Veel problemen kunnen worden opgelost door Initialize All Data uit te voeren nadat u een back-up
van uw data hebt gemaakt op een USB-flashstation.
Als het probleem zich blijft voordoen, moet u de Yamaha-dealer raadplegen.

Als dit niet het geval is, kalibreer dan het aanraakscherm.
[UTILITY] + [DAW REMOTE] → Calibrate Touch Panel

[UTILITY] → Settings  → System  → Calibrate Touch Panel

[UTILITY] → Settings  → System  → Calibrate Ribbon Controller

Omdat dit instrument geen ingebouwde luidsprekers heeft, is het noodzakelijk om versterkers,
luidsprekers of een hoofdtelefoon aan te sluiten om geluiden te kunnen horen.

Zorg dat een voetregelaar is aangesloten op de [FOOT CONTROLLER]-aansluiting en probeer
de voetregelaar te bewegen.

Als Local Control op Off is ingesteld, wordt er geen geluid geproduceerd als u het toetsenbord
bespeelt.
[UTILITY] → Settings  → MIDI I/O  → Local Control

Wijs in dat geval een geluid toe aan de partij of selecteer een andere partij.

Problemen oplossen

De respons van het aanraakscherm is slecht

Wijst de cursor naar de exacte locatie die u op het aanraakscherm hebt aangeraakt?

De reactie van de lintregelaar is slecht

Kalibreer de lintregelaar.

Geen geluid

Zijn alle schuifregelaars op het juiste niveau ingesteld (niet op nul of de
minimumwaarde)?

Zijn er versterkers, luidsprekers of hoofdtelefoons op het instrument aangesloten?

Zijn dit instrument en eventuele aangesloten apparaten ingeschakeld?

Hebt u alle niveaus juist ingesteld, waaronder het mastervolume op dit instrument en de
volume-instellingen op andere aangesloten apparatuur?

Is Local Control ingesteld op 'Off'?

Is er een lege partij geselecteerd?

Is de schakelaar Mute voor elke partij ingeschakeld?
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Als de schakelaar Mute is ingeschakeld, wordt er geen geluid geproduceerd als u het
toetsenbord bespeelt.
[PERFORMANCE] → Part -selectie → Mute

[PERFORMANCE] → Part -selectie → Kbd Ctrl

Als deze parameter is ingeschakeld, produceert de overeenkomstige partij alleen geluid via
afgespeelde arpeggio.
[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Part Settings  →
Arp Play Only

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Arpeggio  → Common  → Arp Play Only

Als u een filter gebruikt, probeer dan de afsnijfrequentie te wijzigen. Bepaalde afsnij-instellingen
kunnen ervoor zorgen dat al het geluid wordt uitgefilterd.
[SHIFT] + [NAVIGATION]

[PERFORMANCE] → Common -selectie → [EDIT/ ] → Effect

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Element  of Key -selectie → Filter

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Effect

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Filter/Amp

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Effect

Als dit het geval is, stelt u de parameters die betrekking hebben op de A/D INPUT-aansluitingen
in op de juiste waarden en bespeelt u het toetsenbord vervolgens terwijl u spreekt of zingt in de
microfoon die op dit instrument is aangesloten. Controleer of de A/D INPUT [GAIN]-knop op het
bovenpaneel op een andere waarde dan 0 is ingesteld.
[PERFORMANCE] → Part -selectie → [EDIT/ ] → Effect  → Routing

[PERFORMANCE] → Common -selectie → [EDIT/ ] → Audio In

[UTILITY] → Settings  → Sound  → Tone Generator Volume

[PERFORMANCE] → Common -selectie → [EDIT/ ] → General/Pitch  → Perf Settings  →
Volume

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Part Settings  → Volume

Is de toetsenbordbesturing van elke partij uitgeschakeld?

Is Arp Play Only van elke partij ingeschakeld?

Is het MIDI-volume en/of zijn de instellingen voor MIDI-expressie te laag bij het gebruik
van een externe controller?

Zijn de effect- en filterinstellingen correct?

Voor normale partijen (AWM2) en drumpartijen

Voor normale partijen (FM-X) en normale partijen (AN-X)

Is Vocoder geselecteerd als het invoegeffecttype van de partij?

Zijn het volume of de niveaus te laag ingesteld?
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[PERFORMANCE] → Part -selectie → [EDIT/ ] → Part Settings  → General  → Dry Level

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Element  of Key -selectie → Amplitude  →
Level/Pan  → Level

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Operator -selectie → Level  → Level

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Oscillator -selectie → OSC/Tune  →
Out Level

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Part Settings

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Element  of Key -selectie → Osc/Tune

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Part Settings

[PERFORMANCE] → Part -selectie → Element , Operator  of de Oscillator -status op de
Navigation bar

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Operator -selectie → Level  → Level

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Part Settings  →
Part Output

Wanneer Destination is ingesteld op Volume of Cutoff, wordt er geen geluid geproduceerd,
afhankelijk van de instelling en regelaarstatus.
[PERFORMANCE] → Part -selectie → [EDIT/ ] → Mod / Control  → Control Assign

Voor normale partijen (AWM2) en drumpartijen

Voor normale partijen (FM-X)

Voor normale partijen (AN-X)

Zijn de instellingen zoals Element Switch, Note Limit, Velocity Limit en Velocity Offset
juist?

Voor normale partijen (AWM2) en drumpartijen

Voor normale partijen (FM-X) en normale partijen (AN-X)

Is de schakelaar Mute voor elk element of elke operator van de partij ingeschakeld?

Is in het geval van een normale partij (FM-X) het niveau van de draaggolf ingesteld op 0?

Is de uitgangsinstelling van elke partij uitgeschakeld?

Zijn de regelaarinstellingen correct?

Er komt geen geluid uit de A/D INPUT-aansluitingen

Is de aangesloten microfoon ingeschakeld?

Is er een dynamische microfoon op het instrument aangesloten?

Is de kabel tussen de microfoon of de audio-apparatuur en dit instrument correct
aangesloten?
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[PERFORMANCE] → Common -selectie → [EDIT/ ] → Audio In  → Mixing  →
A/D In Input Mode

Wanneer een microfoon of ander apparaat met een laag uitgangsniveau is aangesloten, stelt u
deze in op Mic. Wanneer een audioapparaat, elektronisch instrument of een ander apparaat met
een hoog ingangsniveau is aangesloten, stelt u deze in op Line.
[UTILITY] → Settings  → Audio I/O  → A/D Input

[PERFORMANCE] → Common -selectie → [EDIT/ ] → Audio In  → Mixing  → A/D In Volume

[PERFORMANCE] → Common -selectie → [EDIT/ ] → Audio In  → Routing

[PERFORMANCE] → Common -selectie → [EDIT/ ] → Audio In  → Mixing  →
A/D In Output Select

Als Vocoder is geselecteerd als invoegeffect, produceert de audio-ingang van de A/D INPUT-
aansluitingen mogelijk geen geluid, tenzij u het toetsenbord bespeelt.
[PERFORMANCE] → Part -selectie → [EDIT/ ] → Effect  → Routing

Stel deze parameter in op een andere waarde dan always, omdat met deze instelling het
klikgeluid altijd wordt afgespeeld, ongeacht de status van de sequencer.
[UTILITY] → Tempo Settings  → Click Mode

Het geluid is mogelijk vervormd, afhankelijk van het effecttype en de instellingen.

Staat de knop A/D INPUT [GAIN] op de minimumpositie?

Is de knop A/D INPUT [ON/OFF] ingeschakeld (brandt deze)?

Controleer of de kabelverbinding met de A/D INPUT-aansluitingen overeenkomt met de
Mono/Stereo-instellingen voor de aansluiting.

Controleer of de Mic- of Line-instelling geschikt is.

Is het volume van het A/D-invoergedeelte te laag ingesteld?

Zijn de effectinstellingen voor de A / D-ingangspartij correct?

Is de uitganginstelling van de A/D-ingangspartij correct?

Controleer of het Vocoder-effect is geselecteerd.

Het afspelen gaat door zonder te stoppen

Als de [KEYBOARD HOLD]-knop aanstaat, probeer deze dan uit te zetten.

Als de [ARP ON/OFF]-knop aanstaat, probeer deze dan uit te zetten.

Voor het scherm Pattern/Song/Audio drukt u op de knop [ ] (Stop).

Als een effectgeluid (zoals vertraging) doorgaat en niet stopt, wijzigt u de effectinstelling
of selecteert u een andere performance.

Als het klikgeluid zich blijft voordoen, controleert u de volgende instelling.

Vervormd geluid

Zijn de effectinstellingen correct?
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[PERFORMANCE] → Part -selectie → [EDIT/ ] → Effect

Bovenmatige instellingen voor filterresonantie kunnen vervorming veroorzaken.

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Element  of Key -selectie → Filter

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Filter/Amp  → Filter Type

[UTILITY] → Settings  → Sound  → Tone Generator Volume

[UTILITY] → Settings  → Audio I/O

[PERFORMANCE] → Common -selectie → [EDIT/ ] → General/Pitch  → Perf Settings  →
Volume

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Part Settings  → Volume

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Element -selectie → Amplitude  →
Level/Pan  → Level

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Key -selectie → Level/Pan  → Level

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Operator -selectie → Level  → Level

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Oscillator -selectie → OSC/Tune  →
Out Level

Als u akkoorden wilt spelen, moet u deze parameter instellen op Poly.

Zijn de filterinstellingen correct?

Voor normale partijen (AWM2) en drumpartijen

Voor normale partijen (FM-X) en normale partijen (AN-X)

Is het volume te hoog ingesteld?

Normale partijen (AWM2)

Voor drumpartijen

Voor normale partijen (FM-X)

Voor normale partijen (AN-X)

Het geluid wordt afgesneden.

Overschrijdt het totaalgeluid de maximale polyfonie?

AWM2 (vooraf ingestelde golfvormen): 128 (zowel stereo als mono)

AWM2 (gebruikers- of bibliotheekgolfvormen): 128 (zowel stereo als mono)

FM-X: 128

AN-X: 16

Er klinkt slechts één noot tegelijkertijd

Controleer of de toongeneratiemodus is ingesteld op Mono.
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[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Part Settings  →
Mono/Poly

[UTILITY] → Settings  → Sound  → Tone Generator Tune

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Pitch  → Note Shift

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch → Pitch  → Detune

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Pitch  →
Micro Tuning Name

[UTILITY] → Settings  → Sound  → Global Settings

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Element -selectie → Element LFO  →
Pitch Mod

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Mod/Control  → 2nd LFO  →
Pitch Modulation Depth

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → Pitch LFO  →
Pitch LFO Depth

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Element  of Key -selectie → Osc/Tune  →
Coarse

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Element  of Key -selectie → Osc/Tune  →
Fine

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Operator -selectie → Form/Freq  → Coarse

Verkeerde toonhoogte

Is Tune ingesteld op een andere waarde dan 0?

Is Note Shift of Detune ingesteld op een andere waarde dan 0?

Als de partij een verkeerde toonhoogte produceert, heeft u dan een speciaal temperament
geselecteerd in Micro Tuning?

Hebt u een speciaal temperament ingesteld in Global Tuning?

Als de partij een verkeerde toonhoogte produceert: is de LFO Pitch Modulation Depth te
hoog ingesteld?

Voor normale partijen (AWM2)

Voor normale partijen (FM-X)

Voor normale partijen (AN-X)

Als een partij een verkeerde toonhoogte produceert: zijn de juiste waarden voor Coarse
Tune en Fine Tune ingesteld?

Voor normale partijen (AWM2) en drumpartijen

Voor normale partijen (FM-X)
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[PERFORMANCE] → Part -selectie → [EDIT/ ] → Operator -selectie → Form/Freq  → Fine

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Mod/Control  → Control Assign  →
Destination

[PERFORMANCE] → Part -selectie → [EDIT/ ] → General/Pitch  → AN-X Settings

Controleer de effectinstellingen met behulp van [SHIFT] + [NAVIGATION].

[UTILITY] → Effect Switch

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Effect  → Routing  → Var Send

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Effect  → Routing  → Rev Send

[PERFORMANCE] → Common -selectie → [EDIT/ ] → Effect  → Routing  → Var Return

[PERFORMANCE] → Common -selectie → [EDIT/ ] → Effect  → Routing  → Rev Return

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Effect  → Routing  → Connect

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Effect  → Ins A  of Ins B

U kunt de arpeggio's van maximaal acht partijen tegelijkertijd afspelen.

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Arpeggio  → Common

Als de partij een verkeerde toonhoogte produceert: is de Controller Destination ingesteld
op Pitch?

Is Voltage Drift voor een AN-X-onderdeel ingesteld op een te hoge waarde?

Er wordt geen effect toegepast

Is de effectschakelaar uitgeschakeld?

Is Variation Send of Reverb Send ingesteld op een andere waarde dan 0?

Is Variation Return of Reverb Return ingesteld op een andere waarde dan 0?

Is het invoegeffect op alle elementen of alle toetsen in de partij ingesteld op Thru?

(Voor systeemeffecten) Is het geselecteerde effecttype voor elk effect ingesteld op No
Effect?

(Voor invoegeffecten) Is het geselecteerde effecttype voor elk effect ingesteld op Thru?

Is de instelling van de invoegschakelaar juist?

Kan het arpeggio niet starten.

Staat de [ARP ON/OFF]-knop aan?

Controleer het aantal partijen waarvoor de arpeggioschakelaar is ingeschakeld.

Zijn de Note Limit- en Velocity Limit-instellingen voor het arpeggio geschikt?

Is het arpeggiotype ingesteld op Off?
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[PERFORMANCE] → Part -selectie → [EDIT/ ] → Arpeggio  → Individual  → Name

Als de arpeggioschakelaar is uitgeschakeld, wordt het arpeggio niet afgespeeld, zelfs niet als u
de knop [ARP ON/OFF] op het bovenpaneel inschakelt.
[PERFORMANCE] → Part -selectie → Arp Part

[PERFORMANCE] → Part -selectie → [EDIT/ ] → Arpeggio  → Common  → Hold

De geheugenruimte op het instrument kan maximaal 128 patronen en 128 songs bevatten. Als u
meer dan 128 songs of patronen probeert op te nemen, krijgt u de melding Song full en is
opnemen niet meer mogelijk.

[UTILITY] → Settings  → MIDI I/O  → MIDI IN/OUT

Schakel Receive Bulk in.
[UTILITY] → Settings  → Advanced  → MIDI Receive Bulk

[UTILITY] → Settings  → Advanced  → MIDI Device Number

[UTILITY] → Settings  → Advanced  → MIDI Device Number

Controleer de instellingen van de arpeggioschakelaar voor elke partij.

Kan het arpeggio niet stoppen.

Als u het afspelen van het arpeggio niet kunt stoppen door uw vinger van de toets te
halen, zet u de schakelaar Arpeggio Hold op Off.

Zet de knop [KEYBOARD HOLD] op het bovenpaneel uit.

Het afspelen van patronen of songs start niet als u op de knop [ ] (Play) drukt

Zijn er data in het geselecteerde patroon of de geselecteerde song?

Kan geen patroon of song opnemen

Is er geheugenruimte beschikbaar voor het opnemen van een patroon of song?

Datacommunicatie tussen het instrument en de aangesloten computer werkt niet correct.

Is de poortinstelling op de computer juist?

Hebt u de juiste terminal (MIDI of USB) geselecteerd op het scherm Utility?

Verzending of ontvangst van MIDI-bulkdumpdata werkt niet correct.

Is Receive Bulk beveiligd?

Om de ontvangst mogelijk te maken van data die zijn opgenomen met de
bulkdumpfunctie van dit instrument, moet u voor zowel verzending als ontvangst
hetzelfde apparaatnummer instellen.

Is hetzelfde apparaatnummer ingesteld op het aangesloten MIDI-apparaat?

523



Open het scherm Save en stel het apparaat in op een USB-flashstation. Controleer of de vrije
opslagruimte die rechtsboven in het scherm wordt weergegeven, 0,0 KB bedraagt.
[UTILITY] → Contents  → Save

Controleer de volgende URL voor de lijst met USB-apparaten waarvan is bevestigd dat ze met
dit instrument werken.
https://download.yamaha.com/

Kan niet opslaan op het USB-flashstation.

Heeft het USB-flashstation schrijfbeveiliging?

Is er voldoende vrije ruimte op het USB-flashstation?

Gebruikt u een USB-flashstation waarvan is bevestigd dat het met dit instrument werkt?

In de display zijn zwarte puntjes (lichten niet op) of witte puntjes (branden continu)
zichtbaar

Dit is een kenmerk van kleuren-LCD's en duidt niet op een storing.
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LET OP

Als de functie Initialize All Data wordt uitgevoerd, worden alle performances en songs die u hebt
opgeslagen in het gebruikersgeheugen en de Utility-instellingen voor de algemene
toetsenbordinstellingen overschreven met de standaardwaarden. Zorg ervoor dat u geen
belangrijke data verliest. Het is daarom verstandig om regelmatig back-ups van belangrijke
instellingen op de slaan op een USB-flashstation.

1. Open het instellingenscherm via [UTILITY] → Settings → System.

Hiermee wordt het instellingenscherm voor het gehele instrument opgeroepen.

2. Tik op [Initialize All Data].

Het bevestigingsscherm wordt weergegeven.
Als u de handeling wilt annuleren, tikt u op de knop Cancel No op het scherm of drukt u op de
knop [DEC/NO] op het bovenpaneel.

3. Tik op de knop [Initialize Yes] op het scherm of druk op de knop [INC/YES] op
het bovenpaneel.

De bewerking Initialize All Data wordt uitgevoerd.

De oorspronkelijke fabrieksinstellingen terugzetten (Initialize All Data)
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